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Introduction

th an amazing time to get to know the Mac. For years these elegantly
designed computers have been a model of simplicity and virus-free

stability. But that’s never stopped Apple from making these machines even
harder to resist by applying stunning changes.

Consider Apple’s seismic embrace of Intel a few years ago. It means you,
Mr. or Ms. Computer Buyer, can have your cake and eat it too. (I love a good
cliché when I need it.) You can benefit from what remains the best marriage
in personal computing (the blessed union between Mac hardware and Mac
software), but you no longer have to ditch the Microsoft Windows-based
software you currently use out of habit, due to business obligations, or
because you don’t know any better.

Indeed, this book is partially targeted at Windows vets who are at least think-
ing about defecting to the Mac. It is also squarely aimed at people who are
new to computers — and the Internet — period. And though this is primarily
a book for beginners, I trust people who have already dabbled with comput-
ers in general and Macs in particular will find it useful.

About This Book

A word about the For Dummies franchise I'm proud to be a part of: These
books are built around the idea that all of us feel like dopes whenever we
tackle something new, especially when the subject at hand (technology)
reeks of a jargon-y stench.

[ happen to know you don’t have a dummy bone in your body, and the pub-

lishers at Wiley know it too. Au contraire. (How dumb can you be if you speak
French?) If anything, you’ve already demonstrated smarts by purchasing this
book. You're ready to plunge into the best computing environment [ know of.

Because you’re so intelligent, you're probably wondering “who is this guy
asking me for 400 pages or so of my time?” Go ahead and read my bio, which
appears just before the Table of Contents.

What you won'’t find there is this: I'm a relative latecomer to the Mac. I grew
up on MS-DOS computing and then migrated like most of the rest of the world
to Windows. I still use Windows machines every day.
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But I've since become a devoted Mac convert and [ use my various Apples
every day too. (No snide remarks, please; I find time for other pursuits.)

When writing this book, I vowed to keep geek-speak to a minimum. [ couldn’t
eliminate it entirely, and to be honest, | wouldn’t want to. Here’s why:

» You may come across absurdly complicated terms in advertisements
and on the Web, so it’s helpful to have at least a passing familiarity with
some of them.

+* Nothing says we can’t poke a little fun now and then at the nerds who
drummed up this stuff.

Conventions Used in This Book

Anyone who has skimmed the pages of this or other For Dummies books
knows they’re not exactly War and Peace. Come to think of it, it’s too bad
Tolstoy got to that name first. It would make a great title when the definitive
account of the Apple-Intel alliance is written.

Macs For Dummies makes generous use of numbered and bulleted lists, and
screen grabs captured, by the way, using a handy little freebie Mac utility
(invaluable to writers of books like this) called Grab. See, you haven’t even
escaped the introduction, and I threw in your first Mac lesson, just like that.

You'll also note several sidebars in the book, containing material that’s not
part of the required syllabus (well, nothing is really required). I hope you’ll
read them anyhow. Some sidebars are technical in nature, and some provide
a little historical perspective.

How This Book Is Organized

The beauty of the For Dummies format is that you can jump around and read
any section you want. You are not obliged to follow a linear structure. Need
to solve a problem? Head straight to the troubleshooting section (Chapter
20) and do not pass Go. Want to find new music to listen to while pounding
away on the computer? Meet me in Chapter 14.

An organizing principle is at work here. This edition of Macs For Dummies is
split into a half-dozen parts. If you're new to computing, you might want to
digest this book from start to finish.
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Part I: Freshman Vear at
Drag-and-Drop Tech

In Part I, I lay out the groundwork for your Mac education: from turning the
machine on to navigating the Mac desktop. You are introduced to ports and
connectors, the dock, freebie programs, and the various Macs models.

Part II: Mac Daily Dealings

If Part | was mainly for seminars and lectures, Part Il is where you get to do
lab work. You find out how to process words and print and how to start
taming the Leopard operating system.

Part I1I: Rocketing into Cyberspace

Part Il covers all things Internet. You find out how to get connected, conduct
online research, shop, and send e-mail. I also introduce Time Machine, the
slickest and easiest computer backup anywhere, and MobileMe, Apple’s fee-
based online club.

Part lU: Getting an iLife

In Part IV you really move into the fun stuff, the programs that may have
driven you to purchase a Mac in the first place: iTunes, iPhoto, iMovie, iDVD,
GarageBand, and iWeb.

Part U: The Creepy Geeky Section

Part V is the part of this computer book that you might imagine is most, well,
like a computer book. Don’t worry, you can read the chapters in this section
without being branded a nerd. In any event, it’s chock-full of practical infor-
mation on networking and diagnosing problems.

Part UI: The Part of Tens

Listmania is a For Dummies trademark. Check out Part VI for ten Mac-flavored
Web sites, ten dashboard widgets, plus ten more nifty things a Mac can do,
from playing chess to telling a joke.

3
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Icons Used in This Book
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Sprinkled in the margins of these pages are little pictures, or icons. I could
have easily mentioned icons in the “Conventions Used in This Book” section,
because icons are For Dummies conventions too, not to mention essential
ingredients in today’s computers. I use four of them throughout this book.

A remember icon means a point of emphasis is here. So along with remember-
ing your spouse’s birthday and where you put the house keys, you might want
to retain some of this stuff.

[ present the tip icon when a shortcut or recommendation might make the
task at hand faster or simpler.

Some percentage of For Dummies readers will get so hooked on computing
they will become the geeks of tomorrow. These are the people who will wel-
come the presence of these pointy-faced little icons. Others among you would
rather swallow turpentine than read an overly technical passage. You can
safely ignore this material. (Still, won’t you be the least bit curious about what
it is you might be missing?)

This icon is my way of saying pay heed to this passage and proceed gingerly,
lest you wreak the kind of havoc that can cause real and possibly permanent
damage to your computer and (by extension) your wallet.

Where to Go from Here

I've made every effort to get things right and present them in a coherent
manner. But if ['ve erred in any way, confused you, made you mad, whatever,
drop me an e-mail at baigdummies@aol . com. I truly welcome your com-
ments and suggestions, and I'll do my best to respond to reasonable queries
in a timely fashion. Mac people aren’t shy about voicing their opinions. Oh,
and since all writers have fragile egos, feel free to send nice e-mails my way
too. Above all, I hope you have fun reading the book, and more importantly, [
hope you have a grand old time with your Mac. Thanks for buying the book.
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In this part . . .

Even at a party school, you have to enroll in a few
academic classes. In these early chapters, the course

work provides you with your first glimpse at the tools and
programs that make Macs so appealing. Plus, the home-
work is light.

You've selected an excellent major.




Chapter 1
Adventuring into the Mac World

In This Chapter

Discovering why your computer is special
Conversing with your computer
Introducing iLife

Going outside the box

Computing safely

F)rgive me for getting too personal right off the bat, but next to your
spouse or significant other, is there anyone or anything you touch more
often than a computer keyboard? Or gaze at more intensely than a monitor?

If this is your initial dalliance with a Macintosh, you are probably already
smitten — and quite possibly at the start of a lifelong affair.

Despite its good looks, the Mac is much more than a trophy computer. You
can admire the machine for flaunting intelligent design, versatility, and tough-
ness. A Mac can take care of itself. As of this writing, the Mac has avoided the
scourge of viruses that plague PCs based on Microsoft Windows. Apple’s dar-
lings are a lot more stable too, so they crash and burn less often.

Mac-Spectacular Computing

You shouldn’t be alarmed that far fewer people own Macs compared with
PCs. That’s like saying fewer people drive Ferraris than drive Chevys.
Strength in numbers is overrated.

Besides, as a new member of the Mac community, consider the company
you are about to keep. Mac owners tend to belong to the cool crowd: artists,
designers, performers, and (can’t resist this one) writers.

Sure, these same people can be smug at times. I've had Mac mavens go ballis-
tic on me for penning positive reviews that were not flattering enough. Or for
even daring to suggest that Macs aren’t always perfect.
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The machines come pretty darn close, though, so if you're new to the Mac
you're in for a treat. It has been suggested that most Windows users go to
their computers to complete the task at hand and be done with it. The Mac
owner also gets things done, of course. The difference is that machines
branded with the Apple logo tend to be a labor of love. Moreover, now that
Intel is inside newer Macs, Apple’s computer can double as a pretty darn
effective Windows machine.

Oh, and you will always remember the first time.

Checking out shapes and sizes

When people speak of the Mac, they may refer to both the physical machine
(or hardware) and the operating system software that makes it all tick. One is
worthless without the other. On a Mac, the operating system is called OS X
(pronounced “oh-S-ten”). The sixth major release of OS X also carries a fero-
cious moniker, Leopard (see Chapter 6 for more on the operating system).

Apple Computer has a tremendous advantage over the companies promoting
Windows PCs because it is the single entity responsible for producing not
only the computer itself but also the important software that choreographs
the way the system behaves. Everything is simpatico.

That’s in stark contrast to the ways of the PC world. Companies such as
Dell and Hewlett-Packard manufacture hardware. Microsoft produces the
Windows software that fuels the machines. Sure these companies maintain
close ties, but they just don’t share Apple’s blood relationships.

You will find a variety of Macintoshes meant to sit on top of your desk, thus
the term desktop computer. These are discussed in greater detail in Chapter 4.
Just know for now that the main examples of the breed are the iMac, the Mac
mini, and the Mac Pro.

Mac laptops, so named because they rest on your lap and are portable,
include the MacBook, the MacBook Pro, and the Twiggy-thin MacBook Air.
They are sometimes referred to as notebook computers or just plain note-
books. As with spiral notebooks, they can fit into a briefcase.

Matching a Mac to your needs

Haven'’t settled on which Mac to buy? This book provides assistance. Cheap
advice: If you can eyeball the computers in person, by all means do so. Apple
operates more than two hundred retail stores worldwide, mostly in North
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America. But there are also retail outlets in the United Kingdom, Italy, and
Japan. Trolling through these high-tech candy stores is a delight. Of course,
you can also buy Macs on the Internet or in traditional “brick and mortar”
computer stores.

Just be prepared to part with some loot. Although the gap between the cost
of PCs and Macs is narrowing, you will typically pay more for a Mac versus a
comparable unit on the PC side.

(Uh oh! The Mac diehards are boiling at that remark: I can practically see
their heads exploding as they rant: “There is no such thing as a comparable
Windows machine.”)
o Keep in mind that students are often eligible for discounts on computers.
Check with your college or university bookstore. Apple also gives breaks to
faculty, administrators, and K-12 teachers.

You might also qualify for a corporate discount through your employer.

Selecting handy pevipherals

As you might imagine, a full range of peripherals complement the Mac.
Although much of what you create in bits and bytes, to put it in computer-
speak, stays in that electronic form, at some point you're probably going
to want to print your work. On old-fashioned paper, no less. Fortunately, a
number of excellent printers work with Macs. [ provide details in Chapter 8.

You may also choose a scanner, which in some respects is the opposite of a
printer. That’s because you start with an image already in paper form, and
scan, or translate, it into a form your computer can understand and display.
Okay, so you can also scan from slides or microfiche but you get my point.

Some machines combine printing and scanning functions, often with copier

and fax capabilities as well. These are called multifunction, or all-in-one,
devices.

Communicating with Vour Mac

The Mac isn’t at all standoffish like some human objects of affection. It is
friendly and approachable. In this section, I tell you how.
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It’s a GU]

Every mainstream computer in operation today employs what’s called a
graphical user interface, or GUI. The Mac’s GUI is arguably the most inviting
of all. It consists of colorful objects or pictures on your screen, plus windows
and menus (for more, see Chapter 3). You interact with these using a com-
puter mouse or other pointing device to tell your machine and its various pro-
grams how to behave. Sure beats typing instructions as arcane commands or
taking a crash course in programming.

Even though GUI is pronounced “gooey,” there’s nothing remotely yucky
about it.

With great tools for you

Given its versatility, I've often thought a Mac would make a terrific product to
peddle on one of those late-night infomercials. “It slices, it dices. Why it even
does more than a Ginsu Knife or Popeil Pocket Fisherman!”

Indeed, have you ever paused to consider what a computer is anyhow? Let’s
consider a few of its most primitive (albeit handy) functions. A Mac can

v Tell time

v Display family portraits

v Solve arithmetic problems

v Play movies

v Let you chat with friends
[ dare say you didn’t surrender a grand or two for a simple clock, photo
album, calculator, DVD player, or telephone. But it’s sure nice having all

those capabilities in one place, and as that announcer on TV might bark,
“That’s not all folks.”

[ can’t possibly rattle off all the nifty things a Mac can do in one section
(besides, [ encourage you to read the rest of the book). But whether you
bought or intend to buy a Mac for work, play, or more likely some combina-
tion of the two, some little birdie tells me the contents of the Mac’s tool chest
will surpass your expectations.
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And output, too

I'm confident that you’ll spend many pleasurable hours in front of your
computer. At the end of the day, though, you're going to want to show other
people how productive and clever you’ve been. So whether you produce
legal briefs, spiffy newsletters for the PTA, or music CDs for your fraternity’s
big bash, the Mac will make you proud.

Living the iLife

All the latest Macs are loaded with a terrific suite of software programs called
iLife to help you master the digital lifestyle you are about to become accus-
tomed to. (On older systems, you can purchase the upgraded iLife suite of
programs.) [ dig deeper into the various iLife components throughout Part IV.
Here’s a sneak preview:

v~ iPhoto: The great photographer Ansel Adams would have had a field
day with iPhoto. This software lets you organize and share your best
pictures in myriad ways, including placing them in calendars or in coffee
table books.

v iMovie: Can an Academy Award be far behind? iMovie is all about apply-
ing cinematic effects to turn your video into a piece of high-minded art
that would make Martin Scorsese proud. Who knows, maybe Apple boss
Steve Jobs will find work for you at Disney or Pixar.

v~ iDVD: Use this program to create DVDs with chapters, like the films you
rent at the video store.

v GarageBand: Did somebody mention groupies? GarageBand lets you
make music using virtual software instruments. The latest version also
helps you create online radio shows, or podcasts.

v iWeb: This member of the iLife troupe is all about helping you create
your own Web site.

Reaching Outside the Box

The modern computing experience extends well beyond the inner workings
of the physical contraption on your desk. Computing is more about what
occurs in the magical kingdom of cyberspace, better known as the Internet.
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Getting online

In Chapter 9, you discover all there is to know about finding your way to the
Internet and the many paths you can take once you get there. The Mac comes
with the software you need to get started and (depending on your model) the
circuitry required to connect online through fast broadband methods. Older
machines may still dial up the Internet, though that is increasingly rare.

Networking with or without wires

Ask a few people to explain what networking is all about, and they’ll probably
utter something about trying to meet and cozy up to influential people who
might help them advance their careers or social lives.

A Mac can help with such things, too, but that’s not the kind of networking

[ have in mind. Computer networks are about having two or more machines
communicate with one another to share files, pictures, music, and most
importantly, a connection to various online outposts. Even on a Mac, this
networking business can get kind of geeky, though Apple does as good a job
as anyone in helping to simplify the process. You can network by connecting
certain cords and cables. The preferred method is to do so without wires.
This is all explained in Chapter 18.

Staying Safe and Trouble-Free

As noted, the Mac has historically been able to avoid the nasty viruses and
other malevolent programs that give Windows owners the heebie-jeebies.

In the nastiest scenarios, those Windows machines (or certain programs)
are shut down and personal information is surreptitiously lifted. In this day
and age, not even Mac owners should let their guard down. (And remember,
in some instances the Mac can double as a Windows machine.) Chapter 13
offers counsel on avoiding online dangers.

No matter how much care and feeding went into producing these beautiful
computers, when all is said and done we are talking about physical contrap-
tions filled with circuits and silicon. Machines break, or at the very least get
cranky. So drop by Chapter 20, where I outline common troubleshooting
steps you can take to ensure that you and your computer develop your rela-
tionship gracefully. It’s the high-tech alternative to couple counseling.



Chapter 2
The Nuts and Bolts of Your Mac

In This Chapter

Turning on the computer and getting set up
Taming the mouse

Keying in on the keyboard

Saving to the hard drive

Mastering memory

Finding common ports and connectors

Have you taken the plunge and purchased the computer? If so, you’'ve
made a fabulous decision.

[ bet you’re dying to get started. You may even have begun without reading
these initial instructions. Fine with me. No offense taken. The Mac is intui-
tive, after all, and the title on this cover notwithstanding, you’re no dummy. I
know because you had the good sense to buy a Macintosh — and this book.
Besides, what would it say about Apple’s product designers if they couldn’t
make you understand how to turn on the computer?

If you didn’t jump the gun, that’s cool too. That’s why your humble servant,
um, author, is here.

Turning On and Tuning In Your Mac

To borrow a line from a famous musical, “Let’s start at the very beginning, a
very good place to start . ..” In the Do-Re-Mi’s of Macintosh computing, plug-
ging the computer in the wall is a very good place to start. It doesn’t get a
whole lot more complicated from there.
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The Fab Four chime?

That musical chord you hear just after press-
ing the on button may sound vaguely familiar.
For a long time | thought it was the same chime
that ends the Beatles” A Day in the Life. Former
hippies, flower children, baby boomers, and just
about everyone else conscious during the 1960s
may wish it were so. For one thing, Macs are
sold with iLife software. Wouldn't it be groovy
to make a nexus between iLife and the Beatle’s

Life? Moreover, John, Paul, George, and Ringo
famously recorded on the Apple record label.
(Anyone remember records?) And Apple
cofounder Steve Jobs, like so many of his gen-
eration, is a Beatles fan. The sad reality is that
the Beatles” Apple Corps had a history of suing
Apple Computer over trademark issues. But
despite their litigious past, the two companies
finally gave peace a chance.

The on button

Take a second to locate the round on, or power, button. Where it resides
depends on the Mac model you purchased, but finding it shouldn’t be too taxing.
I'll even give away the secret on recently issued models. On the latest iMac, the
on button is on the lower-left back panel of the monitor (when you are facing the
monitor). On Mac laptops, the button is to the right of the keyboard.

Go ahead and press the on button now. Explosive things are about to happen.
Not those kinds of explosives; it’s just that igniting your first session on the
Mac makes you da bomb (translation: college slang for awesome or cool).

To let you know that all is peachy (or should I say Apple-y), you hear a musi-
cal chime (see the sidebar) while the Apple logo briefly shows up on the
screen in front of a gray background.

Getting credentials

Powering up a new Mac for the first time may make you feel like you're enter-
ing the United Nations. After the Apple logo disappears, a lengthy interroga-
tion process commences.

You are kindly instructed to pledge allegiance to a particular language.
Deutsch als Standardsprache verwenden and Gebruik Nederlands als hoofdtaal
are among the seventeen choices in a list box. If you don’t know what either
of these means, you should probably make another choice. In any case,
choose your selection by clicking with the mouse (see details later in this
chapter) or pressing Enter or Return on the keyboard.
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If you select Use English as the main language (as I did), you're treated to a
short movie welcoming you in several languages to OS X Leopard, the Mac’s
operating system software. Next, you get to tell your nosy computer your
country or region (United States, Canada, United Kingdom, Australia, New
Zealand, Ireland, and so on). There’s no need to whip out a passport.

At this stage you have the option to hear instructions for setting up your Mac.
To do so, press the Escape key.

If you happen to own another Mac, you can then transfer network settings,
user accounts, documents, applications, files, e-mail, and various preferences
from that other computer to this one. The process typically involves connect-
ing a FireWire cable, which you discover more about later in this chapter.

With the introduction of the MacBook Air notebook, Apple upgraded its soft-
ware so that you could migrate from another Mac wirelessly over a computer
network. The reason: Air does not have FireWire.

You also are presented with the option to transfer information from another
partition on this Mac. That’s a geeky term we’ll skip for now.

And you can migrate from another Mac volume using Leopard’s Time
Machine feature. Read Chapter 13 to find out how to go back in time.

Of course, if this is your maiden voyage on the SS Macintosh, the previous
choices are unimportant. Instead, select the box “Do not transfer my informa-
tion” and click Continue.

As the cross-examination goes on, you get to choose a keyboard layout and
then select any available wireless Internet service to use.

The next step is to enter your Apple ID, assuming you have one. Such creden-
tials let you buy stuff later.

Before completing this drill, you are also asked to reveal your name, address,
phone number, and (again if you have one) e-mail address. You can’t say no,
(though I suppose you can fib).

Distrustful types can click to read Apple’s privacy policy. Best I can tell, no
one will ask for your social security number or driver’s license.

Still, the prying goes on. Apple next wants to know what you do for a living
(“Other” is a safe choice in the menu) and where you will primarily use the
computer. You also get to tell Apple whether to keep you abreast on com-
pany news, software updates, and the latest products and services. Opting-in
is entirely up to you. Just be aware that you have to remove the check mark
in the box to opt-out.

15



1 6 Part |: Freshman Year at Drag-and-Drop Tech

Creating an identity

You're almost ready to begin touring the computer. But not quite. An impor-
tant step remains. You must choose an identity, or user account, to tell the Mac
that you are the Grand Poobah of this particular computer. As this almighty
administrator, you and you alone can subsequently add accounts for other
members of your family or workplace, each with a password that keeps them
from snooping into one another’s computing workspace (see Chapter 5).

Type the name of the account holder (for example, Cookie Monster), the short
name (Cookie), the password (chocolatechip or better yet something that’s
harder to guess), and the password again to verify it. You are also asked to
type a password hint (yummy flavor) as a gentle reminder should you ever
forget your password. Failing to remember things may not happen to you,
but it sure happens to me.

On models with a built-in camera you will also be asked at this stage to
choose an account picture. Better not be camera-shy, because this too you
can’t refuse.

Clocking in

Because it probably already seems like day is turning into night, this is as
appropriate a time as any to, well, select your time zone by clicking near
where you live on the world map that appears. If you're connected to the
Internet, the computer already knows the date and time. If not, you can enter
them now.

Registering your Mac

When all is said and done, the nice folks at Apple would also like you to regis-
ter your Mac. You can put this off till later or skip it. Letting Apple know who
you are gives the company the opportunity to flood you with promotional
e-mail. But you can register and opt-out of promotional e-mail.

Making acquaintances

Depending on how you set things up, you may see a welcome screen listing all
the people on the computer with a user account, each with a personal mug
shot or other graphical thumbnail next to their names. Click the name or pic-
ture next to the thumbnail. You're asked to enter your password (assuming
you have one). Type it properly, and you are transported to the main working
area, or desktop.
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down?
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The desktop [ am referring to here is the interface you see on the computer
display, not to be confused with a desktop-type machine.

Shutting down

We began this chapter with a noble discussion of how to turn on the Mac.
(Humor me if you didn’t think the discussion was even remotely noble.) So
even though you barely have your feet wet, I'm going to tell you how to turn
the dang thing off. Don’t you just hate people who not only give away the
ending (it’s the butler) but also tell you to do something and then tell you
why you shouldn’t have done it?

Okay. Ready? Sayonara time.

Using the arrow-shaped cursor, which you control with your mouse, stab the
small & logo found at the upper-left corner of the screen. Click once, and a
drop-down menu appears. Move the cursor down until the Shut Down entry
is highlighted. You know a command or an entry is highlighted because a
blue strip appears over its name.

Pressing Enter on the keyboard or clicking Shut Down brings up what’s called
a dialog box (see Figure 2-1). I'm no shrink, but it’s obvious based on the
question the computer asks inside this box that it suffers from separation
anxiety. “Are you sure you want to shut down your computer now?”

Are you sure you want to shut down your
computer now?

\\‘:,f, If you do nothing, the system will shut down automatically
in 52 seconds.

( Cancel ) (ShutDuwn‘}

Do nothing, and the machine will indeed turn itself off in a minute on Leopard
machines or two minutes on older Macs. If you want to say “so long” imme-
diately, click the button labeled Shut Down. If you hold down the Option key
when choosing Shut Down, this dialog is bypassed.

Having second thoughts? Click Cancel.

17



18

Part |: Freshman Year at Drag-and-Drop Tech

3

Giving your Mac a nap

Apart from guilt, why not shut down? The main reason is that you can let

the computer catch a few Zs without turning it off. A sleeping Mac consumes
far less energy than one that’s in a conscious state. Mac’s don’t snore, but
you know they’re alive because of a dim blinking light. As it turns out, your
machine is a light sleeper. You can wake it up right away by pressing any key
on the keyboard. Best of all, whatever you happened to be working on is just
where you left it. You have to begin from scratch when you restart a Mac that
you had completely shut down.

If you're going to leave the Mac on for an extended period of time, make sure
it’s plugged in to a surge protector that can protect the machine from light-
ning. More expensive surge protectors have backup batteries.

You can make a Mac laptop go to sleep immediately by shutting its cover.
'1:0 make a desktop machine go to sleep, click the Sleep command on the
® menu.

Mousing Arvound the Interface

By now you're catching on to the idea that this computing business requires
a lot more clicking than Dorothy had to do to get back to Kansas. She used
ruby slippers. You get to use a mouse.

A computer mouse is generally less frightening than that other kind of critter.
In keeping with this Wizard of Oz comparison, not even the Cowardly Lion
would be scared of it. And though your high-tech rodent can get finicky at
times, you're unlikely to set traps to bring about its demise.

Some mice connect to the computer through cords. Some mice are wireless.
(And laptops use trackpads.) In each case, they’re called pointing devices
because — brace yourself for this advanced concept — they’re devices that
sort of point.

I'll explain. You roll the mouse across a flat surface (typically your desk, per-
haps a specialized mouse pad). As you do so, a cursor, or insertion point, on
the screen miraculously apes the movement of your hand gliding the mouse.
(Note to self: The mixed metaphor police, a.k.a. my editor, must love the
mention of a mouse and a monkey in the same breath.) If the mouse loses
touch with the surface of your desk, the cursor will no longer move.
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When you place the cursor precisely where you want it, you're ready for the
clicking part. Place your index finger on the upper-left portion of the mouse,
press down quickly, and let go. You'll hear a clicking sound, and in some
cases your entire body will tingle with satisfaction. You have indeed mas-
tered the fine art of clicking.

Don’t get too cocky. Now try double-clicking, an action often required to get
something accomplished. You're pretty much repeating the preceding exer-
cise, only now you're clicking twice in rapid succession while keeping the
cursor in the same location. It may take a little practice. But you’ll get it.

Left- and right-clicking

If you've been using a Windows computer, you're accustomed to working
with a mouse that has two or more buttons. More times than not you click,
or double-click, using the upper-left button. That’s where the remarkably
unoriginal name of left-clicking comes from. Left-clicking usually serves the
purpose of selecting things on the screen. By contrast, the opposite action,
right-clicking, brings up a menu of shortcut commands.

Until recently, the typical Apple mouse had just one button, the functional
equivalent of the left button on a Windows mouse. (Apple’s programmable
Mighty Mouse, included with recent Macs, can behave like a multibutton
mouse.) Having just one button on a Mac is less of a big deal than you might
think. That’s because you can effectively right-click, or bring up a shortcut
menu, with a one-button Mac mouse anyway. To accomplish this great feat,
press Control on the keyboard while you click.

Pointing and clicking on a laptop

You can attach a regular mouse to any Mac laptop, but it is not always conve-
nient to use one when you'’re on a 747 or working in tight quarters.

Fortunately, Mac portables have something called a trackpad, a smooth
area just below the keyboard. You glide your finger on the trackpad to cho-
reograph the movement of the cursor. The button just below the trackpad
handles clicking chores.

What a drag

The mouse is responsible for at least one other important bit of business:
dragging. Position the cursor on top of the symbol or icon you want to drag.
Then hold down the mouse button and roll the mouse across your desk. As
you do so, the icon moves to a new location on the screen.
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Knowing What's Handy about
the Keyboard
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As with any computer — or an old-fashioned typewriter for that matter — the
Mac keyboard is laid out in QWERTY style, meaning the top row of letters
starts with Q, W, E, R, T, and Y. But a computer keyboard also contains a
bunch of specialized keys that the inventors of the typewriter wouldn’t have
dreamed of.

Finding the major functions

The top row of the Mac keyboard carries a bunch of keys with the letter F
followed by a number. From left to right, you go from F1, F2, F3, all the way
out (in some cases) to F16. These are your loyal function keys, and their par-
ticular marching orders vary among Mac models. Depending on your setup,
pressing certain F keys has no effect at all.

With some exceptions, the F9, F10, F11, and F12 relate to a Mac feature called
Exposé, which I explain in Chapter 5. In the same chapter I discuss the role F8
has in launching a new feature called Spaces.

On Mac laptops, the F1 and F2 keys can raise or lower the brightness of your
screen. On other types of Macs, F14 and F15 perform those functions. Again
there are exceptions.

Those various F keys may be difficult to spot at first on a laptop. They have
teeny-tiny labels and share keys. You'll have to press the fn key at the same
time you press a function key to make it, well, function as a function key.
Otherwise such keys will perform their other duties.

The keys you use every day

Quick quiz: Guess which keys you employ most often? Too easy. The keys
you use every day are the ones representing vowels and letters with low
point values in Scrabble.

Naturally, these aren’t the only keys that work overtime. The spacebar,
comma, and period are darn busy. If you're into hyperbole, the exclamation
mark key puts in an honest day’s effort too. Don’t let me shortchange Shift
or Return. And I know you accountants in the crowd spend a lot of time ham-
mering away at all those number keys.
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More keys to success

You'll find these other keys extremely useful:

v esc: The great Escape key. The equivalent of clicking Cancel in a dialog box.

p# % %) % These raise, lower, or mute the volume of the computer’s
speakers, though in laptops certain function keys perform these duties.

1~ A: No doubt this is James Bond’s favorite key. Press it, and one of two
things is supposed to happen. On most newer Macs, a CD or DVD loaded
inside the guts of the computer spits out of a hidden slot. On other
models, the tray holding the disc slides out.

+* Delete, delete: You are not reading double. Some Mac keyboards have
two delete keys, each with a different assignment. Regular delete is your
backspace key. Press it, and it erases the character directly to the left of
the cursor. The second delete key, which sometimes appears as Del and
sometimes as delete accompanied by an x inside a small pentagon, is the
forward delete key. It wipes out the character to the right of the cursor.
Confusingly, on some laptops and with a new aluminum keyboard, you
can purge the letter to the right of the cursor by pressing fn and delete
at the same time.

v Home, End: The jumpiest keys you will come across. Press Home and
you're instantly vaulted to the top of the document or Web page window
in which you are working. Press End and you often plunge to the bottom,
depending on the application.

1~ Page Up, Page Down: A keyboard alternative for moving up or down one
huge gulp or screenful at a time.

v Option: Pressing Option (labeled Alt Option on some keyboards) while
you press another key generates symbols. You can’t possibly recall
them all, though over time, you’ll learn the key combinations for sym-
bols you regularly call upon. For example, press Option and 2 for ™,
Option and V for v, and Option and R for ®. Feel free to play around with
other combinations.

v Control: The Control key and the mouse click make a powerful
combination. Control-clicking yields pop-up contextual menus that only
make sense in the moment. For example, Control-clicking a term in the
Microsoft Word word processing program brings up a menu that lets
you find a synonym for that word, among other options. Because
finding a synonym doesn’t make a lot of sense when you control-click a
picture in iPhoto (Chapter 15), the action opens up different possibilities,
including editing, rotating, and duplicating an image.

v~ 8: Pressing this cloverleaf key at the same time you press another
keyboard character creates keyboard shortcuts, a subject worthy of its
own topic (see the next section).

21
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Taking a shortcut

If you hold the mouse in high regard, you may want to give the little fellow
time off now and then. That’s the beauty of keyboard shortcuts. When you
simultaneously press 8 and a given key, stuff happens. You just have to
remember which combination of keys to use under which circumstances.

To understand how such shortcuts work, consider the popular act of copying
material from one program and reproducing it in another. You are about to
practice copy-and-paste surgery.

I present two ways to do this. One leaves pretty much everything up to your
mouse. The other, while still using the mouse a little, mainly exploits key-
board shortcuts.

The first option follows:

1. Use the mouse to highlight, or select, the passage you want to copy.
2. On the menu bar at the top of the screen, choose Edit~>Copy.

3. Move the mouse and click to place your mouse at the point where you
want to paste the text.

4. Choose Edit=>Paste.

The copied material magically appears at its new destination.
Here is the keyboard shortcut method:

1. Highlight the text you want to copy.
2. Hold down the 3 key while you press the C key.
The result is the same as if you had clicked Edit and Copy.

3. Move the mouse and click to place the mouse at the point where you
want to paste.

4. Press 3 and the V key.
You just pasted the text.

Many clickable menu items have keyboard equivalents. These shortcuts are
displayed in the various menus to the right of their associated commands, as
shown in Figure 2-2. Note that some keyboard shortcuts shown in the menu
appear dimmed. That’s because the commands can’t be used at this particu-
lar point. And some shortcuts require both the 8 key and one or more addi-
tional modifier keys, as in Shift+88+N for a New Folder.
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Storing Stuff on the Hard Drive

You keep lots of things on a computer. Software you've added. Photos,
songs, movies. Your graduate thesis examining Simon Cowell’s grip on young
American divas. Apple left a lot of stuff behind too, mainly the files and pro-
grams that make your Mac special.

The bottom line: Computers are a lot like houses. The longer you stick
around, the more clutter you accumulate. And despite your best rainy day
intentions, you almost never seem to get rid of the junk.

Besides, you have plenty of treasures worth holding on to, and you need a
place to store them. The great storage closet on your computer is called the
hard drive, and just as with a physical closet, the bigger it is the better. You
may even choose to add a second or third hard drive. You can almost always
take advantage of the extra storage. Plus, you can use an additional hard
drive to back up, or keep a copy of, your most precious digital keepsakes. For
that matter, an additional hard drive is required for Time Machine — and as
we’ll discover later, it’s a feature well worth exploring.

Indeed, this is a point [ cannot ram into your heads hard enough: However
you choose to do so, back up, back up, back up.
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Memory Essentials, or RAM On

Notice my not-so-subtle use of the word ram in the preceding section? That’s
to get you thinking about the other kind of RAM. It stands for Random Access
Memory or, mercifully, just memory for short. (I can’t help but think that
accessing my own memory is random, which may explain why I can recall
things from the third grade but not yesterday.) Just as you want as capacious
a hard drive as possible, you want to load as much RAM into your system as
you can possibly afford.

Here’s why. The hard drive is the place for your long-term storage require-
ments. RAM is femporary storage, and having lots of RAM on hand helps when
you open several programs at once and work with large documents. You
may be editing videos, listening to music, and crunching numbers, all while
pausing your work to defend the planet by deep-sixing evil aliens. Dude, you
are doing some serious high-tech juggling, otherwise known as multitasking.
Multitaskers guzzle up RAM.

Geeks refer to the amount of memory and hard drive space you have in terms
of bits and bytes. The itsy-bitsy bit (short for binary digit) is the tiniest unit of
information handled by a computer. Eight bits make up a byte, and a byte typi-
cally represents a letter, a punctuation mark, or a digit on your screen. [ know.
That’s an awful lot to chew, um, byte on.

You'll see measurements in Rilobytes, or KB (actually 1,024 bytes), mega-
bytes, or MB (1,048,576 bytes), and gigabytes, or GB (1,073,741,824 bytes).
Perspective: At the time of this writing, the least expensive iMac comes with
a 250GB hard drive and 1GB of RAM.

At the other extreme, the souped-up Mac Pro computer can handle up to 4
terabytes (TB) of storage. A terabyte is 1,024 gigabytes.

Locating the Common Ports
and Connectors

Industry standard jacks, holes, and connectors on the back or side of your
Mac (depending on whether you have a desktop or laptop and which model)
may look funky. But you can’t live without (most of) them. They are your
bridge to the gaggle of devices and peripherals that want to have a relation-
ship with your computer (see Figure 2-3).
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Figure 2-3:
Hook me up,
Scotty.
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Peripherally speaking: USB versus
FireWire

Ralph Kramden never drove a Universal Serial Bus. But you will take the USB
route quite often. That’s because USB (pronounced “you-S-bee”) connects
printers, scanners, digital cameras, Webcams, iPods, joysticks, speakers,
keychain disk drives, piano keyboards, and even your mouse and computer
keyboard.

The state of the art for USB ports is USB 2.0. Older Macs have slower
USB 1.1 ports.

Plugging in a USB device is as simple as, well, plugging it in (though some-
times you have to load software first). You can often remove USB devices
from the computer without causing harm by merely pulling the cable out of
the jack.

Sometimes, however, the Mac prefers that you let it know before pulling out
the cable. To remove an iPod connected by USB, for example, your Mac typi-
cally wants you to click a tiny icon in the iTunes software source list, next

to the name you’ve assigned the portable music player. Failure to click the
icon can cause unpleasant consequences. (For complete details on iPods and
iTunes, refer to Chapter 14.)

USB generally works like a charm. But like most things in life, there are occa-
sional drawbacks. For one, given all the devices that love USB, you may run
out of available ports. In that case, you can buy a USB expansion hub. If you do
so, l recommend a hub that you can plug in to an electrical outlet.
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Many USB devices don’t require any kind of electrical outlet because they
draw power from the Mac itself. You can recharge an iPod, for example, by
plugging it into a Mac’s USB port. But some USB ports, typically those that
reside on the keyboard, are relative weaklings. They work fine with low-power
devices such as your mouse but not with, say, a power-thirsty digital camera.
If you plug a USB device into a port in the keyboard and it doesn’t work, try
plugging it into a USB port directly on the back or side of the computer.

FireWire is the friendly name coined by Apple for a connector that Sony calls
iLink and that is also known by the unfortunate descriptor IEEE 1394. (I won’t
bore you with an explanation except to say it’s the reason why engineers are
engineers and not marketers.) FireWire is a speedy connector often used with
digital camcorders. But it also connects external hard drives and older iPods.

FireWire comes in two flavors, the older FireWire 400 specification and its
faster cousin, FireWire 800. Only certain Macs can handle the speedier guy.
And as mentioned earlier in this chapter, the MacBook Air doesn’t have any
FireWire port.

Two of a kind: The phone jack
and Ethernet

Older Macs have a phone jack that is identical to the wall outlet where you
plug in a regular phone. You connect a phone line to this jack to take advan-
tage of a dial-up modem to the Internet (Chapter 9). But now that we’ve
entered the speedy broadband era, dial-up modems are yesterday’s news,
which is why Apple no longer considers them standard issue on newer Macs.
That’s unfortunate because you may still encounter rare situations where
dial-up is your only option. Apple sells optional USB dial-up modems for just
that situation.

The end of the cable that plugs into an Ethernet jack looks just like a phone
jack on steroids. Ethernet’s main purpose in life is to provide a fast outlet to
the Internet or your office computer network.

Jacks of all trades

The following connectors are used less often and again vary by machine:
v Video output jack: This connects a Mac to an external monitor for, say,
giving classroom presentations.

v External Apple monitor jack: Apple’s own proprietary jack for
connecting one of its own monitors.
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v Lock: Found on laptops and the Mac mini, this tiny hole is where you
fit in a Kensington Security lock cable. With one end securely attached
to the computer, you loop a Kensington cable around the leg of a heavy
desk or other immovable object. The hope is that you’ll prevent a thief
from walking off with your notebook. The laptop cable is similar to a
bicycle lock and cable that you wrap around the bicycle wheel and a
pole to help stymie a thief.

1 Headphones: For playing games or taking in tunes without bothering
your next-door neighbor or cubby mate.

v Video out: Sometimes known as DVI output or Mini-DVI output ports.
You can use optional adapters for connecting the computer toa TV,
DVD player, or projector. That way, you can watch a DVD in your Mac
on a large screen. Adapters may support VGA, S-video, and composite
video connections.

v ExpressCard slot: The slot (for adding memory card readers or TV
tuners) is a relatively new standard that has started to replace the PC
Card slot you find on older Mac notebooks. As of this writing, it was
available only on MacBook Pro.

Making the right connections on your computer, as in life, can take you a
long way.
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Chapter 3
Getting to the Core of the Apple

In This Chapter

Traveling around the desktop

Introducing the menu bar

Getting to know icons, folders, and windows
Sneaking a Quick Look

Demystifying the dock

Stocking Stacks

Discovering cool software

A Ithough I'm quite positive he never used a personal computer a day

in his life, the wise Chinese philosopher Confucius could have had

the Mac in mind when he said, “If you enjoy what you do, you’ll never work
another day in your life.” People surely enjoy their Macs, even when they are
doing work on the machine. Before you can totally whoop it up, however, it’s
helpful to get down a few more basics. That way you’ll better appreciate why
this particular Apple is so yummy.

Navigating the Mac Desktop

All roads lead to and depart from the computer’s desktop, a confusing name if
ever there was one. In this context, [ do not mean the physical hardware that
might sit on top of, say, a mahogany desktop.

Rather, this is the desktop that takes over the whole of your computer
screen. On a PC, this is known as the Windows desktop. On a Macintosh, it
is the Mac desktop or (as a homage to the machine’s operating system) the
Leopard desktop.
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Time and time again we will come upon an important part of your desktop.
It’s the Finder, and it’s a place to organize and sometimes search through the
files and folders of your Mac, Finder may serve as a launchpad for all that you
may do on your computer.

Have a peek at Figure 3-1, which shows a typical Mac desktop layout. The
background used to be blue by default. Leopard brought about a starry new
default desktop called Aurora. If you're not feeling celestial, you can alter that
and make other cosmetic changes (see Chapter 5). The time is displayed near
the upper-right corner of the screen, and a trash can is at the bottom right.
Look around and you'’ll see other funky-looking graphical icons on the screen.

Menu bar Desktop Hard drive icon

ow _ Help . =T N=T Hm&l'

i PG,

Figure 3-1:
The typical
Mac
desktop.

[
Dock

Let me try this comparison. A Major League ballpark always has foul lines,
bases ninety feet apart, and a pitcher’s rubber sixty feet and six inches from
home plate. These are standard rules to be followed. But outfield dimensions
and seating capacities vary dramatically. So do dugouts, bullpens, and sta-
dium architecture.

Certain conventions apply to the Mac desktop too; then you can deviate from
those conventions. So in the end, everyone’s Mac desktop will look different.
For now, I address some of the main conventions.
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Clicking the Menu Bar
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See the narrow strip extending across the entire top of the desktop screen?
Yes, the one with the little picture of an apple at the extreme left side,

and words such as File, Edit, and View to its right? This is your menu bar,
so-named because clicking the apple — or any of the words in the strip —
brings up a menu, or list, of commands. (Sorry, it’s not that kind of menu. You
can’t order tapas.)

Single-click the apple, and a menu pops up with some important functions.
Readers of Chapter 2 are already familiar with the Sleep and Shut Down com-
mands. You will also find Software Update, System Preferences, Force Quit,
and other commands I revisit throughout this book. Suffice to say, the % menu
is so relevant that it is available from any application you’re working in.

Now click the top item under the &€ menu, About This Mac. The window that
appears lets you know the version of the Mac OS X operating system soft-
ware you're running (see Chapter 6), the kind of processor, or main chip, that
the system is operating on, and the amount of memory onboard.

Click More Info in the same window, and the System Profiler appears. Among
other things, you can find your machine’s serial number, darn useful informa-
tion if you are ever captured by the enemy. I trust you already know your
name and rank. (According to the Geneva Conventions, that’s all you need to
reveal to Microsoft.)

Most of the rest of the stuff, frankly, is a lot of technical mumbo-jumbo pre-
sented in list form. However, some information is worth knowing, including a
quick peek at your system power settings.

Understanding lcons, Folders,
and Windows

You've already been introduced to icons, the cutesy pictures that miracu-
lously cause things to happen when you double-click them. The beauty of
graphical computing is that you need not give a moment’s thought to the
heavy machinations taking place under the hood after you click an icon.

Try double-clicking the icon labeled Macintosh HD. The HD stands for hard
drive and appears (by default) near the upper-right corner of the desktop.
A window containing more icons appears. These represent the various soft-
ware applications loaded on your hard drive, plus folders stuffed with files
and documents.

31
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Now try this one out for size: Double-click the Users folder. See whether you
can locate your home folder. Giveaway hint: It’s the one with a picture of a
house and your name. Double-click the home folder, and yet another window
jumps to the forefront. It contains subfolders for the documents you have cre-
ated, plus movies, music, and pictures.

You can double-click under Users to see home folders for other people with
user accounts on your system. But the tiny red circles with a white line
through them tell you that the contents of these respective subfolders are
private or restricted. I call the little red circles Back off, Bud symbols. If you do
boldly click a BoB, you will be gently scolded with a note that says “you do not
have sufficient access privileges.”

Windows dressing

The mere mention of windows may make some of you skittish. It might con-
jure up thoughts about a certain vision of computing propagated by that
really rich fellow hanging out in the Seattle outskirts. But I'm not speaking of
Microsoft or Bill Gates. The windows under discussion here start with a low-
ercase “dubya.”

There’s nothing small about these windows’ capabilities. Just as opening
windows in your house can let in fresh air, opening and closing Mac windows
can do so too, at least metaphorically.

Of course, the windows on the Mac can do a heck of a lot more than your
typical windows at home, unless you live with Willy Wonka. These windows
can be stretched, dragged to a new locale on the desktop, and laid one on top
of another.

To help you understand these windows, check out Figure 3-2.

A stunning view

The Mac graciously lets you peek at information from four main perspec-
tives. Open the View menu in the menu bar and choose As Icons, As List, As
Columns, or As Cover Flow.

Alternatively, click the appropriate View button in the toolbar at the top of
the Finder window, as shown in Figure 3-3. Can’t, um, view those View but-
tons? Click the oval button to the upper-right corner of the window. Let’s
zoom in for a close-up of these views.
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Close—Click the cute red gumdrop button to close the window
Minimize—Click the yellow circle to send the window into hiding
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By icon
In the example in Figure 3-3, we explored the home folder window through
what’s known as the icon view because the windows are populated by those
pretty little pictures. You know the Music subfolder by its icon of a musical
note. And you know the Movies subfolder by the small picture of a strip of
film or (in pre-Leopard versions of OS X) a movie clapper.
<P If you're in a playful mood (or have nothing better to do), you can change the

size of the icons by choosing View=>Show View Options and dragging the Icon
size slider from left to right. Drag the Grid spacing slider to change the dis-
tance between icons.
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By accessing View Options under the View menu, you can also alter the posi-
tion of an icon label (by clicking the Bottom or Right radio button). You can
change the color of the window background or use one of your own images
as the background. You can also arrange the order of icons by the date they
were modified, date they were created, size, kind, or label. Or choose Snap to
Grid to make icons obediently align themselves in rows and columns.

The View Options window changes depending on which view you have
chosen.

Icon view
List view
Column view

Cover Flow view

| | | (I edwardbaig =
< » B3 él@‘”ll\ © || Q
¥ DEVICES M =
8 ibisk e = L i
A Untitled :! '! “
El FireLite 60 GB &
(2! Macintash HD Desktop Documents Library iPhoto Libraryl
[l Backup a 47 items 724 items 50 items 14 items
¥ SHARED
I £d Baig's iBook & S| == —
¥ PLACES H g g J e
B Deskeop
= Movies Music Pictures
i
0 44 jtems 27 items 17 items Magazines
{ Documents Litem
H movies  ——  —
E@i Pictures £5 %5
ne @ - @ ——
(53 untitled folder W @
7\ Applications '.)“:E‘Jf = ‘s"-[.erfg —
[ MacDummies 10 Burn Folder Downloads
(&3] iPhone pix No items 38 items
¥ SEARCH FOR
(O Today - - - e
(5 Yesterday
(D) Past Week . =
(35 Al images + | = Macintosh HD » [i] Users » ¢} edwardbaig
19 items, 21.28 GB available A

By list

Look on the View menu, and note the check mark next to As Icons. Now click
the As List item, and the check mark moves there. The icons shrink dramati-
cally, and the subfolders in the home folder appear, well, as a list. Thus, you
are living in List view land, shown in Figure 3-4. A lot more info is displayed
in this view, including the date and time a file was modified, its size, and the
type of file (such as application or folder). And by clicking a column heading,
you can sort the list anyway you see fit.
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Click triangles to uncover subfolders or files

Click heading to sort
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Suppose you’re looking for a file in your Documents folder. You can’t remem-
ber the name of the file, but you can remember the month and day you
worked on it. Click the Date Modified heading, and subfolders and files are
now listed chronically, oldest or newest first, depending on the direction of
the tiny triangle next to the heading. Click the Date Modified heading again to
change the order from most recent to oldest or vice versa.
If size matters (and doesn’t it always?), click the Size heading to display the
list from the biggest file size to the smallest or smallest to biggest. Again,
clicking the little triangle changes the order.
If you would rather organize the list by type of file (such as text or folder),
click the Kind column heading to clump together like-minded entries.
<P While in list view, you may notice right-pointing triangles next to some of the
names. This triangle tells you that a particular listing contains subfolders
or files. To see what they are, click the triangle. The little symbol points in a
downward direction, and any subfolders and files associated with the original
folder are now revealed, in some cases with a little triangle of their own.
<P Sometimes you can’t see all the headings because the window isn’t large

enough. You have a few options. Drag a column heading to the right or left to
reorder the columns so the one you want to see appears. You can drag the
slider bar at the bottom of the screen to view headings without rearranging
the order. Or grab the handle at the bottom-right corner of the window to
increase the size of the entire window.
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A sidebar on the sidebar

Leopard’s new sidebar shares a lot in common
with the source listin iTunes (Chapter 14). ltems
have been segregated into collapsible sections;
click the triangle symbol to collapse these sec-

browse public files from another. And by typing
a user name and password of that other com-
puter, you can access other nonpublic files.

Under the Places section you can get to the

tions and reduce clutter. folders you most often use (such as Desktop,

Under the Devices section in the sidebar you'll Movies, and Pictures).
find hard drives, USB drives, or iDisk storage
as part of MobileMe, Apple’s online club we'll

learn more aboutin Chapter 12.

The last Search For section in the sidebar
lets you find stuff you worked on earlier in the
day, the day before, or the past week. Or you
might search for All Images, All Movies, or All
Documents. These last groupings are examples
of Smart Folders, which I'll spend more time on
in Chapter 6.

The Shared section lets you access other Macs
or Windows PCs in your local home network.
That's another topic we’ll delve into later. Just
know for now that from one Mac you are able to

By columns

Next, choose View=>As Columns. Again, the check mark moves, altering your
perspective. Several vertical panes appear inside one large window. These
smaller windows within windows show a progression.

At the far left is a pane called the sidebar, a regular hangout for your network,
hard drive, home folder, applications, documents, movies, and more.

The sidebar appears in the same place in every Finder window. Since it has
been redesigned as part of Leopard, I figured it deserved a little sidebar treat-
ment of its own.

Now suppose that the home folder is highlighted in the sidebar. The pane to
its immediate right displays its contents. Highlight an item in that pane, and
the column to its immediate right reveals its contents. Each time you high-
light an entry in a particular pane, a new pane appears to its right.

Again, you can resize a column pane by dragging the handle at the bottom of
the pane, as shown in Figure 3-5. To resize all the columns simultaneously,
press the Option key while dragging. You can expand the entire window by
dragging its handle at the bottom right.
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Drag a handle to change a column’s size

By Cover Flow

If you're old enough to have owned a record collection, you likely remember
rummaging through album covers to find one you wanted to play. That’s the
principle behind Cover Flow, the three-dimensional album art feature that
Apple introduced awhile back in iTunes.

Adding Cover Flow to the Finder was another Leopard initiative. It’s pretty
nifty. To access Cover Flow, click the Cover Flow icon in the Finder toolbar or
choose View>As Cover Flow.

By dragging the slider shown in Figure 3-6, you can flip through high-resolu-
tion previews of documents, images, Adobe PDF files, and more, just as you
can flip through those album covers in iTunes.

What’s more, you can skip past the first page in multipage PDF documents or
slides in a presentation created with Apple’s own Keynote program. To do so,
move the mouse over the Cover Flow image and click the arrows that appear.

Try playing a movie from within Cover Flow by clicking the arrow that
appears. Here’s how. Click Movies in the sidebar, then drag the slider until the
movie you want to watch shows up. Mouse over the still image from the movie
in question so that a circle with an arrow appears. Click the circle to start
playing. The inside arrow turns to a square; click it again to pause the movie.
Without knowing it, you've just had your first quick look at Quick Look, as the
next section will elaborate.
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Have a Quick Look

Indeed, Apple gives the Leopard crowd yet another clever way to peek at the
contents of files on your Mac — without having to launch the applications
that created those files.

More than living up to its moniker, Quick Look lets you look at a file as a
pretty decent-sized thumbnail or even full-screen. And Quick Look might also
be called Quick Listen because you can even play music. Indeed, the feature
works with all sorts of files — PDFs, spreadsheets, Microsoft Word docu-
ments, movies, and more. That’s because Quick Look plug-ins for many other
formats are available on the Internet.

Here’s how to make it happen:

1. Highlight a file in Finder.
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2. Click the Quick Look button (labeled in Figure 3-2) on the toolbar or
press the spacebar on the keyboard.

The file jumps out at you in a window. To display the file full screen,
click the button shown in Figure 3-7 that looks like two diagonal arrows
pointing in opposite directions.

3. If you are looking at a picture and want to add it to your iPhoto image
library, click the iPhoto button.

4. If you decide to open the file you are previewing and the program that
opens it, double-click the Quick Look preview window.

To get out of Quick Look, click the x in the circle at the upper-left corner
of the window or press the spacebar again.

|
Figure 3-7:
Quick, take
a look at my
picture.
|
Click to add to iPhoto
Click to display the file full screen
<P You can preview multiple images in Quick Look. Just highlight more than one

file and press the Quick Look toolbar button or the spacebar. You can then
use the forward or backward arrow to manually navigate through the files. Or
press play to preview the files in a slideshow. Lastly, you can click the light
table button to peek at documents in a grid.
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What's Up, Dock?

Your eyes can’t help but be drawn to the colorful reflective three-dimen-
sional bar at the bottom of the screen (refer to Figure 3-8). This is your dock,
and it may comfort those familiar with Microsoft’s way of designing a com-
puter interface to think of the dock as a rough cross between the Windows
taskbar and the Start menu. In my humble opinion, it’s more attractive than
the Windows taskbar. More fun too. Drag a window near the bottom of the
screen, and it reflects off the dock.
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To remove an icon, drag it away Stacks and the trash appear to
the right of this dashed divider

A shiny orb indicates a program is open

Mouse over anicon and its name appears

Try single-clicking an icon in the dock. The little picture bobs up and down
like a school kid desperate to get the teacher’s attention so he can safely
make it to the bathroom.



Chapter 3: Getting to the Core of the Apple

\\3

What you'll find on the dock

The dock is divided by a white dashed line into two parts. To the left of the
line are programs and other tools. To the right are any open files and folders,
plus a new collection of expandable icons called Stacks, of which I'll have
more to say later in this chapter. You'll also find the trash can. Keep in mind
that the mere act of single-clicking a dock icon launches a program or other
activity. When you mouse over a dock icon, the title of the appropriate
application appears.

Notice the blue orb glowing under some dock icons? That tells you the
program that the icon represents is running on your system.

On newer Macs, the following icons appear by default on the left side of the
dock (the order in which they appear is, for the most part, up to you):

v Finder: With a goofy face on top of a square, the Finder icon looks like it
belongs in a SpongeBob SquarePants cartoon. Single-clicking here brings
up the main Finder window.

v+ Dashboard: The round gauge is the front end for clever little applications
called widgets (see Chapters 6 and 21 for more information).

v~ Safari: Apple’s fine Web browser (Chapter 9).
v Mail: Yes, Apple has a built-in e-mail program (Chapter 10).

v~ iChat: Part instant messenger, part audio and video chat program
(Chapter 11).

v Address Book: The place for phone numbers and e-mail addresses
(more later in this chapter).

v iTunes: Apple’s renowned musical jukebox (Chapter 14).

v+~ iPhoto: The shoebox for storing, sharing, and touching up digital images
(Chapter 15).

v iMovie: The place to edit videos (Chapter 16).
v~ iCal: A built-in calendar (more later in this chapter).

v Preview: A program to view images and Adobe PDF files (more later in
this chapter).

v QuickTime Player: Multimedia audio/video player (later in this chapter).
v~ System Preferences: Having it your way (Chapter 5).

v GarageBand: This is where you can launch your musical career
(Chapter 17).
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1 Spaces: A keen method of organizing the computer so that just those
windows relating to a specific activity are displayed (Chapter 5).

v Time Machine: Leopard’s clever new backup feature lets you restore
lost files by going back in time to find them (Chapter 13).

1 iWeb: Lets you create personal Web sites, blogs, and podcasts
(Chapter 12).

v iDVD: Burn movies onto a disk (Chapter 16).
And these appear on the right bank:

v Stacks: Collections of icons to keep your desktop organized and tidy,
especially for documents or when downloading files (more later in this
chapter).

v Trash: Hey, even computer garbage has to go somewhere (Chapter 7).

Loading up the dock

Adding favorite items to the dock is as simple as dragging and dropping them
there. Of course, the more icons that get dropped in the dock, the more con-
gested the joint gets. Even icons deserve breathing room. To remove items, just
drag them outside the dock. The icon disappears behind a little white cloud.

Here’s another neat stunt:

1. Open the Apple menu.
2. Choose Dock=Turn Magnification On.

Now as your cursor runs over the icons, the little pictures blow up like
bubble gum.

If you're into resizing dock icons, choose Dockm>Dock Preferences. Make sure
the Magnification box is selected and drag the Magnification slider from left
(Min) to right (Max) depending on your fancy. A separate slider lets you alter
the dock size.

You can also alter the size of the dock by clicking the dashed line separating
the programs and Stacks, and dragging it to the left or right.

Docking the dock

The very first time you notice the dock, it appears at the bottom of your
screen. Apple doesn’t make you keep it there. The dock can move to the left or
right flank of the screen, depending, I suppose, on your political persuasion.
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Again, choose the Dock command from the ® menu. Choose either Position
on Left or Position on Right. Pardon the pun, but your dock is now dockside.

If you find that the dock is getting in the way no matter where you put it, you
can make it disappear, at least until you need it again. Choose @=>Docke>Turn
Hiding On.

When Hiding is On, drag the cursor to the bottom (or sides) of the screen
where the dock would have otherwise been visible. It magically glides into
view. The dock retreats to its cave when you glide the cursor away. If you
find you miss the dock after all, repeat the previous steps, but now choose
Turn Hiding Off.

A minimizing effect

The dock isn’t the only thing you’d like to nudge out of the way from time

to time. Sometimes entire windows take up too much screen real estate or
cover up other windows you want to see. You can close the objectionable
window altogether, but that is sometimes a Draconian maneuver, especially if
you intend to work in the window again a moment or so later.

You can minimize the window instead. Move the mouse to the upper-left
corner of your open window and find the tiny yellow droplet flanked by tiny
red and green droplets. (That is, they are red, yellow, and green by default.)
I'd show you a picture, but this book is in black-and-white. I'd say leave it to
your imagination, but something tells me you’re already familiar with this
red, yellow, and green idea. In any case, if you single-click the yellow circle
in the upper-left corner of a window, the entire thing shrivels up and lands
safely on the right side of the dock (assuming you've stuck with Minimize
using Genie Effect inside Dock preferences).

To restore the window to its full and (presumably) upright position, single-
click its newly created dock icon.

Be careful not to click the tiny red circle instead. That closes the window
instead of minimizing it.

Clicking the green circle maximizes the window to its full potential and click-

ing it again returns it to the previous size. If one of the circles appears with
no color, it means that particular function is currently unavailable.

Stockpiling Stacks

I have myriad stacks of paper in my office. And in theory anyway all the
papers in one stack are related to all the other papers in the same stack.
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This same organizing principle applies to a handy new Leopard feature called
Stacks. Stacks are quite simply a collection of files organized by theme, and
they do wonders for all you clutterholics in the crowd, of which, alas, [ am
one. You'll find Stacks to the right of the dashed divider on the Dock.

Apple has already put together two useful premade Stacks right off the bat.
One is a Stack for your documents, the other is reserved for all the stuff you
might download — such as saved Mail attachments, file transfers through
iChat, and files captured from the Internet with the Safari browser. As you’ll
see, it’s a breeze to create your own Stacks.

I'm fond of the Downloads Stack in particular, which bobs up and down to let
you know a new arrival is there. Before Leopard, downloaded files had a ten-
dency to mess up your desktop.

The icon for the Downloads Stack takes the form of the most recent item
you’ve downloaded, a PowerPoint presentation, Audible audio file, or what-
ever it happens to be.

Opening Stacks

To view the contents of a Stack, click the Stacks icon. It immediately opens in
one of two ways:

v Icons for the files, along with their names, fan out in an arc (see Figure
3-9). The most recent file is at the bottom of the fan.

v Files and names appear as a grid (see Figure 3-10).

By default, the fan or grid decision is determined automatically by the
number of files in a Stack. So while the fan view is more attractive, a grid lets
you peek at many more icons at once. However, both views have their stor-
age limits. There is no way to display, for instance, hundreds of documents in
a grid or a fan. So you'll see an icon that says 598 More in Finder or whatever
the actual sum is. Clicking the More in Finder icon takes you to the Finder.

Cool special effect: Hold down the Shift key when you click a Stack, and it
opens in slow motion, as a fan or a grid. If you already had a Stack open when
you Shift-click another Stack, you can watch one collapse slowly while the
other opens.

You can dictate whether Stacks spring out as a fan or grid. Right-click or
Control-click the Stacks icon in the Dock to instantly bring up the Stack’s con-
textual menu, as shown in Figure 3-11. Or hold down the left mouse button for
just a second until the menu appears. From the menu, choose Fan, Grid, List,
or Automatic to give the Stack your marching orders. You'll notice a few other
choices in this contextual menu. You can sort the Stacks icons by name, date
added, date modified, date created, or kind of file.
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|
Figure 3-9:
Fanning out
your files.

|
Figure 3-10:
There is
more than
one way

to blow up
your Stack.
|
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& remove the item from the Dock, to open the program in question when you log

in, or show it in Finder.

Adding Stacks

You can turn any folder in your arsenal into a Stack by dragging it from the
Finder or desktop to the right of the dock’s dashed line and to the left of the
Trash. Easy as that.

Quitting time

It’s 5 P.M. (or in my world, hours later), so it’s quitting time. Here’s how to
punch out of a specific application. Just to the right of the % menu, you see
the name of the program you're currently working in. Suppose it’s Safari.
Single-click the Safari name and choose Quit Safari from the drop-down menu.
Or if you had been working in, say, Word, you’d choose Quit Word from the
drop-down menu. Here’s a quickie keyboard alternative: Press 88+Q and
choose the program you’re in from the drop-down menu.

A Gaggle of Freebie Programs

A major fringe benefit of Mac ownership is all the nifty software you get
gratis. Many of these freebie programs, notably those that are part of iLife,
are such a big deal that they deserve entire chapters unto themselves.
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In this section, I discuss programs of smaller stature. 'm not demeaning them;
in fact, a number of these bundled programs are quite handy to have around.

You'll find some of the programs [ am about to mention in the dock. But
another good place to look is the Applications folder, accessible as follows:

v Click Applications in the sidebar.
v Choose Go=>Applications.
v Press the keyboard shortcut Shift+38+A.

Staying organized

Not all of us have the luxury of hiring an assistant to keep our life in some
semblance of order or just to provide a jolt of caffeine when we need it. | sure
don’t (sigh).

Regrettably, a Mac still can’t make coffee. But it is reassuring that the com-
puter can simplify other administrative chores. Check out the applications in
this section.

Address Book

You just met an attractive stranger on the way to the Apple store? Address
Book, accessed through the Applications folder or by clicking its dock icon, is
a handy repository for addresses, phone numbers, and e-mail addresses. You
can also add a picture and note about the person (“awfully cute; owns a Mac”).

After opening the program, here’s how to add an Address Book entry:

1. Under the column marked Name, click the + sign (shown if Figure 3-12).
You can alternatively open Address Book and choose Filem>New Card.

2. Type the person’s first and last names, company, phone number, and
other information in the appropriate fields.

Press the tab key to move from one field to the next. You can skip fields
if you don’t have information and add others as need be. For example, to
add space for a new mobile phone number entry, click the + next to the
field name.

3. Close Address Book.
If someone sends you a virtual address card (known as a vCard), just drag it

into the Address Book window. If you already have an entry for the person,
you’ll have the option to blend the new data with the old.
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You can instantly draw a map to a person’s house in your Address Book.
Here’s how:

1. Hold down the Control key while clicking an address.
2. Click Map Of in the contextual menu.

3. On the Google Map that appears, you can click to get directions or
search for a nearby pizza shop or other destination.

As you might imagine, Address Book has close ties to a bunch of other

Mac applications that I discuss later in this book, most notably Mail and
iChat. You can also synchronize contacts with other computers using your
MobileMe account, to which I devote Chapter 12. If you have a Yahoo!
address book, you can synchronize that too. And you can synchronize your
Address Book with an account that uses a Microsoft Exchange server.

Creating Smart Groups

Now suppose a whole bunch of people in your Address Book have something
in common. Maybe you all play softball on weekends. (That’s a good thing.
Break away. Have fun. Limber up. Your computer will be waiting for you
when you get back.) A Smart Group is a terrific way to manage information in
Address Book on all your teammates.
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Figure 3-13:
Creating

a Smart
Group.

The key is to add a descriptive word that lumps you all together in the Notes
field. Something, like, voila, softball. So whenever a new contact comes along and
you type the word softball, he or she will become part of your Smart Group.

To create a Smart Group from scratch, follow these steps:

1. Choose File->New Smart Group.
2. In the Smart Group Name field, type a name for your group.
[ typed Weekend Athletes.

3. Click the + and specify the group criteria using the pop-up menus, as
shown in Figure 3-13.

4. If you want to know when a new slugger has been added to the roster,
make sure the Highlight Group When Updated option is selected.
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iCal

It’s swell that all your friends want to join the team. But good luck figuring
out a time when everybody can play.

For assistance, consult the Mac’s personal calendar application, iCal. It lets
you share your calendar with people on the same computer or “publish” a
calendar over the Internet to share with others, perhaps by subscribing to
MobileMe. The program can help you find a convenient time everyone can
meet.

iCal also lets you subscribe to public calendars over the Internet (movie
openings, religious holidays, and so on). As you might imagine, it can also
show the birthdays of folks residing in your Address Book.

Oh, and if you need a reminder of all the things you have to do — Finish
Dummies chapter — iCal lets you display a To Do list, (sorted manually or by
due date, priority, title, or calendar).
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iSync

Many of you use more than one computer (you should be so lucky if you
have more than one Mac). You probably also have a cell phone, a personal
digital assistant (PDA), and an iPod. Through iSync, you can keep your cal-
endar, Address Book, and Internet bookmarks synchronized across multiple
devices. If you change an e-mail address on your cell phone, you can con-
nect the device to the Mac (even wirelessly through technology known as
Bluetooth) and have the number automatically updated in the computer’s
Address Book. Some sync functions are now the province of MobileMe.

Stickies

Walk around your office, and I'll lay odds that some of your colleagues have
yellow Post-it notes attached to their computer monitors. You too, huh?
They’re a great way to make your supervisor think you're really busy.

The Mac provides an electronic version called Stickies. Just like the gluey
paper kind, electronic notes let you jot down those quickie shopping lists,
phone numbers, and To-Dos.

But virtual Stickies have it all over their paper counterparts. Consider these
stunts:

» You can resize Stickies by dragging the handle on the note’s lower-right
corner.

v You can import text or graphics, and alter fonts and font sizes.

»* You can check the spelling of words in the note.

» You can create translucent Stickies to see what’s behind them.

» You can delete a note without crumpling it or crossing out its contents.

» You won't clutter up your good-looking Macintosh computer. (You will
have to concoct another scheme to convince your boss how hard you
are working.)

Creating a new Stickie doesn’t count as work. After opening the app, choose
File>New Note. Then start scribbling, um, typing away.

Tooling around for a reference

Alot of what people do on a computer is look things up, mainly through
Internet search engines (Chapter 9) and other online tools (Chapter 11). Help
is closer at hand — in the Applications Folder.
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Dictionary

Finding the meaning of words or phrases is as simple as typing them in a
search box. Finding the meaning of life is something else altogether. The
Mac supplies versions of the New Oxford American Dictionary and Oxford
American Writer’s Thesaurus. With Leopard comes a new Apple Dictionary to
look up terms you can'’t find in this book. You can now consult the Wikipedia
online encyclopedia or transfer English words to Japanese or vice versa. The
computer can even read a dictionary entry out loud.

TextEdit

TextEdit is a freebie word processor. Although it offers nowhere near the
flexibility of an industrial-strength word processor such as Microsoft Word
(Chapter 7), it’s no slouch either. You can create tables and lists and apply
a bunch of formatting tricks. And it can accommodate Word documents (if
someone sends you one).

Calculator

Hey if all of us could do math in our heads, we wouldn’t need a calculator.
In fact, the Mac supplies three on-screen calculators: Basic, Scientific, and
Programmer. Choose the one you need from the calculator’s View menu.

The Basic Calculator is for people like me who find the need to perform
simple arithmetic here and there. You can use the numeric keypad on your
keyboard or use the mouse to click the calculator’s keypad.

The Scientific version adds square root, sin, cos, and other keys whose mere
thought causes me to break out in hives. (Don’t count on seeing me as a
future author of Math For Dummies.)

The Programmer calculator is even more intimidating. It has keys labeled Hide
Binary, Byte Flip, Unicode, RoL, and RoR. You earn extra credit if you know
what all these do.

The Mac Calculator is capable of tricks that blow away even the fanciest
pocket calculator, such as going online to fetch the latest currency exchange
rates.

QuickTime in the nick of time

QuickTime Player, Apple’s free multimedia player, comes to the rescue when
you want to watch a movie (but not a DVD), play sounds, or display pictures.
QuickTime typically pops up as needed.

If you want to edit movies or have other bold ambitions (that is, full-screen
playback), consider springing for a $30 version of the program called
QuickTime Pro.
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Previewing Preview

Preview is a versatile program that lets you view graphics files and faxes,
screen captures, convert file formats (e.g., from TIFF to JPEG), and handle
PDFs with panache. (PDF is shorthand for Adobe’s portable document format.)
Preview typically loads automatically as needed. For example, if you double-
click a PDF file someone sent you, Preview is probably the program that lets
you read it. You can use Preview also to rotate, resize, and crop images in
one of the many file types it recognizes.

Preview in Leopard added a bunch of new features, the coolest of which is
probably Instant Alpha, which lets you remove an, um, insignificant other (or
background) from an image.
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Here a Mac, There a Mac,
Everywhere a Mac Mac

In This Chapter

Understanding Intel’s impact

Deciding between a desktop and a laptop

Getting the lowdown on the latest desktop models
Going mobile with a laptop

Using a trackpad

Bolstering your battery

thich of the following describes you?

v Based on what you already know (or gleaned from this book), you are on
the righteous path toward purchasing a Macintosh computer. The chal-
lenge now is figuring out which model makes the most sense.

» You already own a Mac and are looking to add a second or even third
machine to your arsenal. The challenge now is figuring out which model
makes the most sense.

» You received this book as a gift and have no intention of buying any
computer. The challenge now is explaining to the person who gave it to
you why no model makes sense (without hurting his or her feelings).

Regrettably, [ can’t help anyone in the third group. Feel free to tag along anyway.

Intel’s Inside?

The computer industry creates strange bedfellows sometimes, maybe none
stranger than the apparently blissful 2005 union between Apple and Intel. To
veteran Mac diehards, placing Intel processors, or chips, inside their beloved
computers was a scandal analogous to an intimate liaison between George
Jetson and Wilma Flintstone.
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Intel was the enemy, after all. Its processors belonged inside Windows’ comput-
ers, not Apple’s, hence the derided (from a Mac point of view) moniker Wintel.
Suffice to say, Apple’s head honcho Steve Jobs blew a few minds when he broke
the news that the company was jilting long-fancied PowerPC G4 and G5 proces-
sors produced by IBM and Motorola and going with chips made by Intel.

In a relatively short period of time, Apple overhauled its entire hardware
lineup with Intel chips. So what is a processor anyway? Put simply, it is the
brains behind your computer.

Two chips are better than one

Most Macs reborn with Intel processors actually have two chips engineered
on a single slab of silicon. The Core 2 Duo chips (found on most models as this
book was being prepared) boast twice the computational horsepower of a
more traditional single chip design. The idea is that the two chips can team up
and share resources as needed but also conserve power if one of the Cores is
not needed for a particular function.

Leave it to Rosetta

To help folks deal with the Mac's brain trans-
plant, Apple and its industry pals started design-
ing so-called Universal software applications.
These programs were meant to run natively on
both G4/G5 machines and Intel-based Macs. In
other words, they rocked either place. You know
you've bought a Universal application because
the box carries the logo shown here. Not sur-
prisingly, the iLife software already loaded on
your computer also receives the Universal seal
of approval.

Universal

But what about older software you may have
lying around? Will those programs make nice
with Intel? Most will, thanks to behind-the-
scenes technology known as Rosetta. (I will
resist a joke about Apple leaving no stone
unturned.) You don’t have to actively mouse
around to wake up Rosetta. Quietly and invis-
ibly, it does its thing, which basically involves
translating software code to ensure that non-
Universal programs will work fine, if not up to
their maximum potential. Most software devel-
opers are still producing Universal apps.

Be aware, though, that the most ancient programs
won't work at all on “Mac-tel” machines. These
include the Classic apps that predate 0S X.
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But are you giving up something
to get something?

The burning issue for Mac loyalists was whether the presence of Intel would
somehow mess things up. The answer turned out to be a resounding no.
Intel-based machines still look like Macs, quack like Macs, and behave like
Macs. I explain the exceptions in the “Leave it to Rosetta” sidebar.

Big Mac or Little Mac? The Laptop
versus Desktop Decision

Desktop? Laptop? Or notebook? Okay, that was a bit of a trick question
because people use notebook and laptop to refer to the same thing. So it’s
really desktop versus laptop/notebook.

The choice comes down to lifestyle, economics, and what you do for a living. If
you burn lots of frequent-flier miles, chances are you’ll gravitate to a laptop. If
you tend to be home- or office-bound, a desktop might be more suitable.

Let’s give each side their due. Here are the reasons for buying a Mac desktop:

»* You generally get more computing bang for the buck.

v It has a larger hard drive, bigger display, and more connectors.
v Upgrading it is easier.

»* You won't slow anyone down checking in at airport security.

v The machine looks cool in your home or office.
And here’s why you would want to buy a Mac laptop:

v~ It’s light and portable.
v~ It is appealing if you work or live in cramped quarters.
v It runs off battery or AC power.

v You can impress your seatmate on an airplane.
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It a Desktop Is Your Poison

Buying an Apple desktop computer does not mean you have to start rear-
ranging or buying new furniture. Sure, Mac desktops generally take up more
space than Mac notebooks. But the machines are no larger than they have to
be and are generally so good-looking that you want to show them off anyway.

iMac

As shown in Figure 4-1, the iMac is the most elegantly designed desktop
computer on the planet.

Figure 4-1:
The elegant
iMac.
|
Courtesy of Apple

Now that I've said that, let me mention a proviso: The iMac is the most
elegantly designed desktop computer on the day that [ write this. By the time
this book gets to you, the gang inside the company’s Cupertino, California,
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headquarters may well have one-upped themselves. Now that that lawyerly
comment is out of the way, back to the captivating charmer at hand. The
innards of the all-in-one system — Intel Core 2 Duo processor, memory, hard
drive, CD/DVD player, and more — are concealed inside a 2-inch-thin flat-
screen monitor. You can’t help but wonder where the rest of the computer
is, especially if you're accustomed to seeing a more traditional tower-type PC
design.

When you place a CD or DVD in the slot on the iMac’s right side, it gets
sucked inside the machine like a dollar in a vending machine’s bill changer.

The small square peephole at the top of the monitor covers up a built-in
iSight video camera. The computer also comes with a Bic-lighter-sized Apple
remote used to control music, videos, and other media through Apple’s slick
alternative full-screen Front Row software interface, especially when you're
not quite sitting on top of the computer.

Mac mini

Is the Mac mini shown in Figure 4-2 really a desktop? After all, Mac mini is
easily mistaken for a bread box or a coaster on steroids. But the petite 2-inch
tall, 6.5-inch square aluminum contraption is indeed Apple’s crazy (and cozy)
notion of what a budget desktop computer is all about. At less than 3 pounds,
Mac mini is portable, but not in the same sense as a notebook you would fly
with cross-country. (Carting this computer from room to room is more like it.)

|
Figure 4-2:
MiniMe's
favorite
Macintosh.

|
Courtesy of Apple
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Models start at just $599 as of this writing, but keep in mind that this is a
BYOB computer — as in bring your own keyboard, mouse, and monitor. (The
assumption is that you have these already, but if not, Apple will happily sell
them to you.) Hey, at least the Apple remote is supplied. Given its size and
price, Mac mini might make an ideal second or third computer and is a per-
fect dorm room companion.

Because Mac mini has Front Row and a collection of video connectors, you
can also hook it up to a big-screen TV or take advantage of a superior speaker
system. And Mac mini includes the smarts to play back music or videos stored
on other computers in your house, including Windows systems.

Mac Pro: A Mac with muscle

The muscular Mac Pro — it’s capable of “eight-core” Intel processing power —
is a preferred system for graphics designers, video production professionals,
scientists, music producers, developers, and the like. If you're not one of those
folks, scram.

Going Mobile

a\\S

You don’t have to be a traditional road warrior to crave a notebook these
days. You might just need something to schlep from lecture hall to lecture
hall, your home to your office, or maybe just from the basement to the bed-
room. And some computers are worth having (such as the MacBook Air,
described shortly) just because they are so darn sexy.

In choosing any laptop, take into account its traveling weight. Besides the
weight of the machine itself, consider the heft of the AC power cord and pos-
sibly a spare battery.

One of the first decisions you have to make is how big a screen you want.
Bigger displays are nice, of course, but they weigh and cost more. And you
may be sacrificing some battery life. Hmm, are you getting the sense that this
battery business is a big deal? It can be, which is why I offer tips on how to
stay juiced, at the end of the chapter.

As part of its migration to Intel processors, Apple retired two longtime
members of its laptop lineup in 2006, the ivory white iBook (popular with
students) and the silver PowerBook. Their Intel-inside replacements, the
MacBook and MacBook Pro, are still on the roster.
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A Mac tablet?

Axiotron of El Segundo, California, performed sur-
gery on an off-the-shelf MacBook, turning itinto a
slate-style tablet computer called Modbook. The
cleverly designed slab is aimed at illustrators, art-
ists, and students who are more inclined to draw
or write (using a special pen) than type.

Modbook also takes advantage of handwrit-
ing recognition technology built in to 0S X to
convert your jottings into text. And with built-in
GPS, or Global Positioning System, technology,
it can tap into orbiting satellites to determine
your Earthly location.

To make this happen, Axiotron took the MacBook,
jettisoned the keyboard and trackpad, and

replaced them with an LCD digitizer display that
works with a pen from Wacom, an outfit that also
makes external devices that add tablet capa-
bilities to regular Apple machines. At $2,279 (on
up), Modbook is in a pricier neighbor than the
MacBook at its core. But without that keyboard
this is not a mainstream computer anyway. There
is a virtual on-screen keyboard that responds to
the Wacom pen. And you can attach a keyboard
via USB or wirelessly with Bluetooth.

Apple, which closely guards its hardware and
software, tolerated the existence of Modbook
as of this writing. And maybe it'll bring out its
own tablet by the time you read this.

MacBook Pro

The successor to the PowerBook is MacBook Pro, shown in Figure 4-3. It will set
you back $1,999 or more. MacBook Pro resembles the PowerBook on the out-
side, but it’s a lot different on the inside. That’s because the inch-thin machine
runs those Core 2 Duo processors. As of this writing, there are models with

15- and 17-inch displays. All of them have those inconspicuous iSight cameras.
MacBook Pros also come with the Apple remote and Front Row.

MacBook Pro did relinquish some features found on PowerBooks, such as
fewer ports and connectors. At first the absence of a standard dial-up modem
for connecting to the Internet in hotels and elsewhere seemed a silly and
annoying omission. But dial-up really is yesterday’s technology. If absolutely
necessary, you can always purchase an external dial-up modem that will
connect to one of the computer’s USB ports for $49.

Apple also replaced a standard PC Card-type slot for adding such things as
memory card readers and cellular modems with a new-generation slot called
ExpressCard.

Ambient sensors that can illuminate the keyboard when the cabin lights are
dimmed on an airplane are included. If that doesn’t create a mood and show
the cute passenger in 12C how resourceful you are, nothing will. Meanwhile,
if you drop the machine, and trust me it happens, built-in sensors instantly
park the hard drive to reduce the damage.

59
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Cord tripping

Has your dog or kid ever come barreling into a
room and tripped over the power cord connected
to your laptop? The machine goes flying off your
desk, and you scramble to assess the damage.
Have you no shame? Tend to your kid first.

Apple had this scenario in mind when it designed
the MagSafe connector, a nifty innovation that
debuted on the MacBook Pro. Instead of physi-
cally inserting the power cord to a connector

as on previous Mac laptops, you adhere the
MagSafe magnetically.

So the next time your adolescents (canine or
human) come running in and trip the wire, the
cord should easily yank free, presumably with-
out harming the Mac or your first born. One
downside: The power brick in the middle of the
new cord is still bulky.

Y S/}
S ¥
5 ol

A handsome

Figure 4-3:

17-inch
MacBook

= — g _]

Pro. [— -

Courtesy of Apple

The next neat feature, called MagSafe, may not win brownie points with
strangers on a plane, but it just might earn you raves at home. To find out
about it, see the “Cord tripping” sidebar.
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|
Figure 4-4:
Floating on
MacBook
Air.
|

MacBook

Despite a lower price — $1,099 or $1,299 for white models and $1,499 for

a version in black — the MacBook shares some of the features of its Pro
cousin, including the built-in iSight camera, Front Row, the Apple remote, and
MagSafe. The main difference is that the 5-pound roughly inch-tall MacBook
has a smaller (13.3-inch-wide) screen and not quite the robust graphics
capabilities for running high-end photography programs such as Aperture.
As with the iBook that preceded it, MacBook found a home on college cam-
puses. And as the “A Mac tablet?” sidebar shows, an enterprising Southern
California company found another purpose for the MacBook.

Indeed, any Lilliputian computer exacts compromises. So it goes with Air.
Unlike the other notebooks in Apple’s lineup, there is no integrated CD/DVD
drive, though you can buy one that plugs into a USB port for $99.

And there’s just a single lonely USB port and no Ethernet connector, though
you can purchase a $29 doohickey.

Air comes in two versions, a $1,799 model with a modest 80GB hard drive, and
a $3,098 model with a less sizable but more durable 60GB solid-state drive.

MacBook Air

It’s hard to imagine how thin the MacBook Air is without seeing it. Pictures —
even the ones in Figure 4-4 — do not do it justice. Encased in aluminum with
a 13.3-inch display, Air measures just 0.16 inches at its skinniest point and
just 0.75 inches at its thickest. But it still boasts a full-size keyboard and very
good battery life. (Too bad the battery is sealed and not easily replaced.)

p

Courtesy of Apple



62

Part |: Freshman Year at Drag-and-Drop Tech

Taming the Trackpad

A\

|
Figure 4-5:
The key to
taming your
trackpad

on different
laptops.
|

In Chapter 2, I introduce the trackpad, the smooth rectangular finger-licking
surface below the keyboard that’s your laptop’s answer to using a mouse.
You can still use a regular mouse with a laptop, of course, and may prefer to
do so if you're sitting at your regular desk. If you're sitting in coach instead,
the mouse is an unwelcome critter, especially to the passenger sitting next
to you. Don’t be surprised if he or she calls an exterminator (or at least the
flight attendant).

A trackpad (and the human beings who control it) has its own annoying
idiosyncrasies. It may refuse to cooperate if you touch it coming out of the
shower. Hand lotions are also a no-no. A trackpad loathes moisture and
humidity. If it does get wet, gently wipe it with a clean cloth. Do not use any
kind of household cleaning solution.

The best place to train a trackpad is in Keyboard and Mouse preferences.
Choose ®System Preferences. Under Keyboard and Mouse preferences,
click Trackpad. Figure 4-5 shows Keyboard & Mouse preferences on a newer
system such as the MacBook Air. Options vary on older systems.

Keyboard & Mouse

<[> || Showal @

! Keyboard = Trackpad Bl h  Keyboard Shortcuts |

Tracking Speed Double-Click Speed

Scrolling Speed

One Finger
"1 Tap to Click
Dragging
Drag Lock
Two Fingers
'Z' Secondary Click
W scroll
Pinch Open & Close
Rotate

¥ 5creen Zoom Options...

Three Fingers.
Swipe to Navigate

"l ignore trackpad when mouse is present

On the Air, for instance, you have options to make things happen with

one finger, or two, by selecting the appropriate boxes. A handy little video
window helps you learn what to do. Two-finger scrolling is a relatively recent
trackpad function not included on older models.
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The MacBook Air is capable of other multitouch gestures, some borrowed
from its famous corporate cousin the iPhone. You can zoom in on a Web page
in Safari or a photo in iPhoto by “pinching,” or placing your thumb and forefin-
ger together on the trackpad and then pulling them apart. And with the
“swipe” gesture, you can navigate Web pages with three fingers by dragging
from right to left to page forward, and left to right to retreat.

Here are some of the things common to other Mac laptops:
v Drag the Tracking Speed slider to change how fast the pointer moves and

the Double-Click Speed slider to set how fast you have to double-click.

v If you want to click by tapping the trackpad surface, without having to
press the trackpad button, select the Clicking option.

» You can drag an item by tapping it twice, without having to hold down
the button, by selecting the Dragging option.

v Using two fingers on the trackpad surface will not move the cursor when
you select the Ignore Accidental Trackpad Input option.

v~ If you plan on using a regular mouse, select the Ignore Trackpad When
Mouse Is Present option.

Keeping Vour Notebook Juiced

3

Sooner or later, especially if Murphy (the fellow behind that nasty Law) has
any say in the manner, your battery will lose its charge. At precisely the
worst possible moment. Like when your professor is prepping you for a final
exam. Or you are about to discover whodunit while watching a DVD on an
overseas flight. [ hasten to point out that watching a movie will drain your
battery a lot faster than working on a spreadsheet.

A tiny gauge on the menu bar, as shown in Figure 4-6, gives you a decent mea-
surement of how long you can work before your battery peters out. You can
display this gauge by time or percentage. Just click the menu bar icon, choose
Show, and then choose Icon Only, Time, or Percentage.

The battery life cited by manufacturers has a lot in common with the miles
per gallon estimates quoted by automakers. Your actual battery life will vary,
depending on how you drive your computer. Expect the total to be less than
the manufacturer’s claim.
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|
Figure 4-6:
Revealing
how much
power you
have left.
|
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You may routinely keep the computer plugged to recharge the battery. Still,
Apple recommends pulling the plug periodically to keep the juices flowing. If
you don’t plan on using the computer for six months or more (and why the
heck not?), remove the battery and store it with about a 50 percent charge.
You may not be able to resuscitate a fully discharged battery that has been
kept on the sidelines too long. (As noted previously, the MacBook Air has a
sealed battery.)

Rechargeable batteries have a finite number of charging cycles, so even with
the best feed and caring they have to be replaced eventually. It will be evi-
dent when it’s time to put the battery out to pasture because it will no longer
hold a charge. Remember to give it an environmentally correct burial.

However, don’t give up the fight just yet. You can take steps to boost your
battery’s longevity. Your computer is smart about conservation. When
plugged in, it feels free to let loose. That means the hard drive will spin
around to its heart’s content, and the display can be turned up to maximum
brightness settings.

You can tell a Mac how to behave when it is unplugged:

v Dim the screen. There’s nothing your laptop battery likes better than
mood lighting. Press F1 on the keyboard to turn down the brightness.

v Open Energy Saver (see Figure 4-7) by clicking the battery gauge in
the menu bar and then selecting open Energy Saver Preferences.
(Alternatively, choose ®=>System Preferences and click Energy Saver.)
Near the top of the window, choose Better Battery Life from the
Optimization pop-up menu. You will notice other options in Energy
Saver, including a slider to put the computer to sleep when it’s not
used for a certain period, plus a slider to put the display asleep after
the machine is inactive. If you click Schedule, you can determine when
the computer starts or wakes up or goes to sleep. It’s also a swell idea
to make sure the Put the Hard Disk(s) to Sleep When Possible option is
selected. Click Show Details if these options don’t show up.
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Energy Saver
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v Shut down the AirPort wireless networking feature (Chapter 18) if you
are not surfing the Internet or sharing files over the network. AirPort

hogs power. And you shouldn’t be using it anyway if you’re traveling on
an airplane.

v Likewise, turn off the wireless settings for Bluetooth if you're on a plane
or if you just want to save some juice.

After all, given all your aspirations with your computer, the last thing you
want is to run out of power.
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In this part . . .

sn’t it about time to do some honest-to-goodness com-

puting? Roll up your sleeves. You're about to personal-
ize the Mac to your taste and styles, dig into System
Preferences, go on lively search expeditions using
Spotlight, and create and print documents — all with the
warm and fuzzy feeling that comes when you’ve accom-
plished what you’ve set out to do.




Chapter 5
Making the Mac Your Own

In This Chapter

Creating user accounts

Entering Photo Booth

Implementing parental controls

Logging in and off

Choosing a desktop picture and screen saver
Exposing Exposé

Becoming a Spaces cadet

Setting priorities

ou adore your family and friends to death but have to admit that they

get under your skin from time to time. They know how to push your but-
tons, and you sure know how to push theirs. People are fussy about certain
things, and that includes you (and me).

So it goes with your Macintosh. The presumption is that you and your Mac
are going to cohabit well into the future. Still, it can’t hurt to get off on the
right foot and set up the machine so that it matches your personal prefer-
ences and expectations, and not some programmer’s at Apple. The software
you load on your system differs from the programs your best buddies install
on their computers. You tolerate dozens of icons on the Mac desktop; they
prefer a less cluttered screen. You choose a blown-up picture of Homer
Simpson for your desktop background; your pals go with a screen-size poster
of Jessica Simpson.
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Establishing User Accounts
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As much as the computer staring you in the face is your very own Mac,
chances are you'll be sharing it with someone else: your spouse and kids,
perhaps, if not your students and coworkers. [ know you generously thought
about buying each of them a computer. But then your little one needs braces,
you've been eyeing a new set of golf clubs and, the truth is, your largesse has
limits. So you’ll be sharing the computer, all right, at least for awhile. The
challenge now is avoiding chaos and all-out civil war.

The Mac helps keep the peace by giving everyone their own user accounts,
which are separate areas to hang out in that are password protected to pre-
vent intrusions. (There’s not much the folks at Apple can do to avert fights
over when people use the computer.)

Ranking user accounts

In Chapter 2, I explain how you create your own user account as part of

the initial computer setup. But not all user accounts are created equal, and
yours is extra special. That’s because as the owner of the machine, you're the
head honcho, the Big Cheese, or in the bureaucracy of your computer, the
administrator.

Being the Big Cheese doesn’t earn you an expense account or a plush corner
office with a view of the lakefront. It does, however, carry executive privi-
leges. You get to lord over not only who else can use the machine but who, if
anyone, gets the same administrative rights you have.

Think long and hard before you grant anyone else these dictatorial powers.
Only an administrator can install new programs in the Applications folder, or
muck around with system settings such as Date & Time and Energy Saver. And
only an administrator can effectively hire and fire, by creating or eliminating
other user accounts.

Let’s take a quick look at the hierarchy of accounts:

v Administrator: As outlined previously, you have almighty powers, at
least when it comes to your computer.

v~ Standard: You can’t mess with other people’s accounts. But you do pretty
much have free reign when it comes to your own account. That means
you can install software, alter the look of your desktop, and so on.

1 Managed with Parental Controls: Consider this mom and dad’s revenge.
The kids may get away with murder around the house, but they can’t get
away with murder on the Mac.
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v Sharing Only: A limited account for sharing files remotely across a net-
work.

v Group: By creating a group account, you can share files with the mem-
bers of said group. It’s really a type of account comprised of one or
more accounts.

v Guest: Willing to let the babysitter play with your Mac after putting the
little ones to bed? A guest account lets her log in without a password
(though you can still restrict her activities through parental controls).
You can allow guests to connect to shared folders on the system. Or not.
And the beauty of one of these accounts is that once a guest has logged
out, all traces of her stay are removed, right down to the temporary
home folder created for her visit.

Creating new accounts

So now that you know the different types of user accounts, let’s find out more
about setting up one. To create a new account for one of your coworkers,
say, follow these steps:

1. Choose %=System Preferences, and then click the Accounts icon in
the System section.

Alternatively, click your user name on the upper-right corner of the
screen, mouse down to Accounts Preferences, and click or get to System
Preferences through its dock icon.

It’s worth remembering how you get to System Preferences because
you’ll be spending quite a bit of time there in this chapter. The Accounts
window that appears is shown in Figure 5-1.

Accounts
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2. If the Password tab isn’t highlighted, click it.
3. Click the + on the lower left below the list of names.

If the + appears dimmed, you have to click the padlock at the bottom
of the screen and enter your name and password to proceed. (You’ll
encounter this padlock throughout System Preferences and must click
it and enter an administrative password before being allowed to make
changes.)

4. In the screen shown in Figure 5-2, do the following:

a. In New Account pop-up menu, choose one of the account desig-
nations listed in the preceding section.

b. Enter a name, a short name, a password, the password verifica-
tion, and (if you choose) a password hint in the blank fields
shown.

For help choosing a password, click the key next to the password
field. And for extra security, select the Turn on FileVault Protection
option — but read Chapter 13 first to weigh its benefits against its
penalties. Unless you have a good reason to do otherwise, leave
the Allow User to Administer This Computer option unchecked
(shown in Figure 5-1). Of course, you may want to give a coworker
or other person sharing an account the ability to enter his or her
own password and user name.

c. Click Create Account.

You may leave the remaining steps to the new Account holder to let him
or her choose an identifying picture, for example.

New Account: | Standard ] :}

Name: |

Short Name:

Password: 9

Verify:
I

Figure 5-2: Password Hint:

{Recommended)

The New
Accounts [ Turn on FileVault protection
window. @ (" Cancel \ ( Create Account }
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5. Click the Picture tab.

6. Select the small image that will be displayed next to the user name
when the account holder logs on to the computer.

You can click the bowling pins, gingerbread cookie, luscious lips, or
other goofy iconic images presented in the Accounts window. But
account holders may well want to choose one of their own images. To
do so:

a. Open OS X’s default navigational window Finder (by clicking the
Finder dock icon) and then click Pictures.

b. Drag an image into the little picture box next to the Reset
Password button in the Accounts window.

A new window showing the picture you have dragged in appears.

c. You can click Set to set that image as your account picture,
Cancel, if you change your mind, or Choose to pick another
image from Finder.

If the new Account holder has a .Mac User Name, they can enter it
here.

Check out the next section “Entering the Photo Booth” for another, more
enjoyable way to create an account picture.

Entering the Photo Booth

Remember when you and your high school sweetheart slipped into one of
those coin-operated photo booths at the five-and-dime? Or maybe it was your
mom or dad’s high school sweetheart. Don’t worry, I'm not telling what went
on behind that curtain. You or your parent probably confiscated the evi-
dence years ago, a strip with all those silly poses.

Silly poses are back in vogue. Apple is supplying its own photo booth of sorts
as a built-in software feature on recent Macs with integrated iSight cameras.
You can produce an acceptable account picture to use when exchanging
instant messages (Chapter 11).

Apple’s Photo Booth and the photo booth of yesteryear have some major
differences. For starters, you don’t have to surrender any loose change with
Apple’s version. What’s more, there’s no curtain to hide behind (which is kind
of too bad), though there’s a picture of a curtain in the Photo Booth icon. And
that old-fashioned photo booth can’t match Apple’s other stunts — making
movie clips or having your mug appear in front of a moving roller coaster or
other fluid backdrop.
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Taking a Photo Booth picture

Open Photo Booth by clicking its name in the Applications folder. You can
snap an image right away by merely clicking the round shutter button below
the large video screen that serves as a viewfinder, as shown in Figure 5-3.

Phote Booth

|
- S———
Figure 5-3: L= @ [ effeas
It's a snap. .
The main : - "
Photo Booth 2 : 4 . i .
VIBW 20 £ 21 & 22 e 13 X 24 £ 25 & 26
E—— 24 photos gnd 2 movies
Click to take a movie clip Click to enter the
Special Effects menu

Click to take four quick pictures

Click to take a still picture Shutter button

Upon doing so, a three-two-one countdown ticks off. On zero, the display
flashes, and your mug is captured. But let’s consider your other options.
Take a gander at the three little icons to the left of the shutter button.
Clicking the leftmost square means the picture you snap will be a single still.
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Now click the middle square, which is divided into four quadrants. You have
activated Burst Mode. This time when you press the shutter button, Photo
Booth will take four successive snapshops in a row, right after the three-two-
one countdown. The just-captured images appear in a single four-up snap-
shot with, well, four panes.

The third icon puts Photo Booth in video mode. After the countdown, the
computer starts making a little video, complete with audio. You'll have to
click Stop to cease recording. A red digital counter reminds you that you are
still shooting.

Applying special effects

So far I've told you how to capture straightforward images. Now the real fun
begins. You can summon your inner mad scientist and apply a series of warp-
ing effects.

Click the Effects button. A Brady Bunch-like grid appears, with each square
revealing a different effect, just like the screen shown in Figure 5-4 Click the
arrows adjacent to the Effects button to check out another set of effects.

Photo Booth

-
Black and White

i .
Comic Book Color Pencil
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t. L
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A
Thermal Camera kY * 2/ Pop Aft &fﬁ
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Going on location (well sort of)

Haven't been to Paris? No reason you can't still
strike a pose in front of the Eiffel Tower.

Thanks to Photo Booth you can appear to be
where you are not. A series of striking, stock
still backdrops can place you in the clouds,
on the moon, or in front of 1960s-ish mod color
dots. Or (provided your Mac has an Intel Core
Duo or faster processor) your backdrop can
be a little video clip instead: a screaming roll-
ercoaster ride, swimming with the fishes, by a
Yosemite waterall, or on a remote beach. You
can even substitute your own photo or movie
clip by dragging your pictures or videos from

Finder onto the empty frames for that very pur-
pose, up to eightin all.

So how do you end up in one of these scenes?
When you choose any of these effects, you're
prompted to momentarily step outside the frame
so that Photo Booth can separate you, the sub-
ject, from the backdrop seen from the camera
lens. Then you can proceed capturing the still
or moving image. Better yet, by choosing one
of these (what | like to call) Hollywood squares,
you can apply such effects without having to
rely on a “green screen” like those employed in
the moviemaking or news business when they

want someone to appear to be on location.

Click a square to preview, and ultimately choose, an effect. Click the middle
of this tic-tac-toe grid to revert to normal.

You can make it look as though the picture was taken with a thermal camera
or an X-ray or drawn with a colored pencil. You can turn the image into pop

art worthy of Warhol or make it glow radioactively. And you can place your-
self in a mirror image reminiscent of the Doublemint gum twins.

Clicking some effects (such as bulge, squeeze, or twirl) display a slider that
lets you use the mouse to tweak the level of distortion. Still other effects, as
described in the “Going on location (well sort of)” sidebar, let you change the
video backdrop.

Admiring and shaving Photo Booth photos

The pictures and movies you make in Photo Booth turn up at the bottom of
the Photo Booth program in an on-screen photo strip. To admire the image,
just click the corresponding thumbnail.

You also have several options for sharing the picture or movie with others.
By choosing the appropriate button, you can make it your Account Picture or
Buddy Picture (for use as a buddy icon) in iChat. You can e-mail the picture
through the Mac’s Mail application or send it to your iPhoto picture library.
Or you can drag it to your desktop.
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<P You can also export the thumbnail by selecting it, choosing File from the
Photo Booth menu, and then selecting Export. If it was a four-up shot, it gets
exported as an animated .gif file that you can use in Web sites or as your iChat
buddy picture.

s If you're like me, you’ll collect a bunch of silly Photo Booth images in short
order. One nice way to show them off is in a slideshow. From the View menu,
click Start Slideshow.

Using Parental Controls: When Father
(or Mother) Knows Best

Suppose one of the new accounts you create is for your impressionable
offspring Cookie Monster. As a responsible parent, you want to set limits to
keep him out of trouble. And as a responsible Mac owner, you want to keep
him from unwittingly or (or otherwise) inflicting damage on the computer.

It’s time to apply parental controls. Presumably, you already set up Cookie
Monster as a managed account with parental controls. If not, click to select
the Enable Parental Controls box in the Accounts window. When you do so,
Cookie Monster’s account goes from being a regular standard account to a
managed account, with you as the manager. You have quite a bit of say about
what your youngster can and cannot get away with. Let’s have a look.

In the Accounts window, click Open Parental Controls. Alternatively click
Parental Controls inside System Preferences. Either way you’ll end up in

the same place. In the Parental Controls window, shown in Figure 5-5, select
Cookie Monster’s name in the list on the left. Now, protective parent, there’s
lots you can do.

Let’s dive in to the five tabs at the top of the window:

v System: Parents can select the Use Simple Finder box to provide Cookie
Monster with the most restricted barebones desktop. Only three fold-
ers reside in the Simple Finder version of the Dock (My Applications,
Documents, and Shared). Meanwhile, the only applications your kid gets
to see are those you've designated by selecting the Only Allow Selected
Applications option. In this System view, you can also choose whether
the little guy can administer printers, burn CDs and DVDs, change a
password, and modify the Dock. (Dock modification is categorically dis-
allowed in Simple Finder.)
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+~ Content: By selecting this tab, you can filter out four-letter words in
Dictonary. You can also restrict Web access so that all Cookie Monster
supposedly gets to see are clean sites. Apple will make the decision
on your behalf if you select the Try to Limit Access to Adult Website
Automatically option. If you click Customize, you can list your own
approved sites, as well as those you don’t deem kosher. To see some of
the sites that meet Apple’s approval, click Allow Access to Only These
Websites. Discovery Kids, PBS Kids, and Smithsonian Institution are
among the sites that made Apple’s list.

v Mail & iChat: By selecting Limit Mail and/or Limit iChat, you get to
approve who Cookie Monster can exchange e-mails and hold chats with
through instant messages. You can also receive an e-mail permission
request should Cookie Monster attempt to communicate with someone
who isn’t on the A-OK list.

v+ Time Limits: It’s not only a matter of who Cookie Monster would like to
interact with or what programs he wants to play around with — it’s also
a matter of when you let him do so. By dragging the sliders shown in
Figure 5-6, you can establish weekday and weekend time restrictions. In
other words, you can prevent access to the Mac when it’s time for him
to go beddy-bye, choosing different times on school nights and week-
ends. Cookie Monster will get a fair warning shortly before shut down
time so he can save his work. He’ll also get the opportunity to plead for
more time.

1 Logs: We know you trust your child. Honest. All the same, you want to
make sure he’s safe and sound. So here’s where you get to, um, moni-
tor (that’s the nice way of saying it) his behavior. You can to see the
Web sites he visited or tried to visit), the applications he used, and who
he chatted with. You can log activity for one week, one month, three
months, and so on. And you can group logs by contact or date.

You don’t have to have kids to implement parental controls. These controls
work nicely in setting limits on employees, friends, or visiting relatives.

Is your kid using another Mac in the house? You can remotely manage paren-
tal controls across all the Macs in your home network. You’ll have to set up
an administrator account across all the computers you want to manage. In the
lower-left corner of the Parental Controls window, click the small gear icon
(just above the padlock). From the pop-up menu, select Allow Remote Setup.
Repeat this exercise on each Mac you want to manage.
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The Lowdown on Logging On

|
Figure 5-7:
Choosing
login
options.
|
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You can create user accounts for any and all family members or visitors who
will be using a particular Mac. And you can control how they log in. In this
section I describe how.

In System Preferences, choose Accounts Preferences, and then click Login
Options at the bottom of the left pane, under the list of all the account
holders on your system. If need be, click the padlock and enter a name and
administrative password. Once in, you'll see the window shown in Figure 5-7.
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To automatically log in a particular user (likely yourself), select the
Automatic Login option and choose the appropriate person from the pop-up
menu. You’'ll have to enter a password.

If the computer is set to automatically log you in, any user who restarts the
Mac in your absence will have access to your account.

If automatic login is not turned on, users who start the Mac will encounter
the computer’s Login screen. It will appear differently depending on which
radio button you chose under Display Login Window As under Login Options.

Select List of Users to see a Login screen with a roster of people alongside
pictures for their respective accounts. Select Name and Password, and
account holders must type a user name and password in the appropriate
boxes on the Login screen.
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Either way, press Enter or click after entering the password to actually log
in. If you type the wrong password, the entire window wobbles as if having a
momentary seizure. Type it wrong a few more times, and any password hints
you previously entered appear (provided you chose that option under Login
Options).

And logging off

Say you are ready to call it quits for the day but don’t want to shut down the
machine. At the same time, you don’t want to leave your account open for
anyone with prying eyes. Baig’s Law: Just because your family, friends, and
coworkers are upstanding citizens doesn’t mean they won’t eavesdrop. The way
to shut down without really shutting down is to choose #=>Log Out.

Pulling a fast one

Now let’s consider another all-too-common scenario. You're in the middle

of working when — how to put this delicately — last night’s pasta exacts
revenge. Nature calls. As you get up to leave, your spouse comes running in,
“Honey, can I quickly check my e-mail?” You could log out to let her do so, but
because you are going to be right back, you figure there’s got to be a better
way. The better way is called fast user switching. To take advantage of the
feature, you must have previously selected the box next to Enable Fast User
Switching, in the Login Options window.

Then, to let your spouse (or any other user) butt in, click your user name in
the upper-right corner of the screen. A list of all account holders appears.
The person can then click his or her name and type a password. Like a
revolving door, your entire desktop spins out of the way while the other
user’s desktop spins in. When you return moments later, you repeat this pro-
cedure by choosing your name and entering your password. Your desktop
twirls back into view, right where you left off.

Letting Someone Go

Sometimes being the boss really does mean being the bad guy. The Mac
equivalent of terminating someone is to delete the person’s user account
from the system. In the Accounts window, click the padlock (it’s at the
bottom left of the window) to permit changes. Then select the name of the
person getting the pink slip. Click the — button under the list of names.
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A dialog box presents a few choices: Clicking OK wipes the account from the
system but you get to check off whether to save the person’s home folder in
a disk image (in an appropriately labeled Deleted Users folder), leave their
home folder where it was in the Users folder, or delete the home folder alto-
gether. The latter is reserved for users who were particularly naughty (and
you don’t need their files).

Changing Appearances

\\3

Now that you're past the unpleasant act of whacking someone from the
system, you can get back in touch with your kinder, gentler side — the part
of you solely occupied with making the Mac look pretty.

Altering buttons and the desktop

Are you not keen on the look of buttons, menus, and windows on your Mac?
Is the wallpaper that Apple’s interior designers put behind your desktop
attractive enough but not your taste? You can rip it down and start anew.

Choose ®=>System Preferences and then click Appearance. This is where you
can alter the menus and the color of those buttons, and apply other cosmetic
touches.

Then move on to the Desktop & Screen Saver System Preference to really
start putting your stamp on the place. Make sure the Desktop tab is high-
lighted, as shown in Figure 5-8. Click one of the design categories in the

list on the left (Apple Images, Nature, Plants, and so on). Various design
swatches appear on the right. Best of all, unlike the swatches a salesperson
might show you in a home decorating store, you can see what a finished
remodeling job here will look like. All you have to do is click.

The design categories on the left include a listing for the Pictures Folder

as well as albums from your iPhoto library (see Chapter 15). Clicking these
options lets you choose one of your own images for the desktop background.
Apple’s designer collection has nothing over masterpieces that include your
gorgeous child.

If variety is the spice of life — or you have a short attention span — click to
add a check mark to the Change Picture Every 30 Minutes option (or select
another timeframe from the pop-up menu). Selecting the Random Order
option will (you guessed it) change the background in random order. This
option cycles through pictures in the folder selected in the left pane.
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While you're at it, click to select or deselect the Translucent Menu Bar box
depending on your fancy.

Choosing a screen saver

“God save the screen. God save the screen? What's that, wrong slogan? “Queen?
Oh, royal bummer, never mind.”

Screen savers are so-named because they were created to save your screen
from a ghostly phenomenon known as burn-in. Whenever the same fixed
image was shown on a screen over long periods of time, a dim specter from
that image would be permanently etched onto the display. Burn-in isn’t much
of an issue anymore, but screen savers survived. Today their value is strictly
cosmetic, in the same way you might choose a vanity license plate or a ring
tone for your cell phone.

In the Desktop & Screen Saver pane of System Preferences click the Screen
Saver tab. (Not there? Choose ®=>System Preferences and then click Desktop
& Screen Saver.)

Click one of the screen savers in the box on the left, as shown in Figure

5-9. Some of the pictures are stunning. (I recommend Cosmos or Nature
Patterns.) You can also select images from your own photo library or install
screen savers created by companies other than Apple.
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If you want to know what words such as “soporific” or “flume” mean, choose
the Word of the Day screen saver. It’s not as pretty as some other options, but
at least it’ll boost your vocabulary.

You can preview screen savers in the small screen to the right or click the
Test button to get the full-screen effect.

After choosing a screen saver (or again having Apple choose one for you
randomly), drag the Start Screen Saver slider to tell the Mac to choose a time
for the screen saver to kick in, ranging from three minutes to two hours (or
never).

Tidying Up with Exposé

You are so frantically busy that your papers end up strewn every which way,
empty coffee cups litter your desk, and boxes pile on top of boxes. Worse,
you can’t lay your hands on the precise thing you need the very moment
when you need it. Sound familiar? Psychiatrists have a technical name for
this kind of disorder. It is called being a slob. (Takes one to know one.)

Things can get untidy on the Mac desktop, too, especially as you juggle
several projects at once. At any given time, you may have opened System
Preferences, Dictionary, iCal, an e-mail program, numerous word processing
documents, and then some. Windows lay on top of windows. Chaos abounds.
You have fallen into the dark abyss that is multitasking.
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Apple has the perfect tonic for MDLS (Messy Desktop Layered Syndrome),
shown in Figure 5-10. The antidote is Exposé, and it is as close as your F9 key
(or the Fn+F9 combination on some models).
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Go ahead and press F9 (or Fn + F9) now (or F3 on Apple’s new aluminum
keyboard). Each previously open but obstructed window emerges from its
hiding place, like crooks finally willing to give themselves up after a lengthy
standoff. All the windows are proportionately and simultaneously downsized
so that you can temporarily see them all at once, as shown in Figure 5-11.

Now move the cursor over one of the visible windows. The title of the appli-
cation or folder is revealed, and the window appears dimmed. Point to the
window you want to bring to the front (to work on) and press the spacebar,
or press Enter, or click inside the window.

Exposé is good for a few other stunts, and these are the default keys to make
them happen:

v F10 (or ctrl+F3 on the new keyboard): Opens all the windows in the
application you're currently using. If you’re working on a document in
TextEdit, for instance, any other open documents in the program will
also be brought to the front lines.

v+ F11 (or 8 +F3 on the new keyboard): Hides all windows so you can
admire the stunning photograph you chose for your desktop.
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Figure 5-11:
Exposé in
action.
|

If you have something against F9, F10, and F11 (or other keys you're using
for Exposé), open System Preferences, choose Exposé & Spaces, and assign
alternative keys. And if you have something against keys in general, you can
arrange to have Exposé do its thing by moving the cursor to one of the four
corners of the screen.

Incidentally, if you're wondering about the Spaces part of Exposé & Spaces,
read on. Then we’ll close this chapter with a tour of some of the remaining
items in System Preferences.

Getting Spaced Out

Exposé is terrific for reducing clutter. But it can’t solve one basic organi-
zational problem: keeping only those programs and windows related to a
distinct pastime in one dedicated location. That’s where the Leopard feature
known as Spaces comes in. It lets you display only the stuff required to tackle
the projects at hand.

So maybe you’re an e-mailin’ Web surfin’ kind of dude. Maybe you’re putting
together a family scrapbook. And maybe you’re writing a For Dummies book
in your spare time. You can set up separate spaces for each of these activi-
ties. Here’s how:



|
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1. In System Preferences, click Exposé & Spaces.

2. Make sure the Spaces tab is selected, as shown in Figure 5-12.
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3. Click Enable Spaces.

4. Click Show Spaces in Menu Bar.

Okay, in truth this step is optional. But it’s a handy way to keep track of
what space you're in.

5. Click the + and - buttons next to Rows and Columns to select the

number of Spaces you think you will need and configure their layout.

You can choose between a two-Spaces layout and sixteen-by-sixteen
grid, with each one numbered, up to the total sum of spaces you've
selected.

6. To assign particular applications to specific spaces, click the + under

the Applications Assignments list and then click under Space to
choose the one you have in mind.

That e-mailin’ surfin’ dude would likely add the Mac’s Mail programs and
the Safari browser to a particular Space. The family scrapbooker would
probably put iPhoto to work in another.

Choose Every Space if you want an application to be available no matter
what space you're in, as I do with the Safari Web browser.
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Moving from space to space

Discovering a few key moves will turn you into a real space cadet.

v To view all your spaces at once, as shown in Figure 5-13, press the F8
key on your keyboard. Just click on a space to enter. You can drag
spaces around this bird’s-eye view to reorder them.

v To go directly to a space, press the Ctrl and the number key of the Space
you want to drop in on.

v To move to the next or last space, press Ctrl and the left or right naviga-
tion arrow key, respectively.

v 1f you chose Show Spaces in Menu Bar as outlined in the preceding
steps, click the Spaces icon in the menu bar and click the space you
want to go to.

v~ If an application is assigned to a specific space, opening it on the dock
will automatically transport you to that space.

Figure 5-13:
A bird's-
eye view of
Spaces.

o\ As clutter-fighting agents, Exposé and Spaces work well together. So from the
birds-eye F8 view of Spaces, press the Exposé F9 key on (older) keyboards and
watch as the open windows in each Space line up obediently. To return them
to their previous position, press F9 again.
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When you enable Spaces (or Exposé, and so on) to override a hard-coded
function on the newer Apple keyboard, you can always go back to it using the
Fn key. For example, if you have the Spaces full view set for F8 but you wanted
to use play/pause, you would simply press fn and F8 to get that functionality.

<MBER
S

Moving windows between spaces

Maybe you decide that a particular window is better suited to a different
space, at least for the moment. Try these tricks.

v From the bird’s-eye view, merely drag a window from one space to
another.

v If you're already working in a space, drag the window you want to move
to the left or right edge of the screen while holding down the mouse. A
moment later the window will switch to the adjacent space.

» You may need to be an athlete to pull this one off. But here are Apple’s
own instructions. “Move the pointer over the window, and hold down the
mouse button while pressing the Ctrl key and an arrow or number key.”

System Preferences: Choosing Priorities

You may be wondering what'’s left. We've already dug inside System
Preferences to alter the desktop and screen saver, establish parental con-
trols, muck around with Exposé and Spaces, and then some. But as Figure
5-14 shows, you can still do a lot more. Let’s explore some of these options
now and some later.
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Getting in sync with date and time

You established the date, time, and time zone when you set up the Mac ini-
tially (in Chapter 2). In System Preferences, you can move the location of the
clock from the menu bar to a separate window. You can change the appear-
ance of the clock from a digital readout to an analog face with hands. If you
choose a digital clock, you can flash the time separators — or not. You can
display the time with seconds use a twenty-four-hour clock or both. You can
even have the Mac announce the time on the hour, the half hour, or the quar-
ter hour.

Displays

If you are hunky-dory with what your display looks like, feel free to ignore
this section. Read on if you are the least bit curious about resolution and what
changing it will do to your screen. Resolution is a measure of sharpness and
is expressed by tiny picture elements, or pixels. Pixels is such a nice sound-
ing word that I always thought it would make a terrific name for a breakfast
cereal, something like new Kellogg’s Sugar-Coated Pixels. But I digress.

You will see resolution written out as 800 x 600, 1024 x 768, 1680 x 1050, and
so on. The first number refers to the number of pixels horizontally, and the
second number is the number of pixels vertically. Higher numbers reflect
higher resolution, meaning the picture is sharper and you can fit more on the
screen. At lower resolutions the images may be larger but fuzzier, though this
depends on your monitor, and any resolution other than the native one on an
LCD display will be somewhat fuzzy. Lower resolutions also refresh, or update,
more quickly, though you will be hard-pressed to tell with most modern moni-
tors. As it happens, the refresh rate doesn’t mean boo on computers such as
iMacs with LCD or flat-panel displays.

You can also play around with the number of colors that a Mac displays (mil-
lions, thousands, or down to a puny 256). Best advice: Play around with these
settings if you must. More often than not, leave well enough alone.

Sound

Ever wonder what the Basso sound is? Or Sosumi or Tink? I'd play them for
you if this was an audio book, but because it isn’t, check out these and other
sound effects in System Preferences. You'll hear one of them whenever the
Mac wants to issue an alert. Sound Preferences is also the place to adjust
speaker balance, microphone settings, and pretty much anything else having
to do with what you hear on the Mac.
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Software update

Your Mac may be a machine, but it still has organic traits. And Apple hasn’t
forgotten about you just because you’ve already purchased one of its prized
computers. From time to time, the company will issue new releases of certain
programs to add features it won’t make you pay for, to patch or fix bugs, or to
thwart security threats. For a full log, click Installed Updates.

You can have the Mac check for automatic software updates daily (might
be overkill), weekly, monthly, or on the spot. If you choose, the Mac will
fetch important updates in the background, and bother you only when the
program update is ready to be installed. Software Update is accessible also
directly from the % menu.

Universal Access

Some physically challenged users may require special help controlling the
Mac. Choose Universal Access under System Preferences, and click the tab
you need assistance with: Seeing, Hearing, Keyboard, or Mouse, as shown in
Figure 5-15.

Universal Access
<[> | showall a

When using this I would like i with:

{ Seeing Hearing Keyboard Mouse |

VoiceOver: Turn VoiceOver on or off: %F5

OO0On ®Off (" Open VoiceOver Utility... )
Zoom: Turn zoom on or off: X8
. Zoom in: (3=
Oon ooff Zoom out: T8~ ( Options... )
Display: Switch to white-on-black: A28

®Black on White [Use grayscale
O White on Black

Enhance contrast: [ e
Normal Maximum

Reduce contrast: ~"\C38,
Increase contrast: A\88. ©)

¥ Enable access for assistive devices

T1Show Universal Access status in the menu bar
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Among the options, you can arrange to

v Turn VoiceOver on or off, to hear descriptions of what’s on your screen.
And by opening the VoiceOver utility, you can change the default voice.
With Leopard, VoiceOver supports the most popular Braille displays.

v+ Enhance the contrast, or alter the display from black on white or white
on black.

v Flash the screen when an alert sound occurs.

v Zoom in on the screen to make everything appear larger. Or enlarge the
size of the pointer if you have trouble seeing the mouse.

v Use a Slow Keys function to put a delay between when a key is pressed
and when the result of that keypress is accepted. Or, if you can’t easily
press several keys at once, use Sticky Keys to press groups of modifier
keys (Shift, 8, Option, and Control) in a sequence.

The Mac may share a nickname with a certain McDonald’s hamburger. But
it’s actually an old Burger King slogan that is most apt when describing your
computer. As this chapter has shown, you can “have it your way.”



Chapter 6
Apple’s Feline Fetish

In This Chapter

Counting the new features in Leopard
Defining OS X Leopard

Searching through Spotlight
Understanding widgets

Automating Automator

Sceve Jobs is fond of big cats. Before Apple unleashed Leopard, previ-
ous versions of Mac OS X software carried such purr-fect monikers as
Cheetah, Puma, Jaguar, Panther, and Tiger. (Apple used the code words
Cheetah and Puma internally.) Snow Leopard has already been announced,
and Apple is also presumably breeding Lynx and Cougar inside its Cupertino,
California, cages.

As strong a release as it is, the name OS X just doesn’t have the bite that
Leopard or any of the other giant kitty nicknames command. However, X (for
ten) is the most celebrated use of roman numerals this side of the Super Bowl.

Leopard actually represents OS X version 10.5. Every eighteen months to two
years or so, Apple brings out a new iteration of its operating system software
(see the “An operating system primer” sidebar), complete with a boatload of
new features and identified by an extra decimal point. Apple says OS X ver-
sion 10.5 Leopard piled more than three hundred features onto its predeces-
sor OS X version 10.4 Leopard. [ haven’t counted.

During the course of a year, Apple will make interim tweaks to its operating
system. You will know because the OS takes on an extra decimal digit. At the
time of this writing, Apple was up to OS X version 10.5.3 (pronounced “ten
dot five dot three”).

[ wonder how many features must be added before Apple changes the
designation to OS XI.

To check out the version of Mac software running on your system, choose
®>About This Mac. Choose Software Update to see whether the OS (and, for
that matter, other programs) are up-to-date.
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An operating system primer

There is software, friends, and there is
SOFTWARE. Make no mistake; a computer’s
operating system deserves top billing. If this
were a movie and the opening credits were
rolling, the name of the operating system would
appear above the title. All other performers on
your computer, no matter how much talent they
possess, are bit players by comparison.

Come to think of it, there would be no movie
at all without the operating system, for it is the
foundation on which all your other programs
run. Minus the OS, that fancy photo editing
program you bought recently might as well be
chopped liver.

As operating systems go, you are truly fortu-
nate to have Leopard. OS X earns raves not just
because it's slick and easy on the eyes. Leopard
is robust, reliable, and stable. Its underpinning

is something called UNIX, a venerable oper-
ating system in its own right. The brilliance
of Apple was in figuring how to exploit UNIX
without making you learn UNIX. Just be thank-
ful it's under the hood, and don't give it another
moment’s thought.

Now | know at least some of you can’t leave it
there. You wantto investigate UNIX. (You're the
person | want in the trenches with me.) Okay,
here goes. Open the Applications folder, choose
Utilities, and delve inside a program called
Terminal. What you'll find here isn't pretty. No
icons. No easy menus. You have split the town
of GUlville and are now tooling around with a
command line interface — meaning you have
to type arcane commands to tell the computer
what to do. Doing so could wreak havoc on your
system, so be careful. You know what they say
about curiosity killing the cat.

Bottom line: Leopards are stunning and powerful creatures. They demand
respect and awe. Something like Apple’s computers.

How Many New Features?
Let Me Count the Ways

As already noted, Apple added more than three hundred features to the

Mac OS in Leopard. We'’ve already discussed some, such as Quick Look and
Spaces, and will get around to others such as Time Machine. But even if I had
the space, I don’t claim the expertise to do all the new features justice. As a
public service and, um, for your reading pleasure, I thought I'd at least tick off
a few of the items on Apple’s long laundry list of features. Disclaimer: I'm not
trying to demean any of these enhancements. These obviously provide great
value to somebody, just not your average consumer. (Danish spell checker,
anyone?) Feel free to skip ahead.
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I'm letting Apple do the talking here. I haven’t changed any of the company’s
descriptions (except for the boldface lead-ins):

v For the international crowd: Take advantage of new input methods for
Chinese, Arabic, and Japanese languages. Leopard also offers two new
input methods for Chinese — Pinyin and Zhuyin.

+* For UNIX lovers: Use Ruby and Python as first-class languages for build-
ing Cocoa applications, thanks to Objective-C bridges as well as full
Xcode and Interface Builder support.

v For networking types: Let Leopard adjust TCP buffer size automatically.
Get optimum application performance, especially in high-bandwidth/
high-latency environments.

v For developers: View your build errors, breakpoint definitions, and
debug values right alongside the relevant source code.

Searching with Spotlight

<MBER
é"\&

Whew! Now that I dispensed with that little piece of trivia, it’s time to put the
spotlight on Spotlight, the marvelous desktop search utility that debuted with
OS X Tiger and only gets better with Leopard. Search is a big deal. A com-
puter isn’t much good if you can’t easily lay your hands on the documents,
pictures, e-mail messages, and programs you need at any particular moment.
When most people think about searching on a computer, they probably

have Google, Yahoo!, or some other Internet search engine in mind. Internet
search is of course a big deal too, and | spend some time discussing it in
Chapter 9.

The searching I have in mind here, however, involves the contents of your
own system. Over time, Mac users accumulate thousands of photos, songs,
school reports, work projects, contacts, calendar entries — you name it.
Spotlight helps you locate them in a blink. It starts spitting out search results
before you finish typing.

What’s even better is that Spotlight can uncover material within documents
and files. That’s incredibly useful if you haven’t the foggiest idea what you
named a file. And as long as your machine has Leopard, Spotlight lets you
search inside the files of any other Mac with Leopard on your network, pro-
vided sharing is turned on.

Let’s try Spotlight now:

1. Click the magnifying glass icon in the upper-right corner of the menu
bar. Or press 38 and the spacebar simultaneously.

(Select the box under Spotlight in System Preferences if the shortcut
doesn’t work.) The Spotlight search box appears.
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|
Figure 6-1:
The
Spotlight
search box.
|

2. Enter the word or phrase you want to search for.

The instant you type the first letter, a window shows up with what
Spotlight considers the most likely search matches. The search is imme-
diately refined as you type extra keystrokes, as shown in Figure 6-1.
Searching is so fast you'll see results more quickly than it takes you to
read this sentence.

Spotlight

Top Hit | i Gilligan tells me there are gr...
Definition @ noun a pebbly or sandy sho

Documents | =| Alohabob Report.ixt
" 048492 Ch06_a.doc
fi Gilligan tells me there are gr...

Folders [1]] Beaches in Turks & Caicos —...
[1] Beaches in Turks & Caicos —...
(1] Beach Road (Unabridged)

Music [ 05 Fun, Fun, Fun.m4a
[7] 10 Help Me, Rhonda (Single ..
[ 01 California Girls.m4a

Messages Two Guys and a Gal
Re: Glen Rock Men's Night O...
RE: Glen Rock Men's Night O

Events & To-Da's : New Event

POF Documents .| Leopard Reviewers Guide.pd...
-_' Lecpard Reviewers Guide.pd...
) safety_study_v04.pdf

Webpages 3-' Scobleizer — Tech geek blo...
& The Hitchhiker's Guide to th...
2 Apple - Mac 0S5 X Leopard -

Spotlight Preferences...

Say you’re planning a tropical vacation and remember that your cousin
Gilligan e-mailed you awhile back raving about the beach at some deserted
Pacific island. You can open the Mac Mail program and dig for the missive
from the dozens that Gilligan sent you. (Evidently he had a lot of time on his
hands.) But it’s far simpler and faster to type Gilligan’s name in Spotlight.

Or maybe you want to give Gilligan a quick buzz. Without Spotlight, you
would probably open your Address Book to find your cousin’s phone
number. The faster way is to type Gilligan in Spotlight and then click his
name next to Contacts in the results window. Address Book opens, displaying
Gilligan’s contact page.
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Rummaging through your stuff

Spotlight is built in to the very fabric of the operating system. Quietly behind
the scenes, Spotlight indexes, or catalogs, most files on the computer so you
can access them in a moment’s notice. The index is seamlessly updated each
time you add, move, modify, copy, or delete a file.

Moreover, Spotlight automatically rummages through metadata, the informa-
tion about your data. Digital photographs, for example, typically capture the
following metadata: the camera model used to snap the image, the date, the
aperture and exposure settings, whether a flash was used, and so on. For
example, if a friend e-mails you pictures taken with a Kodak camera, you can
quickly find those images — as opposed to, say, the pictures you took with
your own Canon — by entering the search term Kodak.

Spotlight is one confident sucker. It boldly takes a stab at what it thinks is the
top hit, or search result you have in mind. (The top hit in Figure 6-1 is a docu-
ment in which Gilligan weighed in on great beaches.) Its track record is pretty
good. If it guesses right, click the Top Hit entry or press Return or Enter. That
will launch the application in question, open a particular file, or display the
appropriate folder in Finder. As is often the case, there’s a shortcut. Press 38
and Return to launch the top hit.

Spotlight is arguably the zippiest way to launch an application. Just start
typing its name into the Spotlight search field, and it should show up as the
top hit after only a few letters (and sometimes a single keystroke). Press
return to launch the program.

Of course, Spotlight isn’t always going to get the top hit right, so it also dis-
plays what it considers to be the next twenty most likely matches. Results
are segregated into categories (Applications, Documents, Folders, PDF
Documents, Music, Messages, Images, Movies, Bookmarks, and so on). Again,
just click an item to launch or open it.

Some searches yield more than twenty possible outcomes. Often a heck of
a lot more. That’s what Show All (refer to Figure 6-1) is all about. Clicking
Show All doesn't, in fact, show you everything. Most of the time your screen
wouldn’t be near big enough. Instead, Show All opens a separate Finder
window like the one shown in Figure 6-2. And as you are about to see, it is a
pretty powerful window indeed.
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|
Figure 6-2:
Spotlighting
the Spotlight
results in

a Finder
window.
|
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Searching "This Mac”
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If you get a flood of results and aren’t sure which is the one you're looking
for, Spotlight provides a good spot to use Leopard’s Quick Look feature (see
Chapter 5). Just click the Quick Look icon and, well, have a quick look at the
sorted files until you find the proper one.

Intelligent searching

You can customize search results in numerous ways. By telling Spotlight
where to search. And by telling it, in precise detail, the criteria to use in that
search.

Look over here

Let’s start with where to look. If the contents you're searching for reside on
the Mac before your very eyes (as opposed to another on your network), make
sure the Search: This Mac button (refer to Figure 6-2) is the one you choose.

The button to its immediate right (edwardbaig in Figure 6-2) refers specifi-
cally to either an open folder, or (if no folder was open) your home folder.
Choosing either option tells Spotlight to look nowhere else but that folder.

The next button, Shared, gives the Mac permission to search the other Macs
in your network. But the Shared option will not appear if no other Mac is on
your network with file sharing turned on. Indeed, you’ll have to set up the
computers so they’re in a sharing mood (see Chapter 18 for more).

Search this, not that

Now that Spotlight knows where to set its sights, it’s time to tell it what
exactly you are looking for. Do you want Spotlight to search for an item by
its file name? Or do you want it to hunt for nuggets buried somewhere deep
inside those files? If the former, click the File Name button; if the latter, click
Contents.
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Remember that in searching for something you don’t necessarily want to cast
too wide a net.

The best way to narrow results is to enter as specific a search term as pos-
sible right off the bat. As you plan your vacation, typing beach will probably
summon the e-mail message Gilligan sent you. But because Spotlight will find
all files or programs that match that text, results may also include PowerPoint
presentations with a beach theme, pictures of your family by the seashore,
and songs on your hard drives sung by the Beach Boys. Typing Gilligan and
beach together will help you fine-tune your search.
If you know the type of item you’re looking for, such as Gilligan’s e-mail as
opposed to his picture, you can filter the search in another way. Enter the search
term followed by kind, a colon, and the file type you are looking for, as in
Gilligan kind:email
If you want to search for a presentation someone sent you on the world’s
best seaside resorts but can’t remember whether the presentation was cre-
ated in AppleWorks, Keynote, or PowerPoint, try

seaside resort kind:presentations

And if you want to search only for presentations opened in the past week,
type

seaside resort kind:presentations date:last week
To search for an application such as Microsoft Word, type
Word kind:application
To search Gilligan’s contact information, type
Gilligan kind:contacts
To search for music, type
Beach Boys kind:music
To search for pictures at the beach, type
Beach kind:images
And so on. The kind keywords all date back to OS X Tiger, when Spotlight
was introduced. Such keywords were expanded as part of Leopard, so

you can now use a label such as author, as in author:baig, or width, as in
width:768-1024.
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Here are a few other new advanced Spotlight techniques, also courtesy of the
latest cat:

+* Boolean query: You can enter a search phrase using AND, NOT, or OR
(in caps as shown) within a parentheses. So you can type (Mary Ann OR
Ginger) NOT Mrs. Howell to bring up references to either of the first two
castaways but not the millionaire’s wife. You can substitute a hyphen (-)
for NOT, as in vacation - island to indicate you don’t want to see any trip
pictures from your tropical adventures.

v Dates: By entering kind:-message created 3/11/08, you can search for an
e-mail you sent on March 11 wishing a pal a happy birthday. You can
also enter a range of dates as in kind:images date 3/11/08 — 3/15/08.

+* Quotes and phrases: By placing quotation marks around a particular
phrase, Spotlight will search for that exact phrase. If looking for a song
with Blue Sky in it, put quotes around the phrase, as in “Blue Sky”, to
have Spotlight look for that precise match. Otherwise, Spotlight will
search for anything with the words blue and sky in it.

v~ Definition: In Chapter 3, I introduce Dictionary as one of the freebie pro-
grams that come on a Mac. Thanks to another Spotlight enhancement in
Leopard you may not even need to consult Dictionary if all you want is a
quick definition. Type the word you have in mind in the Spotlight search
field, and Spotlight will tell you what it means, just below the top hit. If
you need a more thorough definition, click the Definition search result,
and Spotlight will take you to Dictionary.

v Calculator: Spotlight will solve a math problem for you without you
having to summon the Calculator program. Just type the problem or
math equation in the search box, and Spotlight will serve up the result.
For example, to divide 654 by 7, all you need to is type in 654/7, and
Spotlight will provide the answer (93.428571429).

1 Web history: Spotlight follows you around the Web. Sort of. That is, it
indexes the names of sites you've recently visited. Just enter a search
query that relates to a site you want to return to.

Fine-tuning Spotlight further

I've already told you how Spotlight is embedded in the very fabric of the operat-
ing system. And how clicking Show All brings up Spotlight in a Finder window.

That Finder has a search box isn’t novel to anyone who has spent time with
previous versions of OS X. But the similarity ends there. I love baseball analo-
gies, so let me explain it this way. Earlier incarnations of the Finder search
box resembled a solid ballplayer who could hit, say, for a high average. But
nowadays the Finder search box is more like a five-tool player who not only
hits for average but can throw, run, field, and hit for power. In other words,
he can beat you in a number of ways.
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So let’s peer again at this Spotlight results window. See the little + in a circle
to the right of the Contents and File Name buttons? Click this button now.

Doing so brings up two customizable buttons that let you filter a search
according to specific parameters. The button to the left is labeled Kind. Now
click Kind. You immediately see that the leftmost button offers other pop-up
options: Last opened date, Last modified date, Created date, Name, Contents,
and Other.

What shows up on the button to its immediate right depends on what
you selected on the left. If you leave the left button as Kind, the right
button labels are Any, Applications, Documents, Folders, Images, Movies,
Music, PDF, Presentations, Text, and Other. So, for example, if you choose
Documents as the Kind, you are directing Spotlight to search only docu-
ments. Pretty simple.

Say you instead chose Created Date in the left box. Now the button to its
immediate right gives you different choices (within last, exactly, before, after,
today, yesterday, this week, this month, this year). Depending on which of
these parameters you choose, yet another button may appear to its right. For
instance, if you choose within last, you have to tell Spotlight the time frame
you have in mind. To do that, enter a number and choose by days, weeks,
months, or years.

Your decisions may not be over. Perhaps after deciding on the Kind of file
(documents in this case), and the time frame (within the last 2 months) you
want to match a Name or Contents. Just keep adding criteria by repeatedly
clicking the + (refer to Figure 6-2). Pressing the — button deletes the entire row.

Suppose you want to search for all the songs with the word Lost in the title
that you listened to within the year. Your Kind is Music, and your Last
Opened Date is Within Last 1 Years. Such a search yielded the results in the
window shown in Figure 6-3.

Speaking of lost, fans of the hit TV series Lost may feel a chill at the mere men-
tion of the Others. (For those who don’t watch the show, they’re apparently
the bad guys.) But you may welcome the others when it comes to running

the most specialized search queries on your Mac. I'll explain. A moment ago |
mentioned the all-inclusive Other as one of your choices under Kind. Making
that selection brings up the window shown in Figure 6-4, which is basically a
lengthy list of filtered attributes you can use in your search, plus a description
of their purpose.

For instance, you can choose a search attribute based on the authors of an
item, due date, duration in seconds, lyricist of a song, musical key of a song,
genre, pixel height of a document, year an item was recorded, and more than
one hundred other characteristics.
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o006 Searching “This Mac”
3 items
Search for: |lost
( Kind 4 is | Music +) (an
Last opened date +) is (within last T (years &
Name 4] Kind Last Opened
@ 05 You've Lost That Lovin' Feelin'.m4p MPEG-4 Au... (Protected) Feb 6, 2008, 4:40 PM
@ 07 Must of Got Lost [Livel. mp3. MP3 Audio File March 7, 2008, 6:12 PM
@ 07 River Blindness.mp3 MP3 Audio File March 8, 2008, 7:27 AM
|
Figure 6-3:
Searching
for Lost
music.
|
Select a search attribute:
Attribute 4 Description In Menu
Album Title for a collection of media, such as a record album (=]
Alpha channel Whether the image has an Alpha channel =]
Alternate display na... Alternate names of the file B
Altitude The altitude of the item in meters above sea level, expre... o
Aperture Aperture setting of the camera when the picture was taken B
Audiences Who the document is intended for (=}
Audio bit rate Bit rate of the audio in the media a8
Audio encoding appl... Name of the application that encaded the data in the au... =]
Author Email addresses Email addresses for authors of this item =]
Authors Authors of this item =
Bits per sample Number of bits per sample =]
Cell Count Number of attachments and links in the OmniOutliner d.. a
Channel count Number of channels in the file's audio data =]
Checked Item Count  Number of checked items in the OmniQutliner document o
City City of the item (=]
Codecs Codecs used to encode and decode the media o
Color space Color space model of this image =]
Column Count Number of columns in the OmniOutliner document =]
Column Titles Names of columns in the OmniOutliner document =]
Comment Comments about this item (=]
I Composer Composer of the song in the audio file (=]
Contact keywords Contacts associated with this item m]
Figure 6_4, Content Creator Application used to create the document 8
- Content created Date when the content of this item was created )
Choosing Content modified Date when the content of this item was modified i
Contributars People or organizations contributing to the content of t... B
Other Copyright Copyright information about this item =]
Country Country or location where the item was created accordi... B
search -
attributes. Comal) ok
| /'

Before closing out of the Spotlight in Finder window, you may want to save
your search results. To do that, simply click Save.
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Searching your way

As the boss you can specify which categories will appear in Spotlight search
results. To do so, open Spotlight Preferences by clicking at the bottom of the
Spotlight results window or from the main System Preferences window. With
the Search Results tab selected, you can select or deselect the types of items
you want Spotlight to search, as shown in Figure 6-5. You can also drag the
categories in the order in which you want results to appear.

Spotlight
<[> || Showai Q

6 Spotlight helps you quickly find things on your computer. Spotlight is located
at the top right corner of the screen.

! Search Results  Privacy |

Drag categories to change the order in which results appear.
Only selected categories will appear in Spotlight search results.
1 ;A Applications
2 ™ [ Documents
3 ¥ [ Folders
4 ¥ A Music
5 [ @ Mail Messages
6 [ [ System Preferences
7 ™ Y Contacts
8 [ i Events & To Do Items
9 ™ i@ Images
10 ¥ = PDF Documents
11 # ¢ Webpages
12 ¥ B Movies
13 © A Fonts
14 @ § Presentations

; =
¥ Spotlight menu keyboard shortcut: | 33 Space 1~
"] Spotlight window keyboard shortcut: 2 Space

If you click the Privacy tab, you can prevent Spotlight from searching par-
ticular locations. Click the Add button (+) or drag folders or disks into the
Privacy pane to let Spotlight know that these are off-limits. Spotlight will
remove any associated files from the index.

Smart Folders

When you go to all the trouble of selecting specific attributes for your search
query, you may want to revisit the search in the future — incorporating the
latest information, of course. And that’s why the Finder/Spotlight window has
a handy Save button.
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|
Figure 6-6:
Here's

the Smart
Folder
window.
|
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Traditionally, the files on your computer are organized by their location on
your disk. Smart Folders change the organizing principle based on the search
criteria you’'ve chosen. These folders don’t give a hoot where the actual files
that match your search criteria reside on the machine. Those stay put in
their original location. You are, in effect, working on aliases, or shortcuts, of
those files. (See the next chapter for more on aliases.)

What’s more, behind the scenes, Smart Folders are constantly on the prowl
for new items that match your search criteria. In other words, they're
updated in real time.

To create a Smart Folder, click that Save button in the Finder window. (The
Save button is shown in the upper right in Figure 6-2.) Alternatively, in the
Finder, choose File>New Smart Folder to create a new Smart Folder. A box
pops up asking you to specify a name and destination for your newly created
Smart Folder, as shown in Figure 6-6. If you want, select the Add to Sidebar
option to easily find the Smart Folder you just created.

Specify a name and location for your Smart Folder

There’s already a premade Smart Folder in the sidebar labeled All Documents.
But you may want to create a simple Smart Folder containing all the documents
you’ve worked on in the past seven days. Give it an original name. Oh, [ dunno,
something like What a Hellish Week! In any case, all your recent stuff is easily at
your disposal. Your older documents will pass new arrivals on their way out.

Fiddling with Dashboard Widgets

Apart from prowling the virtual corridors of cyberspace or interacting with
Apple’s iLife programs, most of your face time on a Mac will find you engaged
with some full-blown (and often pricey) software application — even if you
take advantage of a relatively narrow set of features.

The wordsmiths among you couldn’t subsist without Microsoft Word or
some other industrial-strength word processor. You graphics artists live and
breathe Adobe Photoshop. But personal computing isn’t always about doc-
toring photos or penning the great American novel (or For Dummies book).
Sometimes all you want is a quick snippet of information, the temperature, a
stock quote or phone number.
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|
Figure 6-7:
Widgets
star in the
Dashboard
collection.
|

That’s what a gaggle of mini-applications known as widgets are all about.
Indeed, these lightweight programs generally serve a useful and singular pur-
pose: from letting you track an overnight package to finding out whether your
favorite team covered the spread. Frankly, you can perform many of these
tasks through the Web or other programs on your desktop. But few do it with
the convenience and flair of widgets.

Fronted by large colorful icons, widgets come at you en masse when you
summon Dashboard. This translucent screen, shown in Figure 6-7, lies on top
of your desktop. Nothing underneath is disturbed.

Previously used widgets

Dashboard icon Dashboard

Click to open widgets bar

To open Dashboard, click the Dashboard icon in the dock (labeled in Figure
6-7) or press the F12 key on older keyboards or F4 on the new Apple alumi-
num keyboard. Pressing the key again closes Dashboard. You can exit also by
clicking anywhere other than on a widget.

To get you started, Apple supplies a collection of basic widgets (calculator,
clock, calendar, weather). Thousands more widgets, many of great interest,
are available online. You can embark on a widget hunt at www.apple.com/
downloads/dashboard. Or right-click the Dashboard dock icon and click

More Widgets.
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When you call up Dashboard, only the widgets you previously used appear
on the screen, right where you left them. The rest are cozying up to the wid-
gets bar, which you can open by clicking the + button (labeled in Figure 6-7).
If you want to enlist one of the widgets, just drag it onto the Dashboard area.
It will dazzle you with a ripple effect as it makes its grand entrance. When it’s
last call, click the X button (labeled in Figure 6-8) to close the widgets bar.

|
Figure 6-8:
Widget-
mania at the
widgets bar. | @ 2% B8 @ = Cosgi - \

Click to close widgets bar Drag icons from widgets bar to Dashboard display Widgets bar

The great majority of downloadable widgets are gratis. A few are available as
shareware, meaning you can try them before paying. Whether you fork over
the loot is up to your conscience, but unless you think the program is worth-
less, its creator should be rewarded for his or her efforts.

Some widgets are extensions to other programs on your computer, such

as the ones that display data from iCal or your Address Book or bring up
blank Stickies. But most widgets grab feeds off the Internet, so you need an
online connection. Widgets in this category might tell you what’s on the tube
tonight or deliver a surfing report (on waves, dude, not cyberspace.)

Other widgets wizardry:

v If you hold down the Shift key while you press F12, the widgets will open
or close in super-slow-motion.

v 1If you hover over an open widget and press 8+R, the wizard twists like a
tornado and refreshes itself. Any live information will be updated.
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v To rearrange widgets on the Dashboard area, just drag them around.

» You can display more than one of the same widget, which is useful, say,
if you want to check out the weather or time in several locations. Just
drag the widget out again from its hiding place in the widgets bar.

A few more widget tricks are in store later in the book. You can clip portions
of a Web page using the Safari browser and turn it into a widget (see Chapter
9). If you're a MobileMe account holder, you can sync the Dashboard from
one Mac to another (Chapter 12). And in Chapter 21, I rattle off ten widget
goodies.

<P Before we skip out on this widgets seminar, though, let me mention one more
in passing, a widget to manage all your other widgets. The widget shown in
Figure 6-9 contains a list of other widgets (People, Researcher, Ski Report,
and so on). By unchecking the names of the widgets in the list, you can dis-
able them and in some instances send them to the trash. If you click the More
Widgets button, you’ll be transported to Apple’s main Dashboard Widgets
Web page, where you can download other widgets.

Uncheck Widgets to disable them.
r
v/ & People
Vi h_( Researcher
I -
. vl Ed SskiReport
Figure 6-9: & surero
The widget |V Stickies
totame | ﬁ Stocks
other
X vl . Tile Game
widgets. —
| More Widgets... | i
I

Unleashing Automator

Quick show of hands: How many of you have ever taken a class in computer
programming? (You think I can’t tell if you have your hand up? Well, I can.)
That’s what I figured, not many of you.

Tiger unveiled a feature called Automator that lets you program repetitive
tasks — renaming a batch of files, say — without having to master
programming — and Leopard made it even easier, starting with a new
interface. Automator is Apple’s way of automating or simplifying a computer
practice known as scripting. (See the “Reading the AppleScript” sidebar for an
overview of AppleScripts.)
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Automatorisn'tthe only way of handling repetitive
tasks on your computer. You can also call upon
AppleScript, which has been around since the
days of System 7 (think Mac OS 7). AppleScript is
really a programming language and is beyond the
scope of a beginner book. But that doesn’t mean
you can‘ttake advantage of AppleScript (and you
often do without realizing it).

For example, open Finder. Chooser>Applications
>AppleScript. Click to open the AppleScript

Reading the AppleScript

Utility. Select the Show Scriptin Menu Bar and
Show Library Scripts check boxes. Finally, click
the tiny icon that appears in the menu bar. A
bunch of example scripts are now at your dis-
posal, organized into 16 categories (Address
Book Scripts, Mail Scripts, etc.). Click on the
arrows in each category to sample the underly-
ing scripts. For example under Internet Services,
you can request the “Current Temperature by
Zipcode” or a “Stock Quote.”

Automator is built around specific tasks, or actions (Open Images in Preview,
for example), dragged from an Action list to a workflow area on the right side

of the window.

To help you get a workflow flowing, Automator (in Leopard) now lets you

choose a starting point by clicking the icons displayed in Figure 6-10: Custom,

Files & Folders, Music & Audio, Photos & Images, or Text.

Select a starting point to open a new workflow:

Custom Files & Folders Music & Audio

Photos & Images

— L!J Custom
Figure 6-10: To start a new workflow, click Choose, and then drag actions to the workflow.
Choosing an
Automator
starting
|

Suppose you select Music & Audio. From the pop-up menus, you can set up

how audio is received by the workflow (from iTunes, from your Mac, from the

Web) and how to proceed based on what you decided (for example, ask for

songs and playlists now, ask for songs and playlists when my workflow runs).

When you’re satisfied, click Choose.
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Figure 6-11:

removes
excuses for
missing a
birthday.
|
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When you've dragged all the actions into the workflow area, click the Run button
in the upper-right corner of the Automator window; each action is performed in a
natural order with the results of one task flowing into the next one. Thus, various
tasks must be performed in sequence and make sense working together. To open
Automator, open Finder, click Applications, and then double-click Automator.

A single action can constitute a workflow. To take a rudimentary example, you
can automate the process of removing empty playlists in iTunes by dragging
that action into the workflow space and clicking Run. A Workflow Execution
Completed message at the bottom-right corner of Automator signifies that the
job is finished. (For more on playlists and iTunes, read Chapter 14.)

Often multiple tasks make up a workflow. In the simple workflow shown in
Figure 6-11, the computer will search Address Book for people having a birth-
day this month, and send an e-mail greeting (with picture) to those folks. You
can save and reuse workflows by pressing & +Shift+S.

If you're not sure about the steps that make up a workflow, click the record
button at the upper-right corner of the screen to take advantage of a “Watch
me do it” feature.

X

.
m) |E
v

(-]

{22 Adé Antachiments to Entourage
Message

Automator |

K805 0L TEAEART ¢ AP A AN

T
i d

Third-party developers are creating workflow actions for their applications.
You can check some of these out at www.apple.com/downloads/macosx/
automator.

Automator is just one more reason to feel good about hanging around with
big cats.
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Chapter 7

Handling All That Busy Work

In This Chapter

Preparing your documents

Selecting text

Dragging, dropping, cutting, and pasting
Revealing fonts

Formatting documents

Saving your work

Making revisions

Taking out the trash

Understanding aliases

n professional football, the skill position players — quarterback, running

backs, and wide receivers — get a disproportionate amount of the glory
when a team wins and assume most of the blame when they fall on their
collective fannies. But any halfway-competent field general will tell you that
those in the trenches typically determine the outcome.

Sure you want to draw up a razzamatazz game plan for your Mac. Probably
something involving stupendous graphics and spine-tingling special effects. A
high-tech flea-flicker, to keep it in the gridiron vernacular.

After all, you bought the computer with the intention of becoming the next
Mozart, Picasso, or at the very least Steve Jobs. (What, you expected Peyton or
Eli Manning?)

But for this one itty-bitty chapter, I am asking you to keep your expectations
in check. You have to make first downs before you make touchdowns. Forget
heaving Hail Mary’s down the field. You're better off grinding out yardage the
tough way.
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In coach-speak, the mission of the moment is to master the computing
equivalent of blocking and tackling: basic word processing and the other fun-
damentals required to get you through your daily routine.

Practice these now. You can pour the Gatorade on my head later.

Form and Function: The Essentials
of Word Processing

I'm old enough to recall life before word processors. (Hey it wasn’t that
long ago.)

I can’t possibly begin to fathom how we survived in the days before every
last one of us had access to word processors and computers on our
respective desks.

Pardon the interruption, but I'm not thrilled with the preceding sentence.
Kind of wordy and repetitious. Permit me to get right to the point.

[ can’t imagine how any of us got along without word processors.
Thanks, much more concise.

The purpose of this mini-editing exercise is to illustrate the splendor of word
processing. Had [ produced these sentences on a typewriter instead of a com-
puter, changing even a few words would hardly seem worth it. I would have
to use correction fluid to erase my previous comments and type over them.

If things got really messy, or | wanted to take my writing in a different direc-
tion, I'd end up yanking the sheet of paper from the typewriter in disgust and
begin pecking away anew on a blank page.

Word processing lets you substitute words at will, move entire blocks of text
around with panache, and display characters in various typefaces or using spe-
cific fonts. You won’t even take a productivity hit swapping typewriter ribbons
(or swapping out balls) in the middle of a project, though, as the next chapter
reveals, you will at some point have to replace the ink in your printer.

Before running out to buy Microsoft Word (or another industrial-strength and
expensive) word processing program for your Mac — and I'm not suggesting
you don’t — it’s my obligation to point out that Apple includes a respectable
word processor with OS X. The program is TextEdit, and it calls the Applications
folder home. TextEdit will be our classroom for much of this chapter.
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Creating a Document

WMBER
@"&
&

|
Figure 7-1:
In the
beginning
was a blank
page.
|

The first order of business using TextEdit (or pretty much any word proces-
sor) is to create a new document. There’s really not much to it. It’s about as
easy as opening the program itself. The moment you do so, a window with a
large blank area on which to type appears, as Figure 7-1 shows.

Untitled

Styles v)[=]/= = =[spacing v [Lists ¥ b+ do0

Have a look around the window. At top you see Untitled because no one at
Apple is presumptuous enough to come up with a name for your yet-to-be-
produced manuscript. We’ll get around to naming (and saving) your stuff
later. In my experience it helps to write first and add a title later, though, um,
scholars may disagree.

Notice the blinking vertical line at the upper-left edge of the screen, just
below the ruler. That line, called the insertion point, might as well be tapping
out Morse code for “start typing here.”

Indeed, friends, you have come to the most challenging point in the entire
word processing experience, and believe me it has nothing to do with tech-
nology. The burden is on you to produce clever, witty, and inventive prose,
lest all that blank space go to waste.

Okay, get it? At the blinking insertion point, type with abandon. Something
original like this:
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Figure 7-2:
Oops, |
made a

mistake.
|

It was a dark and stormy night
If you type like I do, you may have accidentally produced
It was a drk and stormy nihgt

Fortunately, your amiable word processor has your best interests at heart.
See the dotted red line below drk and nihgt in Figure 7-2? That’s TextEdit’s
not-so-subtle way of flagging a likely typo. (This presumes you've left the
default Check Spelling As You Type activated in TextEdit Preferences. Since
we're at the beginning of this exercise, that seems like a safe presumption.)

Untitled

Styles vIEEEE Spacing ) .Lists ™)
id 3 3 3
Iy : I : 12 : I3 : 12 i Is i Ig

itwas a drk and stormy nihgl

Fed0

You can address these snafus in several ways. You can use the computer’s
Delete key to wipe out all the letters to the left of the insertion point. (Delete
functions like the backspace key on the Smith Corona you put out to pasture
years ago.) After the misspelled word has been quietly sent to Siberia, you can
type over the space more carefully. All traces of your sloppiness disappear.

Delete is a wonderfully handy key. I'd recommend using it to eliminate a
single word such as nihgt. But in our little case study, we have to repair drk
too. And using Delete to erase drk means sacrificing and and stormy as well.
Kind of overkill if you ask me.

Back to football. It’s time to call an audible. A few quick options:
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v Use the left-facing arrow key (found on the lower-right side of the key-
board) to move the insertion point to the spot just to the right of the
word you want to deep-six. No characters are eliminated when you
move the insertion point that way. Only when the insertion point is
where it ought to be do you again hire your reliable keyboard hit-man,
Delete.

v Eschew the keyboard and click with the mouse to reach this same spot
to the right of the misspelled word. Then press Delete.

v Of course you need not delete anything. You can merely place the
insertion point after the d and type an a.

<P Now try this helpful remedy. Right-click anywhere on the misspelled word. A
list appears with suggestions, as shown in Figure 7-3. Single-click the correct
word and, voila, it instantly replaces the mistake. Be careful in this example

not to choose dork.

G & : 0 O8 0 F o hulliii wandlag O

|
Figure 7-3:
I'm no dork.
| fixed it. - i ' -
o RSN e Eere N e e B T T

Selecting Text in a Document

Let’s try another experiment. Double-click a word. See what happens. It’s as
if you ran a light-blue marker across the word. You've highlighted, or selected,
this word so that it can be deleted, moved, or changed.



] 16 Partii: Mac paily Dealings

Many times, you’ll want to select more than a single word. Perhaps a com-
plete sentence. Or a paragraph. Or several paragraphs. Here’s how to high-
light a block of text to delete it:

1. Using the mouse, point to the block in question.

2. Press and hold down the left mouse button and drag the cursor
(which bears a slight resemblance to the Seattle Space Needle) across
the entire section you want to highlight.

The direction in which you drag the mouse affects what gets highlighted.
If you drag horizontally, a single line is selected. Dragging vertically
selects an entire block. You can highlight text also by holding down Shift
and using the arrow keys.

3. Release the mouse button when you reach the end of the passage you
want highlighted, as shown with Once upon a time in Figure 7-4.

4. To immediately wipe out the selected text, press Delete.

Alternatively, start typing. Your old material is exorcised upon your very
first keystroke and replaced with the new characters you type.

Untitled

Styles v [=[= = =[Spacing | v)[Lists v b e do0
S S S SN SR S SN SN SN S SN S .
i T YRR PSS PR PR R
[twas a dark and stary night. Once upon a time

|
Figure 7-4:
Highlighting
text.
|

o To jump to a specific line of text, choose Edit=>Find=>Select Line. Then enter

its line number. Or to jump ahead, say, five lines, add the + symbol as in +5. To
jump backward 5 lines, enter -5 instead.
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To select several pages of text at once, single-click at the beginning portion
of the material you want to select, and then scroll to the very bottom. While
holding down the Shift key, click again. Everything between clicks is high-
lighted.

<P Now suppose you were overzealous and selected too much text. Or maybe
you released the mouse a bit too soon so that not enough of the passage you
have in mind was highlighted. Just click once with your mouse to deselect the
selected area and try again.

Another screw-up. This time you annihilated text that upon further review
you want to keep. Fortunately, the Mac lets you perform a do-over. Choose
Edit=>Undo Typing. The text is miraculously revived. Variations of this
lifesaving Undo command can be found in most of the Mac programs you
encounter. So before losing sleep over some silly thing you did on the com-
puter, visit the Edit menu and check out your Undo options.

Dragging and Dropping

In Chapter 3 I discuss dragging and dropping to move icons to the dock. In this
chapter, we drag an entire block of text to a new location and leave it there.

Select a passage in one of the ways mentioned in the preceding section. Now,
anywhere on the highlighted area, click and hold down the mouse button.
Roll the mouse across a flat surface to drag the text to its new destination.
Release the mouse button to drop off the text. And if you hold down the
Option key, you can drag a copy, which allows you to duplicate a passage
without having to cut and paste (see next section).

You are not restricted to dragging and dropping text in the program you’re
in. You can lift text completely out of TextEdit and into Word, Stickies, or
Pages, an Apple program for producing spiffy looking newsletters and bro-
chures.

Alternatively, if you know you’ll want to use a text block in another program
at some point in the future — you just don’t know when — drop it directly
onto the Mac desktop (see Figure 7-5) and call upon it whenever necessary.
Text copied to the desktop will be shown as an icon and named from text in
the beginning of the selection you copied. Moving text in this manner to an
external program or the desktop constitutes a Copy command, not a Move
command, so the lifted text remains in the original source.
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|
Figure 7-5:
Dropping
text on the
desktop.
|
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Cutting and Pasting

WING/
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In the preceding section, we copied material from one location and moved
a copy to another location. By contrast, cutting and pasting lifts material
from one spot and moves it elsewhere without leaving anything behind. (In
the typewriter era, you literally cut out passages of paper with scissors and
pasted them onto new documents.)

After selecting your source material, choose Edit=>Cut (or the keyboard
alternative 38+X). To paste to a new location, navigate and click the spot and
choose Edit~>Paste (or 38+V).

The Cut command is easily confused with Copy (3+C). As the name suggests,
the latter copies selected text that can be pasted somewhere else. Cut clips
text out of its original spot.

The very last thing you copied or cut is temporarily sheltered on the clip-
board. It remains there until replaced by newer material you copy or cut.

If you can’t remember what you last placed on the clipboard, choose
Edit=>Show Clipboard when Finder (the leftmost dock icon) is activated.
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Changing the Font

When typewriters were in vogue, you were usually pretty much limited to
the typeface of the machine. Computers being computers, you can alter the
appearance of individual characters and complete words effortlessly. Let’s
start with something simple.

In the TextEdit window, click the pop-up menu Styles and choose Italic.
Highlighted text becomes text. Now try Bold. Highlighted text becomes text.

\J . . - .

) [ recommend using keyboard shortcuts in this instance. Just before typing a
word, try 88+l for italics or 8+B for bold. When you want to revert to normal
type, just press those respective keyboard combinations again.

Making words bold or italic is the tip of the proverbial iceberg. You can dress
up documents with different fonts, or typefaces.
Open the Format menu and choose Font=>Show Fonts. The window in Figure
7-6 appears. You can change the typeface of any highlighted text by clicking
a font listed in the pane labeled Family. Choices carry names such as Arial,
Baghdad, Chalkboard, Courier, Desdemona, Helvetica, Papyrus, Stencil, and
Times New Roman.
@ TextEdit File Edit Format Window Help = 4)) + Sun12:15PM edwardbaig
k. - W - v S
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Figure 7-7:
Previewing
your fonts.
|

Unless you wrote your graduate thesis on Fonfomology (don’t bother looking
up the word; it’s my invention), nobody on the For Dummies faculty expects
you to have a clue about what any of the aforementioned fonts look like. |
sure don’t. Cheating is okay. Peek at your document to see how highlighted
words in the text change after clicking different font choices.

As usual, another way to view different fonts is available. In the lower-left
corner of the Font window, click the icon that looks like a gear or cog. Choose
Show Preview from the menu (see Figure 7-7). You'll be able to inspect various
font families and typefaces in the preview pane that appears above your selec-
tion. Click the gear icon again to choose Hide Preview.

You can also preview the type size of your chosen font, as measured by a stan-
dard unit called points. In general, 1 inch has 72 points.

Previewing your font
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Revealing the Font Book

You likely have well over a hundred fonts on your computer, if not a lot
more. Some were supplied with TextEdit. Some arrived with other word pro-
cessing programs. You may have even gone on a font hunt and added more
yourself on the Internet. At the end of the day, you may need help managing
and organizing them.

That’s the purpose behind an OS X program called Font Book, found in the
Applications folder. It’s shown in Figure 7-8. Think of Font Book as a gallery to
show off all your finest fonts. Indeed, fonts here can be grouped in collections.

Boch _file _Edn_Firsww Wondes bl } [- WS F 0 OB - 0 F 4 14 Ceward By O
=Ty

- Se<FFROEFEFHNIND I
o/ YV XRXX 10T
| FHEXfeoleofocls <> Y0 Kk W
BRI X € 2o 2 & = 5 S 3
- QR EORtRRANE
100000 0DB®OQWLWY e

]

|
Figure 7-8:
The great

Font Book. |3 —
— Lo te0dlute 0baPPen - &

Disable selected fonts Drag to change size of selected font

Add fonts

Typefaces avaliable for selected font

Create a new collection

Two main font groupings are listed:

v User: The private fonts unique to your user account (Chapter 5).

v+ Computer: The public fonts available to anyone who uses this machine.
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In addition to the main font groupings, you'll find other font collections,
including Web, PDF, and Classic. The Classic collection assembles classic
fonts with names such as Baskerville, Copperplate, and Didot.

You can create your own font collections by choosing File=>New Collection
and typing a name for the collection. Then just drag fonts from the Font
column into your new collection.

By clicking a name in the Font column, you can sample what your font of
choice looks like in the pane on the right. Drag the slider (labeled in Figure 7-8)
to the right of that pane to adjust the type size of the fonts you're sampling.

If you happen to be in Finder, another nifty way to preview fonts is via Quick
Look. You'll see the entire uppercase and lowercase alphabet (plus numerals
0 through 9) in the font you've selected.

If you're like most mortals, you'll use a small set of fonts in your lifetime, even
some with funky names such as Ayuthaya or Zapf Dingbats (see the “All in the
fonts” sidebar).

You can disable the fonts you rarely or never use by clicking the little box
with the check mark under the Font list (labeled in Figure 7-8). The word Off
appears next to the font’s newly grayed-out name. If you change your mind,
choose Edit=>Enable font you disabled.

Don’t worry if you come across an application that requests a disabled font.
Leopard will open the font on your behalf and shut it down when you close
the program.

If you want to add fonts to the machine, click the + button under the same
column and browse to the font’s location on your computer. You can also
open new fonts you've downloaded or purchased with the Font Book applica-
tion by simply double-clicking them.

When a dot appears next to a name in the Font list, duplicates of that font
family are installed. To eliminate doubles, select the font in question and
choose Edit=>Resolve Duplicates.

Printing fonts

You can also preview a font family (or families) in the Font Book by print-
ing them. You can display these fonts in three ways, depending on which of
the three Report Type options you select from a pop-up menu. The menu
appears after you choose File>Print. (If it doesn’t, click the triangle next to
the Printer pop-up menu.)
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All in the fonts

Admit it, you're curious about the genealogy the keyboard shortcut 38+1) and the Font Book
behind the font named Zapf Dingbats. Me too.  window reveals all, including the full name of a
For that matter, you may be wondering about  font, the languages in which it is used, and any
the roots of other fonts on the system. Hey, it's  copyright and trademark information. Best | can
your computer; you have a right to know. Under  tell, Zapf Dingbats was not created by Archie
the Preview menu, select Show Font Info (oruse  Bunker.

v~ Catalog: A line of sample text (in uppercase and lowercase) is printed.
Drag the Sample Size slider to alter the size of the sample text.

v Repertoire: Prints a grid of all the font glyphs. This time you can drag a
Glyph Size slider.

v Waterfall: The Niagara Falls of font printing. An entire font alphabet is
printed in increasingly larger font sizes until there is no more room on
the printed page. You can choose the sample sizes of the text.

Formatting Vour Document

Fancy fonts aren’t the only way to doll up a document. You have important
decisions to make about proper margins, paragraph indentations, and text
tabs. And you must determine whether lines of text should be single or dou-
ble-spaced. Hey it’s still a lot easier than using a typewriter.

Okay, we’re back in our TextEdit classroom. Set your margins and tab stops
by dragging the tiny triangles along the ruler.

Now click the drop-down menu that says Spacing, just above the ruler. Clicking
Single separates the lines in the way you are reading them in this paragraph.

If I go with Double, the line jumps down to here, and the next line
jumps down to here.
Got it?

The control freaks among you (you know who you are) might want to click
Other under the Spacing menu. It displays the dialog box shown in Figure 7-9.
Now you can precisely determine the height of your line, the way the para-
graphs are spaced (that is, the distance from the bottom of a paragraph to the
top of the first line in the paragraph below), and other parameters, according
to the points system.
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|
Figure 7-9:
When it has
to look just
like this.
|

Line height multiple 1.0
Line height (=) At least
Inter-line spacing 0.0

Paragraph spacing
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before 0.0 points

GGy
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(cancel) ( ok )

Here are other tricks that make TextEdit a capable writing companion:

v~ Aligning paragraphs: After clicking anywhere in a paragraph, choose

Format=>Text and choose an alignment (left, center, justified, or right).
Play around with these choices to determine what looks best.

v Writing from right to left: | suppose this one’s useful for writing in

Hebrew or Arabic. Choose Format=Text=>Writing Direction and then
click Right to Left. Click again to go back the other way, or choose
Edit=>Undo Set Writing Direction.

v Locating text: You can use the Find command under the Edit menu to

uncover multiple occurrences of specific words and phrases and replace
them individually or collectively.

v Producing lists: Sometimes the best way to get your message across is in

list form. Kind of like what I'm doing here. By clicking the Lists drop-down
menu, you can present a list with bullets, numbers, roman numerals,
uppercase or lowercase letters, and more, as shown in Figure 7-10. Keep
clicking the choices until you find the one that makes the most sense.

v Creating tables: Then again, you may want to emphasize important

points using a table or chart. Choose Format>Text>Table. In the
window that appears (see Figure 7-11), you can select the number of
rows and columns you need for your table. You can select a color back-
ground for each cell by clicking the Cell Background drop-down list

and choosing Color Fill, and then choosing a hue from the palette that
appears when you click the rectangle to the right. You can drag the bor-
ders of a row or a column to alter its dimensions. You can also merge or
split table cells by selecting the appropriate cells and then clicking the
Merge Cells or Split Cells button.

v Smart Quotes: Publishers sometimes try to fancy up books by using

curly quotation marks rather than straight ones. Somehow curly is
smarter than straight. Whatever. To use smart quotes in the document
you are working on, choose TextEdit>Edit=>Substitutions =>Smart
Quotes. To use curly quotes in all docs, choose TextEdit Preferences,
click New Document, and select the Smart Quotes box. If you've already
selected smart quotes but want to revert to straight quotes inside some
document you are working on, press Ctrl and apostrophe (for a single
quotation mark) or Ctrl+Shift+apostrophe for a double quotation mark.
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Figure 7-10:
Formatting
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+* Smart Links: You can set it up so that anytime you type an Internet

address

(Chapter 9) in a document, it acts as a link or jumping point to

take you to that Web page. Choose TextEdit=>Substitutions=>Smart Links
to use a smart link in the document you are working on. Or visit TextEdit
Preferences, click New Document, and select the Smart Links box to
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Saving VYour Work

Figure 7-12:
Everyone
needs a file
saver.
|

You’ve worked so darn hard making your document read well and look nice
that I'd hate to see all your efforts go to waste. And yet in the cruel world of
computers that’s precisely what could happen if you don’t take a second to
save your file. And a second is all it takes to save a file — but you can lose
everything just as fast.

Stable as it is, the Mac is a machine for goodness sakes and not immune
to power failures or human foibles. Odd as it may seem, even tech authors
pound a calamitous combination of keys from time to time.

All the work you’ve done so far exists in an ethereal kind of way, as part of tem-
porary memory (see Chapter 2). Don’t let the fact that you can see something
on your computer monitor fool you. If you shut down your computer, or it
unexpectedly crashes (it’s been known to happen even on Macs), any unsaved
material will reside nowhere but in another type of memory. Your own.

So where exactly do you save your work? Why on the Save sheet of course
(see Figure 7-12). It slides into view from the top of your document when you
press the keyboard combo &+S or choose Filer>Save.

Save As:  Dark and Stormy

[« |»] FéB

M ' | (& Documents

¥ DEVICES ’]
E| Edward -
& iDisk
2 Untitled

Ed Firel.., & |

=} Macdinto...
[l Backup &

¥ PLACES

E Desktop

OGETHICSPaolicy4. 7CAD.doc 0104 CES USA Today Bil
4% oo T | OBETHICSPolicy AD.doc 0104 CES USA Today B

File Format: | Rich Text Format (RTF)

’zl Hide extension

New Folder

Cancel ) ( Save

A

Remember way back in the beginning of this chapter when I mentioned that
Apple wouldn’t dare name a file for you (except to give it the temporary moniker
Untitled). Well this is your big chance to call the file something special by filling
in a title where it says Save As. Go ahead and name it, | dunno, Dark and Stormy.

When you click the Save button, the contents of Dark and Stormy are
assigned to a permanent home on your Mac’s hard drive, at least until you're
ready to work on the document again.
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But there’s more. You get to choose in which folder to stash the file. The Mac
suggests the Documents folder, a logical choice. But you can choose among
several other possible destinations, as becomes clear when you click the
arrow next to where you just named your document. You can stuff your man-
uscript in any existing folder or subfolder in the sidebar or create one from
scratch by clicking the New Folder button and giving the folder a name.

Confession time: I've been holding back. When you christened your opus Dark
and Stormy little did you know that you were actually giving it a slightly longer
name: Dark and Stormy.rtf. The little suffix, or extension, stands for Rich Text
Format, one of the file format types the Mac makes nice with. You could have
saved the file in various Microsoft Word formats instead (such as the doc or
docx extension). Or you could have chosen HTML, the language of the World
Wide Web (see Chapter 9). If you want to see what extensions are tagged to
your various files, deselect the Hide Extension check box.

Leopard in all wisdom provides a safety net for saving. In other words, you can
now save TextEdit documents automatically. Choose TextEdit=>Preferences,
and click Open and Save. In the Autosave Modified Documents pop-up menu,
choose an appropriate time interval (every 15 seconds, 30 seconds, minute, 5
minutes, or never).

Unless you take this last step, you are hereby advised to save and save often
as you work on documents.

Making Revisions

Dark and Stormy is safe and sound on your hard drive. But after downing a
few chill pills overnight, you have a brand-new outlook on life in the morning.
You're past your brooding period. You want to rework your inspiration’s cen-
tral theme and give it a new name too, Bright and Sunny.

Back to TextEdit we go.

Choose Filem>Open. A dialog box appears. Scroll down in the folder where you
last saved your document, and double-click its name or icon when you find it.

You are now ready to apply your changes. Because your document is only as
permanent as the last time you saved it, remember to save it early and often,
as you make revisions. (It’s a good habit to get into even if you've turned on
the autosave preference: TextEdit is not the only program in which you’ll
want to save your work, of course.) Along the way, you can rename your
bestseller by using Save As and choosing a new name, though you’ll still have
the previous version under the old name.

You may be better off renaming a file by selecting it (from a Finder window or
the desktop) and pressing Enter. Type the new name and press Enter again.

127
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As always, your Mac tries to assist you in these matters. The computer makes
the assumption that if you worked on a document yesterday or the day before,
you might want to take another stab at it today. And to prevent you, Oh
Prolific One, from having to strain too hard digging for a document you may
want to edit, choose File>Open Recent. Your freshest files will turn up in the
list. Just click the name of the document you want to revisit.

Perhaps the fastest way to find a file you want to revise is to use the Spotlight
tool. Choose Spotlight by single-clicking its icon at the upper-right corner of
the screen and type the name of the manuscript that requires your attention.

Taking Out the Trash

|
Figure 7-13:
Think before
trashing.
|

Like much else in life, documents, if not entire folders, inevitably outlive their
usefulness. The material grows stale. It takes on a virtual stench. It claims
hard drive space you could put to good use elsewhere.

Yes it’s time to take out the trash.

Use the mouse to drag the document’s icon above the trash can in the dock.
Release the mouse button when the trash can turns black.

As usual, there’s a keyboard alternative, 8+Delete. Or you can choose
File>Move to Trash.

You’ll know you have stuff in the trash because the icon shows crumpled
paper. And just like your real life trash bin, you’ll want to completely empty it
from time to time, lest your neighbors complain.

To do so, choose Empty Trash under the Finder menu or press 88+Shift+
Delete. A warning will pop up (see Figure 7-13), reminding you that once
your trash is gone, it is gone. (Even then you may be able to get it back by
purchasing data recovery software or hiring an expert.)




<P If you're absolutely, positively certain that you want to get rid of the contents
of your trash — and paranoid about industrial spies recovering the docs —
choose Secure Empty Trash from the Finder menu instead of the regular
Empty Trash command.

Never Mind: Retrieving
What Vou've Tossed

It’s pretty easy to pull something out of the trash, provided you didn’t take
that last Draconian measure and select Empty Trash. It’s less smelly or embar-
rassing than sticking your hands in a real trash bin. Click the Trash icon in the
dock to peek at its contents. If you find something worth saving after all, drag
it back onto the desktop or into the folder where it used to reside.

Making an Alias

You can create an alias of a file to serve as a shortcut for finding it, no matter
where it’s buried on your Mac. To understand what an alias is, it helps to
understand what it’s not. It’s not a full duplicate of a file. (If you want to
create a full duplicate, press 8+D or choose Filec>Duplicate.)

Instead, you are effectively copying the file’s icon, not the file itself, meaning
you are barely using any disk space. Clicking an alias icon summons the origi-
nal file no matter where it’s hanging out on the computer — even if you've
renamed the file.

Why create an alias in the first place? Perhaps you're not sure where to place a
file that you could easily justify putting in any number of folders. For instance,
if you have a document titled Seven Dwarfs, it might belong in a folder for Snow
White, one for Bashful, one for Doc, and so on. Because the Mac lets you create
multiple aliases, you can effectively place the file in each of those folders (even
though you and I know it really resides in only one place).

To create an alias, highlight the original icon and press 38+L or choose
Filem>Make Alias. You can also drag an icon out of its file window or to another
location inside the window while you hold down the Option and 88 keys.

As you can see in Figure 7-14, the alias looks like a clone of the original icon,
except the alias suffix is added to its name and a tiny arrow appears in the
lower-left corner of the icon. Clicking either brings up the same file.

Chapter 7: Handling All That Busy Work ] 29
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Figure 7-14:
The original
icon and it's
alias.
|
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If you want to find the location of the original file, highlight the alias icon and
choose Filec>Show Original.

To get rid of an alias, drag it to the trash. Doing so does not delete the
original file.

If you had separately deleted the original file, the alias can’t bring it back. But
you can link the alias to a new file on the machine.
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Printing and Faxing

In This Chapter
Selecting a printer
Hooking up a printer
Printing
Troubleshooting
Using the Mac as a scanner
Using the Mac as a fax machine

‘ omputers are supposed to bring relief to pack rats. The idea that you

can store documents and files in their electronic state on your hard
drive — thus reducing physical clutter — has widespread appeal. A few trees
might breathe a sigh of relief too.

Yet for all the buzz over the years surrounding the potential for a paperless
society, [ don’t reckon pulp industry executives are losing much sleep.

Fact is, you want to pick up something tangible for your own edification and
convenience. And you want hard copies to show people. It’s better to hand
grandma printed pictures of the newborn rather than pull out a computer
(or other gizmo) to show off your latest bundle of joy. What’s more, even in
the age of e-mail and electronic filings, you still usually print documents and
reports for employers, teachers, financial institutions, and (sigh) the Internal
Revenue Service.

Which reminds me: Despite wonderful advances in state-of-the-art printers,
the counterfeiters among you will find no helpful hints in this chapter about
printing money.
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Choosing a Printer
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What are those state-of-the-art printers? So kind of you to ask. Today’s
printers generally fall into two main camps: inkjet or laser, with the differ-
ences coming down to how ink makes its way onto a page. (Yes, there are
other variations, especially for photo printing — dye sublimation or dye sub,
anyone?) Printers vary by speed, features, resolution (sharpness), quality of
the output, and price.

Popular models are produced by Canon, Epson, Hewlett-Packard, Kodak, and
Lexmark, but you can buy printers from a host of competitors.

Believe it or not, you can still find an el-cheapo, hand-me-down daisy-wheel or
dot-matrix printer on eBay and elsewhere (and some manufacturers still make
new ones too that work with modern Macs). But these so-called impact print-
ers are most definitely not the state-of-the-art I have in mind.

Inkjets

Inkjet printers consist of nozzles that squirt droplets of ink onto a blank
sheet of paper. Models may be equipped with a single black cartridge and a
single color cartridge. Or they may contain several color cartridges.

Where’s that magenta cartridge when I need it?

Most of you, I suspect, will end up with an inkjet printer. They are the least
expensive to buy, with some rock-bottom models costing as little as $19.

Bargains aren’t always what they seem, however. The cost of ownership of
inkjet printers can be exorbitant. You must replace pricey ($30 or so) ink car-
tridges on a routine basis, more often if you spit out lots of photographs of
your pet kitten Fluffy. So an inkjet printer’s cost-per-page tends to be consider-
ably higher than that of its laser cousins.

Having said that, inkjets are generally the most flexible bet for consumers,
especially if you demonstrate shutterbug tendencies. Besides standard size
8 %-by-11-inch paper, some inkjet models can produce fine looking, 4-by-6-
inch color snapshots on glossy photographic paper. (Photo paper, I'm obli-
gated to point out, is expensive.)

Granted, black text produced on an inkjet won’t look nearly as crisp as the
text produced by a laser, though it can be quite decent just the same. Under
certain conditions, some inks bleed or smudge. But for the most part, the
quality of inkjets is perfectly acceptable for producing, say, family newslet-
ters or brochures for your burgeoning catering business.
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Lasers

It’s somewhat remarkable that a focused laser beam can produce such excel-
lent quality graphics. Then again, if lasers can correct nearsightedness and
perform other medical miracles, perhaps printing isn’t such a major deal
after all.

Laser printers use a combination of heat, ink, and static electricity to pro-
duce superb images on paper. Such printers, especially color models, used to
fetch thousands of dollars. To be sure, you'll still find prices for some models
in the stratosphere. But entry-level color lasers are now around $150, and
monochrome models are less than $100.

However affordable they have become in recent years, lasers still command
a premium over inkjets. But they are far more economical over the long term.
Toner cartridges are relatively cheap and don’t need to be replaced very
often. A highly efficient laser might cost a couple of cents per page to oper-
ate, a small fraction of what an inkjet costs to run.

Lasers remain a staple in corporate offices. Businesses appreciate the pho-
tocopier-like output and the fact that lasers can handle high-volume printing
loads at blistering speeds. The machines typically offer more paper handling
options as well. On the other hand, they consumer far more electricity than
most inkjets, making them less “green.”

All-in-ones

Printers print, of course. But if your Mac is the centerpiece of a home office,
you probably have other chores in mind. Copying and scanning, for instance.
And faxing too. An all-in-one model, otherwise known as a multifunction
printer, can provide some combination of these tasks. Most multifunction
workhorses in home offices are inkjet based.

It’s cheaper to buy a single multifunction device than several standalone
devices. That lone machine takes up less space too. And many current all-in-

@\“‘NG ) ones are photo friendly.

If your fax, copier, or scanner goes on the fritz, you may also have to live with-
out a printer while the multifunction unit is under repair.

What else to think about

Other features to consider when shopping for a printer follow:
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1~ Large paper trays: Few things are more annoying than having to load a
fresh stack of paper in the middle of an important printing job. With a fat
paper tray, you won’t be hassled quite as often. And some models have
separate trays for photo paper, so you won'’t have to constantly shuffle
different types of paper in and out depending on what you’re printing.

* Memory slots: Maybe | shouldn’t mention this feature in a Mac book.
Because frankly, the purpose of memory slots is to take the Mac out of
the equation. Indeed, you can print images stored on a memory card
without getting a computer involved.

v LCD display: You use this for peeking at the pictures you want to print
(see preceding item) without the benefit of a computer. You can use the
display also for various menu functions on the machine.

1 Two-sided printing: This is useful (you guessed it) for printing on both
sides of a sheet of paper. It’s often called duplex printing.

v Slides: Some printers print off slides and negatives (sometimes with
optional adapters).

1 Networking capabilities: Share your printer among multiple Macs or
Windows PCs or both. Wireless network printers cost more. Networking
is a topic reserved for Chapter 18.

Connecting and Activating a Printer

\NG/
$

Almost all printers compatible with OS X, and that includes most printers
sold today, connect to your Mac through the Universal Serial Bus (USB) port
we became acquainted with in Chapter 2. So much for un-retiring the printer
in the closet that connects through what’s called a parallel port.

You'll almost certainly leave the store considerably poorer than you would
have first imagined even with a bargain printer. Gotta buy stacks of paper,
extra ink because the starter cartridges included with your printer may not
last very long, and very likely a USB cable.

The good news is not all printers require a cord. Some are compatible with
Wi-Fi or Bluetooth.

Ready, Set, Print

You have ink. You have paper. You have a USB cable. You are antsy. Time’s a
wasting. | sense impatience. Let’s jump to the task at hand.
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|
Figure 8-1:
Fit to print?
|

Plug the printer into an AC wall jack. Plug the USB cable into the USB port

on the Mac and make sure it’s connected snugly to the printer itself. Turn on
your printer. The thing is warmed and ready for action. Leopard big-heart-
edly assembled most of the software drivers required to communicate with
modern printers. Chances are yours is one of them. If not, it probably resides
on the software that came with the printer. Or visit the company’s Web site.

Configuring wireless or wired (through Ethernet) networked printers is a tad
more complicated. For now, we’ll assume you’ve connected a USB printer.
Open the Mac’s trusted word processor, TextEdit. Then follow these steps:

1. Open the document you want to print.
2. Choose File=>Print, or use the keyboard shortcut 8+P.

Even though we’re doing this exercise in TextEdit, you’ll find the Print
command under the File menu across your Mac software library. The
38 +P shortcut works across the board too. The print window shown in
Figure 8-1 appears. (If the print window that appears shows less than
you see here, click the downward pointing triangle at the upper right.)

Printer: [ HP Photosmart 3300 series 3 =)

Presets: | Standard H

Copies: 1 # Collated

Pages: (2) All
OFrom: 1 to: |1

Paper Size: [ US Letter %) 850 by 11.00 inches

Orientation: |Ii‘

| TextEdit o ——

[ Print header and footer

44 4] lofl L» )
(@ ( PoFv ) ( Supplies.. ) (Cancel ) ( Print )

3. Click the Printer pop-up menu and select your printer, if available.
4. If your connected USB printer is not in the print window:
a. Click Add Printer in the pop-up menu.
An add printer setup window opens.

b. If your printer appears in the list, click to select it (if it’s not
already selected). Click Add and you’re golden. Continue with
Step 5.
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c. If your printer isn’t listed, click the printer connection type
icon at the top and make the appropriate selection, as shown in
Figure 8-2.

Choices include Default, Fax (if choosing a fax machine), IP (an
Internet printer), AppleTalk (signifying a network), Bluetooth, and
More Printers. When you make your choice, the Mac will search for
any available printers.

d. Highlight the printer you want to use and then click Add.

You can alternatively click the Print Using pop-up menu and then
choose Select a Driver to Use to find a specific model, if available.

met [Tl . i PR
== 9 & g = = 2
Default Fax P Windows Bluetooth AppleTalk More Printers Search

Printer Name & Kind

Adobe POF 8.0 Adobe PDF 8.0{pdf)

HP Photosmart 3300 series USB

Name: HP Photosmart 3300 series

Location: Edward Baig's iMac

Print Using: | Select a driver to use... [
Q
3300 Series
350 Series q
4300 Series
5200 Series
|
5400 Series
Figure 8-2: 6200 Series
Adding a
printer. -
A

5. Choose from the bevy of options in the print window.

Select which pages to print. (All is the default, but you can give any
range by tabbing from one From box to the other.) Click where indicated
to select the paper size and print orientation, which you can examine in
a quick preview of the document you want to print. You get to select the
number of copies you need and whether you want pages collated. You
can decide whether to print a header and footer. And you can choose
whether to save your document in the Adobe PDF format (along with
other PDF options).
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Note that this print window or dialog box differs a bit from program to
program. In the Safari browser, for instance, you can to choose whether
or not to print backgrounds, an option that doesn’t appear in the
TextEdit dialog box.

6. When you're satisfied with your selections, click Print.

If all goes according to plan, your printer will oblige.

Even if the Mac instantly recognizes your printer, | recommend loading any
Mac installation discs that came with the printer.

Why bother? My printer is already printing stuff. The answer is that the disc
might supply you with extra fonts (see Chapter 7), as well as useful software
updates.

It wouldn’t hurt to also visit the printer manufacturer’s Web site to see
whether updated printer drivers are available.

Printing it your way

The Mac gives you a lot of control over how your printer will behave and
your printouts will look.

You may have noticed another pop-up menu in the print sheet just below
the orientation icons. TextEdit is now showing, but if you click the button, a
gaggle of other choices present themselves. (Some listed options are specific
to your printer or the application in use.)

v Layout: You can select the number of “pages” that will get printed on a
single sheet of paper, and determine the ways those pages will be laid
out, as shown in Figure 8-3. You can choose a page border (Single Thin
Line, Double Hairline, and so on). And you can turn two-sided printing
on or off, provided your printer can handle such a task.

v Scheduler: Suppose you have to print dozens of invitations for your
spouse’s surprise birthday party and want to make sure to do so when
your honey is out of the house. Set your Mac to print at a time when the
two of you are out together.

v+ Paper Handling: You can choose to print only odd- or even-numbered
pages or to print pages in reverse order. You can also scale a page so
that it fits a legal- or letter-sized sheet, an envelope, or a variety of other
paper sizes.

v Color Matching: Choose this setting to select ColorSync Profiles (from
Apple and others). Thus you can match the color on the screen to the
color you are printing.
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v Cover Page: Pretend you work for the CIA. Then print a cover sheet stat-
ing that everything else you're printing is classified, confidential, or top
secret? (Yea, like they’re not going to look.)

v Paper Type/Quality: Clues the printer in on the type of paper you
loaded (inkjet, transparency film, brochure, and so on). You also get to
choose the print quality. A fast draft uses less ink than printing in the
spiffiest, or best, quality. If your printer has more than one tray (for
example, a main tray and a photo tray), you can also choose the source
of the paper to use.

1 Borderless Printing: Tell your printer to print without borders. Or not.

Printer: | HP Photosmart 3300 series 2] fa)

Presets: | Standard

Copies: |1 ¥ Collated

Pages: (%) All
O From: |1 to: |1

Paper Size: [ US Letter %+ 8.50 by 11.00 inches

Orientation: |Il‘

T —

HJﬁ‘fHﬂ’E

PagesperSheet: (4 3]

S
44 4] lofl » > ]

| Border: | Single Thin Line
Figure 8'3: Two-Sided: | Off
. [ Reverse Page Orientation
Choosing a
print layout. (@ (POFv ) (Supplies... ) (Cancel ) (" Print )
|

This seems as good a time as any to see what other print options await you
in System Preferences, found per usual under the % menu. In the Hardware
section of System Preferences, click the Print & Fax icon. You can select the
Share This Printer box if you are willing to share the printer with other com-
puters in your house or office.

Now click the Print Queue button to check the status of any current printing
jobs, among other things.

Previewing your print

Before you waste ink and paper on an ill-advised print job, you probably want
to be sure your documents meet your lofty standards. That means the mar-
gins and spacing look jiffy and you have a clean layout with no widows. That’s
publishing-speak for a lonely word or two on a line of text all to itself.
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As you've already seen, the Mac lets you sneak a peek in the small window
that appears in the TextEdit (and other program’s) print dialog. For a larger
view in such programs as Microsoft Word, choose File>Print Preview.

If you're satisfied with the preview, go ahead and click Print. If not, go back
and apply the necessary changes to your documents.

One more nice thing about printing on your Mac: The various programs you
work in give you lots more custom printing options. For example, you can
print a CD jewel case insert in iTunes (Chapter 14) or a pocket address book in
Address Book.

When Printers Stop Printing

A\

As sure a thing as you’ll get in computing is that sooner or later (but prob-
ably sooner) your printer will let you down. I've already hinted at why.

Running out of ink or toner

Ink is perishable. Especially with an inkjet printer. The symptoms will be
obvious. The characters on a page get lighter and lighter each time you print,
to the point where they become barely legible. The software that came with
your printer may give you an estimate on how much ink you have left each
time you print. You can also check supply levels by clicking the Options &
Supplies button in the Print & Fax section of System Preferences, and then
clicking Supply Level. You can also click Supplies in the print dialog box.

Running out of paper

Unless you make a habit of peeking at your printer’s paper tray, you won’t
get a fair warning when your paper supply is exhausted. Of course, the rule
of thumb is that you will run out of paper the hour before an important term
paper is due (or legal brief or journalism deadline; feel free to insert your
own catastrophe).

Wherever you buy your ink and paper, | recommend having a spare set
around.

Sometimes a printer stops working for no apparent good reason. In the Print
Queue, try clicking Resume or Start Jobs. If all else fails, turn off and restart
your printer.
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Digital longevity?

Does the paper you buy make a difference?
Some experts believe it does. Scientists main-
tain that the ink and paper combination you
use to print digital photographs has a major
effect on how the images will endure through
the decades. Wilhelm Imaging Research has
conducted accelerated aging tests that have
indicated that, even on the same printer, prints

made on high-quality paper could last more
than seventy years when exposed to light, as
compared to just two or three years using infe-
rior paper. Regardless of the paper you use, you
can bolster the lifespan of printed photographs
by keeping them from light, humidity, and ciga-
rette smoke and other pollutants.

Hooking Up a Scanner

As with printers, connecting a scanner is no big deal. It usually hooks up
through USB, although FireWire models are in the marketplace as well. Or
you may gain a scanner as part of a multifunction, or all-in-one, device.

Scanners are kind of anti-printers because you already have a printed image

that you want to reproduce on your computer screen, such as receipts, news-
paper clippings, or photo slides and negatives. Standalone scanners may cost

less than $50, though you pay a lot more as you add features.

If you click Scanner in the Print Queue, you can tinker with the software pro-
vided by your scanner manufacturer. The software may let you remove dust
or scratches from an image and restore faded colors.

Your scanner can also team up with an onboard Apple program called Image
Capture, found in the Application folder. To do so, select Image Capture
Preferences in the Image Capture menu, select When Image Capture Is
Launched, Open Scanner Window. Then when you fire up the scanner, you
can choose the resolution, or sharpness, of scanned images. Image Capture

works with scanners that have OS X software drivers, as well as some TWAIN-

compatible models.

Turning the Mac into a Fax Machine

If your Mac has a built-in, dial-up fax modem, which is less and less likely,

you don’t need a dedicated fax machine. Just connect a telephone cord to the

Mac’s modem jack and you're all set. Unfortunately, the dial-up modem is no
longer standard on the latest Macs; it’s a $49 USB add-on.
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Sending a fax

If you have the Apple modem, you’ll appreciate the convenience of computer
faxing. You don’t have to print a document and go to the trouble of feeding
a dedicated fax machine. Instead, you dispatch faxes directly from any pro-
gram with printing capabilities. Follow these steps:

1. Open the document you want to fax.

2. Chose File>Print.

3. Click the PDF button and choose Fax PDF from the pop-up menu.

A sheet such as the one shown in Figure 84 appears.

Print

Printer: | © Bluetooth-PDA-Sync = L‘
Presets: | Standard 44
| Fax Information -

To: | [ 1212-555-1234 (&

Dialing Prefix: 9

Eﬂ Use Cover page

Subject: | As we discussed...

Message: |Check this out

( PRI | ( Y y
Ir_;\ ( PDF¥ ) [ Preview )} ([ Cancel i

4. In the To field, type the fax number of the person to whom you want
to send the fax, including 1 and the area code.

If necessary to access an outside line, add a dialing prefix such as 9 in
the box marked as such.

Alternatively, chose an entry from your Address Book by clicking the
shadowy silhouette icon to the right of the To field and then double-
clicking the card of the contact to whom you want to fax.

5. In the Modem box, select Internet Modem (or whatever) as the means
for dispatching your fax.

6. If you want a cover page, select the Use Cover Page option and type a
subject line and brief message.
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7. If you click the pop-up menu that says Fax Information, you can
choose other options to schedule the delivery of your fax or alter the
layout.

8. Use the preview window to review the fax before sending it.
9. Click the Fax button.

You should hear that awful, grinding faxing sound. It’s the best evidence
that your fax is on its merry way.

Receiving a fax

It makes sense that if a Mac can send a fax, it can receive one too. Make sure
you have an available phone line, and your computer is awake. A Mac in
sleep mode cannot receive a fax. Then follow these steps:

1. From System Preferences, choose Print & Fax and then click the Open
Fax Queue button.
2. If your fax number is not shown, enter it.

3. Click Receive Options and select the Receive Faxes on This Computer
option.

4. Designate the number of rings before the fax is answered.

Make sure the computer gets to pick up before an answering machine
connected to the same phone line.

5. Choose how you want the incoming fax to be treated:

e Save the fax as a PDF in the Shared Faxes folder that Apple sug-
gests, or save it to another folder

¢ Send the fax to a specific e-mail address

e Automatically print the fax

You can accept an incoming fax even if you haven’t bothered to set up the
system to receive faxes automatically. Go to System Preferences, choose
Print & Fax, and when your fax machine is highlighted in the list to the left of
the window, select the Show Fax Status in Menu Bar option. When the phone
rings, click the Fax Status icon in the menu bar and choose Answer Now.
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In this part . . .

Do you sometimes feel like the last person on Earth to
figure out the Internet? The chapters here will direct
you online and help you survive after you get there. You
also find out why e-mail is so wonderful — and so horrific
at times. Then take a trip on a Time Machine, and give
some deep thought to the merits of MobileMe membership.




Chapter 9
Stairway to the Internet

In This Chapter

Deciding how to connect
Comparing features from ISPs
Browsing with Safari

Discovering a Web of online riches

R emember what life was like prior to the middle half of the 1990s? Before
this nebulous thing called the Internet changed only everything.

Way back in the Dark Ages people routinely set foot in record stores to buy
music. Students went to the library to do research. Folks paid bills with
checks and read newspapers on, gosh, paper. They even picked up the tele-
phone to gab with friends.

How passé.

Nowadays, such transactions and exchanges take place gazillions of times a
second on the Internet. Cyberspace has become the place to shop, meet your
soul mate, and conduct business. It is also a virtual playground for the kids.

You can fetch, or download, computer software, movies, and all kinds of
other goodies. You may even get the stuff for free. Let your guard down, how-
ever, and you can also lose your shirt. (You really have to question how you
won the Sri Lankan lottery when you never bought a ticket.)

Nobody in the early days of the Internet could have envisioned such a future.
What eventually morphed into the Net was invented by the nerds of their
day, 1960s Defense Department scientists. They constructed — in the interest
of national security — the mother of all computer networks.

Hundreds of thousands of computers would be interconnected with hun-
dreds of thousands more. The friendly face of cyberspace — what became
the World Wide Web, or Web for short — was still decades away.
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Has this somehow passed you by? Forget about fretting if you haven’t boarded
the cybershuttle just yet. Getting up to speed on the Internet isn’t as daunting
as you might think. You can enjoy a perfectly rewarding online experience
through your Mac without ever deciphering the Net’s most puzzling terms,
everything from domain names to file transfer protocols. And you certainly
don’t have to stay up late cramming for any final exams.

But the Internet is not for people who cherish siestas either. It’s as addic-
tive as nicotine. Expect a warning from the surgeon general any day now:
Spending time online is hazardous to your sleep cycle.

Feeling brave? Want to take the online plunge anyhow? The rest of this chap-
ter will clue you in on how best to proceed.

Dialing In

Let the games begin. At home, you can find your way online in two main
ways, and both involve getting chummy with an important piece of computer
circuitry, the modem. 1 address dial-up modems here and broadband modems
in the next section.

Dial-up is the simplest and cheapest scheme. It’s nearly as brainless as
making a phone call. Wait a second; it is making a phone call. When the
modem works its magic, it dials the Internet over a regular phone line as if
you were calling your mother. The difference is that no one at the other end
will make you feel guilty for not visiting often enough. With any luck, you
won’t get a busy signal, either.

Dial-up used to merit a longer discussion, but such modems are yesterday’s
news. Apple hasn’t sold a Mac with an internal modem since the Intel switch-
over. If you do have a model with an internal modem, you only need to locate the
phone jack on the back or side of the computer. A little phone icon lets you know
you’ve arrived at the right place. If you haven’t embraced broadband yet, you
can buy an optional dial-up modem that connects to a USB port on the machine.
Either way, connect one end of a standard phone cord into the modem jack and
the other end into the wall jack where your telephone was connected.

Taking the Broadband Express

If the traditional dial-up modem is the local, broadband is the express. Who can
blame you for wanting to take the fast train? You’ll pay more for a ticket — prices
vary, but $30 a month is fairly typical. The positive spin is that you won’t need

a second phone line. Besides, the broadband express is almost always worth it.
After you've experienced a fast hookup, you'll have a difficult time giving it up.
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Speed kills

When geeks speak of modem speeds, they three Mississippi,” and so on before the Web
typically talk in terms of kilobits per second, or  page you clicked on even starts to show up.

Kbps, which is the equivalent of one thousand
bits per second. The itty bit, or binary digit, is
the tiniest unit of measurement for data. Dial-up
modems are typically rated at 56 Kbps (often
expressed as 56K). Reality check: Rarely are the
maximum speeds achieved, so a 56K modem is
probably transmitting data at 48K or so. If you
don't have a clean connection, you might creep
along at much slower speeds than that. You'll
be counting “one Mississippi, two Mississippi,

Now consider broadband modems. The ones
that truly rock might blaze along at over 10
megabits per second, or10 Mbps. The broad-
band to dial-up difference is like comparing
an Olympic sprinter to a weekend jogger. Web
pages can turn up thisfast, downloaded files
also show up in a jiffy, and videos appear much
more fluid, as if you were watching TV rather
than viewing the equivalent of a herky-jerky
slide show.

DSL, cable . . .

Broadband service comes in several flavors nowadays. Depending on where
you live, you may have a choice of all, some, or none of the various alterna-
tives. All broadband types have dedicated modems that reside outside the
computer. In many but not all cases, a technician will come to your house
(generally for a fee) and connect a broadband modem to the service you
have selected. The options are

1 Cable modem: Often the fastest of the broadband choices and the one
that may well make the most sense if you already subscribe to cable TV.
The reason is that your cable company is likely to cut you a small break
on the monthly fee (especially if you also opt for phone service through
them). The connection involves hooking up the cable TV cord to the
modem.

v DSL: As with dial-up, DSL, which stands for Digital Subscriber Line,
works over existing telephone lines. But a big difference compared to
dial-up is that you can prowl the Internet and make or receive phone
calls at the same time. And DSL, like a cable modem, is leagues faster
than a dial-up modem though usually slower than cable. As with cable,
deals can be had if you take on service from the same company supply-
ing your regular phone service.

v FIOS: In this speedy fiber-optic broadband network offered by Verizon,
hair-thin strands of glass fiber and laser-generated light pulses transmit
data. Verizon was expanding its FIOS network at the time of this writing,
but its availability remains somewhat limited.
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v Cellular broadband: Several emerging wireless technologies can speed-
ily access the Internet when you are out and about with a Mac laptop.
And they work through high-speed cellular networks. Zippy wireless
broadband inroads were made a few years ago by Verizon and Sprint
with a geeky sounding technology known as EV-DO (Evolution-Data
Optimized or Evolution-Data only depending who you ask). These are 3G,
or third-generation, wireless networks. If you have a MacBook Pro, you
can take advantage of EV-DO modems that plug in to the ExpressCard
slot. On other laptops or desktop models, you can go with a modem that
plugs in to USB. The technology is still fairly pricey as I write this, with
data plans typically in the $60-a-month range.

1~ Satellite: A satellite might be your only alternative to dial-up if you live
in the boondocks. You get the Internet signal the same way you receive
satellite TV, through a dish or antenna mounted on your house. If you
go the satellite route, make sure your modem can send, or upload, infor-
mation as well as receive, or download, it. Upload speeds are typically
much pokier than download speeds, and satellite service in general is
sluggish compared to other broadband choices. (Of course, uploading
and downloading are components of all modem types.) Satellite also
commands higher upfront costs than cable or DSL because you have to
shell out for the dish and other components.

Always on, always connected

In the dial-up world, you make your call, wait for a connection to be estab-
lished, grab what you are looking for on the Net, and say adios. Heaven forbid
you forget something. Each time you want to go back online, you have to
repeat this drill. Amounts to too many phone calls, too many hassles.

Broadband generally has fewer hang-ups. The experience is far more liberat-
ing because you have a persistent, always-on connection, at least as long as
the Mac itself is turned on. You won’t have to compete with your teenagers
for access to the only phone in the house. Web pages get updated. E-mails
and instant messages usually arrive in a blink. And you can share your
Internet connection with other computers in the house (see Chapter 19).

Let Me In

This whole Internet business has one more essential piece: deciding on the

outfit that will let you past the Net’s front gate. That company is called an Internet
Service Provider, ISP for short. You'll invariably have to slip this gatekeeper a

few bucks each month, though sometimes paying annually lowers the price of
admission. Many ISPs, such as AOL, Comcast, EarthLink, and MSN, are large,
well-known enterprises. But tiny unfamiliar companies may also serve the bill.
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As always, there are exceptions: You may not have to shop for an ISP if your
employer provides the Internet gratis. Students often get complimentary
access on college campuses, though the costs are likely buried in tuition.

If you signed up for broadband, chances are you’ve already met your ISP
because it’s the cable or phone company that set you up. But if you're play-
ing one company off against another, here are key points to consider:

v Service: An ISP’s reputation is the whole enchilada. Seek companies
that do a lot of handholding, from Getting Started pamphlets to toll-free
technical-support phone numbers. If they do provide toll-free support,
give the number a try before you sign up. Look elsewhere if it takes for-
ever for a live person to answer your call.

v Fees: Membership fees vary, and companies often run promotions.
Compare rate options if you live in a town with lots of dial-up and broad-
band choices. Choose a plan in which you are given unlimited access
for a generous chunk of hours. Metered pricing in which you are billed
hourly isn’t smart for anyone but the most disciplined user who seldom
expects to go online. Fortunately, such plans are rare.

v Local number: This is an important consideration for dial-up custom-
ers. If possible, choose a plan where you can dial the Net without incur-
ring long-distance charges. If you travel a lot, it’s also helpful to have a
choice of local numbers in the city or cities you most often frequent.

v~ E-mail: Just for being a customer, some ISPs give you one or more e-mail
accounts. More is obviously better if you intend on sharing the com-
puter with family members. Ask also whether the ISP provides tools for
cutting down on spam. [ have more to say on this topic in Chapter 10.

v~ Family protection: If you have kids, find out whether the ISP offers
parental controls or takes other steps to help protect the little ones in
cyberspace. Excellent parental controls are built in to Leopard.

Going on a Safari

It is virtually impossible to ignore the World Wide Web. Practically every-
one you come across is caught up in the Web in one way or another. On a
typical day, you might hear how “little Johnny built this amazing Web page

at school.” How your best friend researched symptoms on the Web before
heading to the doctor. And how you can save a bundle booking your vacation
online. Web addresses are plastered on billboards, business cards, and the
cover of books like this one.
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Just browsing

Technologists have an uncanny knack for making simple things hard. They
could ask you to make a phone call over the Internet. But if they told you
instead to make a VolP, or Voice over Internet Protocol, call, they’d pretend to
be really smart. So it is unbelievably refreshing to discover that to browse or
surf the World Wide Web, you need a piece of software that is called, um, a
Web browser. Okay, so they might have called it a Web surfer.

Because you had the good sense to purchase a Mac, you are blessed with one
of the best browsers in the business. It’s aptly named Safari because much of
what you do in cyberspace is an expedition into the wild. See Figure 9-1.

AutoFill form
Add bookmark | Reload current page
Open in Dashboard Change font size
Home page Print
Forward Report a bug to Apple
Bac|k Enter Web address here Enter Google| search here
l.u".' T ae P AR A o B e

l _Anale

More power. Thinly disguised.

iMac. Now up to 3.06GHz.

|
Figure 9-1:
The Safari
Web
browser.
|
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Learning to tame Safari means getting fluent with the concept of a Web
address, or what those aforementioned technologists dub a URL (Uniform
Resource Locator). 1 told you, these guys can’t seem to help themselves.

Just because of the way things are, Web addresses usually begin with www.
and end with a suffix, typically .com (pronounced “dotcom”), .edu, .gov, .net,
or .org. What you type in between is often an excellent indicator of where
you will end up on the Web. So typing www . usatoday . com takes you to the
nation’s largest newspaper. Typing www . espn . com leads to a popular sports
destination. And so on. You enter the URL into an address field at the top of
the browser window (labeled in Figure 9-1). As a Web page loads, a blue bar
fills the address field to let you know the page is coming.

Financial institutions and other companies sometimes begin a Web address
with https:// instead of http.//. This indicates that the site is more secure.

Clicking links

Web surfing would be awfully tedious if you had to type an address each time
you wanted to go from one site to another. Fortunately, the bright minds who
invented Safari and other browsers agree.

On the Safari toolbar you’ll typically see a series of buttons or icons to the
left of the address box where you entered the URL. The buttons you see and
the order in which they appear vary, depending on how you customize the
browser (refer to Figure 9-1 for a look at some of these buttons). To make the
toolbar disappear entirely, choose Viewr>Hide Toolbar. To make it reappear,
choose View=>Show Toolbar.

The left- and right-facing arrow buttons function as the back and forward but-
tons, respectively. So clicking the left arrow transports you back to the last
page you were looking at before the page that is currently displayed. Click
the right, or forward, button to advance to a page you have already looked at
but backed up from.

Click the toolbar icon that looks like a house, and you go to your starting
base, or home page. That’s the site that greets you each time you fire up the
browser for the first time. It’s no coincidence that Apple chose one of its

own Web pages as the default Safari starting point. That way, it can promote
the company and try to sell you stuff. As you might imagine, home pages are
valuable pieces of screen real estate to marketers. Everyone from AOL to
Google to Yahoo! would love for you to choose their portal as your start page.
Fortunately, changing Safari’s home page is simple. Select Preferences from
the Safari menu, click the General tab, and then type the Web address of your
page of choice in the field labeled Home page, shown in Figure 9-2.
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Open links from applications:

You'll notice that some text on various Web pages is underlined in blue (or
some other color). That means it’s a link. As you move the mouse over a link,
the pointer icon changes from an arrow to a pointing finger. Clicking a link
takes you to another page without having to type any other instructions.

Some links are genuinely useful. If you are reading about the New England
Patriots game, you may want to click a link that would lead to, say, quarter-
back Tom Brady’s career statistics. But be wary of other links that are merely
come-ons for advertisements.

Using bookmarks

Odds are you'll rapidly get hooked on a bevy of juicy Web pages that become
so irresistible you’'ll keep coming back for more. We won’t ask, so you need
not tell. Of course it’s downright silly to have to remember and type the
destination’s Web address each time you return. Create a bookmark instead.
The easiest way to add a bookmark is to click the + button in the toolbar.
Alternatively, choose the Add Bookmark item under Safari’s Bookmarks menu
or press the keyboard shortcut 8+D. A dialog box appears (see Figure 9-3),
asking you to type a name for the bookmark you have in mind and to choose
a place to keep it for handy reference later. Clicking the Show All Bookmarks
icon lets you manage all your bookmarks.



Chapter 9: Stairway to the Internet 753

Figure 9-3:
Where to
book your

bookmarks.

A\\S

Bookmarks bar

Bookmarks menu

e - I 0 B OB F e m il AN ldwadlag O

Add Bockmark Folder
. Bockmarks B (451)

9 Miteoaalt Dutiooh Web Access
|? Poysser Daline - Aomenesis

0 A Cholon Manmy - Nasnies S __em ind Rockland Coutins - N
I Micrenoft Echucation  Ten Tigs fir Disnating & Computer
9 TechSsup oy - DiscounTech

You can group bookmarks in menu folders called Collections, shown in
Figure 9-4. If you decide to bookmark the Internet Movie Database home
page, for example, you might decide to place it in a Collections folder called
Entertainment. Whenever you want to pay a return visit to the site, you open
the Entertainment folder and click the bookmark.

Despite your best organizational skills, your list of bookmarks and
Collections may become so, well, overbooked, that it becomes far less func-
tional. I practically guarantee that you will tire of at least some of the sites
now cluttering up your bookmarks closet. To delete a bookmark, highlight
its name, click the Edit menu at the top of the screen, and then choose Cut. If
you change your mind, choose Editz>Undo Delete Bookmark.

If all that seems like too much work, highlight an unwanted bookmark and
press the Delete button on your keyboard.

You’ll want to return to some sites so often they deserve VIP status. Reserve
a spot for them in Safari’s Bookmarks marquee, otherwise known as the
bookmarks bar, situated below the browser’s toolbar. Choose Bookmarks Bar
when the dialog box pops up, asking where to place the bookmark you’ve
just created.
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Employing the tools of the
trade on your Safari

Safari is capable of other neat tricks. [ describe some of them in this section.

Pop-up blocker

Tolerating Web advertising is the price we pay for all the rich Web resources
at your disposal. The problem is some ads induce agita. The most offensive
are pop-ups, those hiccupping nightmarish little windows that make you think
you woke up in the middle of the Las Vegas strip. Pop-ups have the audacity
to get between you and the Web page you are attempting to read. Turning on
the pop-up blocker can shield you from such pollutants. Click Block Pop-Up
Windows under the Safari menu or employ the keyboard shortcut & +Shift+K.
If a check mark appears, you have successfully completed your mission.
Once in a great while, a pop-up is worth viewing; to turn off the pop-up
blocker, simply repeat this exercise.

Find
Now suppose you want to find all mentions of a particular term or phrase in

the Web page you are looking at. Choose Edit=>Find menu or click 38+F. Type
the word you want to find, and Safari highlights all occurrences of the text.
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Apple’s not leaving anything to chance; the rest of the page is dimmed so you
can more easily make out those highlighted words. The number of matches
is also displayed, as are arrows that let you go to the next or previous occur-
rence of the word.

SnapBack

Sometimes you get carried away surfing, either while searching Google or
just browsing the Web. In other words you move from page to page to page
to page. Before you know it you're in Never Never Web land. You can cer-
tainly keep clicking the back button until you return to your starting point.
But by clicking the orange SnapBack icon that appears in the right side of the
address field and Google search box, you can return to square one without
those excess clicks.

To turn your current page to a SnapBack anchor point, choose History=>Mark
Page for SnapBack or press option+88+K.

Filling out forms

Safari can remember your name, address, passwords, and other information.
So when you start typing a few characters in a Web form or other field, the
browser can finish entering the text for you, provided it finds a match in its
database. From the Safari menu, choose Preferencest>AutoFill, and select the
items you want Safari to use (such as info from your Address Book card). If sev-
eral choices match the first several letters you type in a form, a menu appears.
Press the arrow keys to select the item you have in mind and then press Enter.

Tabbed browsing

Say you want to peek at several Web pages in a single browser window
instead of having to open separate windows for each “open” page. Welcome
to the high art of tabbed browsing. Visit Preferences in the Safari menu and
then click Tabs. The window shown in Figure 9-5 appears. Place check
marks next to each of the settings you want: 8-click Opens a Link in a New
Tab, Select Tabs and Windows as They Are Created, Confirm When Closing
Multiple Pages. Then close the Preferences window.

Tabs

1 [ @ E@7 g G

General Appearance Bookmarks Tabs RSS  AutoFill Security Advanced

'zl 88 -click opens a link in a new tab
’Z' Select tabs and windows as they are created
’zl Confirm when closing multiple pages

32 —click: Opens a link in a new tab and selects it.
88 -Shift-click: Opens a link in a new tab.
8 -Option-click: Opens a link in a new window and selects it.
32-Option-Shift-click: Opens a link in a new window behind the current one.

@

155
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Now each time you 3-click, you open a link in a new tab instead of a window.
To toggle from one open Web page to another, just click its tab. The tabs
appear just under the bookmarks bar.

To open a new tabbed window, choose FilecoNew Tab or press 38+T.

To rearrange the way tabs appear, just drag them in any order.

Benefiting from History

Say you failed to bookmark a site and now days later decide to return. Only
you can’t remember what the darn place was called or the convoluted

path that brought you there. Become a history major. Safari logs every

Web page you open and keeps the record for a week or so. So you can
consult the History menu to view a list of all the sites you visited on a par-
ticular day during the week. Choose History=>Show All History or choose
Bookmarks=>Show All Bookmarks and then click History under Collections to
view a more complete historical record. You can even search for a site you
visited by typing a keyword in the Bookmarks search field. In Figure 9-4, [
searched for all the sites I'd visited mentioning basketball.

If you're wigged out by this Internet trail, you can always click Clear History to
wipe the slate clean. Or choose the General tab under Safari Preferences and
indicate whether you want to remove all traces of History after one day, one
week, two weeks, one month, or one year — or to handle the job manually.

Private browsing

Hey maybe you do have something to hide. Perhaps you’re surfing in an
Internet cafe. Or just possibly you're being paranoid. Whatever. Turn on a
hush-hush Safari feature called private browsing by choosing that option on
the Safari menu. Now Safari won’t add the Web pages you've visited to the
History menu (though you can still use the Back and Forward buttons to
return to sites you’'ve been to). When private browsing is turned on, AutoFill
is turned off, searches are not added to the pop-up menu in the Google search
box, and Web cookie preferences are also deep-sixed.

Web clipping

Back in Chapter 6, [ introduced you to Dashboard widgets, those handy little
apps for looking up phone numbers or getting sports scores. Coming up in
Chapter 21, I list ten of my favorite widgets.

So why are we talking about widgets here? Because Safari lets you create
your own, by clipping out a section of a favorite Web page. The beauty is that
you are giving birth to a live widget that gets refreshed whenever the under-
lying Web page is updated. (You'll need Leopard to take advantage of this
trick.)



Chapter 9: Stairway to the Internet ’ 5 7

|
Figure 9-6:
Drag the
rectangle
over the
portion of
the Web
page that
you want to
clipintoa
widget.
|

\\3

In Safari, navigate to the Web page you want to transform into a Dashboard
widget, then click the Open in Dashboard button (labeled in Figure 9-1).

The screen dims, except for a resizable white rectangle that appears, as
shown in Figure 9-6. The rectangle automatically wraps around various por-
tions on the page that seem like a natural section you may want to clip. You
can reposition this rectangle so that another section gets highlighted. And if
Apple still doesn’t highlight the portions you have in mind, click inside the
rectangle to bring up handles that appear on its edges. Drag these with your
mouse until the rectangle is expanded on the complete section you want to
snip out for your widget.
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When you're satisfied, click Add. The Dashboard appears with your newly
created widget. You can apply cosmetic changes to the widget by clicking
the small i button in its lower-right corner. Upon doing so, the widget flips
around, and you’ll see a screen such as the one in Figure 9-7. Your first chore
(if you so choose) is to pick a new border or your widget by clicking one of
the small pictures representing a themed edge.

Click Edit. You now have the ability to change the size of the widget or to
drag its content to a new place.

Sometimes a widget plays sounds. If you want sound to play only when you’ve
summoned Dashboard, select the Only Play Audio in Dashboard box.
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Make a Web picture your desktop picture

Ever come across a stunning picture on the Web that you wish you could
make your own? Go right ahead. Right-click the picture in question and
choose Use Image as Desktop Picture from the menu that appears.

If you choose a low-resolution image, it will look lousy blown up as your desk-
top background.

Report a bug to Apple

Hey, even Apple screws up sometimes, as Chapter 20 points out. But if you
run into trouble while browsing in Safari, click the Report a Bug to Apple
toolbar button (labeled in Figure 9-1). In the box that appears, describe your
issue and problem type (crash, can’t log in, can’t load page, and so on). You
can even send a screen shot of the page that is giving you problems.

Using an Alternative Browser

Safari is swell, but it’s not the only game in town. Eventually, you’ll stumble
upon a Web site that doesn’t make nice with the Apple browser. That’s likely
because the site was programmed to work solely with the Grand Poobah
among browsers, Microsoft’s Internet Explorer. Hey, no one ever said life was
fair (see the “Putting up with Internet Explorer” sidebar).

Other fine browsers abound. I'm partial to Mozilla’s speedy Firefox, which
among many niceties preserves and restores your tabs and windows should
the browser unexpectedly shut down. You might also check iCab and Opera
at their respective Web sites. Google Chrome, another browser to watch, was
not available for the Mac at the time of this writing. That may change.



Chapter 9: Stairway to the Internet

Putting up with Internet Explorer

For years Microsoft adopted a kind of /aissez-
faire approach when it came to revving up its
famed Web browser. It generally left tabbed
browsing and other innovations to others. Such
is the complacency that sets in when you've
bagged a monopolistic share of the market. Still
the venerable browser comes in handy at times,
especially if Safari has difficulty communicating
with a particular Web page you're trying to view
(which, frankly, is less and less a problem). If
someone gives you an older enough Mac, you
may find Internet Explorer in the Applications
folder. But not only is IE not on newer

systems, Microsoft doesn’t even want you to
use its browser on a Mac. (The exception is if
you run Windows on your Mac, which I'll dis-
cuss in Chapter 19.) In the middle of 2003, word
out of Microsoft’'s Redmond, Washington, head-
quarters was that the company was halting all
development on IE for the Mac. Then a few
years later, Microsoft said it would no longer
offer tech support for the Mac version of IE and
indicated it also wouldn’t provide security or
performance updates. The message was prac-
tically deafening: Go book a Safari.

The Skinny on Search Engines

In Chapter 6 we focus on the wonders of searching your Mac through
Spotlight. But what about searching all these plum pickings on the Internet

while avoiding all that is rotten? An Internet search engine is the best place
to begin. These useful tools scan Web pages to find links based on instances

of the search terms you enter. Most folks start with Google.

Google this

Anyone who is anyone — and that might as well include you — uses Google.

Google has become so popular that it’s often treated as a verb, as in, I

googled something. It is also why Google’s founders have become richer than

Croesus.

Haven't the foggiest idea who Croesus was? Just Google the name, and you’ll

soon discover how this sixth-century Lydian monarch managed to amass a

fortune without launching an IPO.

The slowpoke way to Google something is to visit www.google.com. Type
your search query, Croesus in this example, and click the Google Search

button. Safari, however, provides a faster alternative. Just enter your query in

the Google text box inside the Safari address bar, as shown in Figure 9-8.
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Either way, Google will rapidly spit back a list of findings, or hits, containing
links to Web pages. That would be all there is to it, except you’'ll probably
have to help Google narrow things down a tad. The Croesus example yields
about 445,000 hits, more than you bargained for.

Enter an even broader search term such as rockets, and Google responds
with something in the order of 34 million hits. I don’t know about you, but I
have time to pore through only half of them. What’s more, smart as Google
is, it has no way of knowing whether you mean the flying machine that soars
into outer space, the basketball franchise that plays in Houston, or even the
hamburger chain Johnny Rockets.

The obvious takeaway: The more descriptive you are the better. Two or three
search terms almost always work better than one.

You can assist Google in several ways. Putting quotation marks around your
search term narrows the returns because the browser thinks you're searching
for that exact phrase. This works wonders with song or book titles.

Conversely, you can exclude topic areas by putting a minus sign next to the
word. For example, if you enter rockets -houston, you shouldn’t receive
references to the basketball team. If you want to find pages that include
either of two search queries, use an OR between the words. Rockets OR
Jets, for example, displays results for two professional sports franchises.
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But proving again how tricky the search biz can be, you would have to be
more explicit if the rockets and jets you have in mind require astronauts and
pilots.

Here’s a sampling of other nifty Google:

v Solve arithmetic: Enter a math problem, such as 63/7.8 =, and Google
supplies the answer (8.07692308).

v Provide the forecast: By adding weather next to a city name or postal
zip code, you can peek at the current temperature, wind, and humidity
and get a quick weather snapshot of the days ahead.

+” Do a reverse phone lookup: Type an area code and a phone number,
and Google will reveal whose number it is (if listed).

v+ Convert currency: Want to determine how many dollars there are to the
euro? Type, for example, 250 us dollars in euros.

MSN and Vahoo!

Google is the search engine of choice for your humble author, but other
alternatives are available. Yahoo! and MSN (from Microsoft) are probably
the best-known rivals, and both do a decent job. In fact, Yahoo! is kind of the
granddaddy of the search business. Moreover, when you go to the Yahoo! or
MSN site, at www . yahoo . com or www .msn . com, respectively, you’ll be taken
to their respective Web portals, where you can do a lot more than search.
Portals are launching pads for a gaggle of goodies, including news and enter-
tainment links, stock quotes, games, and e-mail.

The Davids to the search Goliaths

You may want to do a Google search on search engines because so many
smaller specialized ones pop up all the time. (I suppose the creators of these
sites want entrée into the same country clubs as the Google guys.) Search
companies may narrowly focus on news, health, videos, travel, local goings-
on, politics, or shopping. And some, such as Dogpile (www.dogpile.com),
merely aggregate or compile results from other leading search engines into
one.

You can jump ahead to Chapter 11 to explore more of what you can do on the
Internet with Safari (and other browsers). But first, why not join me for a tour
of e-mail on your Mac.
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Chapter 10
Going Postal Over E-Mail

In This Chapter

Setting up e-mail accounts

Composing messages

Receiving messages

Dealing with attachments

Handling junk mail

Getting tutored on Smart Mailboxes

Taking note of notes and to-dos

Eectronic mail is a blessing and a curse. Why you can’t live without
e-mail: Messages typically reach the person to whom they’re addressed
in a few seconds as compared with a few days for snail mail. (That’s the
pejorative label geeks have tattooed on regular postal mail.) You won’t waste
time licking envelopes either. Why e-mail drives you batty: It won’t take long
before you're likely buried under an avalanche of messages, much of it junk
mail, or spam.

Not that any mail system is perfect. You can only imagine the snide com-
ments heard in the day of the Pony Express: Love that I got my tax refund and
Lands’ End catalog, but the stench on that steed. . . .

If you're an e-mail tyro, you discover the basics in this chapter. But even

those who have been sending electronic missives for years might be able to
collect a useful nugget or two.

Understanding E-Mail

In broad terms, e-mail is the exchange of messages over a communications
network, typically the Internet but also a network within an organization.
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To use e-mail, you need an e-mail account. These are traditionally offered
by employers, schools, or Internet Service Providers (ISPs) such as AOL,
EarthLink, or MSN. You also need e-mail software to send, receive, and orga-
nize these messages. Fortunately, Apple includes such an application with
0OS X, and there can’t be any doubt about what the program does. It’s aptly
named Mail.

To access Mail, single-click the icon that looks like a stamp on the dock. If for
some reason the icon isn’t there, choose Mail inside the Applications folder.

By the way, don’t let the stamp representing the Mail icon fool you. E-mail
doesn’t require postage; for that matter, many e-mail accounts are free. Well,
like most things in life, e-mail is not really free. You pay for it

v As part of your ISP fees

v As part of your college tuition

v+ By having to read irritating online advertisements

v By the aggravation accompanying your boss’s e-mails

The Worldwide E-Mail Exchange

<MBER

A\

Before telling you how to set up e-mail accounts to work with the Mac’s Mail
program, know that you can continue to send and read mail inside such
applications as Microsoft Entourage (consider it Outlook for the Mac crowd).
What’s more, if you've been sending and receiving e-mail on other comput-
ers through Web accounts such as Google’s Gmail, Microsoft’s MSN Hotmail,
or Yahoo! Mail, you can continue right along on the Mac. AOL, the outfit that
popularized the phrase “You've Got Mail,” works too.

Having one or more Web-based e-mail accounts is nice. You get the tremen-
dous advantage of being able to access mail from any Internet browser (on
a Mac or a PC or Linux machine). Plus, popular Web e-mail accounts are free
and loaded with gobs of storage.

Setting Up a New E-Mail Account

Sending and reading e-mail through the Mac’s Mail program is a breeze, once
you set the thing up. And Mail setup has become simpler in Leopard. I've
listed several steps in this section, but if you're setting up such mainstream
accounts as AOL, Comcast, Gmail, Verizon, or Yahoo!, among others, you
need not go beyond the second step:
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1. Open Mail by clicking the Mail icon (it looks like a stamp) on the dock
or by double-clicking Mail in the Applications folder.

First-timers are greeted with a Welcome to Mail window, shown in Figure
10-1. If you're a member of Apple’s MobileMe service (Chapter 12), Mail
automatically sets up an account for you using information from the
MobileMe pane of System Preferences. If not proceed as follows.

Welcome to Mail

Welcome to Mail

You'll be guided through the necessary steps to set up
your mail account.

- f

To get started, fill out the following information:

W
I"..__ \ Full Name: ed baig
g .{0 '-:-é‘l Email Address:
\ @ Password:

‘ "] Automatically set up account

@ . Cancel Go Back ( Continue

2. If you are not a member of MobileMe and want to set up a mainstream
e-mail account automatically:

¢ If you have one of the popular e-mail accounts (such as AOL,
Comcast, Gmail, Verizon, or Yahoo!), merely enter your full name
(if not already there), current e-mail address, and password. When
Apple sees the e-mail address from one of the aforementioned
providers, an Automatically Set Up Account check box appears.
It’s already selected, so deselect it if you want to complete the task
manually and skip to Step 3. If you leave the check box selected,
Apple does the configuring on your behalf after you click Create.

e If you enter an e-mail address that is unfamiliar to Apple, an
Automatically Set Up Account check box will not appear. Enter
your password and click Continue, then go to Step 3.

3. Fill in the General Information required in the next screen.

You must fill in an Account Type (POP, IMAP, or Exchange) from the
menu), Description, User Name, Password, and Incoming Mail Server.
That last one is where your messages are retrieved; you’ll enter some-
thing along the lines of pop . yourprovider.com.

4. Click Continue.
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5. Now you must add information about your outgoing server, which
goes by the name of SMTP.

[ won’t keep you in the dark: SMTP stands for Simple Mail Transfer
Protocol. POP, by the way, is short for Post Office Protocol, and IMAP
stands for Internet Mail Access Protocol or Internet Message Access
Protocol.

6. Click Continue to bring up an Account Summary. If satisfied, click
Create to complete the Mail setup process.

At certain points during the preceding steps, the Mail program tests the
information you provide to make sure the settings are correct. If you run
into snags along the way, click the question mark button in the Mail dialog
for Help. Setting up additional mail accounts involves repeating these steps.
Begin by choosing Filec>Add Account in Mail.

If the IMAPs and SMTPs and the rest are not exactly at your fingertips (and
why should they be?), call your ISP or poke around the company’s Web site
for assistance. But again, you need not worry about such matters with most
mainstream e-mail accounts.

Before You Click Send

[ promise the difficult part is behind you (and was it really that difficult?) And
if you're already an e-mail whiz, you can skip the next few sections. If you're
still with me, you're going to find out how to send e-mail, with minimal atten-
tion paid to protocol. E-mail addresses always have the @ symbol somewhere
in their midst. They look something like this: paula@americanidol . com,
deputyfife@mayberrysheriff.gov, or costanza@nyyankees.com.

With the Mail program open, choose File> New Message, use the keyboard
alternative 3+N, or click New in the Mail toolbar. (Once again, if Mail isn’t
open, click the stamp icon on the dock.) A window like the one in Figure 10-2
appears.

Addressing your missive

With the New Message window on your screen, you're ready to begin the pro-
cess of communicating through e-mail with another human being.

In the To box, carefully type the recipient’s e-mail address. If you type even

a single letter, number, or symbol incorrectly, your message will not be
deliverable (you should get a bounce-back notification) or, worse, will be dis-
patched to the wrong person.
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As you start banging out an e-mail address, the Mac tries to be helpful. It

fills in the name and address of the person it thinks you are trying to reach
(culled from your Address Book). Don’t worry if the wrong name shows up at
first. Keep typing until either Apple guesses correctly or you have manually
entered the full address.

If you are sending mail to more than one recipient, separate the addresses
with a comma.

If you want to send mail to folks who are not the primary addressees of your
letter, type the addresses for these people (again separated by commas if
you have more than one) in the Cc., or carbon copy, box.
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There’s an even easier way to add an e-mail address, provided your recipi-
ent already resides in your Address Book. In the New Message window, click
the Address button. Then just double-click the name of the person from your
Address Book who you want to send mail to, and the Mail program takes
care of the rest. The real names of these Address Book people appear in the
To box (or cc box); you won'’t see their actual e-mail address. For example,
you’'d see the name Tony Soprano rather than boss@sopranos.com. Have
no fear; under the hood, Apple is making all the proper arrangements to send
your message to the rightful recipient.

You may want to keep the recipients’ list confidential. (The Feds need not
know where Tony’s mail goes.) There are a few ways to accomplish this:

»* You can send mail to a Group in your Address Book (Chapter 3) just by
typing the Group name in the To field. Mail then automatically routes
mail to each member’s e-mail address. To keep those addresses private,
choose Mail=>Preferences and select Composing. Make sure the When
Sending to a Group, Show All Member Addresses option is not checked.

v To keep the addresses of recipients who are not members of the same
group private, click the little drop-down arrow to the left of the Account
box in the New Message window. Choose Bcc Address Field. Bec stands
for blind carbon copy. Everyone included in the list will get the message,
but they won’t have a clue who else you sent it to.

Composing messages

Keep a few things in mind before pounding out a message. Although optional,
it’s good e-mail etiquette to type a title, or Subject, for your e-mail. (See the
“E-mail etiquette” sidebar.) In fact, some people get right to the point and
blurt out everything they have to say in the Subject line (for example, Lunch
is on at noon).

To write your message, just start typing in the large area provided below the
address, subject, and from (whichever e-mail account) lines. You can also
paste passages (or pictures) cut or copied from another program.

The standard formatting tools found with your word processor are on hand.
You can make words bold or ifalic and add spice to the letters through fancy
fonts. Click the Fonts button to display different typefaces. Click the Colors
button to alter the hues of your individual characters. Both the Fonts window
and the color wheel are shown in Figure 10-3.
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Choosing stationery

It’s nice that you just dressed up an outgoing message with fancy fonts and
different colors. But there’s dressing up e-mail and there’s dressing up e-mail.
And the Leopard crowd can apply just the right visual tonic to outgoing mes-
sages.

Apple added more than thirty spiffy stationery templates as part of Leopard,
covering most major occasions and organized by category. These include
birthday parties, baby announcements, and thank-you notes. Click the Show
Stationery button at the upper-right corner of the compose window (refer to
Figure 10-2) to check out the possibilities. Clicking one gives you a preview of
what your message will look like.

Although many stationery templates include lovely pictures, Apple doesn’t
expect you to use them in your mailings. These are merely premade drop
zones for adding your own pictures. Click the Photo Browser button at the
upper-right corner of the New Message window and drag a picture from
iPhoto, Aperture, or some other location into the picture placeholder on the
template. Double-clicking this new photo lets you pan and zoom the image,
letting you place the image just so.
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Of course you need not accept Apple’s wording in any of these templates
either. If you're wishing a Happy Birthday to Janie instead of Jessica, just
single-click the area with text and make the substitution. Your words stay
true to the design.

Find a stationery pattern you really like? Drag it into the Favorites area to
build up a custom collection.

Since Mail templates conform to HTML (the language of the Web), the people
receiving your e-mail will be able to view the stationery you intended. It
doesn’t matter if they’re on a PC or Mac. Mail also lets you use your own
custom designs as templates.

Saving drafts

You're almost there. But what if you're waiting to insert an updated sales
figure into a message? Or decide it wouldn’t be a bad idea to let off steam
before submitting your resignation (via the cold harsh world of e-mail, no
less)? Click the Save as Draft button and do whatever it takes to calm down.
When you’re ready to resume working on the message, demanding a raise
instead, choose Mailbox=>Go To and click Drafts. Or press 88+3.

Attaching files

You can attach a payload to your e-mail. Attachments are typically word pro-
cessing documents, but they can be any type of file: pictures, music, spread-
sheets, videos, and more.

To send a file with your e-mail, click the Attach button. In the window that
appears, select the file you have in mind from the appropriate folder on your
hard drive.

Given the market dominance of that other operating system, it’s a fair bet
you're sending attachments to a Windows user. Windows is particular about
the files it can read. It wants to see the file extension, such as .doc (see
Chapter 7). Because Apple wants to make nice with the rest of the computing
public, all you need to do is select the box that reads Send Windows Friendly
Attachments before sending an attachment to a PC pal.

Windows users may receive two attachments when you send mail

from a Mac. (And you coulda sworn you sent a single file.) One reads
TheNameoftheFileISent and the other . TheNameoftheFileISent.
Your recipients can safely ignore the latter.
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You should clue recipients in ahead of time when you’re planning on sending
them large files, particularly high-resolution images and video. And by all
means refer to the attachment in the message you send. Why?

v Many Windows viruses are spread through e-mail attachments. Although
you know the files are harmless, your Windows pals may be understand-
ably skittish about opening a file without a clear explanation of what
you'’re sending.

v Sending oversized attachments can slow down or even clog your
recipient’s e-mail inbox. It can take him or her forever to download these
files. Moreover, ISPs may impose restrictions on the amount of e-mail
storage that users can have in their inboxes or in the size of a file that
can be transported. The company you work for may enforce its own
limits. In fact some employers prevent staffers from sending messages
(or replying to yours) until they’ve freed up space in their inboxes.

To get past an ISP’s size restrictions, Mail gives you the option to resize
images. Click the tiny pop-up menu at the bottom-right corner of the New
Message window, which shows up along with the image you are sending. The
menu appears in Figure 10-4. Of course, if your largest files reside on an acces-
sible Web page, your best bet may be to send a link to folks you are allowing
to download those files.
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Spell checking

There’s a certain informality to e-mail. Rather than type a sentence that says,
“How are you?” you might instead type “How r u?” But not always.

Spelling counts (or ought to) when you are corresponding with potential
employers or, for that matter, the person currently responsible for your pay-
check. I know you won’t want to be reprimanded if you send e-mail with mis-
spellings to your seventh-grade English teacher.

Fortunately, Apple provides assistance to the spelling-challenged among us.
A spell checker is a basic feature, just don’t put all your faith in it. You may

have correctly spelled a word you inadvertently used (“through” instead of

“threw,” say).

To access the e-mail spell checker, choose Mail=>Preferences, and then click
Composing. In the Check Spelling pop-up menu, choose As I Type, When |
Click Send, or Never.

Assuming you ignored that last option, the Mail program will underline in red
what it thinks are misspelled words, just as TextEdit and other word proces-
sors do. Right-click the suspect word and click the properly spelled word
from the list of suggested replacements.

If your spell checker keeps tripping over a word that is in fact typed correctly
(your company name, for instance), you can add it to the spell checker dic-
tionary. Control-click the word and select Learn Spelling from the pop-up list.
Your Mac should never make the same mistake again.

Signing off with a signature

You can personalize Mail with a signature plastered at the bottom of every
outgoing message. Along with your name, a signature might include your
snail mail address, phone number, iChat account name, and a pithy slogan.

To add your e-mail John Hancock, choose Mail=>Preferences. Click the
Signatures tab, and then click the Add (+) button. You can accept or type
over the default signature that Apple suggests and choose whether to match
the font already used in the message. You can assign different signatures to
different e-mail accounts.
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E-mail etiquette

If Emily Post were alive today, she would surely
draw up a list of acceptable practices for han-
dling e-mails. In her absence, permit me to
school you on e-mail decorum. I've already
mentioned a few proper conventions: It helps
to add a title or subject line to your e-mail
and warn people if you're going to send large
attachments. In some instances, you'll also
want to use Bcc to protect the anonymity of the
other people receiving your messages.

Here are some other conventions. DON"T
SHOUT BY USING ALL CAPITAL LETTERS.
Typing in lowercase letters like these is much
more civilized. And you will avoid someone
SHOUTING BACK and deliberately insulting, or
flaming, you.

Do not forward e-mail chain letters. They will
not bring you or your comrades vast riches. Or
good luck. On the contrary, chain letters have
been proven to cause people to stick needles
in voodoo dolls representing the person who
passed on the chain letter.

If replying to an e-mail, include the original
thread by clicking reply rather than compos-
ing a new message from scratch. If the original
thread does not automatically show up (as is
the case with AOL mail), try this trick. Highlight
the pertinent passages (or all of) the incoming
message you want to respond to. When you
click Reply, the original text will be there. Tailor
your reply so the responses are above or below
the original queries.

Keep emoticons, such as : ) (a smiley face) and
text shortcuts, such as LOL (laugh out loud) and

IMHO (in my humble opinion), to a minimum. You
can use these more often when sending instant
messages, as | elaborate in the next chapter.

In general, keep messages short and sweet.
Some people get hundreds of e-mails a day. If
you want your message to be among those that
are read, don’t compose an e-mail that is the
text equivalent of a filibuster.

Take care to ensure that the message is going
to the right place. Nothing's worse than mis-
takenly sending a message that says “Jack is
a jerk” to Jack. For that matter, think long and
hard before sending the “Jack is a jerk” memo
to Jill. E-mails have a life of their own. They can
be intentionally or accidentally forwarded to
others. Maybe Jill is on Jack’s side. (They've
been spotted together fetching a pale of water,
you know.) Maybe she thinks you are the jerk.

Along this line, remember that e-mails lack the
verbal or visual cues of other forms of com-
munication. Maybe you were kidding all along
about Jack being a jerk. But will Jack know you
are merely pulling his chain? To make sure he
does know, this is one instance where it is per-
fectly acceptable to use a smiley.

In general, ask yourself how you’d feel receiv-
ing the same message. And don’t assume your
message will remain private. Think before send-
ing anything in an e-mail that you'd be reluctant
to say in public.

Ignore these suggestions at your own peril.
Somewhere Emily Post is watching.
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Managing the Flood of Incoming Mail

The flip side of sending e-mail is sifting through the mess of messages that
may come your way. You can spend hours trying to get through an e-mail
inbox, depending on your line of work.

The little red balloon on the Mail icon on the dock indicates the number of
unread messages demanding your attention.

New e-mails arrive as a matter of course through the Internet. You can click
the Get Mail button on the Mail toolbar to hasten the process, as shown in
our little tour of the Mail program in Figure 10-5. Tiny status circles next

to each of your e-mail accounts spin until the number of messages in that
account pops up.

Drag bar to adjust window size

. ' . I
Messages with a blue dot haven't been read Click column header to sort by that criteria
Number of unread | Drag divider to adjust Drag slider to scroll through
messages in the account column width messages in your inbox
nbox — Gmail (2570 rhessages, 250 unread)
@) GRS @8 [ @ OB 5,
Deletef  Reply Reply All Forward | New Message Get Mail Junk  Note ToDo
MAILBOXES ® ® [From — Subject Date Received v
v 7 Inbox A net Degen on Stag! Today 9:17 AM B
- iGoogle Alerts Coogle Alert - dward baig Yesterday 11:41 PM
= @ IGoogle Alerts Google Alert - pd baig Yesterday 8:24 PM
L o | d Baig fg 10-1 SO FA Yesterday 5:50 PM
L] Google Alerts Google Alert - pd baig Yesterday 5:28 PM
» | 1 Drafts @ Ed Baig Re: Steve and Bjll Yesterday 5:07PM |7
» &/ Sent Ed Baig Re: another shgt at the video. Yesterday 4:53 PM
o P N i i i) e By
lesdegen@optonline net
¥ REMINDERS Degen on Stage
» T Notes June 1, 2008 9:17:10 AM EDT
/ To Do To: lesdegen@optonline.net
P SMART MAILBOXES Hello Friends and Fans. Happy June 1st !
» RSS It's The Funniest Jewish Comedian Contest sponsored by The Jewish Week and produced/osted by the one
ol and only Geoff Kole (Hi Geoff, | know you are reading this)
L] >
Monday, June 23rd
- N Showtime TPM (seating at 6:30)
Flgure 10-5: Broadway Comedy Club
. 318 West 53rd St in NYC
The drill §15 cover (cash only) and 2 drink minimum
For Reservations, call 212-842-8680 or e-mail superlew100@yahoo.com
on readmg Always follow your dreams ... just remember to be awake while youe doing it!
e-mail. Les
I st Ll i i

\3
P If you click the Get Mail button and nothing happens, make sure your account

isn’t offline (the account name appears dimmed). To remedy the situation,
choose Mailbox and then choose Go Online.
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If that too fails to alleviate the problem, choose Window=>Connection Doctor.
It verifies that you're connected to the Internet and examines each e-mail
account to make sure it’s properly configured.

Single-click an incoming message to read it in the lower pane of the Mail
window. Or double-click the message to read it in its own window.

Choosing what to read

I'm no censor. I'd never tell you what you should or shouldn’t read — online
or off. So know that I have only your best interests at heart when I urge you
to maintain a healthy dose of skepticism when it comes to tackling your
inbox.

As you pore through said inbox, you’ll probably notice mail from companies,
online clubs, or Web sites you might have expressed an interest in at one
time or another. You might have subscribed to e-mail newsletters on sub-
jects ranging from ornithology to orthodontics. Most of the mail you get from
these outfits is presumably A-OK with you.

I'll take it as a given that you’re going to read all the e-mails you get from col-
leagues, friends, and family. Well, maybe over time you’ll come to ignore mail
from Uncle Harry and Aunt Martha, especially if they insist on sending you
lame joke lists. If your mother is now using e-mail to hassle you about how
you still aren’t married, you have permission to ignore those too.

That leaves e-mail from just about everyone else, and it likely falls into one of
three buckets. These categories fit most people’s definition of junk mail, or
spam:

v They’re trying to sell you something. It might be Viagra or Xanax. It
might be a (supposedly) cheap mortgage. It might be a small-cap growth
stock. It might be a Rolex. It probably means trouble.

1+ They’re trying to scam you. You have to ask yourself, why me? Of all
the deserving people on the planet, how is that you have been chosen
by a private international banking firm to collect a small fortune left by
arich eccentric? Or the secret funds hidden by a deposed Third World
diplomat? This too will probably get you in a pickle. (In Chapter 13, I dis-
cuss a special type of scam known as phishing.)

1 They’re sending you pornography. It’s out there. In a major way.
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Opening mail from strangers

What was it your parents taught you about not talking to strangers? That’s
generally sound advice with e-mail too. As [ hinted at in the preceding sec-
tion, cyberspace has a lot of misfits, creeps, and (I knew I'd have to throw

in this phrase somewhere in the book) bad apples. They’re up to no good.
Because I don’t want to cast aspersions on every unknown person who sends
you e-mail, go with your gut. Common sense applies.

You can learn a lot from the subject line. If it refers to someone you know or
what you do, I don’t see the harm in opening the message.

If the greeting is generic — Dear Wells Fargo Customer; Get Out of Debt Now —
I'd be a lot more cautious. Ditto if there’s no subject line or there are gross
misspellings.

If a sender turns out to be a decent business prospect or your new best friend,
you can always add him or her to your Address Book by choosing one of the
following alternatives:

v Choose Message>Add Sender to Address Book.

v Right-click a sender’s name or address in the From line of a message and
select Add to Address Book. (If you have a one-button mouse, the alter-
native is Ctrl-click.)

A few other handy shortcuts appear when you right-click a sender’s name.
You can Copy the person’s address, reply to the person, send him or her a
new message, create a Smart Mailbox (more later) or run an instant Spotlight
search on the person.

Junking the junk

If senders turn out to be bad news, you can sully their reputation. At least on
your own computer. Throw their mail into the junk pile. It’s easy: Just click
Junk on the message toolbar.

Marking messages happens to be your way of training the Mail program in
what you consider spam. Mail flags potentially objectionable messages by
highlighting them with a brown tinge. Click Not Junk in the message if the junk
label is inappropriate.

You can direct Apple on how to handle the junk. Choose Mail=>Preferences
and then click the Junk Mail tab. The screen shown in Figure 10-6 appears.
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Figure 10-6:
The junk
yard.
|
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Junk Mail
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General Accounts RSS  Junk Mail Fonts & Colors Viewing Composing Signatures Rules

¥ Enable junk mail filtering

When junk mail arrives:
(*) Mark as Jjunk mail, but leave it in my Inbox
() Move it to the Junk mailbex
() Perform custom actions (Click Advanced to configure)

The following types of messages are exempt from junk mail filtering:
'zl Sender of message is in my Address Book
’ZI Sender of message is in my Previous Recipients
&l Message is addressed using my full name

'?Trustjunk mail headers set by my Internet Service Provider

I Filter junk mail before applying my rules

( Reset... Advanced D)

By default, the Mail program leaves junk mail in your inbox so that you get to
be the final arbiter. If you want Leopard to segregate suspect mail in its own
mailbox, click the Move It to the Junk Mailbox option.

As a matter of course, Mail exempts certain messages from spam filtering. This
includes mail from senders who are in your Address Book, as well as senders
who already received mail from you. Messages that use your full name are
also exempt. In the Junk Mail section of Mail Preferences, remove the check
mark next to any Mail preferences you want to change.

Most reputable ISPs attempt to fight spam on their own. If you're satisfied
with the job they’re doing, leave the box Trust Junk Mail Headers Set by My
Internet Service Provider selected. Apple’s Mail program will leverage your
ISP’s best efforts.

Tips for avoiding spam

You can do your part to eliminate spam too. Spammers are resourceful and
can get your e-mail address through various methods:

v They employ automated software robots to guess at nearly every pos-
sible combination of addresses.

v They watch what you're doing. Do you fill out online sweepstakes forms?
There’s a winner, all right — the spammer.

v Do you hang out in chat rooms and Internet newsgroups? Bingo.

v Do you post messages in a public forum? Gotcha again.
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Figure 10-7:
You have

to establish
rules.
|

You can stop engaging in these online activities, of course, but then the
Internet won'’t be nearly as much fun. I have a better idea. Set up a separate
e-mail account to use in these out-in-the-open kinds of scenarios. (ISPs such
as AOL let you set up myriad accounts or screen names.) You'll still get
spam there. Just don’t bother using those accounts to send or receive e-mail.
Instead, treat your other account or accounts as the sacred ones you share
with family, friends, and colleagues.

Setting the rules

Potent as Apple is at filtering spam, you can set up your own filters, or rules,
for combating junk. You can set rules also to automatically reorganize the
messages on hand that are perfectly acceptable. When incoming mail meets
certain conditions such as the subject matter or who sent the mail, the Mail
program automatically forwards, highlights, or files them accordingly. For
instance, you might want to redirect all the messages you've received from
your investment advisor into a mailbox named stocktips.

To set up a rule, follow these steps:

1. Choose Mail=>Preferences, and then click the Rules tab.

2. Select Add Rules to open the pane shown in Figure 10-7.

Description: How to get rich

i [all % of the following conditions are met

From + | | Begins with s | whuffett

®

Perform the following actions:

Move Message 3 to mailbox: | [ stocktips 3]

( |) (l\
(#) (+)|

set Color %) [of background +! | []Green

( Cancel ) ( oK

3. Choose parameters identifying which messages are affected by the
rule.

To redirect e-mail from your financial guru, for example, choose From in
the first box, Begins With in the second box, and the name in the third.
Click + to add parameters and — to remove them.

4. Now choose parameters for what happens to those messages.

For example, highlight the messages in green and move them to the
stocktips mailbox.

5. When you’ve finished entering parameters, click OK.
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Figure 10-8:
The smart-
est mailbox
around.
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Smart Mailboxes

In Chapter 6, you discover dynamic Smart Folders. Welcome to the e-mail
variation, Smart Mailboxes. Just as Smart Folders are constantly on the prowl
for new items that Match specific search criteria, Smart Mailboxes do the
same. They are tightly integrated with Spotlight search.

You can set up Smart Mailboxes as a way to organize all mail pertaining to

a specific project or all mail from a specific person. For instance, you might
want to create a Smart Mailbox containing all correspondence with your boss
for the most current fortnight. Mail older than two weeks is replaced by the
latest exchanges.

Incidentally, the messages you see in a Smart Mailbox are virtual; they still
reside in their original locations. In that sense, they are similar to aliases,
described in Chapter 7.

To create a Smart Mailbox:

1. Choose Mailbox=>New Smart Mailbox.

The screen shown in Figure 10-8 appears.

Smart Mailbox Name: The boss
Contains messages which match _ all + | of the following conditions:
a) " " 'S | 2 £
From . Begins with + | headhoncho@mycompany.com - :/
p— Foam— —~
Date Received + ] [isin the last 32 Weeks ) Wl
- ra| S | £ 2
Subject . Contains = | Bonus - +
AN
“Include messages from Trash
_lInclude messages from Sent (_ Cancel ] (oK )

2. Use the pop-up menus and text fields to characterize the parameters of
the mailbox.

The process is similar to the one you follow when creating a rule. To add
criteria, click the + button. To remove a condition, click the — button.

3. When you’re finished, click OK.

You can create a duplicate of a Smart Mailbox in Leopard by holding down the
Ctrl key while you click the Smart Mailbox. Then choose Duplicate. Why do
this? One possibility: You want to create a new Smart Mailbox that uses only
slightly different criteria from the mailbox you are duplicating.
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Searching mail

With an assist from Spotlight, the Mac’s fast and comprehensive search
system, you can find specific e-mail messages, or the content of those mes-
sages, in a jiffy.

v To search an open message, choose Edit>Find and type the text you're
looking for.

» You can also enter a search term in the search box at the upper-right
portion of the Mail program screen. Use the All Mailboxes, Inbox, Entire
Message, From, To, or Subject headers (which appear only when you’ve
entered a search) to determine how to display the results.

You can find messages without opening Mail. Spotlight, in my humble opinion,
is the fastest and most efficient way to find wayward messages.

Opening attachments

You already know how to send attachments. But now the tide has shifted,
and someone sends you one (or more). Attachments may appear with an
icon in the body of the message or as a paperclip in the message header area.

You have a few choices:

v Drag the icon onto the desktop or a Finder window.

v Double-click the icon, and the attachment should open in the program
designed to handle it (for example, Word for a Word file or Preview for
an image).

v Click Save to save the file to a particular destination on your computer.

v Click Quick Look to peek at the attachment without opening it.

Normally, I tell people not to open attachments they weren’t expecting, even if
they know the sender. Mac users can be a little more relaxed about this than
their Windows cousins. While the times they are a-changin’, the odds that the
attachment will damage the Mac, even if it did carry some type of Windows
virus, are low.

If you want to remove an attachment from an incoming message, choose
Messager>Remove Attachments. As a reminder, the body of the message will
include a line telling you that the attachment in question has been “manually
removed.”
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Making the Most of Vour Mail

Before leaving this chapter, I want to introduce other ways to get the most
out of your e-mail:

1 View a photo slideshow: Picture attachments are afforded special treat-
ment. By clicking Quick Look, you can view attached images in a lovely
full-screen slideshow. From on-screen controls, you can go back to the
previous image, pause, advance to the next slide, and view an index of
all pictures. You can also click to add pictures to your iPhoto library
(see Chapter 15). When you're finished with the slide show, press the
Escape key on the keyboard to go back to the original e-mail.

v Pass it on: Sometimes you get stuff that is so rip-roaringly hysterical
(or at the other extreme, tragic and poignant) you want to share it with
everyone you know. To forward a message, click the Forward button
inside the e-mail and enter the recipient’s address in the New Message
window that pops up. The entire previous e-mail will go out intact, save
for a couple of subtle additions: the Fwd: prefix in the Subject line and
the phrase “Begin forwarded message” above the body of the message.
You can add an introductory comment along the lines of “This made me
laugh out loud.”

1 Flag messages: To call attention to messages you want to attend to later,
place a little flag next to it. Choose Message=>Mark=>As Flagged, or press
Shift+38+L.

v Synchronize e-mail: If you have a MobileMe account (Chapter 12), you
can synchronize all your rules, signatures, and other settings across all
your OS X computers.

v Archiving mailboxes: Mail that is too important to lose is worthy of
special backup treatment. That’s what archiving mailboxes is all about.
First select the box or boxes you want to archive. Next, either choose
Mailbox=>Archive Mailbox from the menu at the top of the screen, or
click the tiny gear-like icon at the bottom of the Mail window and choose
Archive Mailbox from the menu that pops up. Then choose the folder
in which to hold this digital treasure. Mail keeps archives in what it
calls an .mbox package. To retrieve archived mail, choose File> Import
MailboxestvMail for Mac OS X, and locate the .mbox file in question.

1 RSS subscriptions: You can receive RSS feeds and blog posts directly
in your inbox and be notified when something is hot off the presses (at
least figuratively). Choose Filec>Add RSS Feeds. (More on RSS in the next
chapter.)

v Use parental controls: You can restrict who junior can correspond with
through e-mail to only those addresses you've explicitly blessed. Choose
Q'E:>System Preferences, choose Accounts, and then click Mail & iChat.
You'll be notified when your kid gets (or tries to send) messages to
addresses not on your authorized list.
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Figure 10-9:
Acting on
the data in
your e-mail.
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v~ Data detectors: A friend sends an invitation to a dinner party at a new

restaurant. A travel agent e-mails the itinerary for your next business
trip. Messages typically arrive with fragments of information we’d love
to be able to act on. Mail in Leopard makes it dirt simple with data
detectors, which can recognize appointments, addresses, phone num-
bers, and the like. So when you move your cursor inside the body of a
message next to data the program can detect, a tiny arrow signifying

a pop-up menu appears, as shown in Figure 10-9. Click the arrow next
to an airline departure, for example, and you can add the event to iCal.
Click next to an address, and Mail lets you create a new contact, add to
an existing contact, or display a Google Map.

v Get rid of mail: You can dispose of mail in a number of ways. Highlight

a message and press Delete on the keyboard. Drag the message to the
Trash folder. Or click the Delete button on the toolbar. The messages
aren’t permanently banished until you choose Mailbox=>Erase Deleted
Messages. Apple can automatically extinguish mail for good after one
day, one week, or one month, or when you quit the Mail program. To set
this up, go to Mail Preferences, click Accounts, choose an account, and
select Mailbox Behaviors.
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Take Note (and To-Dos)

Figure 10-10:
This is
worth
noting.

|

Do you frequently e-mail reminders to yourself?  used to, at least until
Leopard added handy Notes and To-Do features inside Mail. Take a moment
to read about these now, so you won’t have to remind yourself to do so later.

Note-taking 101

If you're like me, your great thoughts are fleeting. That “ta-da” discovery rises
out of the ashes only to disappear just as fast. So I best jot down a note when
this brilliant idea is still floating about. Fortunately, creating notes inside Mail
doesn’t require much effort or any heavy thinking. Just click the Note button

inside the Mail viewer window or choose FilecoNew Note.

Then just scribble (um, type) your musings in the lined yellow notebook
window shown in Figure 10-10. By clicking the appropriate button, you can
change the colors and fonts of your note, attach it, or e-mail it. You don’t
even have to drum up a title for your note — Apple conveniently uses the
first line of your note as its subject.
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Figure 10-11:
To-do or not

to-do.
|

Notes are stashed in folders and (if you choose) Smart Mailboxes and readily
accessible through the Mail sidebar. And like all the other stuff on your Mac,
you can search them using Spotlight.

Much ado about to-dos

Creating a to-do is the same as creating a note except you click the To Do
button instead. In fact you can transform a note (or a portion of an e-mail
message) into a to-do by clicking the To Do button after highlighting the text
you want to track. As with notes, to-dos are stored with your Mail.

You have several options when creating a to-do — you can set a due date or
an alarm, or assign priorities (low, medium, high). And you can add items
to iCal. Such choices are revealed when you click the arrow to the left of the
to-do item or when you right-click (or Ctrl-click) an item in the to-do list, as
shown in Figure 10-11.
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Place a check mark in the little box next to a to-do when you’ve completed a
task on your list. As in, dare [ say, slogging through this chapter.




Chapter 11

Caught Up in the Web

In This Chapter

Joining chat rooms

Communicating through instant messages
Sharing video chats

Digging through newsgroups and blogs
Socializing through social networking
Finding a mate online

Shopping online

F)lks routinely surf the Web seeking specific types of information.
Headlines, stock quotes, vacation deals, weather, homework help, sports
scores, and technical support. But as much as anything, the Internet is about
meeting and connecting with people. These people could be job prospects

or would-be employers. Or people who share your zeal for the Chicago

Cubs, sushi, and Macintosh computers. Persuasion takes on a major role in
cyberspace, too — you’ll get on your virtual high horse and attempt to coax
others around to your way of thinking.

And, yes, finding companionship, romance, and (under the best of circum-
stances) long-lasting relationships is part of the cyber-experience too.

Critics have often sneered, “These people need to get a life.” But many
Netizens (citizens of the Internet) have rewarding lives online and offline,
thank you very much. And on the Net, they’re congregating in vibrant
communities with individuals of similar interests and passions.

We'll explore many of these avenues in this chapter.
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Chat Rooms
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Alot of congregating on the Net happens in chat rooms, areas where you can
converse in real time on pretty much any topic: quilting, cricket, fad diets,
parenting, biotechnology, extraterrestrial sightings, and on and on. The
conversing has typically been left up to your fingertips. Indeed, typos be
damned; expect to bang away at the keyboard with reckless abandon
because text exchanges in chat rooms come fast and furious. There may be
dozens of people in a room. Good luck determining who’s talking to whom.

As broadband hookups becoming increasingly common, audio and video
chats (through the use of a small cameras called webcams) are likewise
becoming more widespread.

Chat is also a staple in the online gaming environment, be it poker or back-
gammon. In an immersive three-dimensional virtual fantasy world, your per-
sona may be represented by an animated avatar. One such setting available to
Mac users is called Second Life (www.secondlife.com). Be aware that the
environment sometimes exceeds PG-13 sensibilities.

Some chat rooms are monitored by people who make sure that the discourse
is civil and courteous. In rare instances, monitors may dictate who can and
cannot speak, or they may boot somebody out.

The first exposure many people had to chat rooms was inside the virtual
confines of America Online. AOL established a set of community guidelines,
mostly having to do with banning hateful speech as well as threatening or
abusive behavior. The same general principles apply, of course, but AOL is
no longer behind a subscription-based walled garden. The subject categories
in chat rooms are quite varied. AOL’s primary rivals, Yahoo! and MSN, run
their own chat areas. All these chats are descendants of something called
IRC, or Internet Relay Chat.

I tell people visiting a chat group for the first time to say hi to everyone and
then take a backseat. Observe. Get a feel for the place. Figure out whether
participants are around the same age (or maturity level) as you. Determine
whether they’re addressing topics you care about — and speak the same
language. Participants in these joints come from all over the planet (and some-
times it seems from outer space).

Along those lines, don’t be surprised if it appears as though members of the
chat community are typing in tongues. You'll notice strange uses of punctua-
tion and abbreviations. Check out the “And you thought mastering Latin was
difficult?” sidebar for a crash course in emoticon linguistics.
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Becoming fluent in the lingo of chat rooms and
instant messaging is crucial if you want to fit
in or merely understand what's taking place.

Common Emoticons

:) = smile

;) = wink

:D = laughing
( =frown

(= crying
>:-} = a devil
0:-) = an angel
{}=hug

* =kiss

:P = sticking out tongue

And you thought mastering Latin was difficult?

However, remember to resist the overuse
of emoticons in your e-mails and real-world
correspondence.

Common Acronyms

BTW = By The Way

ROTF = Rolling On The Floor (Laughing)
LOL = Laugh Out Loud

IMHO = In My Humble Opinion
BRB = Be Right Back

TTEN = Ta-Ta For Now

GMTA = Great Minds Think Alike
F2F = Face to Face

FOAF = Friend Of a Friend

WB= Welcome Back

Communicating One-on-One:

Instant Messaging

You may be speaking (broadcasting really) to dozens of people at a time in a
chat room. But what if you strike a bond with the mysterious stranger whose
quips catch your fancy? And want to whisper sweet virtual nothings behind
this person’s ear and no one else’s? Such intimacy requires a private conver-
sation. It requires an instant message, or IM.

Instant messages need not originate in chat rooms, and for most people they
do not. Participants instead rely on dedicated instant messaging client soft-
ware that can be downloaded for free from AOL, Yahoo!, Microsoft, Skype,
and others.

Just as the company did with e-mail, AOL gets the lion’s share of the credit
for spreading IMing — yes, you can treat it as a verb — among the masses in
the United States. AOL owns the popular AOL Instant Messenger, or AIM, soft-
ware, as well as the exceedingly popular global IM program, ICQ. You can
fetch these free at www.aim.com and www. icq. com, respectively. In fact, as
we’ll see shortly, you need not even download AIM, because Apple’s own
iChat program lets you kibitz with the AIM community.

187
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Instant messaging has become a mainstay in business as well as in social cir-
cles. It’'s a complement to e-mail and in many ways more appealing. Here’s why:
Just as in a chat room, instant messaging conversations occur in real time,
without the delays associated with e-mail. In addition, IM permits the kind of
spontaneity that’s not possible through e-mail or even an old-fashioned

phone call. Through a concept known as presence, you can tell not only
whether the people you want to IM are currently online but also whether
they’re willing to chat. Status indicators next to their names on a buddy list
clue you in on their availability.

Instant messaging has at least one major downside compared to e-mail and
the plain old telephone: the lack of interoperability among the major IM pur-
veyors. The phone also has the advantage of conveying tone without you
having to remember to include appropriate emoticons. For competitive rea-
sons, market leader AOL carefully guards its buddy list, so an AIM member
can’t send a direct instant message to a Yahoo! or MSN user, at least not with-
out techie workarounds. Think about what would happen if a Verizon cell
phone customer, say, couldn’t call a friend who was an AT&T subscriber, and
vice versa. But peace is breaking out all the time, so this too may be solved by
the time you read this.

Just as regular chat has evolved well beyond a text-only communications
channel, so has instant messaging. Today’s IM programs let you engage in
audio exchanges and make free computer-to-computer Internet phone calls.
Moreover, if you have a webcam — and owners of most new Macs are
blessed with built-in iSight cameras — you can also hold face-to-face conver-
sations. And that leads us to Apple’s own ever-evolving instant messaging
application, iChat AV.

iChat AU

In truth, calling iChat AV an instant messaging program is selling it way short,
kind of like telling somebody that Michael Jordan knows how to make free
throws. The AV part stands for audio visual or audio video, depending on who
you ask. And iChat AV is often referred to as just plain iChat.

For sure, iChat is a competent instant messenger for handling traditional text
chatter. But consider some of iChat’s other tricks:

»* You can exchange files while talking with someone.

»* You can have a free audio conference with up to nine other people.

»* You can engage in a video conference from your Mac desktop with up to
three other people.

»* You can apply (in Leopard) funky Photo Booth video effects and
backdrops.
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v You can collaborate on presentations during the video conference and
even swap views and take over each other’s computer desktops.

You'll need at least one of the following to get going with iChat:

v An existing AIM or AOL screen name and password: As noted, iChat is
tied in with AOL’s popular instant messaging program.

v~ A Jabber ID: You can use a Jabber ID to exchange messages with
cohorts who share the same Jabber servers. Jabber is an open standard
chat system employed in many organizations. Through Jabber, you can
exchange instant messages with a Google Talk member. Although iChat
is still not directly compatible with screen names from the MSN or
Yahoo! instant messaging system, you may be able to do a technological
workaround through Jabber. Regardless of which you use, you can log
into all your chat accounts at the same time.

» A .mac or me.com account: You can use the me.com ID that you get by
being a MobileMe member for iChat. Or you can continue to use the
mac.com ID you may have had under MobileMe’s predecessor service
known as .Mac. I elaborate on MobileMe in Chapter 12.

1 A local network or classroom using Apple technology called Bonjour,
formerly known as Rendezvous: Through this built-in technology, iChat
lets you see who on your local network is available to chat. Bonjour,
however, is used for configuration-free networking throughout OS X.

If you want to exploit video, you’ll need a fast broadband Internet connec-
tion, plus a compatible camera. Apple’s iSight camera (standard on recent
models) works well, but any FireWire-based camera should do.

Hey buddy

iChat is useless without one more essential component: at least one other
person with whom to schmooze. If you signed up with an AIM account, your
buddy list may already be populated with names.

To add new people to the list, click the + button at the bottom of the Buddy
List window and choose Add Buddy, or press Shift+38+A. In the window that
appears, type your buddy’s AIM, MobileMe, or Mac.com account plus his or
her real first and last names in the designated fields. Or you can choose an
entry from your Address Book by clicking the downward-pointing arrow in
the bottom-right corner of the window. The person’s name turns up instantly
on your buddy list.

In the same windows, you can also lump your buddies into groups (coworkers,
soccer team, and so on). Or you can choose Viewr>Use Groups and click + to
add or edit a group.
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The buddy list has a bunch of visual status cues. Your buddy may have
included a mug shot, perhaps through Photo Booth. Or buddies may express
themselves through small images called buddy icons. You can even animate
these icons in Leopard. A telephone symbol tells you whether you can con-
nect through voice, and a movie camera icon indicates that you can connect
through video, as shown in Figure 11-1. Click those icons to initiate that kind
of chat.

baiged@mac.com
Edward Baig
o Available in a pinch but busy « ”ﬁ E
W Buddies
B i T . |
@ Jeff Graham (4] ‘.é_'
@ Ken Bereskin (] @1
Away e
P Family 0
P Co-Workers 0
I
W Recent Buddies
Figure 11-1: | ¥ offine
Visual cues
letyou
know how
to instantly
contact your
buddies. —
+ AlQ]m 5 P
I 2

Mostly you'll be able to tell whether your buddies are online at the moment
and willing to give you the time of day. Here’s how:

v A green circle to the left of a person’s name means he or she is ready
and (presumably) willing to talk.

v A red circle means the person is online but otherwise engaged. The
person is considered Away.

v A yellow circle means the person on your list is idle and has not used
the machine for awhile (the window tells you how long the person has
been in this state). Your buddy just hasn’t bothered to change his or her
status from Available to Away.

v~ If a name is dimmed, your buddy is offline.

QWP You can set your own status for everyone else to see. And you are not limited
to Available or Away. Click under your own name and choose Custom from
the drop-down menu. You can choose a custom message to appear next to a
green or red circle, depending on your circumstance. Type any message you
want, such as, can chat in a pinch but busy or back after lunch.
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Sharing a tune

You can tell your IM chums what music you are
listening to in iTunes. From the iChat drop-down
menu indicating your availability status, choose
Current iTunes Track. This serves a few pur-
poses, best | can tell. For one thing, your pals
will discover how hip you are (assuming they
don't know it already). What's more, you

become an influencer: If your friends click your
musical selection, they can preview the song in
the iTunes Store (Chapter 14). If your buddies
purchase ten or more of the songs you're listen-
ing to over a two-week period, Apple sends you
a computer. Okay, so | made the last part up.
But know this: Steve Jobs will really like you.

Incidentally, if you've been absent from the computer for awhile, the Mac will

kindly welcome you back to the machine and ask whether you want to
change your iChat online status from Away back to Available.

Chatting

To initiate an instant message, double-click a name in the buddy list, which
pops up whenever you open iChat. Type something in the bottom box. Hey

stranger will suffice for now.

Alternately, you can chose File>New Chat and enter the name of the person

with whom you would like to chat. You can do this even if the individual is
not in your buddy list or Address Book.

What you type instantly appears in a comic-strip bubble in the upper portion

of the window. (You can view chats as rectangular boxes instead.) If the
person responds, what he or she has to say appears in its own comic-strip

bubble. And so on.

You can type in your own smileys and emoticons or check out Apple’s own

collection by choosing Edit=>Insert Smiley. (I suspect I'll be using the smiley

representing “Foot in mouth” more often than not.) And if you need to use
currency symbols and other special characters, choose Edit=>Special

Characters.

Figure 11-2 shows yours truly having a silly conversation with yours truly.
(Honestly, [ don’t normally talk to myself. This little exercise is strictly for

your benefit.)

191
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W Now say you're having an important IM exchange with your lawyer or accoun-

tant. Or swapping tuna casserole recipes with your best friend. You may want a
record of your conversation that you can easily refer to later. To create a tran-
script of your session, open iChat Preferences by clicking the iChat menu and
then clicking Preferences. Click the Messages icon and then select the Automat-
ically Save Chat Transcripts option shown in Figure 11-3. iChats is the default,
but you can click the pop-up menu to save the transcript to a different folder.

Messages

1] 2210 & O

General Accounts Messages Alerts Audio/Video

vaveica 2 [
ﬁ " Helvetica 12

My balloon color: [ Purple &)
My font color: | 8 Black 4! ([ SetFont.. )
¥ Reformat incoming messages
Sender's balloon color: [ Random 3|
— Sender's font eolor: [ [ Black +) (SetFont..)
Figure 11-3:
Chatting the "1 Use keyboard shortcut to bring iChat to the front: "% F1 e
way you like ¥ Automatically save chat transcripts to: | [ iChats o)
it through "1 Collect chats into a single window
|Chat '2* Remember my open chats across launch
Preferences. 1 Watch for my name in incoming messages o)




Chapter 11: Caught Up in the Web 1 93

A\

A\\S

A\

To wipe away the record, choose Edit in the menu bar at the top of the screen
and choose Clear Transcript.

Take note of other things you can do inside iChat Preferences. For instance,
you can change the balloon color and font. And you might turn on a tabbed
chats feature by selecting the Collect Chats into a Single Window box. Now
you chat with multiple friends at the same time in a single convenient
window.

You can use iChat also to send files to your IM buddy (or get a file in return).
Not only is it convenient, but unlike with e-mail there’s no size restriction on
the file you're sharing. (You can send only one file at a time, however.) Select
a name on your buddy list and then choose Buddies=>Send File. Select the file
you want to send. Alternatively, drag a file to a buddy’s name or into the area
of an open chat window. Either way, your buddy has the option to accept or
reject the incoming file.

While we’re on the painful subject of rejection, if one of your buddies (or
anyone else) initiates an IM and you don’t feel like talking, click Decline in the
window that pops up.

If the person gets on your nerves, click Block to prevent the person from ever
sending you IMs again. (Just know that your would-be buddies can do the
same to you.)

You can proactively determine who can see that you're online and send you
messages. Under iChat Preferences, click the Accounts icon and then click
the Security tab. Choose a Privacy Level that you're comfortable with. The
options are

v~ Allow anyone.

v Allow people in my buddy list.

v Allow specific people. If you make this choice, you have to type each
person’s AIM or .Mac (or me.com) address.

v Block everyone.

v Block specific people. Again, type the appropriate addresses.
Inside iChat preferences, you can also automatically encrypt, or scramble,
text, audio, and video chats with fellow MobileMe subscribers who have also

selected this option. When in this secure chat mode, you’ll see a lock icon in
the upper-right corner of the iChat window.
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Seeing is believing; hearing too

As I already alluded to, IMing and text chatting in general are kind of yester-
day’s news (though still darn useful). The twenty-first-century way of commu-
nicating is through a video phone call. (Never mind that a primitive version
of this technology was exhibited at the 1964 New York World’s Fair.)

Assuming your camera and microphone are configured to your liking, click
the video camera icon in the buddy list or, for just an audio session, click the
telephone icon. As usual, your IM partner has the option to accept or decline
the invitation. If he or she accepts, you can gaze at each other full screen.
(Your image will appear in a smaller window.)

This stuff is super slick. In a multiroom conference, participants appear in a
virtual three-dimensional conference room with authentic video effects that
make people’s reflections bounce off a conference table.

And by clicking the Effects button, you can replace the normal iChat back-
ground with gorgeous, or bizarre, backdrops from Photo Booth, as high-
lighted in Chapter 5 and as seen in Figure 11-4. You need Leopard and a Mac
with a Core2Duo or better chip to apply one of these scenes, but pals using
older versions of iChat or AIM will see the backgrounds even if they haven’t
upgraded to the latest Mac operating system.

The quality is generally pretty good, though the picture may show some dis-
tortion, depending on your cable or DSL connection.

The video used in iChat (and QuickTime) adheres to a video standard known
as H.264, or Advanced Video Codec (AVC). It’s meant to deliver crisp video in
smaller file sizes, saving you bandwidth and storage.

If you have a webcam but your IM buddies do not, they still get the benefit of
seeing your smiling face at least. And provided they have a mike, you still get
to hear them.

You can record video chats and share them on your iPod. Choose Video=
Record Chat. Don’t worry: A chat can’t be recorded without your permission.
To stop recording a chat in progress, click Stop or close the chat window.

iChat Theater

You can share pictures from iPhoto, presentations from Keynote, and even
QuickTime movies by turning on a Leopard goodie called iChat Theater,
shown in Figure 11-5. You can take advantage of the feature in a few ways,
provided your broadband Internet connection is up to the task (384 Kbps
or faster):



Chapter 11: Caught Up in the Web
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v To share pictures from iPhoto, choose Filez>Share iPhoto with iChat
Theater and select the pictures you want to show off. You can even
present an album as a slide show, provided you have iPhoto "08
onboard.

v To share files that aren’t pictures in iPhoto, choose Filer>Share a File
with iChat Theater, and then select the files you want to share. If you've
already begun your video chat, you can merely drag the item into the
video window. You'll be asked whether you want to share the file
through iChat Theater or send it as a file transfer.

A\

If you're not sure whether one of your files can be presented in iChat Theater,
highlight the item in Finder and choose File=>Quick Look. If you have the ability
to peek at it, so will the person you want to show it to through iChat Theater.

195
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Screen sharing

It’s all well and good that you can make a long-distance presentation via
iChat. But suppose you and your buddy want to toil together on a Web site or
some other project from far away. If you both have Macs with Leopard, you
can work on one or the other’s screen — just click back and forth to swap
screens. This stunt works through any of the accounts that iChat makes nice
with: MobileMe, AIM, Jabber, or Google Talk.

From the Buddies menu, chose either Share My Screen or Ask to Share. Rest
assured you can politely decline if you're the one being asked. But positive
thoughts here, folks, so let us assume you’ve given the green light. You can
each freely run amok on the shared desktop, even copying files by dragging
them from one desktop to the other. iChat keeps an audio chat going so you
can let each other know what you’re up to.

Not satisfied with what your chat buddy is telling you? Press Ctrl+Escape to
put an instant kibosh on the screen sharing session.

If you're sharing the other person’s screen, you’ll notice your own Mac
desktop in a tiny window, as shown in Figure 11-6.

As you might imagine, this screen sharing business can get a little too close to
home, especially if you don’t fully trust the person you're letting loose on your
computer. Be especially leery if someone not on your buddy list comes calling
with a screen sharing request. You should also be careful before granting
permission to someone on your Bonjour list. They are not always who they
say they are.
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Having an Online Vvice

You can be heard and seen on the Internet in lots of places. In this section we
explore some of them.

Newsgroups

The term newsgroups may make you think of journalists retreating to the
nearest watering hole after deadline. (Been there, done that.) Or a posse of
friends sitting around together watching, [ dunno, Bob Schieffer. Newsgroups
are defined differently in the chapter you are so kindly reading.

Newsgroups go by numerous descriptors: electronic (or online) bulletin
boards, discussion groups, forums, and Usenet (a techie name that dates
back to Duke University in the late 1970s). Google acquired the Usenet
archives in 2001; through Google Groups, you can read more than one billion
Usenet postings dating back to 1981.

In a nutshell, people post and respond to messages on everything and any-
thing: pipe smoking, low-carb diets, monster movies, world-class tenors,
nanotechnology, canine incontinence, alternative sources of energy, snake
charmers ... Thousands of these discussions are taking place online.
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Newsgroups generally adhere to a hierarchical structure. At the top level,
you'll see comp for computers, rec for recreation, sci for sciences, soc for
socializing, talk for politics, news for Usenet, misc for miscellaneous, alt for
alternative, and so on. As you move down the food chain, the categories
become more specific. So you might start at alt, then drill down to alt.animals,
then alt animals.cats, then alt.animals.cats.siamese.

You'll need a newsgroup reader program to read these posts. If you bought
Microsoft Office for the Mac, it includes a newsreader in the Entourage e-mail
program. You can also download free or low-cost shareware newsreaders for the
Mac. They go by names such as Hogwash, MacSoup, MT-NewsWatcher, News
Hunter, and Unison. Keep in mind your ISP needs to support newsgroup access.

Blogs

Blogs, or weblogs, have become an Internet phenomenon. The blogging
search engine Technorati is tracking more than 112 million blogs and
counting. Thousands of new blogs pop up every day.

Although still in its relative infancy, the blogosphere has already been
exploited by politicians, educational institutions, marketers, publicists, and
traditional media outlets. And as you might imagine, you can also find Mac-
related blogs, such as www.cultofmac. com, www. tuaw.com (The Unofficial
Apple Weblog), and www . theappleblog. com.

Some bloggers may dream of becoming journalistic superstars overnight,
though few achieve such status. And many in the mainstream media fret that
bloggers lack editorial scrutiny and journalistic standards. But most blogs
are nothing more than personal journals meant to be read by a tight circle
of friends and family. Bloggers share their musings, provide links to other
content, and invite comments from others.

Destinations for creating and hosting a blog include Google’s free Blogger.
com service, WordPress, also free, and SixApart’s TypePad (starting around
$5 a month). You can subscribe to or read other blogs through technology
known as RSS. See the “What the heck is RSS?” sidebar for more information.
You can use the Mac’s iWeb program to publish a blog through the MobileMe
service ($99 a year through Apple but discounted to $70 through Amazon).
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What the heck is RSS?

Blogs and other news feeds are distributed
through a technology known as RSS, shorthand
for Really Simple Syndication. You can view
RSS feeds in the Safari browser (they're some-
times called XML feeds) and Mail, choosing
either as the default RSS reader. When you
subscribe to an RSS feed, you'll get a barebones
summary (and title) for articles listed, such as
the feed shown here from Apple. You can click
the Read More link to check out the full article.
If Safari finds a feed, RSS appears in the
address bar.

If you want to be notified when new feeds
arrive, go to Safari preferences (found in the
Safari menu), click RSS, and select how often to
check for RSS updates (every 30 minutes, every
hour, every day, or never). To peek at all RSS
feeds (from multiple sites) at one time — a great

way to customize your own newspaper, in
effect — place all your feeds in a single book-
mark folder. Then click the folder’'s name and
choose View All RSS Articles. The default book-
marks bar that comes with Safari includes fold-
ers full of RSS feeds.

You can even turn your RSS feeds into a cool
screensaver with flying news headlines that
charge at you like the credits in a Tinseltown
blockbuster. Choose ®=>System Preferences,
click Desktop & Screen Saver, and then click
the Screen Saver tab. Next, in the Screen
Savers list, click RSS Visualizer. Then click the
Options button and select a specific RSS feed.
If you want to read the underlying news story,
you'll be instructed to press the 1 key to read
one feed, 2 key to read another, and so on.

Social Networking

Who do you know? Who do your friends know? Who do the friends of your

friends know? Oh, and how can / benefit from six (or many fewer) degrees of

separation?

That’s pretty much what online social networks are all about. By leveraging

your direct and indirect contacts, you might find a place to live, broker the
deal of the century, or land a recording contract. That’s the hope anyway.
Hate to be a glass-is-half-empty kind of guy, but none of these outcomes is

guaranteed.

Still, social networking sites can help you network and help you be social.
They may combine blogs, instant messaging, photo and video sharing,
games, music, and a lot more. Facebook, MySpace, and — if you consider

199

video sharing to be social networking — YouTube have become cultural phe-
nomenons and are the most representative of the breed. But there are many
other popular examples, even if they don'’t fit the classic definition of social
networking, including Craig’s List (global communities with free classifieds),
LinkedIn (business-oriented), and Flickr (Yahoo!’s image sharing site).
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The Virtual Meet Market

As you might have surmised by now, Cupid spends a lot of time on the
Internet. You may even run into him in one of the aforementioned social net-
working sites. But if you're determined to find a mate in cyberspace at all
costs, the direct approach is probably best. Dating sites often let you peruse
online personals and fill out detailed online profiles for free. With some
variation in subscriptions and fees, they typically start charging only when
you're ready to get in touch with Mr. or Ms. Right.

Rest assured, there’s a dating site to fit your lifestyle. Online matchmakers
focus on particular communities, political beliefs, sexual preferences,
religions, hobbies, and even love of four-legged creatures (check out date
mypet .com). Leading examples include eHarmony.com, Match.com,
AmericanSingles, True, and Yahoo! Personals.

A few important disclaimers: [ take no responsibility for who you meet online
through these or other Web sites (unless it works and then you can invite me
to the wedding). And I can’t predict what kind of sparks will fly if a Windows
user pairs up with Mac loyalist.

Buying Stuff Online
Grandpa, what was it like when people shopped in stores?

[ doubt you’ll hear such a conversation anytime soon. But more and more
people are purchasing products online, and those products are not just
books, music, and software. Increasingly, folks go to the Net to shop for big-
ticket items: backyard swing sets for the kiddies, high-definition televisions,
even automobiles. Electronic commerce, or e-commerce, is alive and kicking,
with Amazon.com and the famed auction site eBay.com at the top of the
virtual heap.

Shopping over the Internet has many plusses. For example:

»* You avoid crowds and traffic.
»* You save on gas or commuting costs.

v You avoid pushy salespeople.
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» You can easily compare products and prices across numerous Web
sites, increasing the likelihood that you’ll end up with an excellent deal.
Visit such comparison shopping sites as www.mysimon.com, www.
pricegrabber.com, and www.shopzilla.com.

» You can choose from a large inventory of products (which is not to
suggest that stuff won’t be out of stock).

» You can get buying recommendations from your cyberpeers.

Shopping online has a few negatives too:

v You can’t “kick the tires” or otherwise inspect the items under

consideration.

v You won't get personal attention from a reliable salesperson.

»* You might get spammed.

v Without proper safeguards, your privacy could be at risk.

v Instant gratification becomes an oxymoron, except on such items as
downloadable software and music.

» You can’t make goo-goo eyes with attractive strangers you might meet

cruising the aisles.

A researcher’s toolbox

Imagine if you could take the Britannica or
World Book Encyclopedia and alter or update it
at will. You now have some idea of what
Wikipedia, found at www.wikipedia.org,
is all about. It's billed as a free encyclopedia
that anyone can edit. At the very least, entries
are more timely. The collaborative global per-
spective may provide insights lacking in other
reference material.

| know what you're thinking. There's a flip side
to all this. What if I'm mischievous? What if I'm
biased? What if I'm a misinformed know-it-all?
Why couldn’t | change the text to read that the
South won the Civil War or Dewey beat Truman?
Yes, it can and does happen, because the very
essence of a wiki allows for anyone with an

Internet connection to mess with any of the ref-
erences. In most instances, blatant vandalism
and dubious submissions are corrected by the
collective efforts of honest writers and editors
from around the world.

But open-sourced wiki entries are organic and
never quite finished, and mistakes are intro-
duced, overtly or subtly, consciously or other-
wise. One side of an argument might be
presented more eloquently than another. There
is almost always room for interpretation and
debate. So, Wikipedia is a remarkably useful
online resource, provided you recognize its
limitations and don't treat everything you come
across as gospel.
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Managing travel

It used to be that people bought airline tickets and booked hotels over the
Internet strictly for convenience. After all, booking online beats languishing
on hold waiting to talk to an airline customer service rep. And you can
choose seats and print boarding passes from the comfort of your own key-
board. (Okay, when things get complicated with connections or flying with
pets, you might still want to go through an airline staffer or a travel agent.)
Nowadays, carriers want you to go through the Web and take advantage

of e-tickets. In fact, you're typically penalized financially for requesting a
paper ticket.

Although you can find deals elsewhere, the big three online travel sites —
www . expedia.com, www.orbitz.com, and www. travelocity.com —

are worth a visit. Also check out the carrier’s own Web site and ask to get

on an e-mail list in which the airline notifies you of last-minute bargains.
Another good stop is www . tripadvisor.com to check out reviews of tourist
destinations written by people just like you.
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Joining MobileMe, the Club That
Will Have You for a Member

In This Chapter

Deciding whether to join
Setting up MobileMe

Getting to know iDisk
Backing up digital keepsakes
Turning to MobileMe Mail
Going Back to My Mac
Publishing your Web site

N inety-nine bucks a year. That’s the price for an individual to join
Apple’s MobileMe service. A MobileMe Family Pack subscription with
one primary account and up to four family member accounts fetches $149.

The set of Internet goodies you get for those princely sums includes tools to
keep multiple Macs (and Windows PCs and various mobile devices) in sync,
plus online storage and e-mail. Many MobileMe services are cleverly woven
into OS X and iLife. And MobileMe also includes spiffy-looking Web applica-
tions at me.com, notably ad-free Mail, Contacts, and Calendars, as well as
iDisk and Gallery.

If you really must know, MobileMe used to be called .Mac, which in turn used
to be called iTools. It used to be free too. Television was once free as well, of
course, but few argue paying for cable or satellite when you get a lot more
viewing choices. So it goes with MobileMe. The folks at Apple have piled on the
features these last few years, even as they now make you fork over extra coin.

Which raises the overall question: Is MobileMe worth the price of admission?
This is where I'd love to pause, run a couple of commercials, keep you hang-
ing for a few minutes. They do it all the time on TV. Oh, well, wrong medium.
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At the risk of copping out, the answer is, it depends. Apple lets you use lim-
ited versions of certain Mobile Me features risk-free for sixty days, so give it a
shot. If it doesn’t work out, well, as they say in basketball, no harm, no foul.

You have the opportunity to sign up for an account (or trial) when you first
turn on your Mac. No worries if you're already well past that point: Go to
System Preferences and click the MobileMe icon (found under Internet &

Network). Or visit www.apple.com/mobileme. You'll see the window shown
in Figure 12-1.

MobileMe

<[> || Showal Q

I ;' ] MobileMe stores your email, contacts, calendar, photos and files in an online "cloud,”

mobile

moe and keeps your Mac, PC, iPhone, or iPod touch up to date.

Figure 12-1:
Wlth Are you a MobileMe member? Try MobileMe for free.
. Sign into your account to set up MabileMe Sign up now and experience MobileMe for
MobileMe,

on this computer. 60 days at no charge.

you can try Member Name: :

before you Faseword:
buy Sign In (" Learn More.
|

Why Belong?

Apple is making MobileMe membership increasingly appealing through
Leopard. In general, the service gets a lot more interesting for you creative
types looking to share your inspirations — photos, movies, blogs, and more —
in cyberspace, and for road warriors who would like to access their computer
at home. Another plus: Many of you can take advantage of the extra online
storage that comes with membership, 20GB for an individual as of this writing.

Meanwhile, for a certain class of users — those with an iPhone or iPod Touch
as well as multiple Macs or Windows computers or both — so-called push
e-mail, push calendar, and push contacts provide the most compelling rea-
sons to sign up.

The core of MobileMe is cloud computing. Your information is stored in that
great big Internet server in the sky. As you make changes to your address
book on one device or computer, say, those changes are pushed more or less
instantly to all your other machines.

QNING/ Apple ran into initial snags with sync during the transition from .Mac to

Yy MobileMe in the summer of 2008, leading the company to apologize to custom-
ers. As part of its, um, MobileMeaculpa, Apple extended subscriptions gratis
by a couple of months. Even as this book was being published, Apple was still
not completely satisfied that it had eliminated all MobileMe kinks.
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Here’s a bird’s-eye view of certain key MobileMe features, some of which I'll
delve in to greater detail in this chapter or other chapters:

1 MobileMe Gallery: A stunning online showcase for pictures and movies
from iPhoto and iMovie, respectively. You can also publish albums
directly to the Gallery from Apple’s Aperture 2 photo-editing software.

1 Web publishing: A venue for hosting the Web site or blog you've
created through iWeb. You'll be issued a Web address as follows: web.
me.com/membername.

v Back to My Mac: Use it to remotely access and control your Leopard-
based Mac from another Mac running Leopard.

v~ iDisk: A centralized online storage facility you can use to exchange files
with others. You can access iDisk through the Finder.

+* Backup: A method of scheduling automatic backups for your Mac. More
useful if you're not exploiting Time Machine in Leopard, or you want to
access current copies of your specific directories from other computers.

v Mail: An ad-free IMAP e-mail account with built-in spam and virus
protections.

v Push e-mail, push contacts, push calendar: As mentioned, updates to
your e-mail, contacts, and calendar are pushed across all your devices
and computers. And MobileMe works with native OS X applications such
as Mail, Address Book, and iCal.

v iCal calendar publishing: Through MobileMe, you can publish an iCal
calendar. Other Mac users can subscribe to your calendar and view it in
iCal on their computers. They’ll receive an update as you make changes.
You can also synchronize to-do items between iCal and the MobileMe
Calendar at me.com.

1 More syncing: OS X users can also sync bookmarks, Dashboard widget
preferences, dock items, and System Preferences across the various
Macs they own.

Setting Up MobileMe on Your Mac

My assumption is that this is the first time you are setting up a Mac with a
MobileMe account. If you've already set up an iPhone or iPod Touch to work
with MobileMe on your Mac, you're ahead of the game. For the rest of you,
proceed to Step 1:

1. In System Preferences, select MobileMe.

There’s no need to panic if you see .Mac instead of MobileMe in System
Preferences. Just click .Mac and follow the on-screen instructions. You'll
end up in the right place.
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2. Click the Sync tab and then click Synchronize with MobileMe (which

may appear as Sync with MobileMe).

Apple recommends that you sync Automatically, but you can sync

. Choose a Sync Interval in the pop-up that appears.

hourly, daily, weekly, or manually instead.

4. Click the boxes to select the items you want to sync, such as Contacts,
Calendars, and Bookmarks.
Among your additional choices (as shown in Figure 12-2) are Dashboard
Widgets, Dock Items, Keychains, Mail Accounts, Mail Rules, Smart
Mailboxes, and Preferences.
MobileMe
«|» || showaAll Q
P MobileMe stores yaur email, contacts, calendar, photos and files in an online *cloud,”
0. and keeps your Mac, PC, iPhone, or iPod touch up to date.
[ Account  Sync  iDisk  Back to My Mac |
"] Synchronize with MobileMe: = Manually ync No»
@ Dashboard widgets
P Docktems
Keyct |
— '
l
Figure 12-2: [
Selecting '
items to
keep in Last Sync: 8/8/08 10:51 PM
SynC. '_f Show status in menu bar Advanced..
|

If all went according to plan, your Contacts and Calendars will turn up at
me.com. It’s not a bad idea to log on to make sure.

You'll need to be using the latest version of Tiger or Leopard on your com-

puter to have access to MobileMe from a Mac.

A\

Syncing in MobileMe is different than using iSync, OS X’s own synchronization
application that helps you manage contact and calendar info on connected
devices such as a wireless Bluetooth cell phone, a Palm handheld, or an iPod.
Use iSync to synchronize files if you have a version of OS X earlier than 10.4.
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iDisk Backups in the Sky

Who wouldn’t want personal storage in the clouds? Data copied to your
iDisk would be safe and preserved if anyone dropped a bowling ball on your
computer. This won’t be the only reference in this book to the importance of
backing up your digital treasures.

What’s more, as long as you have an online connection, you can access the
files in your iDisk locker wherever you happen to be, even from a Windows or
Linux machine. Plus you can easily collaborate or exchange documents with
others or access files remotely, especially those too large to e-mail.

[ already mentioned that your membership comes with 20GB (gigabytes) of
storage space. What I didn’t mention is that you can divvy that up as you
see fit between iDisk and your MobileMe e-mail account. You can boost the
storage amount 40GB or 60GB for an extra $49 or $99 a year, respectively.
Upgrade prices are prorated daily; your expiration date is unchanged.

Subscribers to MobileMe can access iDisk via the Finder by choosing
Go=iDiske>My iDisk (or by pressing Shift+3+I). You'll be asked to present
your member name and password.

Under that Go menu, you can connect to another user’s iDisk or Public folder
by choosing Other User’s iDisk or Other User’s Public Folder.

<P You can keep a copy of your iDisk on your desktop to access on your Mac,
even when you are not connected to the Internet. Any changes you make to
this iDisk copy are synchronized with iDisk in the clouds when you connect to
cyberspace. Click the iDisk tab in MobileMe preferences and click Start to turn
on iDisk Sync.

An iDisk actually consists of ten folders for storing your digital valuables.
Storing files inside these folders is as simple as dragging stuff to them, just as
with any Mac folder. Most of the folders including Documents, Movies, Music,
and Pictures, are self-explanatory.

At least one other folder is worth highlighting: the Public folder. And as the
name suggests, you can share the contents of this folder with anyone in
cyberspace who knows your MobileMe name and (if you created one) pass-
word. The folder is obviously useful for coworkers and other people who
regularly collaborate.

CMBER . . .
If you ever decide not to renew your MobileMe membership, remember to

drag any backup data or other data back onto your Mac’s own hard drive

before the account expires.
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Other Backup Methods

Regularly backing up your digital keepsakes (pictures, videos, financial docu-
ments, and so on) is vital. [ hope I've impressed that upon you by now. (If I
haven’t, what will it take?) Lecture over.

iDisk is a terrific vehicle for backing up bits and bytes, but it doesn’t afford
you enough storage if you have, say, a sizable multimedia collection. So
today’s backup arsenal typically consists of recordable CDs and DVDs, exter-
nal hard drives, and networks.

In Chapter 13 I discuss Time Machine, the coolest and arguably the most
beneficial new Leopard addition. If you haven’t sprung for the additional hard
drive needed to take advantage of Time Machine or you don’t have Leopard,
consider using Apple Backup, included with a MobileMe membership. You
can download Backup software (version 3.1.2 as of this writing) by selecting
the Backup icon on the MobileMe Web. Files you copy from the Mac’s hard
drive show up in the Backup folder of iDisk.

MobileMe Mail

I'd like to tell you that there’s something extra special about having a
MobileMe e-mail account. But it’s like any other Web-based e-mail account.
Okay, it has a cleaner interface than most online mail accounts, speedy mes-
sage addressing (through Contacts), and drag-and-drop simplicity. You can
click a quick reply icon to dash off a speedy response to a message in your
inbox, without leaving the inbox. And having a me.com sulffix is kind of nice
too, as in membername@me.com. You can create multiple e-mail folders and
preview messages in a single view. And of course, you can check MobileMe
mail from any browser. The program also integrates with the Mac’s own Mail
application. As I noted, the amount of storage you have is directly tied to the
amount of storage you use in iDisk.

Back to My Mac

Suppose you're using a Mac laptop from your hotel room to prepare a pre-
sentation and would like to retrieve a picture from the hard drive of your
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machine at home. As a MobileMe member, you can exploit Back to My Mac, a
feature that lets you remotely connect to your Leopard-based computer from
another Mac with Leopard.

Choose MobileMe under System Preferences and click the Back to My Mac
tab. Click the Start button shown in Figure 12-3. Repeat this procedure on

all the machines you want to access; they must share the same MobileMe
account. Plus if you have a router, you might have to open ports in your fire-
wall for Back to My Mac to work in all its remote computing glory.

MobileMe

<[> || Showal Q

s MobileMe stores your email, contacts, calendar, photos and files in an online "cloud,”
me and keeps your Mac, PC, iPhone, or iPod touch up to date.

| Account Sync  iDisk = Back to My Mac |

O Back to My Mac: Off

Using Back to My Mac you can access this computer, and services such as file sharing and
screen sharing, from your other computers that have Back to My Mac enabled.
( Start ) Click Start to turn on Back to My Mac on this computer. You need to turn on Back to My Mac

St e e o Tors vkl Wikt acee s

Use Sharing preferences to tur on sharing services, such as file sharing ~ ————————————
or screen sharing. [ Open Sharing Preferences

Then to locate the file you want to lift off the home computer, click that home
machine (under Shared) in Finder, and browse its hard drive for the file you
need. Drag the file to the desktop of the computer you are using for remote
access.

You can also share and control your home screen remotely by clicking Share
Screen in Finder, as is the case in Figure 12-4. (Before you leave on your trip,
remember to select the Screen Sharing option, found when you click Open
Sharing Preferences under MobileMe preferences.) Sure beats lugging a desk-
top computer on your travels.
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Figure 12-4:
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Sharing Your Digital Masterpieces

I've already touched on the MobileMe Web Gallery, which lets you share
pictures and movies. For instance, you can publish photos from iPhoto "08
and with your blessing let visitors download them. Inside iPhoto you’ll want
to assign login names and passwords to determine who gets access to which
MobileMe Gallery albums. (MobileMe syncs with your iPhoto library when
you are online.)

You can similarly apply passwords to determine who gets to watch and
download your iMovie movies inside the Gallery. More to come on iPhoto
and iMovie in Chapters 15 and 16, respectively.

Meanwhile, the iWeb software introduced with iLife '06 and refined in iWeb
’08 lets you build striking Web pages and create online journals, or blogs, by
laying your own content on top of placeholder text and images found on pre-
designed Apple templates. And the latest version of iWeb even lets you add
Google AdSense ads and Google Maps.

MobileMe assigns the web .me . com/membername URL for your iWeb site. If
you already have a personal domain in iWeb, choose Set Up Personal Domain
in the iWeb file menu and take it from there.
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43“ If you have already created an iWeb site under .Mac, the site will still be avail-

able at its current URL as well as at the new me.com URL. Similarly, your Web
Gallery will be available at its existing URL as well as at me.com.

When you are satisfied with your new creation, you can foist it on a waiting
public by publishing it through your MobileMe account. Click the iWeb icon
in the dock or open the program in the Applications folder. Then, in iWeb,
choose Filec>Publish to MobileMe to make your page visible to others. Or
choose Publish All to MobileMe to publish all the pages in your iWeb site.

As a MobileMe member, you can also add a photo slideshow viewer to your
Web pages and let visitors leave comments on your work or search through
blogs and podcasts.

<P Consider adding a password to lock out strangers from viewing your site. Do
you really want to share your thoughts with everyone? In iWeb'’s site orga-
nizer, select the site (or a specific page), click Inspector, and select the Make
My Published Site Private option. Then enter a user name and password that
visitors must enter to access your site.

Oh, and don’t use your MobileMe password for this purpose.
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Chapter 13
Mounting a Defense Strategy

In This Chapter
Coming to grips with Internet security
Spying on spyware
Going phishing

Firing up the firewall
Opening FileVault
Keying in on passwords
Securely logging out

Entering a time machine

OS X has been immune from the swarm of viruses that have plagued
Windows computers through the years. Folks traditionally have needed
to call a security specialist for their Macs about as often as you summon the
Maytag repair man.

But times change. Heck, Whirlpool bought Maytag. So when it comes to com-
puters nowadays, you can’t take anything for granted — even if you own a Mac.

The Truth about Internet Security

There are suggestions that OS X isn’t as bulletproof as was once believed.
Back in May 2006, the McAfee Avert Labs security threat research firm issued
a report claiming that the Mac is just as vulnerable to targeted malware, or
malicious software attacks, as other operating systems. Although the volume
of threats is low, no invisible cloak is protecting Apple’s products.

Moreover, the security firm expected malicious hackers to increasingly place
the Mac OS in the crosshairs given Apple’s recent (at the time) transition to
Intel chips and especially as Apple’s products gain popularity.
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The implication was that the bad guys hadn’t spent much time targeting
Apple because the Mac had such a miniscule market share. Although that
argument may have had some merit, the Mac has become more popular,
and the machines have been engineered with your protection in mind. So
your operating system is as secure as they come, even more so in Leopard.
But since Macs do now double (if you want) as Windows machines, you are
advised to take proper precautions.

What then are we to make of the McAfee report? Should Mac owners never
turn their computers on? Methinks not. But Mac loyalists shouldn’t get
complacent either, even though no major security breaches have hit the
headlines in the years since the report was issued. For starters, you should
install the security updates that show up on your Mac when you click System
Preferences under Software Updates. And you should load software on your
computer only from companies and Web sites you trust.

One other crucial point: Sensible security starts with you. And that means
backing up all your important digital jewels, a process now a whole lot sim-
pler with the arrival of a Leopard feature that would make H.G. Wells beam.

But before delving in to the OS X version of Time Machine, let’s examine a
very real threat that has more in common with Wells’ The War of the Worlds.

Spies in our mist

Viruses are menacing programs created for the sole purpose of wreaking
havoc on a computer or network. They spread when you download suspect
software, visit shady Web sites, or pass around infected discs.

Computer viruses take many forms. Windows users are all too familiar with
spyware, the type of code that surreptitiously shows up on your computer to
track your behavior and secretly report it to third parties.

Spyware typically differs from traditional computer viruses, which may try
to shut down your computer (or some of its programs). Authors of spyware
aren’t necessarily out to shut you down. Rather, they quietly attempt to mon-
itor your behavior so that they can benefit at your expense.

At the lesser extremes, your computer is served pop-up ads that companies
hope will eventually lead to a purchase. This type of spyware is known as
adware.

At its most severe, spyware can place your personal information in the hands
of a not-so-nice person. Under those circumstances, you could get totally
ripped off. Indeed, the most malicious of spyware programs, called keyloggers
or snoopware, can capture every keystroke you enter, whether you're holding
court in a public chat room or typing a password.
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The good news is that as of this writing, no major reports of OS X-related
spyware have surfaced.

But there’s always a first time.

Gone phishing
Dear Citibank Member,

As part of our security measures, we regularly screen activity in the Citibank
system. We recently contacted you after noticing an issue on your account. We
requested information from you for the following reasons:

We have reason to believe that your account was accessed by a third party.
Because protecting the security of your account is our primary concern, we have
limited access to sensitive Citibank account features. We understand that this
may be an inconvenience but please understand that this temporary limitation
is for your protection.

This is a third and final reminder to log in to Citibank as soon as possible.

Once you log in, you will be provided with steps to restore your account access.
We appreciate your understanding as we work to ensure account safety.

Sincerely,
Citibank Account Review Department

The text from the preceding e-mailed letter sounds legitimate enough. But the
only thing real about it is that this is an actual excerpt lifted from a common
Internet fraud known as a phishing attack.

Identity thieves, masquerading as Citibank, PayPal, or other financial or Internet
companies, try to dupe you into clicking phony links to verify personal or
account information. You're asked for home addresses, passwords, social secu-
rity numbers, credit cards numbers, banking account information, and so on.

To lend authenticity to these appeals, the spoof e-mails often are dressed up
with real company logos and addresses, plus a forged company name in the
From line (for example, From: support@ebay.com).

Phishing may take the form of falsified company newsletters. Or there may be
bogus requests for you to reconfirm personal data.

So how do you know when you're being hoodwinked? Obvious giveaways
included in some fake e-mails are misspellings, rotten grammar, and repeated
words or sentences.
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No company on the level is going to ask you to reconfirm data that’s been lost.
And reputable companies usually refer to you by your real first and last names
and business affiliations rather than Dear Member or Dear PayPal Customer.

If you have doubts that a communication is legit, open a new browser
window and type the real company name yourself (for example, www . ebay .
com or www . paypal .com.) Your gut instincts concerning phony mail are
probably on the mark.

Bottom line: Never click links embedded in suspicious e-mails. When you hover
the cursor over a link such as www.paypal . com, it actually leads elsewhere.

Firewalls

Figure 13-1:
Making

the
connections
or not.
|

More than likely, if you're connecting to the Internet through a network
router (see Chapter 18), you're protected by a shield known as a firewall. But
Leopard also has a software firewall, and you can use it to block unwanted
Web traffic.

Here’s how to access it:

1. Choose ®System Preferences.
2. In the Personal section, click Security.
3. Click the Firewall tab.

As Figure 13-1 shows, you can determine whether to permit all incoming
connections to come in, whether to limit those to essential services, or
whether to block specific programs.

Security
<> Show Al 'Q firewall

! General  FileVault  Firewall |

(*) Allow all incoming connections
() Allow only essential services
() Set access for specific services and applications

Mac 05 X normally determines which programs are allowed incoming connections. Select this
option if you want to allow or block incoming connections for specific programs.

File Sharing (AFP)
Printer Sharing
Screen Sharing

JODSAgent Allow incoming connections

ul
J7| Click the lock to prevent further changes. @
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If you click the Advanced button, you'll be able to log information about unau-
thorized attempts and destinations blocked by the Mac’s firewall.

You can also operate the computer in Stealth mode (by selecting that option
in the Advanced section) so that any uninvited traffic receives no acknowl-
edgment or response from the Mac. Malicious hackers won’t even know
there’s a machine to attack.

And you can help safeguard your machine by selecting various options under
Sharing, which is in the Internet & Network section of System Preferences. |
touch on Sharing in Chapter 18.

FileUault

If your computer houses truly hush-hush information — your company’s finan-
cial books, say, rather than Aunt Minnie’s secret noodle-pudding recipe — you
can scramble, or encrypt, the data in your Home folder (and only your Home
folder) using an OS X feature known as FileVault. You know your secrets are
protected should thieves get their grubby paws on your machine.

FileVault automatically applies the level of encryption employed by Uncle
Sam. It’s what nerds refer to as AES-128 (for Advanced Encryption Standard
with 128-bit keys). And let me tell you, it’s really secure. Apple claims it would
take a machine approximately 149 trillion years to crack the code. Even if
Apple is off by a couple of billion years, I'm thinking your system is pretty safe.

The FileVault window shown in Figure 13-2 turns up when you choose
Security under System Preferences. As an administrator, you can set up a
safety net master password for your system, which you’ll need to unlock
FileVault. This computer-wide password can be used to bail out authorized
users on your system who forget their passwords. And it might be a lifesaver
if you run a small business through your Mac and have to let a wayward
employee go. You'll be able to recover any data left behind in that person’s
account.

NG/
v%

Heed Apple’s warning. If you forget your login password and master pass-
word, your scrambled data may as well be toast.

If FileVault is turned on and you're not logged in to the machine, other people
you normally share folders with on the computer will not be able to access
those folders.
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Figure 13-2:
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FileVault secures your home folder by encrypting its contents. It automatically
y: ﬁ . encrypts and decrypts your files while you're using them.

WARNING Your files will be encrypted using your login password. If you forget your login
password and you don't know the master password, your data will be lost.

A master password is not set for this computer. (" Set Master Password... )

This is a "safety net" password. It lets you unlock any
FileVault account on this computer.

FileVault protection is off for this account. Turn On FileVault..

Turning on FileVault may take a while.

ul
§7| Click the lock to prevent further changes. @

It’s worth mentioning that FileVault can exact an extreme performance hit on
home directories with, say, large iPhoto or iTunes libraries — it can take a
long time to decrypt files when you log in and scramble them again when you
log out. So while FileVault is a wonderful tool for confidential stuff, be aware
of the potentially harsh consequences for folks with little to hide. One way
around this is to set up a specific account with your confidential stuff and
FileVault it.

Password Management:
The Key to Keychains

Have you stopped to think how many passwords are in your computing
life? You probably have so many that you use the same ones over and over,
though security experts think that’s not such a keen practice.

The pun police will get on me for saying this, but Apple has the key to manag-
ing your passwords, account numbers, and other confidential info: a feature
known as keychain. A keychain can store passwords for programs, e-mail
accounts, Web sites, and more.

You can create keychains for different purposes (one for online shopping,
say) by opening Keychain Access in the Utilities folder under Applications.
Your keychain password is initially the same as your login password, and

for many users that’s the way it’ll stay. To add keychain passwords, choose
Filec>New Password Item or click the + at the bottom of the Keychain Access
window. Fill in the account name, keychain item, and password. Apple will let
you know if you've chosen a wimpy or bulletproof password.
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Logging In and Logging Out
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If you work in an office or other environment where anyone can peek at the
monitor to see what you've been up to, log out of your account when you’re
finished doing what you’re doing.

But if you'd rather not bother logging out or you don’t think you’ll remember,
go to the Security pane of System Preferences, click General and select the
Require Password to Wake This Computer from Sleep or Screen Saver option
and the Log Out after x Minutes of Inactivity option.

You also may want to select the options to Disable Automatic Login and Use
Secure Virtual Memory. The latter setting ensures that data stored in virtual
memory is encrypted. You'll have to restart the computer for the change to

take effect. You can even disable a remote control infrared receiver.

If you're really distrustful, select the Require Password to Unlock Each
System Preferences pane option.

Entering a Time Machine

The feature that generated most of the excitement when Apple announced
Leopard was Time Machine — and rightfully so. Here, finally, was an effort-
less way to back up everything on your system. You could gracefully float
back in time to retrieve a file that was lost, damaged, or changed. Why it’s
almost science fiction.

To exploit Time Machine, you need to supply a big enough extra drive to
store what’s on your computer. Time Machine pretty much takes over from
there. It automatically keeps backups every hour on the hour for the past
twenty-four hours, and daily backups for the past month. Beyond that, Time
Machine goes weekly, at least until the backup drive is packed to the rafters.
(This is a darn good reason why you ought to devote an empty drive for your
Time Machine backup.)

Setting up Time Machine

Plug in that new secondary hard drive, and your Mac asks if you want to

use it for a Time Machine backup, as shown in Figure 13-3. You won’t regret
saying yes, and that’s really all you need to do, unless you want to customize
which files are backed up.
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Figure 13-3:
Are you
ready for
time travel?
|

A\

A\

T‘*.' Do you want to use “OneTouch4 Mini" to back up with Time
> Machine?

E— Time Machine keeps an up-to-date copy of everything on your Mac. It not only
keeps a spare copy of every file, it remembers how your system looked, so you
can revisit your Mac as it appeared in the past.

@ (" Cancel ) { Useas Backup Disk \

Apple sells a wireless companion for Time Machine called Time Capsule. This
backup appliance combines a Wi-Fi base station (Chapter 18) and secondary
hard drive. It comes in 500GB ($299) and 1TB ($499) versions.

The Mac begins dutifully copying everything on the computer, including
system files. This first copy job is likely to take awhile, especially if your Mac
is stuffed with files. (I recommend letting the computer do its thing while
you're asleep.) Subsequent backups are a lot quicker because by then the
Mac copies only what’s changed, such as edited manuscript.

The results are worth it, because you can go back in time to see what a file or
folder looked like on the day it was backed up, using Quick Look if you want
a quick preview. Say you're looking at the batch of photos that make up the
Last Import folder in iPhoto (Chapter 15). When you go back in time with
Time Machine, you’ll see how the Last Import folder changes on different
dates. In other words, the remarkable thing about Time Machine is it cap-
tures multiple copies of your digital belongings.

Although Time Machine is initially set up for automatic hourly backups, you
can arrange an immediate backup. Hold the mouse on the Time Machine icon
in the dock. Select Back Up Now on the menu that pops up.

[ suspect most of you will choose to back up the full contents of your com-
puter: It’s so simple, and if you have the storage capacity, why not? But if
your secondary hard drive is crammed or you have stuff you want to keep
private, you can omit certain items from being copied. Open Time Machine
preferences (see Figure 13-4) and click Options. Then click + to add the files
that you want to exclude, or drag items onto your no-backup list.

You can also turn Time Machine off altogether in Time Machine preferences
by sliding the off-on switch to the left. Frankly, I can’t think of a sufficient
reason yet for flipping off the switch, but the option is there nonetheless.
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<[> | Showall Q

‘\ Name: Backup
= Available: 125.7 GB of 465.4 GB

Oldest Backup: October 23, 2007

ChanosDiskes Latest Backup: Yesterday, 10:38 PM

Options... Next Backup: Today, 12:39 AM

Time Machine Time Machine keeps

= Hourly backups for the past 24 hours
= Daily backups for the past month

OFE Ej ON = Weekly backups until your backup disk is full

¥ Show Time Machine status in the menu bar

n
[] ﬂ Click the lock to prevent further changes. G)

Going back in time

Time travel is way cool. I'm betting you’ll hunt for files from a moment in time
just because Apple makes this historical journey such a visually intoxicat-
ing experience. Click the Time Machine dock icon and your current desktop
slides out of view. You and whichever Finder-like window was open at the
time you clicked the icon are now floating in space, as shown in Figure 13-5.
So if you know that the particular item you’re looking for used to reside in a
given folder, open that window before embarking on your journey. Or enter
its name in the search box in the Finder window.

You can now venture across the universe to discover the lost or altered file.
Say you unintentionally wiped out a critical document several weeks ago that
you now hope to recover. Use the timeline along the right edge of the screen
or the navigational arrows toward the bottom right to go back to the time of
deed. When you click, the windows fly forward or backward for a second or
two until landing on the day you chose.

If your search-and-rescue mission doesn’t immediately uncover the lost file,
try typing its name again in the Finder search box. You are searching for the
file on that particular date. When you encounter the wayward file, highlight

it and click Restore. It’s transported back to the present, with Time Machine
conveniently dropping the file in its original location. Click Cancel to return

to the present.

If the main hard drive on your Mac bites the dust, you can use Time Machine
to restore your entire computer. Just insert the Leopard Install or restore DVD
that came with your Mac, and select Restore from Time Machine. You’ll have
an option to choose the date from which you want to restore your system.
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Enter a search term to browse for files on the day in question

Thursday, February 28, 2008 12:50 ARM

The date you are viewing

Jump to the last time the window you are viewing changed

Bring a lost file back to the present (in its original location)

Exit Time Machine and return to the desktop Drag over the timeline to choose a given time;
click and the windows fly by until you get there

You can also use Time Machine to transfer important settings, applications,
and files to another Mac. Open Migration Assistant (in the Utilities folder
under Applications) and choose From a Time Machine Backup when asked
how you would like to transfer your information.

A couple of security notes: You can make sure a given file is not backed up
by highlighting it in Time Machine, clicking the Action icon in the Finder
window, and then choosing Delete All Backups of the file in question. And had
you chosen to encrypt files in FileVault (as outlined previously in this chap-
ter), they remain encrypted as part of your Time Machine backup. So even in
Time Machine you’ll need a password to get at Aunt Minnie’s pudding recipe.
What can possibly be more secure than that?



Part IV
Getting an iLife

’Ille 5th Wave By Rich Tennant

ORICHTENNANT

T could tell gou more aboutb mgéel(i, but | ’okinl%
the playlist on my {Pod says more about me
than mere words can.”




In this part . . .

C ome and greet the Murderers’ Row of multimedia
software: iPhoto, iMovie, iDVD, GarageBand, and
iWeb, known collectively as iLife. We’'ll spend a bunch of
time with iTunes too. Music junkies, photography buffs,
auteurs, videographers, aspiring rock stars, podcasters,
and bloggers are all invited. So are you and your family.
Special bonus: a peek at Apple’s remarkably successful
iPod. iLife '08 is included on all new Macs and is a $79
upgrade if you have an older system.




Chapter 14
Living in an Tunes Nation

In This Chapter

Choosing an iPod

Touring the iTunes jukebox
Managing your music collection
Finding music online

Downloading books, podcasts, videos, movies, and more

Fe demographers may have missed it. But we’re in the midst of a major
population explosion. Everywhere you look, vast colonies of tiny white
earbuds are proliferating. They’re spotted on subways and on the street.
On airplanes, buses, and college and corporate campuses.

Those signature white earbuds, of course, are connected to iPods, or its
close Apple kin the iPhone. And there’s every chance you're reading a
Macintosh book because of them. Although iPods are meant to work

with iTunes software in Windows machines as well as on OS X, your first
infatuation with the Mac may well have occurred in an Apple store when you
ostensibly went to check out the darling of all portable music players.

You also may be thinking that if Apple hit such a home run with the iPod,
perhaps Steve Jobs and crew know something about making darn impressive
computers too. (Naturally, you'd be right.)

So although this is first and foremost a computer book (and I promise we’ll
venture back to the Mac before long), please forgive a minor detour into
iPod territory. [ won’t dwell on everything the iPod can do except to quickly
mention here that in addition to music and (with some models) video and
pictures, iPods can synchronize contacts and calendar information and store
text files. And the iPhone can do a lot more than that.

[ hope you’ll keep reading this chapter even if you don’t have an iPod. You
can still take advantage of iTunes.
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Choosing Vour iPod

|
Figure 14-1:
The smaller
Nanos.
|

Sprinkled throughout this book is the disclaimer as of this writing because
Apple is known for surprises. After all, Apple once replaced what had been
the best-selling iPod model to date, iPod Minis, because it came up with
something even more extraordinary, the Lilliputian Nano. Then it redesigned
the Nano a few times. So all bets are off. As of this writing, there are
essentially four iPod classes, each sold with different storage capacities.

iPod Classic

The $249 iPod Classic is the model for those of you with enormous media
libraries. At 120GB, it can store up to 30,000 songs or up to 150 hours of
video. (Apple discontinued the sale of an even larger and thicker 160GB
model.) Roughly the size of a deck of cards and still closest in design to the
original classic white iPod, these newest models come in silver or black. The
devices are famous for their touch-sensitive scroll wheel, which you use to
control the gizmo’s operations (menus, skipping tracks, play/pause, and
more). As with other models, you peek at your music (and other content)
using Cover Flow, the clever interface that makes it look like you are flipping
through album covers.

Nano

I can tick off the Nano’s weight (1.3 ounces) and dimensions (just 3.6 by-1.5
by-0.24 inches), but you can’t truly appreciate how tantalizingly small that is
until you place a Nano (see Figure 14-1) next to a grown-up iPod. Of course,
giving in on size means giving up some song capacity. The largest capacity
16GB Nano can hold around 4,000 songs.

Courtesy of Apple
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Figure 14-2:
Even
smaller, the
Shuffle.
|

Still, if you're looking for an iPod so small that you're not even sure whether
it’s still in your pocket, Nano is the choice. Like its full-size cousin, Nano
sports a version of the scroll wheel. It can show off pictures and videos

too. Nano, which starts at $149, comes in nine colors. It features nifty acceler-
ometer technology, found also in the iPhone and iPod Touch (discussed
shortly), that lets you switch to Cover Flow just by rotating the device to its
side. And if you lightly shake the Nano, it automatically goes into Shuffle or
random mode as it advances to the next song. Cool stuff.

iPod Shuffle

Starting at just $49, the half-ounce iPod Shuffle is the ultimate impulse buy.
The $60 2GB version can accommodate up to 500 songs (see Figure 14-2). It
derives its name from the shuffle setting found on larger iPods, compact disc
players, and other musical devices. Songs on the device can play in random
order (or sequentially by default). Moreover, because the Shuffle has no dis-
play, the only way to tell what’s playing, assuming you don’t know just by lis-
tening, is to connect the Shuffle to your Mac (or Windows machine) through
a USB connector on the supplied dock. It too comes in multiple colors.

Courtesy of Apple

iPod Touch (iPhone lite)

The ever-thinner iPod Touch has been compared to the iPhone without the
phone part. And the large multitouch-controlled device — you use your digits
to pound away at a virtual keyboard — is terrific not only for listening to
music (up to seven thousand songs in the top model), and displaying photos,
but also for watching widescreen movies and TV shows. It has a generous
3.5-inch display. The Touch, shown in Figure 14-3, is capable of several

other impressive stunts, also borrowed from the iPhone. It has an honest-to-
goodness mobile version of the Safari browser. You display maps and get
directions. You can send and read e-mail. You can turn rotate it to its side,
and the whole display goes from portrait to landscape mode.
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Figure 14-3:
The iPod
Touch is like
an iPhone
without the
phone.
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Courtesy of Apple

And with built-in Wi-Fi, you can browse and purchase music wirelessly.
The Touch starts at $229 (for 8GB) and jumps to $299 (16GB) and $399
(32GB); you can download games and a gaggle of downloadable third-party
applications through Apple’s App Store, again just like the iPhone.

Speaking of iPhone, it too functions as an iPod (and a pretty darn good

one at that). But there’s a lot more to it, so much more that books have been
written about it. And that leads to a shameless plug for iPhone For Dummies,
coauthored by yours truly and Bob LeVitus.

iTunes: The Great Mac Jukebox

As stand-alone devices, iPods are wonderful examples of exemplary design
and superb engineering. But though the iPod name signifies star power, it
must share (and truth be told probably relinquish) top billing to the maestro
behind Apple’s musical ensemble, iTunes software.
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If the iPod is Lennon, Apple’s multimedia jukebox program is McCartney. Or
it is Mick to Keith? Rodgers to Hammerstein? You get the drift; the little
player and Apple’s software make terrific music together. Best of all, iTunes
is one of those melodious programs that musical enthusiasts (and everyone
else) get just for owning a Mac.

Here’s a quick rundown on what iTunes permits you to do, with further com-
mentary to come later in this chapter:

v Listen to CDs.

v Rip, or encode, the songs on a CD into music files that are compressed
(see the “Compassionate compression” sidebar) and stored in your
digital library.

v Add music to the library from the Internet.
v Create, or burn, your own CDs or DVDs, with the proper CD or DVD

burner, such as Apple’s own Super Drive, which is included in most
Macs.

v~ Listen to Internet radio by clicking the Radio icon in the source list to
display a list of streams by category, such as Alt/Modern Rock, Blues,
and Electronica.

v Watch videos.

v Organize your music by name, artist, time, album, genre, rating, play
count, and more.

v Segregate your music into customized playlists.

v Stream or share the music in your library across a network — within
certain limitations.

v Create ringtones for your iPhone.

v Transfer music onto an iPod, an iPhone, and non-Apple MP3 players.

To open iTunes, click its dock icon, which looks like a musical note resting on
top of a CD.

Let’s explore some of the iTunes controls referenced in Figure 14-4.
(Depending on the selections you make in the iTunes view options, what you
see may vary.):

v Back/Forward: The double arrows pointing to the left and right are your
back and forward buttons, respectively. Place the cursor above these
buttons and hold down the mouse to rewind or fast-forward through a
song. If you instead single-click these arrows, you’ll advance or retreat
to the next or previous track.
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Click here to enter the iTunes Store
Click here for Internet radio

Previous track/back

Source list
Play/pause Click to change a digital readout
Next track/forward Now playing List view/Grid view/Cover Flow view
Volume Track list Track status Genius sidebar

7. P

Figure 14-4:
Ode to
iTunes

software.
|

Hide/show album art or video Click column heads to sort
Repeat
Shuffle

New playlist

Album cover art

Playlists

Start Genius | Cover flow window

Show/hide Genius sidebar

v~ Play/Pause: Click the single arrow pointing to the right to play a song.
When a song is playing, the button changes to two vertical bars. Click
again to pause the music. Alternatively, press the spacebar to play or

pause.

v Volume: Dragging this slider increases or decreases the volume, relative

to your system volume settings.

v Cover Flow: As you've seen throughout this book, you can take advan-
tage of the Cover Flow view from any Finder window. But Cover Flow
debuted as part of iTunes, and where else would it make as much sense?
To find music, you can rummage through album covers just as you once
did with physical LPs. But if you prefer, you can view the contents of
your iTunes stash using List view or Grid view instead.
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Figure 14-5:
Mouse over
the thumb-
nail album
coversin
Grid view.
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v Grid view: Apple’s handsome new iTunes Grid view interface uses

album covers too, but you approach it somewhat differently. Basically, a
collection of your music (or movies, TV shows, podcasts, or audio-
books) is lumped together in a group representative of, say, a singular
artist or genre. Atop the group is cover art. As you mouse over the
group, the art rapidly changes to other album covers (or whatever) in
the group. When the selection you have in mind turns up, you can play it
with a single click. This skimming action is similar to the way you’ll
scrub through Events in iPhoto ’08 (see next chapter) or video in iMovie
(Chapter 16). Figure 14-5 shows the Grid view in my iTunes library from
the genre perspective.

v~ Shuffle: When the symbol in this little button is highlighted (it turns

blue), tracks play in random order. Be prepared for anything. There’s no
telling when Eminem will follow The Wiggles.

1 Repeat: Click once to repeat all the songs in the library or playlist you're

currently listening to. Click twice so that the number 1 appears on the
button. Only the current track will repeat.

v+ Equalizer: If you've ever tweaked the treble and bass controls on a

stereo, you'll appreciate the equalizer. It allows you to adjust sound
frequencies to match the genre of a song, the speakers on your system,
or the ambiance of the room in which you are listening. Choose
Window=>Equalizer to display the equalizer window. You can manually
adjust the equalizer by dragging the sliders or choose among more
than 20 presets (such as Bass reducer, Flat, Hip-Hop, or Lounge). To
bring up those presets, click the pop-up menu in the window.
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v~ Visual Effects: If you were conscious during the '60s, you’ll welcome
these funky psychedelic light animations and 3D effects that dance to
the beat of whatever’s playing. And if you're the offspring of a Baby
Boomer, you'll arrive at this amazing realization: Maybe mom and dad
were pretty groovy in their heyday. You can drum up your visual
serenade by pressing 38+T or choosing Viewr>Show Visualizer. You can
also choose the types of visualize effects you get in the View menu.
And a number of visualize plug-ins are on Apple’s Web site and other
cybersources. For a full-screen effect when the visualizer is active,
press 38+F; press Esc or click the mouse button to return to reality.

Managing VYour Music

So how exactly does music make its way into iTunes? And what exactly
comes of the songs after you have ’em? I thought you’d never ask.

Ripping audio CDs

A remarkable thing happens moments after you insert the vast majority of
music CDs into your Mac. Typically, iTunes opens, and the contents of the
disc — song titles, artist name, length, album name, and genre — are
automatically recognized and copied into iTunes. The software actually
fetches this licensed information from a massive online database run by a
company called Gracenote.

Now here’s another remarkable feat: Next time, you won’t have to keep
inserting said CD into the computer to hear its music. That’s because you can
rip, or copy, the contents onto the Mac’s hard drive, and then stash the disc
somewhere else.

A pop-up asks if you'd like to copy the album. Agree and all songs with a
check mark next to their name will be copied; be sure to click to deselect any
songs you have no interest in before proceeding. In some instances, you’ll
copy a CD by clicking the Import CD button at the bottom-right corner of the
window instead.

As iTunes goes about its business, a tiny orange circle spins next to the song
being ripped; the circle turns green and gains a check mark after it’s been
copied. You can monitor the progress of your imports also by peeking at the
top display shown in Figure 14-6. It shows you how much time remains before
a particular track is captured and the speed at which the CD is being ripped.
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Figure 14-6:
Ripping a
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Incidentally, you can listen to the CD (or do other work) while ripping a disc.
After iTunes has completed its mission, remove the CD by clicking Eject

(the rightmost icon at the bottom of the screen). Copied songs are stored in
the iTunes library.

If you weren’t connected to the Internet and couldn’t grab song names when
copying a disc, you don’t need to reinsert the CD into the computer the next
time you are on the Net. Select songs and open the Advanced menu and
choose Get CD Track Names.

Importing other ditties

Songs previously downloaded from the Internet can be imported into iTunes
by dragging them into your iTunes library. The assumption here is that you
obtained those music files legally. If you did not, placing them inside iTunes
will blow up your computer. (That’s not really the case, but I urge you to play
by the rules just the same. People’s livelihoods depend on it.)

To import audio files from other applications or your desktop, choose
Filem>Add to Library and then select the file. Or drag the music into the
Library, onto a playlist (see next section), or onto the iTunes dock icon.

Creating playlists

You listen to music under a variety of circumstances, such as entertaining at
a dinner party, soothing a crying baby, setting a romantic mood, or drowning
in your sorrows after a painful breakup. In the last situation, you wouldn’t
want to hear Barbra Streisand belting out “Happy Days Are Here Again,” even
if the song is otherwise a staple in your iTunes library. With a playlist, you
can organize material around a particular theme or mood.

The simplest way to create a new playlist is to click the + button in the
bottom-left corner of the iTunes window. You can also choose File>New
Playlist or press the keyboard tandem 88+N.

A new playlist with the inelegant name Untitled playlist appears in the source
list. Type over that with the name of the playlist you have in mind (Jazz
Crooners, Dance Mix, Corny Songs, or whatever). Then merely drag the songs
from the library into the folder representing the new playlist.
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If you're adding multiple songs into the playlist, hold down the 88 or Shift key
to select a bunch of tracks. You can drag the whole batch over in one swoop.
Or select a bunch of songs and choose File>New Playlist from Selection. To
delete a song from a playlist, highlight it and press Delete. Don’t worry, the
original track remains in your library. Songs in playlists never really leave
the library; the playlist merely functions as a pointer to those files. For the
same reason, a particular song can show up in as many playlists as you want
without consuming any additional space on your hard drive.

When playlists get smart

Putting together a playlist can be fun. But it can also take considerable time
and effort. Using smart playlists, you can have iTunes do the heavy lifting on
your behalf, based on specific conditions you establish upfront: how fast a
song is (based on BPM, or beats per minute), the type of music, a song’s
rating, and so on. You can also limit the playlist to a specific length.

Choose File>New Smart Playlist. In the dialog box that appears, click Add (+)
to choose from pop-up menus the parameters on which you're basing the
smart playlist. Click the — button to remove a condition.

Take a look at the Smart Playlist Figure 14-7. It has iTunes looking for all
songs with Love in the title that you haven’t heard in a couple of months or
haven’t heard more than fourteen times. The song must have been encoded
with a bit rate between 128 and 160 Kbps (see the “Compassionate compres-
sion” sidebar). The overall length of the playlist cannot exceed two hours. If
you want iTunes to alter the smart playlist as songs are added or removed,
select the Live Updating option.

Smart Playlist

Name 5 contains *  Love

Last Played + s notin the last e 2 months

Bit Rate 5 is in the range ¥ 128 to 160 kbps
Play Count +  isless than ¥ 15

0 2
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When playlists get even smarter

With the launch of iTunes 8, Apple unleased a powerful new Genius playlists
feature. In a nutshell, it promises to create an instant playlist of songs

from your library that mesh well with a given song you are listening to. Click
the Genius button (refer to Figure 14-4) when listening to that track to
generate the playlist. Figure 14-8 shows a Genius playlist created from the
“seed song” A Song for You by Donny Hathaway. You can save a Genius
playlist and instantly refresh it if you don’t like the results. And you can limit
the collection to twenty-five, fifty, seventy-five, or one hundred songs.

As of this writing, you could generate playlists only with songs you own that
are also for sale in the iTunes Store, eliminating playlists based on the
Beatles among others. That might change by the time you read this. And
Genius was a little less smart generating some classical music playlists. That
too might change.

You'll have to opt in (under the Store menu) because to help craft the
playlists, Apple anonymously shares data from your iTunes library with
anonymous data from countless other users. You can also generate Genius
playlists on-the-fly with the new iPod Nano and Touch.

Take note also of the Genius sidebar in Figure 14-8. Apple will recommend
songs you don’t already own from the artist who generated the Genius
playlist along with other purchasing suggestions.

|
Figure 14-8:
This playlist
is pure
Genius.
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Compassionate compression

iTunes can sing to a variety of audio file formats.
Most digital tracks imported into the iTunes
database are compressed, or shrunken, so the
music doesn’t hog an inordinate amount of
space on your hard drive. But there's generally
a tradeoff between file size and sound quality.
As you mightimagine, larger files offer the finest
sonic fidelity — at least in theory.

The best known of these compression schemes
is MP3, a method in which files are squeezed to
a reasonable size, even though the sound is
perfectly acceptable to all but the most serious
audiophiles. Apple prefers an alternate com-
pression method. On Macs with QuickTime 6.2
or later, Apple uses a default encoding scheme
known as MPEG-4 AAC (Advanced Audio
Coding), a compression format that Apple
claims is equal if not superior to MP3s encoded
at the same or a slightly higher bit rate. (If you

have an earlier version of QuickTime, MP3 is
the default.)

The songs you purchase at the iTunes Store are
also in the AAC format. According to Apple, the
High Quality AAC setting produces files that
take up less than 1MB for each minute of music.
But iTunes also recognizes other file formats,
among them: Apple Lossless, AIFF, and WAV.
These last two flavors are uncompressed, so
the music is of exceptional quality, but the files
gobble up disk space. Apple Lossless is an
audiophile format that matches AIFF and WAV
in sound quality but takes up half the space. If
you're inclined to mess with these file formats,
visit iTunes Preferences, click the Advanced
tab, and make your choice in the Importing sec-
tion. You can set up the encoder to import using
AAC, AIFF, Apple Lossless, MP3, or WAV, and
also choose the stereo bit rate. In techie terms,
128 Kbps is the default.

Loading tunes onto the iPod

Transferring your songs, playlists, and — as you’ll also see — videos, audio-
books, and podcasts to an iPod (or other portable device) is as simple as
connecting the device to your Mac through USB or FireWire, depending on
the model. Each time you connect, the iPod automatically mirrors any
changes to your songs and playlists in iTunes. That is, unless you select
Manually Manage Music and Videos on the Summary tab in the iTunes
window when the device is connected.

A connected iPod shows up in the iTunes source list under the Devices

heading. Click the little Eject icon next to the name of your iPod in the source
list before removing the device from a USB or FireWire cable.

Burning audio CDs

Knowing how to create a playlist is a handy precursor to burning or creating
your own CD that can be played in virtually any standard compact disc player.
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To burn a CD:

1. Click the Burn Disc button near the bottom-right corner of the iTunes
window.

The Burn Settings window appears.
2. For the Disc Format, select Audio CD.

3. Choose the gap between songs (from 0 to 5 seconds, 2 seconds is the
default).

4. If you want all the songs on the CD to play at the same volume, select
Sound Check. If you want, select Include CD Text.

5. With those preliminaries out the way, choose the playlist with the
songs you want to burn and make sure all the tunes you want have
check marks next to their names.

Be mindful of the length of those tracks; regular CDs have room for
about seventy-four or eighty minutes of music, or approximately
twenty songs.

6. When you’re ready, click the Burn button in the bottom-right corner
of the Burn Settings window.

7. When instructed, insert a blank disc.

Use a CD-R disc if you want to play the CD in almost any player.
Although this type of disc can’t be erased after you’'ve recorded on it, it
works in many more players than rewriteable CD-RW type discs, the
kind that can be erased and rerecorded.

8. Click Burn Disc again.

Your CD burner chugs away. The entire procedure may take several
minutes.

In this example, we burned an audio CD. Apple also gives you the option to
burn an MP3 CD. The advantage is that you can store a lot more music (more
than twelve hours, or 150 songs) on a typical CD-R disc. The rub: Fewer CD
players can handle this type of disc. You can also burn to a data CD or DVD,
but again the discs may not play in some players.

Tuning in to Internet radio

Listening to your own CDs and digital tracks is terrific. Presumably a lot of
thought went into amassing your collection. But at times, nothing beats the
serendipity of radio: Not knowing what’s coming next, hearing a nugget you
haven’t heard in decades, hearing a new jewel for the first time.

You don’t have to leave your Mac to revel in this type of experience. In fact,
when you click Radio in the source list, you'll have access to a heck of a lot
more radio stations than you’ll find on AM, FM, or even subscription-based

Chapter 14: Living in an iTunes Nation 23 7
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satellite radio. These are streaming Internet radio stations, and you can
choose from hundreds of them. Apple categorizes these by genre, as shown
in Figure 14-9. Click the triangle next to a category name to see all the station
options in that genre. Double-click to tune in to a particular station. It starts
playing in a few seconds, mercifully minus the static of regular radio.

Pay attention to the bit rate. The higher the bit rate number, the better a sta-
tion will sound, though you’re at the mercy of your Internet connection.
Dial-up users may want to stick with stations streaming at less than 48 Kbps.

You can include Internet radio stations in a playlist. Of course, you must
still be connected to the Internet to hear them. Recording Internet radio
streams requires a third-party application such as RadioLover from Bitcartel
Software. Download an evaluation version at www.bitcartel.com/
download.html.

Finding Music (and More) Online

iTunes serves as a gateway to a delightful emporium for music lovers. The
iTunes Store is where hunting for songs is a pleasure for all but the most
tone-deaf users. Don’t believe me? How else to explain more than five billion
downloads since Apple opened up the place? To enter the store, click iTunes
Store in the source list.

Sadly, you won'’t find every song on your wish list because some performers
or the music labels that control the artists’ catalogues foolhardily remain
digital holdouts. They have yet to put their records up for sale in cyberspace.
If you ask me, it smacks of greed. But then don’t get me started.
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Now that I have that rant off my chest, let’s put a positive spin on buying
music online compared to doing so in the physical world. For one thing,
your neighborhood record store isn’t going to carry the eight and a half
million (and counting) tracks found in the iTunes Store. And sadly many
of those physical stores are disappearing, in large part because of the
popularity of cyberpurchases. Moreover, every tune in the iTunes joint is
always “in stock.”

Shopping online for music affords you other privileges. Most notably, you
have the opportunity to cherry-pick favorite tracks from an album, without
having to buy the entire compilation. Note, however, that some record labels
require that some tracks be purchased only as part of a full-blown album.

What’s more, you can sample all the tracks for thirty seconds, without any
obligation to buy. Most of the songs that you do choose to buy cost 99¢ a
pop. Then there’s the matter of instant gratification. You can start listening
to the music you buy inside iTunes mere seconds after making a purchase, as
you’ll see later in the chapter.

Seeking online music recommendations

In a real-life music store, you might find an adolescent clerk willing to recom-
mend an album or artist. (Although why is it you have a sneaking suspicion
this kid doesn’t speak the same language you do, much less enjoy the same
repertoire?) If you get really lucky, you may come across a Julliard graduate
moonlighting between gigs. But more often than not you're browsing the
shelves on your own, not that that’s a bad thing; I love spending time in
record stores.

But face it, we all need a little counsel now and then. You'll find plenty of it in
the iTunes Music Store from Apple as well as from people like you who
happen to adore music.

The front page of the Music Store is like the window outside a physical
record store. You'll see colorful album covers, promotions for particular
artists, and more.

Store pages are laid out with new and recent releases, staff favorites, and a
list of top songs, albums, and ringtones (for your iPhone). You may see a few
exclusives and other recommendations — presented in the main genre you
select by clicking the drop-down menu under inside the Store (on the left
side of the screen).

Figure 14-10 shows the front page of the store when you’ve selected
Children’s Music as your genre.
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Now suppose you clicked the banner for Barenaked Ladies Snack Time.
You're transported to a page like the one shown in Figure 14-11. In the
bottom half of the screen is the list of songs in the compilation. Click any of
these to hear thirty-second samples. Now look above the song list. You'll find
customer reviews and ratings.

Figure 14-10:
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Feel free to contribute your own reviews. In iTunes, everybody can be critic.

iMixes
In the last section, | mentioned that you can write your own reviews. In fact,
you can go a lot further than being a critic. You can compile a list of songs for

people with similar tastes. Throughout the Music Store, you'll come across
top-rated iMixes, playlists created by ordinary music fans like you.

To contribute your own iMix for all the world to see in the iTunes Music
Store, follow these steps:

1. In the source list, click the little arrow to the right of a selected
playlist.

If no arrow appears, select the Show Links to Music Store option, which
is on the General tab in iTunes Preferences.

2. Click Create iMix.
3. Enter a title and a description and then click publish.

You might use a title such as Ed’s Sappy Love Songs and a description
such as Great sentimental music to share with a bottle of a wine and
a special friend. Apple won'’t let you use profanity.

4. Click Tell a Friend to spread the word.

Although your playlist can include tracks you’ve ripped from a CD, only tunes
sold in the iTunes Store will appear in your iMix. Apple makes the iMix
available for one year from its publish date.

You can rate other people’s iMixes on a scale of one to five stars.
Accordingly, they get to rate your compilation. If enough of them grade you
favorably, your iMix may also be featured on the album pages of featured
artists. That gives you as much credibility as any American Idol judge.

The search for great music continues

[ already mentioned the new Genius sidebar as one way to stumble upon
terrific music. Check out the following list for other methods, keeping in mind
that the quest can be deeply addictive:
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1~ Search: A great starting point in your exploration is to search for artists
or song titles by entering the name in the Search iTunes Store box
near the upper-right corner of the screen. You can put more weight
behind your search by clicking Power Search inside the Quick Links list,
on the (refer to Figure 14-10). It lets you search by several parameters
simultaneously (song, artist, album, genre, and composer).

1 Browse: If you're not starting out with a particular artist in mind, click
Browse from the Quick Links list. You see a window such as the one
shown in Figure 14-12. Choose whether you’re searching for an audio-
book, a movie, music, a music video, a podcast, or a TV show in the
leftmost column, and then select a genre in the column to its right, a
subgenre in the next column, and so on, until you’'ve narrowed the list
to tunes you want to own.

v Top Songs: If you happen upon an album page but aren’t familiar
with the performer’s music, consult the Top Songs list and click to hear
your thirty-second sample. You can also sample Top Ringtones, if
available.

v~ Listeners also bought: If you're impressed by what you hear from a
given artist, you may also be attracted to other music purchased by fans
of the artist’s work.

0000000000000,

Figure 14-12: ===
Browsing
for music is
nirvana.
| ) R
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Figure 14-13:
We're
happy to
take your
money but

+ Hobnob with the stars: Well not exactly hobnob. But an eclectic cast

of the rich and famous — Liv Tyler, Madonna, Mike Myers, William
Shatner, Kim Cattrall, Bill Maher, Billy Bob Thornton, Carole King, B.B.
King, Nicole Kidman, Russell Crowe, Jennifer Garner, Taye Diggs, Jackie
Chan, Smokey Robinson, RuPaul, Andrew Lloyd Webber, Kanye West,
Sting, Al Franken, Lance Armstrong, the Reverend Al Green, and many
more — have put together lists of their favorite works. The artists
usually provide brief descriptions of why they chose certain songs.
Regrettably, purchasing songs from these celebrity playlists is not an
automatic ticket to stardom.

When you've ready to buy

So now that you have all these recommendations, you're ready to spend
some money. First, though, you have to set up an account with Apple
(assuming you haven’t already done so) or use an existing AOL account.
Here’s how:

1.
2.
3.
4.

In the Source List, click iTunes Store.

In the sign-in window, click Create New Account.

Fill in the requested credit card and other info.

The rest is easy. Find a song you want to buy and click Buy Song.

To make sure you really mean it, Apple serves up the warning shown in
Figure 14-13.

. Click Buy to complete the transaction.

In a matter of seconds (usually) the song is downloaded to the aptly
named Purchased playlist. But as the “Digital rights police” sidebar
suggests, the purchased track typically has some restrictions.

Are you sure you want to buy and download the Song
"Pocketful of Sunshine"?

for this purchase and your music

Don't ask me about buying Songs again.

Cancel Buy
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Digital rights police

When you buy a regular compact disc, you can
pretty much do with it whatever you like. Pop
the disc into as many CD players as you have
access to. Copy the songs (via iTunes) onto
your Mac. Fling the thing like a Frisbee for all
anyone cares.

So what exactly do you own when you pur-
chase a song electronically from iTunes? The
rights to listen to that song on just five “autho-
rized” computers. If you try to share music on a
sixth machine, you're told you need to deautho-
rize one of the previous five. To do so, make
sure the computer is connected to the Net.
Then under the Store menu in iTunes, click
Deauthorize Computer. The five-machine limit
applies to Macs as well as Windows machines.
You can also deauthorize all five machines at
once by choosing Deauthorize All on the
Account Information page. The option will turn
up only if you have authorized five computers.

Quick takeaway: If you're getting rid of an old
machine, remember to deauthorize it.

Many of the songs purchased through the
iTunes Store are saddled with DRM (Digital
Rights Management) restrictions, typically
imposed by record labels. Such songs can be
played only on up to five computers and are
subject to other restrictions. In 2007, Apple
started offering a selection of DRM-free songs
under the name of iTunes Plus. The songs
initially cost $1.29, though Apple eventually
dropped the 30-cent premium. What's more,
iTunes Plus songs have been encoded at a
higher quality. (You can convert songs you've
already bought to iTunes Plus for a nominal
fee.) Because of continuing squabbles with
the labels, Apple has not been able to go all
DRM-free. But rivals have, including Amazon,
which also typically sells tracks for 89 and 99
cents a pop.

Once a week, you can download at least one free single handpicked by Apple
and usually more. The freebies are usually from artists you've never heard of,
though the music is often quite good. The downloading experience is identical
to buying any track, except you're clicking Get Song instead of Buy Song.

3

Apple’s generosity has a hidden cost. The company is taking the Lay’s Potato
Chip “bet you can’t eat just one” approach. The expectation is that you’ll
stick around the Music Store for awhile and part with your hard-earned
money at some point. Heck, less than a buck a track doesn’t sound like much
for those songs you just gotta have. But take it from first-hand experience,
those 99¢ tunes add up quickly. To find out just how much you’re spending,
click Account under the Quick Links list, enter your password, and click
Purchase History to check out your latest transactions.

If you've cherry-picked the songs you've bought from select albums, Apple
will lets you buy the rest of the titles on the album at a reduced cost. There’s
a six-month limit to take advantage of this Complete My Album feature, from
the time you first downloaded a song from an eligible album.



Chapter 14: Living in an iTunes Nation 245

a\\J

W

If you click Manage My Alerts on the Account Information page, Apple will
send you e-mail letting you know when artists whose music you’ve bought in
the past have added new music to the Music Store. To do so, select the Send
Me an Email Alert for All Individuals in My Purchase History option. Just
another way to get you to part with your money.

Allowances and gifts

If you've bought one too many lame sweaters or neckties over the years as
an eleventh-hour birthday gift, iTunes may be your salvation. Click Buy
iTunes Gifts under Quick Links to buy something truly valuable. iTunes Gift
Certificates can be issued in amounts from $10 to $200. You can e-mail the
certificate, print it, or have it go out through the U.S. Mail. You can even give
a specific song, TV show, or movie, or create a custom playlist for that lucky
person. The whole shebang takes a minute or so.

If you click Allowances instead under Buy iTunes Gifts, you can set up a
regular monthly allowance (in the same $10 to $200 amounts) that gets auto-
matically topped off on the first of the each month. If all goes well, Junior
will learn a thing or two about fiscal responsibility. Unused balances are
saved until your kid makes another purchase. Of course, should your son or
daughter abuse any privileges, you can pull the plug on his or her iTunes
allowance at any time by heading over to the Account Information page.

You can drag songs into a playlist and give them as gifts, even if you don’t own
the songs. You hear the thirty-second previews; your recipients get the full
treatment. Click the arrow next to the playlist and click Give Playlist.

You can also give an entire album inside the iTunes Music store by selecting
Gift This Music on the Album page. To redeem a certificate you’ve received,
click Redeem under Quick Links and enter the Redeem code on your gift card
or certificate.

Sharing music with other computers

If your Mac is part of a local computer network (see Chapter 18), you can
share the music in your library with other machines running iTunes version
4.5 or later. Go to iTunes Preferences, click Sharing, and select the Share
My Music option. You can share the entire library or selected playlists.

For added security, you can require users of other computers to enter a
password. iTunes must remain open for other computers to access your
music. Limits apply, as indicated in the “Digital rights police” sidebar.
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iTunes: More Than Just Music

It was inevitable that the iTunes Music Store would become just the iTunes
Store because, as you know by now, you can purchase a lot more than just
music, and share it on an iPod.

Listening to audiobooks

From Ernest Hemingway to James Patterson, you can fetch the iTunes equiva-
lent of books on tape. You can sample ninety-second previews, three times

as long as music selections. Of course, audio books can go on for hours,
compared to three or four minutes for your average song. Prices vary too. A
twenty-three-minute audio of Stephen Colbert’s remarks at the White House
Correspondents’ Dinner costs $1.95; an eight-and-a-half-hour audio version of
“Papa” Hemingway'’s A Farewell to Arms goes for $25.95.

Capturing podcasts

Podcasts are another form of Internet radio but very different from the radio
[ described earlier in this chapter. For one thing, many podcasts go beyond
radio and show video, including the Talking Tech video podcast I co-host
with one of my USA TODAY colleagues. Moreover, instead of listening to

live streams via the Net, podcasts are downloadable files you can listen to
whenever you get around to it.

As you’ll see after choosing the Podcasts genre inside iTunes, podcasts cover
a broad range of topics (business, politics, sports, TV and film, technology,
and so on) and are served up by experienced broadcasters, mainstream
media outlets (National Public Broadcasting, Newsweek, USA TODAY, Wall
Street Journal), as well as ordinary Joe’s and Josephine’s.

Podcasts are free to download and often commercial free. You can fetch
individual episodes by clicking Get Episode or subscribe to podcasts
that arrive on a regular basis. As with audiobooks, you can click to hear
(or watch) a ninety-second sample.

You can find the podcasts you’ve downloaded by clicking Podcasts in the
Source list. You can also instruct iTunes on how often to check for new
episodes (hourly, daily, weekly, manually) and how long to keep episodes
you’'ve downloaded (all unplayed, most recent, last two, last five, and more).
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Catching up on Lost and Family Guy

Quick story. I had never seen the hit series Lost before downloading the
pilot episode onto iTunes (and then an iPod). I was instantly hooked.
[ immediately understood the power of iTunes/iPod video.

Lost was among the first handful of TV shows that Apple made available on
iTunes. The number of programs quickly mushroomed to incorporate
everything from The Daily Show with Jon Stewart to The Sopranos. Music
videos and short films are also available.

Videos and TV shows inside iTunes cost $1.99 to $2.99 apiece; high-definition
shows fetch the higher price; as with audio tracks, you can sample thirty-
second previews and also subscribe to a season for a given series.

You can drag movie or video files you create yourself or obtain from other
sources into iTunes.

Before you can transfer some videos to an iPod, you may have to convert
them to a format iPod recognizes. Select the video, and choose Advanced=
Convert Selection for iPod.

Buying and renting movies

Apple started not only selling motion pictures through iTunes but renting
them too. Newer films typically cost $14.99 to purchase or $3.99 to rent; add
a buck for HD. Rented movies come (what again?) with restrictions. You have
thirty days to start watching, but only twenty-four hours to finish once
you’'ve begun playing it.

Through iTunes you can view the trailer and read plot summaries, the
credits, and customer reviews.

You can watch a movie on your computer, of course, and a Mac laptop is a
great substitute for a portable DVD player or the dreadful film the airline
chooses to show you. But when staying put, you probably want to watch on
the widescreen TV in your home theater. Apple sells a $229 (on up) box
called Apple TV that connects to a TV and wirelessly communicates with
your iTunes library to show movies, pictures, and videos and play music
through the television.



248 Part IV: Getting an iLife

iPod games

Want to play Sudoku or Pac-Man on your iPod? Apple sells these and other
iPod games in iTunes for $4.99 each. As of this writing, the games were
compatible with third-generation iPod Nano, iPod Classic, and some other
models, (but not the Touch or iPhone — see the next section). And though
the games are transferred to the iPod when you connect it to iTunes on your
Mac, you cannot actually play the games on your computer. Too bad.

The App Store

If you have an iPhone or iPod Touch, you can access a gaggle of nifty
programs for those devices — covering games, news, productivity, social
networking, and a whole bunch more. More than three thousand apps were
available as this book went to press, with more than 90 percent priced at
under $10 and more than six hundred free. While you can access the App
Store wirelessly on an iPhone or Touch, you can also get there directly

via iTunes.

iTunes U

Bet you thought this was all about fun and games? Hey, learning is fun too.
You can take in a lecture on the Roman Empire from a professor at UC
Berkeley. Or learn about Green Chemistry from Yale. iTunes offers more than
fifty thousand educational audio and video files from top colleges, museums,
and other global organizations. Tuition is free and, better still, there are no
surprise quizzes.
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Taking an iPhoto Close-Up

In This Chapter

Getting pictures into your Mac
Locating and organizing your pictures
Touching up photos

Sharing your pictures

Introducing iPhoto to iWeb
Preserving your digital pictures

Disruptiue technology is a concept that has been floating around for
nearly a decade. Loosely defined, it describes how a once dominant
technology gets elbowed aside and eventually displaced by something new.
The idea was coined by Harvard Business School Professor Clayton M.
Christensen, and those Ivy educators are pretty darn smart.

Disruptive technology is just what seems to be happening in the world of
photography, where digital cameras have dramatically overtaken the film
side of the picture-taking biz. Ever cheaper and more capable cameras are
becoming so pervasive that they’re even built in to most mass-market cell
phones.

For consumers, digital cameras afford lots of advantages over their film
counterparts. Most notably, you can preview shots before you ever snap an
image. (Try that one with your old man’s Instamatic.) What’s more, if you
aren’t pleased with the results — for goodness sakes, one kid is looking
sideways, and the other has her eyes shut — you can erase it on the spot
with no harm done and without having to pay to get the shot developed,
instantly reclaiming the image storage on your digital roll.

With iPhoto, Apple brings its own special smarts to digital photography. The
program is part digital shoebox, part processing lab, part touch-up artist, and
more. Through this wondrous member of the iLife suite, you can import,
organize, view, edit, and ultimately share your masterpieces with an adoring
public (or, at the very least, family and friends).
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Getting Pictures into the Computer

Figure 15-1:
Zooming in
on iPhoto
Events.
|

Taking pictures with most digital cameras is a snap. Taking good digital
pictures is another matter entirely and beyond the — pun alert — focus of
this book.

After pressing your digital camera’s shutter button, images end up on small
(and removable) memory cards. Even as the price of memory declines,

the capacity on these cards rises. You can now capture many hundreds of
pictures on relatively inexpensive and reusable cards.

In the past, it was a challenge to get digital images onto your computer,
where the real fun begins. iPhoto drastically simplifies the process. Take
a gaze at Figures 15-1 and 15-2 to familiarize yourself with some of the
program’s main elements. You're peeking at the Events view in the first
figure and the Photos view in the second. There’s a lot here, which we’ll
delve in to throughout this chapter.

Source list (albums appear here) Events viewer

Click to create event | Click to edit photos in event Toolbar buttons

Play slideshow Search photos by name, Drag to resize thumbnails

date, keyword, or rating
Enter full screen Drag to scroll through events

Showr/hide information

Click to create a new album, smart album, Web Gallery, slideshow, book, card, or calendar

Information pane
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Figure 15-2:
The Photos
view of
iPhoto.
|
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Connecting a digital camera

In most cases, you run a direct connection from the digital camera to the Mac
by connecting the USB cable supplied with the camera. Turn the camera off
and then plug one end of the cable into the camera and the other end into the
Mac. Turn the camera back on.

iPhoto opens, assuming you clicked Yes when the program asked whether
you want to use iPhoto to download photos when a camera is connected.
(This question pops up the first time you launch the program.) The way
iPhoto takes charge, you won’t even have to install the software that came
with your camera. Consider yourself lucky (at least most of the time).

If everything went down as it should and iPhoto was called into action,
skip ahead to the next section. If you ran into a problem, you can try the
following:

1 Check to make sure your camera is turned on and you have a fresh set
of batteries.
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Figure 15-3:
Getting
ready to
import your
pictures.
|

v Because every camera is different, consult the instructions that came
with your model to make sure it’s in the proper setting for importing
pictures (usually Play mode). Don’t you just hate when that happens?
You want an answer now, and here [ am directing you to some manual
that was likely translated into English from another language. Translated
poorly, [ might add.

Importing images from the camera

When you connect a camera and iPhoto comes to life, the camera name will
appear in the source list to the left of the screen, and your pictures will show
up in the main viewing area, as you can see in Figure 15-3.

To transfer images, follow these steps:
1. Type an event name (for example, Father’s Day) and a description

(after dad opened presents) in the appropriate fields.

2. If the pictures span a few days, select the Autosplit Events after
Importing option to split the collection into several different events.

3. If you've already imported some of the pictures in the camera, select
the Hide Photos Already Imported option so you won’t see them in
the window.

4. To import only select pictures from this batch, press the 3 key and
click the pictures you want to include. Click Import Selected.

—\...'muﬁﬂﬁdzﬁthQEEEw
MTEELFT I 1111

Impet A
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5. Click Import All to transfer the pictures to iPhoto’s digital shoebox.

The process may take several minutes depending on a variety of factors,
including the number and size of the images being imported. You'll see
the images whiz (or crawl) by as they’re being copied. A counter at the
bottom indicates how many pictures remain to be copied.

6. When the program has finished importing, a dialog window gives you
the option to delete the originals on the camera or keep them.

7. Drag the camera’s name from the source list to iPhoto trash, or right-
click and choose Dismount. Turn off and disconnect the camera.

Seeing double? If iPhoto detects a duplicate photo, it will ask whether you're
sure you want to copy it over again. Click Import to proceed or Don’t

Import to skip this particular image. To avoid getting this question for each
duplicate image, select the Apply to All Duplicates option.

<MBER iPhoto will also copy over movie clips from your digital camera, provided
they’re compatible with QuickTime. These videos are automatically trans-
ferred in the same way as still images.

Importing images from other sources

Not all the pictures in your iPhoto library arrive by direct transfer from
your digital camera. Some reach the Mac by the Web, e-mail, CDs or DVDs,
flash drives, or memory card readers. Other pictures may already reside
somewhere else on your hard drive.

To get these pictures into iPhoto, simply drag them into the iPhoto viewing
area or onto the iPhoto dock icon. You can drag individual pictures, albums,
or an entire folder or disk.

If you prefer, choose File>Import to Library and browse for the files you
want to bring over. Then click Import.

iPhoto is compatible with JPEG and TIFF, the most common image file formats,
a photo enthusiast format (available on some digital cameras) known as RAW,
and other formats.

If you haven’t bought a digital camera yet and are shooting 35mm film, you
can still play in iPhoto’s sandbox. Have your neighborhood film processor
transfer images onto a CD or post them on the Web. Given where the film
processing industry is heading, the company will be thrilled to have your
business.
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Finding and Organizing Images
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Right from the outset, iPhoto helps you organize pics so you can more easily
find the ones you want to view later. All the imported pictures are stuffed in
the iPhoto library, which you can easily access in one of two ways: by click-
ing Events or by clicking Photos, each of which is in the source list under
Library. I'll start with the basic Photos view, and then move on to Events.

The Photos View

Your entire image collection shows up in a grid of thumbnails, or mini pic-
tures, in the main viewing area on the right. If you're having trouble making
out those thumbnails, drag the slider at the bottom-right corner and watch
how the thumbnails grow. Cool, huh? Now drag the slider to the left to

make the pictures shrink. You can peek at many more pictures in the viewing
area that way.

Double-click a photo to make it larger. Press the Escape key to return to the
thumbnail view.

Movie thumbnails appear with a little camera icon and the duration of the
clip. Clicking a movie thumbnail opens the QuickTime Player.

iPhoto can accommodate up to 250,000 pictures. That’s a very big number.
Of course, if all Apple did was drop all those pictures into one large digital
dumping ground, you’d have a heck of a time finding that oh-so-precious shot
of your proud kid getting her elementary school diploma. So how do you
uncover the very images you want to admire over and over?

For starters, there are the organized Events, discussed in the next section.

Apple automatically creates virtual film rolls on your behalf. For instance, to
help you locate the batch of pictures you just imported, iPhoto conveniently
places them into a folder named Last Import. If you click Last Import in the
source list, those are the only photographs you'll see.

If you're looking for the pictures you took during, say, the past year instead,
click the Last 12 Months roll.

Go to Preferences under the iPhoto menu and click the General tab if you want
to change what’s shown in the source list from Last 12 Months to an album
containing photos in the Last 1 to 19 months.
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Events planning

All the photos snapped in a given day are lumped into an event. The assump-
tion is that you took a bunch of pictures during the kid’s soccer game, a
birthday bash, or some other activity. Of course, the smart folks at Apple
recognize that life doesn’t always work that way. So you might have attended
the soccer game in the afternoon and the birthday party in the evening.

So now we're talking two events. As you'll see, you can easily split events
into two. Or, for that matter, merge events that span more than a one day
(areunion weekend, say).

Skimming events

It’s fabulous that all the pictures attached to a single event are organized in
one grouping. But if you're the least bit snap-happy, an individual event may
be attached to dozens, if not hundreds, of photos. A very cool skimming
feature helps you find the images you want amongst the others in the given
Events pile.

All the photos grouped in an Event are represented by a single photo that
sits atop an interactive thumbnail. Events are labeled by the name you
assigned them or the date. Drag your mouse over the thumbnail and watch
how quickly you can skim through all the underlying pictures. No clicking
required. Stop rolling the mouse when you land on the image you're
looking for.

To change the thumbnail that sits atop the Events stack, skim to the image
you’d like to use and press the spacebar. When you move the mouse away,
that very image appears on top.

To view all the pictures that make up an Event, double-click the thumbnail.
Click the All Events button to return to the previous view.

As with the Photos view, you can drag the slider at the bottom right of the
iPhoto window in either direction to watch the Events thumbnails grow
or shrink.

Splitting and merging events

Double-click the event you want to split and then highlight the picture that
begins the new event. Click the Split button shown at the bottom of the
screen (or choose Eventse>Split Event). Figure 15-4 shows the screen that
appears. Double-click Untitled Event and type a name.

To merge events, drag one thumbnail over the other and click Merge
when the window shown in Figure 15-5 appears. Choose a name for your
untitled event.
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|
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Finding pictures by date

Now suppose you want to display just the pictures you took around a mile-
stone, perhaps when your little angel was born. Click the tiny magnifying
glass in the search box to bring up a little calendar. If a date appears in bold
type, iPhoto is holding pictures taken that day. Point to the date to see just
how many pictures that is, as Figure 15-6 shows. Click the day to check out
those photos. Clicking the little arrow swaps between a display of the days of
the month and the months of the year. Months with images are in bold.

iPhoto captures more than just photos when picture files are transferred over.
Through captured metadata, the program knows the make and model of the
camera used to take the image; the date and time the picture was taken and
imported; the size in pixels, or picture elements; the aperture setting of the
camera; whether a flash was used; and more. Such data is factored into
Spotlight searches. Refer to Chapter 6 for more on Spotlight.
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Figure 15-6:
Viewing
pictures by
the month
and by

the day.
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Assigning keywords

Keywords may be the key to finding pictures in the future. These are labels, or
tags, applied to a set of photos. Apple provides some keywords right off the
bat: Favorite, Family, Kids, Vacation, and Birthday.

Of course, you can type in your own. Mouse over an image, and the words
add keywords appear. Single-click, and a type a keyword in the box that
appears.

Alternatively, Choose Window=>Show Keywords and then click the keywords
in the window shown in Figure 15-7 that you want to assign to a selected
photo or groups of photos. You can also select a checkmark to flag all the
photos you may assemble for a project. Still another way to create keywords
is to select Edit->Keywords and click the + (Add) button.

You can change a keyword name at any time. Just remember that doing
so makes the change in every photo that carries the previously, assigned
keyword.

Now that the underlying keywords are in place, how the heck do you put
them into action? Click the search field at the bottom of the viewing area and
choose Keyword from the pop-up list of search criteria (the others options
are All, Date, and Rating). Choose the keyword that applies to your search.
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Use keywords as a handy way of finding only the Photo Booth images in your
library — or any movies you shot.

Now suppose that you want to display pictures that match one keyword or
another (Family or Vacation, for example). This time, click the keywords in
question while also holding down the Shift key. Again, the viewer will show
only the appropriate collection of pictures.

If you want to hide pictures with certain keywords — I won’t ask, so don’t
tell — press Option on the keyboard while clicking the keyword or keywords
you want to hide. The pictures represented by those keywords are not
shown.

Assigning ratings

You can also assign ratings to pictures on a scale between zero and five stars.
You can do so in several ways with selected images:

v Choose Photos=>My Rating and click the number of stars you have
in mind.

v Open the Information pane by clicking the little circled i button near the
bottom-left corner of the screen, and then click the representative dot
next to Rating.
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1 Mouse over an image and click the dots above where it says add
keywords.

v While holding down the 38 key, press the 1, 2, 3, 4, or 5 key (representing
the number of stars) on the keyboard.

Placing your work into albums

In the film age, really organized people took the time to methodically place
prints into old-fashioned picture albums. [ admire people like that because I
lack this particular organizing gene.

Fortunately, the iPhoto equivalent of placing pictures into albums is much
simpler. The process is similar to creating playlists in iTunes (see Chapter
14). So you can place all the pictures from your ski trip in one album,
pictures of the high school reunion in another, and so on. Here’s the drill:

1. Choose File>New Album, or click the + button at the bottom-left
corner of the iPhoto screen.

2. Make sure the album tab is selected and type a name for your album
(Hawaii Honeymoon, Dance Recital, whatever).

3. Click Create.

The name of your new album shows up in the source list. Now you have to
populate that album with pictures, as follows:

v Drag entire events or individual photos onto the Album name or icon in
the source list.

v To select a batch of photos to drag over, hold down the 3 key while
clicking the pictures you want to include.

v To select adjoining photos, hold down the Shift key and use the arrow
buttons.

v To select all the photos between two photos, hold down Shift and click
the first image, then hold Shift and click the last image.

As you drag a batch of photos en masse to the album, a little red circle
indicates how many pictures you’re moving over.

If you want to select the photos before creating an album, select the pics and
then choose FilecoNew Album from Selection.

Although photos are lumped into albums, the pictures actually remain in the
iPhoto library. The images inside albums are merely pointers to the original
files. So you can place the same picture in multiple albums. You can also
remove pictures from an album without fear that the images will be deep-sixed
from the iPhoto library.
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After you create a bunch of albums, you can group them into a folder. Choose
Filer>New Folder. Give the folder a name (such as Vacations) and drag all the
relevant albums into the folder. When you select the newly created folder,
you'll see all the pictures stored in all the albums contained in that folder.

Creating a smart photo album

Just as you can create smart playlists in iTunes, you can sire smart albums in
iPhoto based on specific criteria, such as keywords, photos you've rated
highly, pictures taken with a particular camera, or the shutter speed. To
create a smart album:

1. Choose File>New Smart Album (or Option-click the + button below
the Source list).
2. Type a name, just as you do with a regular album.

3. Select the conditions that must be met for pictures to be included in
the Smart Album.

Click the + button to add matching criteria or the — button to remove
criteria. As new pictures are imported to your library, those that match
these conditions are added automatically to the smart album.

In Figure 15-8, I've set up a smart album seeking only highly rated pictures
taken without a flash at the beach since the end of 2007.

Smart Album name: Baig Family Beach Photos

Match [ all 4] of the following conditions:

["Album H (s =] [any 5 SO
[ Keyword + | [ contains 2] |Beach E/ @
[ Date £ [is after +] [12/31/2007 [3) = ®
[MyRating %] [isin the range t] dkkk - o dokkkk [CXO)
["Flash 4 [is +) [off % = ®

Cancel | OK

Viewing pictures

In the main Photos viewing area, photos are displayed in the order in which
you imported them. If you want to change the order, choose View=>Sort
Photos, and then choose an option, such as By Keyword or By Rating. You
have the same options for sorting events.
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Something to hide

I'd like to believe every picture I shoot is museum-quality. Truth is, [ shoot
my share of duds that can be easily discarded. But then there are those
“tweeners” — pictures that you don’t want to showcase but aren’t ready to
get rid of either. You are about to encounter the iPhoto equivalent of shoving
something in the closet or under the bed. Just select the suspect photos, and
click Hide in the toolbar. To see the picture again, choose View>Hidden
Photos=>Unhide.

Touching Up Your Photos

A\\S

Here’s a dirty little secret. The drop-dead gorgeous models gracing the
covers of magazines don’t really look like that. (Well maybe some do, but
work with me here.) The unsung heroes are the touch-up artists, who remove
a flaw from a picture here, a blemish there. We should all be so lucky to be
able to put our own mugs in the best light. And lucky we are for having
iPhoto on the Mac.

Now iPhoto is by no means a photo editing superstar along the lines of
Adobe’s Photoshop or Apple’s own Aperture. But for the mainstream snap-
shooter, iPhoto comes with several handy editing tools for removing red eye
or applying special effects.

We’ll get around to these in a moment. But first let’s examine a majestic way
to display your images in iPhoto that can help you take advantage of every
last pixel.

The full-screen treatment

iPhoto’s full-screen viewing option lets you exploit today’s large and beautiful
computer displays. What’s more, Apple lets you edit in this mode.

To enter the full-screen edit mode, select a photo from the main viewing area
and click the full-screen button (labeled in Figure 15-1). When you roll your
mouse at the top of the screen, a strip of thumbnails called the photo browser
(see Figure 15-9) slides in and out of view. Roll your mouse to the bottom of
the screen to slide the various editing tools into view.

You can compare between two and eight photos in the full-screen view by
holding 8 while clicking thumbnails in the photo browser. If you click the
Compare button instead, the photo you choose is compared with the one to
its immediate right.
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Editing tools

If you prefer the full-screen view all the time, go to iPhoto Preferences and
click the General tab. Under the Edit Photo pop-up menu, select Using Full
Screen.

To exit the full-screen mode, press the Escape key on the keyboard.

If you want to edit photos from the conventional view instead, double-click a
thumbnail in the viewing area, and the same editing tools you see in the full-
screen view appear below the selected image. If they don’t appear, highlight
a picture and click Edit in the menu bar. Let’s have a look at some of those.

Rotating an image

Sometimes the picture that turns up in the photo library is oriented incor-
rectly because of the way you rotated the camera when shooting the original.
To fix the orientation in iPhoto, select the image and click Rotate on the
editing toolbar, at the bottom of the screen. The image rotates counterclock-
wise by 90 degrees. Keep clicking until the picture is oriented properly. Press
the Option key while clicking to make the picture flip the other way.
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Cropping an image

Cropping means snipping away at the periphery of an image, so you can get
up close and personal to the subject at hand while removing traces of that
Yo-Yo in the background who is sticking his tongue out. To crop an image:

1. Click Crop on the editing toolbar.

2. Choose the cropping area.

To limit the crop area to a specific dimension, select the Constrain
check box (if not already checked) and make a selection. Among the
choices are 4 x 6 for a postcard, 20 x 30 for a poster, or 4 x 3 if you plan
on using the picture in a coffee table book, which I discuss later this
chapter. iPhoto puts a border around the potential cropping area.

3. Use the mouse to drag the crop area into the proper position.
4. Click Apply and then Done to save your changes.
In helping you crop an image, Apple applies a compositional principle known

as the Rule of Thirds. The cropping area you drag around is divided into nine
equal parts like a tic-tac-toe grid, as shown in Figure 15-10.
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If you’re unhappy with a newly cropped picture, choose Edit=>Undo (or press
3+Z). And at any time, you can choose Photos=>Revert to Original and
pretend like nothing happened.

If you want to crop an image and keep the original, choose Photos>Duplicate.
Give the cloned picture a name and use it to do your cropping.

Repairing blemishes

What do you do when that otherwise immaculate portrait is ruined by a small
stain on your sweater? Or the sudden appearance on your face of the zit that
ate Cincinnati?

Click Retouch on the editing toolbar to turn on iPhoto’s high-tech spot
remover or software airbrush. Drag the slider to select a brush size. Then
hold down the mouse button as you brush over a freckle, blotch, or pimple.
iPhoto paints over these spots using surrounding colors. Use short strokes to
avoid smearing an image and making the picture appear even more ghoulish.
Alternatively, click over a small spot you want to remove. Click Retouch
again when you're finished.

Retouching larger images is easier than smaller ones, making full-screen
mode all the more valuable when editing thusly. Still (I hate to be the one to
tell you this), getting rid of minor defects won’t win you a modeling contract.

Straighten

Does the photo you took appear crooked? Or maybe you just can’t come to
terms with the fact that the leaning tower of Pisa is actually leaning. Clicking
Straighten brings up a slider that lets you rotate a picture 10 degrees or less
in either direction.

Enhance and adjust

The quick-fix Enhance tool automatically brightens a faded or too-dark image
or adjusts one that’s too bright by correcting the image’s color saturation
and tint. Click the Enhance button once, and iPhoto does the rest. The pic-
ture isn’t always enhanced, but as usual you have a variety of undo options.

While iPhoto does all the work for you inside Enhance, Adjust puts the onus
on you. Clicking Adjust brings up a palette like the one shown in Figure 15-11.
Manually drag the sliders to adjust the exposure, contrast, highlights and
shadows, color saturation, and other elements. If you get totally lost after
messing with these settings, click Reset to start from scratch.
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Figure 15-11:
Getting
adjusted.
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Reducing red-eye

Flash photography often results in red-eye, where it looks like your subject is
auditioning for the lead role in Rosemary’s Baby: All Grown Up. Fortunately,
iPhoto, like Visine, can get the red out. The operation is devilishly simple.
Click the Red-Eye button and place the crosshairs pointer in the center of
each red eye. Or use the size slider to zoom in on each reddened pupil and
click. Click the Red-Eye button again to complete the exorcism.

Special effects

Clicking the Effects button brings up a tic-tac-toe style panel with eight
one-click special effects (a ninth button, in the center, brings the photo back
to its original state. Black & White, Sepia, and Antique (an aging effect) affect
the actual image. So do Fade Color, which lessens the color intensity in a
photo, and Boost Color, which has the opposite effect. You can repeatedly
click the mouse to lay on the effects even more. Clicking Matte, Vignette, and
Edge Blur alter the edges of the picture.

Admiring and Sharing Pictures

Until now, I've been speaking of organizing and doctoring images. Enough of
that. It’s time to sit back and admire your handiwork. And show off your
Ansel Adams skills to everyone else.
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Creating slideshows

If you're of a certain generation, you may remember having to sit still while
your parents pulled out the Kodak Carousel Slide Projector. “There we are in
front of the Grand Canyon. There we are in front of the Grand Canyon — from
a slightly different angle.”

The twenty-first-century slideshow, in care of a Mac, brings a lot more
pizzazz. Your pictures can have a soundtrack from your iTunes library. You
can slowly zoom in and out of photos employing the Ken Burns Effect, named
after the documentary filmmaker.

To create a slideshow, follow these steps:

1.
2.

Choose the album or groups of photos you want in your show.

Click the Add (+) button on the toolbar and then click the
Slideshow tab.

. Type a name (if it’s not already filled in with an album name) for the

slideshow and make sure the Use Selected Items in New Slideshow
option is selected.

. Click Create and drag pictures in the order you want them to play in

the photo browser at the top of the viewing area.

The name of your slideshow is now in the source list under a Slideshows
heading.

. Click Music to choose a soundtrack from iTunes, GarageBand (Chapter

17), or sample music included with iPhoto.

. Click Settings and make your selections.

You can choose how long you want to play each slide (three seconds
is the default) and a transition between slides (Dissolve, Page Flip,
Twirl, and so on). Remove the check mark if you don’t want to use the
Automatic Ken Burns Effect. Add check marks if you want to scale
photos to fill the screen, and show titles, ratings, and slideshow con-
trols. You can also choose whether to repeat music during the slide-
show or whether to adjust slide durations so slides will play as long as
the music plays.

7. When you'’re satisfied with the settings, click OK.

8. If you want to tweak settings for individual slides, click Adjust.

10.

. To preview visual changes to slides in a smaller window without

sound, click Preview.

Click Play to get on with the show.
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You can rotate and rate pictures in a slideshow on-the-fly or pause the show
by moving your cursor onto the screen.

You can also burn your slideshow to a DVD, share it online, or export it to a
QuickTime movie. We'll talk more about burning DVDs in Chapter 16.

E-mailing pictures

To send pictures using e-mail, highlight an image in your library or an album
and choose Share=>Email. Or hold down the 8 key to send a bunch of photos.
A dialog box asks you to choose a size for the photo (small, medium, large, or
actual size).

Smaller files are faster to send and download; the larger files boast superior
quality but may not slip past your ISP’s server size limitations.

Before clicking Compose, decide whether you want to include the titles and
comments with your photo by selecting those options (or not).

Click Compose. Leopard’s Mail program opens with the picture already
attached (assuming Mail is your default e-mail application). Fill in the
recipient’s address, type a subject line, and add any additional prose before
sending the picture on its merry way.

Visit iPhoto Preferences if you want to send e-mail through another mail
program such as AOL, Eudora, or Microsoft Entourage.

You can also e-mail pictures as attachments through such Web-based e-mail
programs as Gmail, Hotmail, and Yahoo! Mail.

Booking them

There aren’t many guarantees in life. But one of them is that bound coffee-
table photo books of the family make splendid presents. Apple makes it a
breeze to design these professionally printed 8!/-by-11-inch books. And when
the grandparents see what you produced, don’t be shocked if they ask how
come you're not working in the publishing business.

From iPhoto, you choose the size and design of these books and the batch of
photos to be included. Images are sent over the Internet to a printing plant,
which binds and ships the book on your behalf.

As of this writing, Apple’s hardcover photo books start around $30 (for 10
pages). Medium and large softcover versions start at $10 to $20, respectively.
Small-sized 2.6-by-3.5-inch books (sold three books at a time) fetch $12.
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Cards and calendars

Choose the Order Prints button to — this isn’t a trick question — order
prints directly from Kodak. You can choose various sizes, of course. You
need an Apple account with Enable 1-Click Purchasing. (You'll be taken
through the account process the first time you order.)

You can design customized greeting cards and calendars (up to 24 months)
by choosing a theme (some with text), a start date, and whether to add
national holidays (from about three dozen countries). You can also import
your iCal calendars as well as birthdays from your Address Book. An 8-by-
10-inch 12-month calendar costs around $20.

Themed prints

Apple has added lovely borders, mattes, and backgrounds to dress up the
photos you print on your home printer. Click Print, then Customize and make
selections from the Themes, Borders, and Layouts buttons on a toolbar that
appears below the image.

MobileMe Gallery

What if your first child was born recently and you want to share images of
the adorable infant with everyone. It’s not practical to invite them all over
to your house to view albums (unless they’re willing to take turns changing
diapers). And e-mailing the pictures to your entire extended family isn’t
practical given your lack of sleep.

As part of your MobileMe (formerly .Mac) subscription, you can publish your
pictures to the new MobileMe Gallery. Lots of online sites let you upload
pictures to share with others. Few do it with Apple’s sense of style.

Here’s how this particular bit of magic works:

1. Choose the album, event, or batch of pictures you want to share.

2. Click the Add (+) button and choose MobileMe, or choose
Share->MobileMe.

3. In the dialog box that appears, type a name for the album, event, or
pictures (if not already shown) and decide who can view it.

Choices are just you, everybody (who has the Web address), and only
those people you let in with a password.

4. Select your other publishing options.
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You get to choose whether to let your viewers download some or all of
the album, or upload their own images to your album. You can create an
e-mail address to send pictures to your album from a cell phone.

5. (Optional) Click Show Advanced.

Selections here let you hide the album on your Gallery page altogether.
And you can also choose whether to optimize the download quality to
publish photos in a jiffy or to stick with photos in their actual resolution.

6. Click Publish.
Your album shows up in the source list under Web Gallery.

7. Click the Tell a Friend button in the Gallery toolbar to spread the
word via e-mail.

You can pull the plug on your pals by clicking the MobileMe tab inside iPhoto
preferences and choosing Stop Publishing. This action removes the photos
from your Gallery but not from iPhoto. While in preferences, you can also see
which other albums you are publishing.

QQ,N\BER The previous edition of iPhoto introduced the concept of photocasting, a
Y kind of podcasting with pictures. You can continue to publish any existing
photocast albums and if you wish can move them to the Gallery. Just
remember to update subscribers to those albums with a new URL.

iPhoto Meet ilWeb

As you know, the iLife applications are meant to work together. iPhoto and
Apple’s clever Web page and blog creator iWeb are chums.

iWeb is built around predesigned templates and placeholders for, among
other things — you guessed it! — pictures. You can export photos from
iPhoto to iWeb and then drag those pictures on top of placeholders, to
replace images that had been warming up the spot. Just follow these steps:

1. Select the photos, movies, albums, or events that you want to export.

2. Choose Share=>Send to iWeb, and click either Photo Page or Blog.

iWeb opens (if it was not open already). You can also click the iWeb
3 button on the iPhoto toolbar.

Apple recommends sending three pictures max to a blog. You can add
up to ninety-nine pictures to a Web site.

3. Inside iWeb, choose the template to which you want to add pictures
and drag them onto the placeholder.

4. If you choose a blog, iWeb creates a new blog entry for each picture;
type text explaining what the picture is all about.
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Sharing pix on your network

You can stream pictures to other computers
connected to your local network. In iPhoto
Preferences, click Sharing and then select the
Share My Photos option. Add a password if
desired. In preferences, the other computers
should select the Look for Shared Photos option.

Although these other machines can display
your images, they can’t add pictures from
the original machine to their library or albums.
All the computers involved in sharing must
have OS X version 10.2.6 or later and iPhoto
4 or later.

Eventually you can publish the whole shebang through MobileMe —
provided you’re a member.

Preserving Your Digital Shoebox

I've already warned you that I'm going to take every chance I get to ensure
that you back up precious files. And what’s more precious than keepsake
photographs?

iPhoto makes it simple to burn CDs and DVDs. Per usual, select the photos
you want to copy (individual pix, albums, events, or your entire library).
Choose Share=>Burn and insert a disc into your CD or DVD burner. Depending
on the size of your collection and whether you have a CD or DVD burner, you
may be able to archive your entire collection onto a single disc.

If you burn pictures inside iPhoto, they can be easily viewed later only in
iPhoto. To create a disc that can be viewed also on a Windows machine or
elsewhere, choose Filec>Export and then choose a file format such as JPG.
Next, choose a location inside Finder. Quit iPhoto and open Finder. Make sure
you have a CD or DVD in your burner and drag the folder with the photos you
exported onto the disc icon. After the files have been copied, choose
Files>Burn Disk and then click Burn.

Q‘“\NG!

Whether you burn CDs or DVDs, you’ll thank me if you ever have to retrieve
photos from these discs. Losing a lifetime of memories is just the kind of
disruption everyone seeks to avoid.
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Shooting an iMovie Screen Test

In This Chapter

Capturing footage

Getting footage onto the Mac

Understanding post-production

Sharing your movie

Becoming familiar with iDVD
Burning a DVD

H ooray for Hollywood. Hooray for iLife. Apple’s digital media suite,
specifically through iMovie, provides the video editing and other

software tools you need to satisfy your auteur ambitions. Then when the
movie is in the can, you burn a DVD with help from iDVD.

“I'd like to thank all the people who made this award possible. The wonderful
cast and crew, my loving family, my agent. And a special thanks to
Steve Jobs . . .”

Of course, even if your filmmaking aspirations are of a more modest nature —
producing slick highlights of Johnny or Gillian’s soccer games, rather than
anything with genuine box office appeal — iMovie and iDVD are still keen
companions for your inner director and producer.

Filmmakers appreciate drama, something Apple provided when it revamped
iMovie in iLife ’08. Not all critics applauded. In an effort to simplify video
editing for newbies, Apple removed some of the most helpful and powerful
editing tools found in the previous version iMovie HD, including the video
and audio timeline tracks some seasoned videographers came to rely on.

If you were already running iMovie HD, installing iMovie 08 left the program
intact on your hard drive. And if you buy a new Mac with iLife 08, you can
download iMovie HD at no cost.

In this book I spend most of the time with the new version, because I suspect
most of you will work with that version. Still, it’s nice to know there’s

a fallback. Take a gander at the new iMovie playing field shown in Figure 16-1.
You'll get a quick sense of how you view, organize, and edit video.
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Okay, then, let’s get on with it. Places everyone. Ready? Action!

Project library  The project you are working on  Where your video plays
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Figure 16-1:
You oughta
bein
pictures.

Event library Toolbar

Browsing your source video filmstrips

Shooting Vour Oscar Winner

Legendary filmmaker Alfred Hitchcock is said to have asked, “What is drama
but life with the dull bits cut out?” So before sitting in front of the Mac, you
have to go out and capture some of that life on video. Trimming the dull stuff
and converting your raw footage into worthy home cinema comes later.

Alas, I can’t train you to become Hitchcock or Orson Welles or Steven
Spielberg. Heck, if I could do that I'd be sipping martinis in Cannes right
about now (or at least authoring Filmmaking For Dummies.) But | do know
enough to send you off to Oz with the right gear. And that gear pretty much
consists of a digital camcorder.
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Using a digital camcorder

Sony is credited with producing the first camcorder, the 1983 Betamovie,
which used a Betamax cassette. Through the ensuing decades, camcorders
handled a variety of media: VHS tapes, VHS-C, 8 millimeter, Hi-8. These
analog camcorders more than served their purpose for years. But as in
almost every other corner of technology, camcorders too have gone digital.
And why not? Video shot with a digital camcorder doesn’t deteriorate when
it’s copied. Pristine sound is also preserved.

iMovie can exploit only video footage in digital form. The good news for
consumers is that prices for most digital camcorders have plummeted in
recent years. The most common type of digital camcorder had made use of
matchbook-sized, sixty-minute MiniDV tapes. But tape is losing ground to
tapeless models, as outlined in the “Tape, hard drive, and DVD camcorders”
sidebar.

[ advise searching online for camcorder options. Apple will be happy to sell
you models at the store on its Web site, at www.apple.com. You can gener-
ally find excellent prices and a wide selection at www . bandhphoto. com. I
also recommend a visit to www . camcorderinfo.com and a sister site for
beginners at www . easycamcorders . com. These terrific resources feature
reviews, ratings, and primers.

When you purchase a camcorder, make sure you also get the proper USB
or FireWire cable to connect to your Mac. (They vary.) Just to confuse you,
FireWire also sometimes goes by the name iLink or IEEE 1394.

From Here to Eternity:
Camcorder to iMovie

Whether in high definition or not, you've shot scene after scene of amazing
footage (what could be more dramatic than junior’s first steps?). But remem-
ber Hitchcock’s creed about getting rid of the dull bits? iMovie can help you
do just that. First, though, you have to dump what you’ve captured into the
computer. You can achieve this in several ways, depending on the type of
camcorder, digital camera, or even camera phone you’re using. You can also
import movies that already reside on your hard drive, including stuff you
created in iMovie HD. And rest assured that importing video into iMovie does
not erase any of the scenes from your camera.
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Tape, hard drive, and DVD camcorders

Not all digital camcorders sold today are simpa-
tico with iMovie. MiniDV camcorders make nice
with Apple. These compact models, from such
leading manufacturers as Sony, JVC, Panasonic,
Canon, and Samsung, now start at less than
$200, though a few models fetch well into the
four digits; the MiniDV cassettes that you record
onto cost as little as $2 and dropping.

Sony is the only maker of Digital8 camcorders,
whose main benefits are low prices and the
ability to handle analog 8mm and Hi-8 tapes.
Consider this camera only if you have a sizable
library of analog media. You can choose from a
few Digital8 models. These cameras are bulkier
than their MiniDV compadres.

If you intend to edit in iMovie, steer clear of
another Sony camcorder type, Micro MV. The

cameras and tapes are appealingly small, but
they are pricey and aren't compatible with
iMovie. Where then to turn? Along with MiniDV
tape, the latest iMovie works with increasingly
popular tapeless models that record onto hard
drives, and flash memory. Some miniDVD cam-
corders work too, but they don't always include
USB or FireWire connectivity, and the disks
aren’t usable in Macs with slot-loading drives.
In scary movie techspeak, the latest iMovie
accepts imported video in the high-definition
formats AVCHD (provided you have an Intel-
based Mac), MPEG-4, and HDV, as well as
standard-definition MPEG-2 and DV formats,
and supports cinematic 16:9 widescreen and
standard 4:3 video.

Using a tape-based camcorder

Camcorders that employ MiniDV tapes, DV, or HDV connect to a Mac through

FireWire:

1. Connect one end of the FireWire cable to your camcorder and the
other to an available FireWire port on the Mac.

2. Switch the camcorder to VIR mode, shorthand for video tape recorder

mode.

Camcorders vary; some devices call this Play or VCR mode.

3. If all goes according to plan, an Import window such as the one shown

in Figure 16-2 opens. If it doesn’t open, choose File->Import from

Camera.

4. If you’re bringing aboard high-definition (HD) footage, in the 1080i
Import Setting dialog box select the size in which you are importing

the video.
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Figure 16-2:
The Import
window.
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In most instances you'll select Large. But for true broadcast quality or if
you plan on using Apple’s Final Cut Pro or Final Cut Express software,
go with Full. Just keep in mind that under the Full scenario you’ll be
gobbling up more disk space.

5. If you’re not importing HD video, click OK.

6. Use the mouse to move the on-screen switch on the left side of the

Import window to Automatic, and then click Import.

. From the dialog that opens, choose the drive where you want to store

the footage, and click to either create (and ultimately name) a new
Event or add to an existing one. Click OK.

We'll dig a bit deeper into Events later in this chapter.

. Click Import to rewind the tape to the beginning, import all footage,

and then rewind the tape again when finished.

You need not stick around and watch at this point but can if you want
to. Know that you’ll only hear the sound through your camcorder.

In Step 4 I told you to set the switch to Automatic. But if you want to
import only a portion of the tape in your camcorder, choose Manual
instead. Then use the playback controls in the Import window to navi-
gate to the section of the video where you want to start importing,
rather than from the beginning.
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Using a DVD, hard drive, or
flash memory camcorder

DVD, hard drive, and flash memory camcorders typically use USB rather than
FireWire. The biggest distinction compared to their tape cousins is that they
let you import videos clips no matter where they reside on the camcorder;
there is no need to follow a linear structure.

When you connect such a camcorder, the Import window opens, only this
time it displays all the clips stored on the device. Click Import All if you want
to bring aboard the entire batch. To selectively import clips, set the Import
window switch to Manual. Then deselect the clips you want to leave behind.
Click Import Checked when you’re ready.

If a bunch of clips are selected but you want to import a precious few, first
select Uncheck All and then select the clips you are interested in.

Patience is a virtue in the moviemaking business, so be mindful that it may
take some time for iMovie to grab all the video and generate thumbnail
images of each clip. A progress bar gauges how long your Mac will be at it.

Plugging a DVD camcorder into the Mac might cause DVD Player to wake up.
No big whoop. Just close it down.

Importing videos from other destinations

You may have video you want to use in your final blockbuster that’s already
on your hard drive. Perhaps it’s a project you previously created in iMovie
HD or video from a digital still or camera phone that resides in iPhoto. Or
maybe you want to incorporate video on a CD or DVD.

To import iMovie HD projects or others videos on your hard drive (or other
disks), choose FileImport Movies or File Import iMovie HD Project.
Either way, search for the location of the video in the Import window. As
before, choose where to stash the recording by making a selection in the
pop-up menu. And again decide whether to create a new event or add to an
existing one.

Videos you’ve already downloaded to your iPhoto Library are readily accessi-
ble in iMovie. Merely click iPhoto Videos in the iMovie Event Library list and
choose the event you want. The only caveat is that the video must be in a
compatible iMovie format.

The first time you open iMovie you may see the message shown in Figure
16-3. Click Now to generate thumbnails for the video in your iPhoto library or
click Later to postpone this time-consuming chore.
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Using an iSight (or another camera)
to record directly to iMovie

Of absolutely no surprise to anyone, iMovie works fine with video captured
by Apple’s own iSight cameras, be it the standalone version that Apple
stopped selling a few years ago or the kind built in to some current Macs.

As of this writing, iSight was not available in high definition, though for many
scenarios the cameras do just fine.

To record directly, connect your Web camera, camcorder, or iSight (if not
built-in) and click the Import button. If more than one camera is connected,
select the one you're calling into action from the Camera pop-up menu.
Click Capture to start recording your movie, and then follow the by-now-
familiar drill of figuring out where to save the footage and determining how
to organize it in Event Library.
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This may be the time to say thanks that you splurged for an extra-roomy (or
additional) hard drive for your Mac. Video consumes about 13 gigabytes for
every hour of footage (and I'm not even talking high definition). After you
finish your movie and put in on a DVD to share with family and friends,
discard the unneeded footage so you’ll have plenty of space for the sequel or
archive it to tape in case you need it again in the future.

Mastering Post-Production

Your raw footage is in place — all in a single unified iMovie video library. In
this section, you find out how moviemaking gets accomplished: by arranging
scenes and adding music, pictures, titles, transitions, and more. Get ready to
unleash your creative juices. Assembling a movie is where the real joy begins.

Staging events

As we’ve already seen, the video you import into iMovie is organized into
events. [ hope you provided reasonably descriptive names for these events:
My Little Girl’s Ballet Recital, Thanksgiving Pig-Out, whatever. If you didn’t
type a descriptor, iMovie will substitute one for you, something like New
Event 8-13-08. Come on folks, you can do better than that.

The iMovie Library groups all events by a given year. You can sort them by
hard disk instead (assuming you have more than one, of course) by clicking
the little button with a hard disk icon in the upper-right portion of Event
Library.

Here are some of the options you have for putting your own stamp on events:
1 Merge them: You can take video from multiple sources and place them

into one event. Merge Events by choosing FileroMerge Events.

v~ Split them: To split one event into two, click the clip you have in mind,
and chose File>Split Event Before Selected Clip.

v Drag them: To move a clip from one Event to another drag it to the title
of the new event in the Event Library. Hold down Option while dragging
and you copy the clip rather than move it.

Milking the Skimming feature

Skimming is one of the coolest and most useful innovations in the new
iMovie. By mousing over the dynamic filmstrips representing your footage,
you can skim through your entire video in a blink — faster than real-time
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anyway. Images move in both the filmstrips and the larger iMovie viewer.
Click the arrows on the keyboard if you'd rather advance or retreat frame by
frame. You’ll hear sound too as you skim through your video; the audio plays
backwards or forward, depending on which direction you skim.

You can mute the sound while skimming by clicking the skimming silencer
button on the toolbar (labeled in Figure 16-5 later in this chapter). Click
the button again to bring back the audio. You can deselect Audio Skimming
also in the View menu.

Turning off Audio Skimming does not affect the sound during normal playback.

Playing around with playback

You can play back your video from any starting point in several ways:
1 Place the pointer where you want to begin watching and press the
spacebar.
v+ Double-click to start playing from a given spot.
v Select part of clip and choose Viewr>Play.

To stop playing a movie, press the spacebar or click anywhere in the iMovie
window.

If you want to watch events from beginning to end, select any part of the clip
and choose View=Play from Beginning or press the \ key on the keyboard.

To admire your video full-screen, choose the part of the video you want to
watch and click the Play Full Screen button just below Event Library. As
shown in Figure 16-4, the button is next to the Play from Beginning button.
Press Escape to leave full-screen mode.

Click to play-full screen

Click to play from beginning

Show/hide Events list

Working with video

As noted, the individual segments or video clips that make up an entire event
look like filmstrips. A typical event has several clips.
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Figure 16-5:
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The length of a clip has to do with when you (or whoever recorded the video)
started and stopped the camera. Video clips are represented by a series of
thumbnails, each a frame within a clip. The number of frames that make up a
second of video will vary, depending on the video format you chose when
shooting. You can select frame ranges to determine the video you are working
with; the range is designated by a yellow border. If you click a source video
clip, iMovie selects four seconds of video from the point you clicked. You can
change this default in iMovie preferences.

You can expand or shorten filmstrips by dragging a thumbnail slider to the
right or the left. And you can drag the yellow selection border to change the
frame range as well.

Matrking video

No matter how talented you are as a videographer, it will be evident as you

skim that some of your footage stands out above the rest, and other footage
is at best amateurish. You can mark video gems as favorites while rejecting

junk footage. Here’s how.

Select the frame range of the video portion you love and click the Mark as
Favorite button on the toolbar. It’s the black star shown in Figure 16-5. A
green bar appears at the top of the frame range. If you change your mind,
click the Unmark button.

If you want to reject a frame range, click the black X on the toolbar. This time
ared bar appears at the top of the frame range. Once again, click the Unmark
button if you change your mind. The videos aren’t totally rejected until you
move them to the Trash (and empty the Trash).

Voiceover
Crop, rotate and Ken Burns
Adjust audio
Open Camera Import Window Reject selection  Turn audio skimming on and off
Swap events and projects .
Display volume level for
Drag to adjust thumbnail size the video at the playhead

[EATE==rr" ol oDz lalsTo ) A==

Add selection to projectw Click for Music and Sound Effects browser
Mark selection as favorite Click for Photos browser
Unmark selection Click for Titles browser

Reject selection Click for Transitions browser
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In the small pop up box to the right of the Play buttons, you can sort or filter
the video shown in the library. You can show Favorites Only, Favorites and
Unmarked, All Clips, or Rejected Only. If you choose Rejected Only, you may
charitably give some of those clips a second chance.

Cropping video

Even under the best of circumstances — perfect lighting, subjects who
actually flash a smile, terrific camera, terrific camera person (that would be
you) — your video might need improvement. Here are a few tricks.

Just as you can crop a still image in iPhoto (see Chapter 15), you can high-
light an area of a scene or focus in on an otherwise distant subject. Be aware
that the crop applies to the entire clip:

1. Select a clip to crop and click the Crop, Rotate, and Ken Burns button.
2. Click the Crop button inside the viewer.

A green crop rectangle appears.

3. Using the rectangle’s out handles, resize it and drag it over the
crop-worthy portion of the image.

4. If need be, click one of the arrows to rotate the entire image in either
direction.

5. Click the Preview button to see what your newly cropped clip will
look like. Or click the Fit button to restore the clip to the full frame
and try over.

6. Click Done when you are satisfied.

Your cropped video might look grainy if you used a low-resolution camcorder
(or shot in low resolution). Press Fit at any time to undo the cropping.

Improving the sound

The sound in one video clip is barely above a whisper; in another you must
turn down the volume. Fortunately, you can tweak the audio in your video so
that the sound remains consistent from one scene to the next.

Start by clicking Audio Adjustments in the toolbar to display various slider
controls. If you want to adjust the volume of a single clip, select it and then
drag the volume slider to the appropriate level. Click Done when you have it
right or select another clip and repeat this little exercise in that one.
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You can always restore the volume to its original level by clicking the Revert
to Original button.

If you want to normalize the volume across all your clips, select a clip and
click Normalize Clip Volume. iMovie makes sure the clip is as loud as it can
be without distortion. Now choose another clip and do the same. The two
clips are now within the same normalized range. Keep normalizing clips in
this manner until they are all the way you want them.

Giving birth to a project

The video looks good; the sound is right. And now it’s time to bring every-
thing together in a project. Choose Filec>oNew Project and name your budding
blockbuster, something revealing like Alex’s Amazing Goal or Leslie’s
Breakthrough Monologue. (Video contained in one or more events tend to

be the building blocks of your project. Just select the source video clip and
click the Add to Project toolbar button. Alternatively, drag video to the area
where you want it to show up in the project.

Then choose an aspect ratio, movie jargon for the way the screen looks. Your
choices are

1~ Standard (4:3): For years, we all watched television. If you choose this
setting and watch your video on a modern widescreen high-definition
television, you'll see a black space on each side of the video, otherwise
known as a pillar box.

v iPhone (3:2): Go with this setting if you plan to watch the finished movie
on Apple’s popular smartphone or the iPod Touch.

1 Widescreen (16:9): This is the theatrical HDTV aspect ratio. If you
happen to watch 16:9 video on a standard TV, black spaces will appear
above and below the video to form what is known as a letterbox.

Now that you’ve mucked with your video and chosen the right moments
for your project, it’s time to apply the tonic that turns raw footage into
a multimedia marvel.

Adding music or sound effects

What would West Side Story be without Leonard Bernstein? Or A Hard Day’s
Night without the Beatles? Music is a vital part of most movies (even
nonmusicals). Here’s how to add a background score or other sound effects:
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1. Click the Music and Sound Effects button, which is on the right side of
the toolbar (or choose Window=>Music and Sound Effects).

On the lower right, the Music and Sound Effects browser shown in
Figure 16-6 appears.

Figure 16-6:
Adding
music and
sound
effects.
|

2. Click the source of your music or sound effects.

You have plenty of choices: ditties in your iTunes library, music you
composed in GarageBand, and dozens of canned Sound Effects,
including booing crowds, crickets, thunder and rain, and an electric
typewriter. Double-click a sound file to hear a preview.

3. Drag the music or sound effects file to the project background.

A green background appears at the beginning of the first clip and lasts
for the duration of the shorter song or video.

4. If you want to trim the music clip, choose Edit~>Trim Music.

5. Drag the selection handle to choose a spot where the video starts
and ends.

The video plays in the viewer to help you decide. Click Play to preview
the job.

6. When you are finished, click Done.

To remove the background music, select the music by clicking behind the
video clips, and press Delete.

Recording a voiceover

What would your epic be without a James Earl Jones or Gene Hackman
voiceover (you should be so lucky)? You can use your own pipes to narrate a
movie and add your voice pretty much anywhere you want in your video.
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Click the Voiceover button, which looks like a microphone, and then choose
your actual microphone (or sound input device) from the window that
appears. Drag the input volume slider so that it jives with the loudness of
your voice. You can select a Voice Enhancement box to electronically make
your voice sound swell. Remember that any sound in your video will be
heard as you record your own voice unless you mute it. Select the Play
Project Audio while Recording box if you need to hear sound as you record
your voiceover.

When you click the video frame in which you want to speak, the program
prompts you with a 3-2-1 countdown. Click anywhere in the project to cease
recording. You'll see a purple soundtrack icon in the video where your voice
will be heard. Did you stutter (as Jones famously used to)? Click Undo
Voiceover and try again.

The cutting room floor

From the get-go, some scenes are obvious candidates for the trash: the ones
with blurry close-ups, pictures of your shoes (when you forget to turn off the
camcorder), or grandma hamming it up for the camera.

Fortunately, you can trim unwanted frames from your project clips. Select
the clips you want to trim, and choose Edit=>Trim to Selection. Off they go.

If you have second thoughts, you can bring them back by adjusting the

clip’s duration or frame range as follows. Select the clip and then choose
Edit>Trim (or click the Clip Duration icon, which resembles a clock and
appears in the bottom-left corner of the clip). Your selected clip appears in a
trimmer, with start and end handles you can drag at either end. There are
other options:

v Move the start or end point frame by frame: Hold down the Option key
while pressing the left or right arrow key, respectively.

v Move the entire frame range selection frame by frame in the direction
you indicate: Press the left or right arrow key, respectively, without
holding down Option.

v Adjust a clip one frame at a time, without using the trimmer: Move the
mouse pointer to the end of a given clip and hold down the 8 and
Option keys. Drag the orange handles that appear to the left or right to
lengthen or shorten a clip duration, respectively, one frame at a time.

v Extend or shorten a clip a frame at a time, again without using the
trimmer: Move the pointer to the end of the clip and hold down the
Option key while pressing the left or right arrow key.

Click Play in the trimmer to preview your efforts, and click Done when you
are satisfied with the results.
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To peek at your edits in a jiffy, do one of the following: Place the mouse
pointer at the spot where you’ve made your fix and then press the left bracket
key. This plays one second of video before and one second of video beyond
the point where the change was made. Or press the right bracket key to play
three seconds of video before or after that point.

Adding transitions between clips

Moving from scene to scene can be jarring unless you add a smooth bridge.
In movie-speak, those bridges are transitions, and iMovie gives you a dozen to
choose from. Click the Transitions button in the toolbar or choose Window=>
Transitions. At your disposal are the various styles in the Transitions pane,
which is shown in Figure 16-7.

You may not know the names of all these transitions, but you've undoubtedly
seen ones such as Fade through Black and Cross Dissolve in movies and
television. You can preview others by placing the mouse pointer over them.

When you choose the transition you want, drag it between two clips in your
project. A black transition icon shows up. You can substitute one transition
for another just by dragging another transition over the icon.

Transitions are set to one half of one second by default, and a transition can
never last longer than half the duration of the shorter clip on either side

of it. All transitions in your video are the same length unless you dictate
otherwise by choosing Edit=>Set Duration; you can change the length of a
selected transition or all transitions in a project.

(Ao T[E)

T

Fade Through Black Fade Through White
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To use the same transition throughout your movie, select a project, choose
Files>Project Properties, and choose the transition you want in the pop-up
menu. Select the Add Automatically box. Deselect this option if you want to
edit or delete any transitions in your project.

Adding titles

Every good movie needs a decent title to hook an audience — even if the film
is all about your recent vacation and the only people watching are the ones
who took the trip with you. While we’re at it, add closing credits. You're the
person who put this darn thing together and you want some recognition.
Besides, selecting titles is easy:

1. Click the Titles button in the toolbar or choose Window>Titles.

2. Choose a title style from the ones that appear and drag it onto the clip
where you want a title.

You might choose Formal for a wedding video or Scrolling Credits for
the end of a movie. Pay attention to the purple shadow that appears
over the clip as you hover. It lets you know if the title will last for the
entire clip or just the first or last third. Once you've chosen a title, a blue
icon appears above the clip.

3. Replace the placeholder text in the viewer with your own text.
4. Click Show Fonts.

You can change the font, color, or style of text by applying selections in
the Font window. You can preview your work by clicking the Play button
in the viewer.

You can lengthen or shorten the screen time for a title. Move the mouse
pointer over either end of the title; when the pointer turns to a cross, drag to
the left or right. You can also drag the title to a different part of the clip or
have it straddle two clips. Make sure the pointer turns into a hand before
dragging the title.

Adding photos to a movie

Interspersing still photos inside your movie is a great way to show off your
artistic prowess. And you can add a bit of pizzazz by adding motion effects to
those pictures in what is known as the Ken Burns effect (named for the famed
documentary filmmaker and explained in Chapter 15). To do so:

1. Choose Window=>Photos or click the Photos button, which looks like a
camera in the toolbar.

2. Choose the photo you want from your iPhoto library or elsewhere.



Chapter 16: Shooting an iMovie Screen Test 28 7

You can search for pictures by name in the search field at the bottom of
the pane.

3. Drag the selected picture to where you want it to appear in your
project.

By default the picture will remain on the screen for four seconds and
apply the Ken Burns panning and zooming effect. You can dictate
otherwise, as noted in the next step.

4. To change a photo’s duration, click the Duration button in the lower-
left corner of a photo clip and type in the new time in seconds.

You see this Duration button when you move the pointer near the end of
the clip.

5. You can also alter the Ken Burns option by selecting a photo, clicking
Crop, and clicking Ken Burns.

Sharing Your Blockbuster

What good would The Godfather be if nobody could watch it? So it goes

for your classic. Take one last look at the movie you've produced so far.
Watch it in full-screen on your Mac. If it’s a wrap, it’s time to distribute it to
an audience — in a suitable format for the device you’ll use to view it.

Let’s explore the options in the iMovie Share menu:

v~ iTunes: Select this option if you plan on watching your finished project
on an iPod, an iPhone, an Apple TV, or a computer. You'll be presented
with various size choices based on the format that most makes sense,
Medium for an iPod; and Large for an HDTV (through Apple TV). After
making a selection, click Publish. Keep in mind that rendering a movie

V&“\NG! can take awhile, especially if you have chosen multiple formats.

If you didn’t shoot your original movie in high definition, a Large size
movie is not an option.

v Media Browser: The movies will appear in the size you've selected here,
in the Media Browsers of iDVD, iWeb, or GarageBand, as noted in Figure
16-8. Again, some size options won'’t be available if you didn’t shoot in
hi-def.

+* YouTube: The wildly popular YouTube site (owned by Google) has
come to practically define video sharing on the Internet. Add your
YouTube account and password, choose a category for your movie
(Comedy, Pets & Animals, and so on) and add the title (if not already
shown), description, and any tags. You can make the movie private by
clicking the appropriate box. Apple recommends using the Medium size.
Once published on YouTube, click Tell A Friend to spread the word.
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1 MobileMe Gallery: If you subscribe to Apple’s MobileMe service (see
Chapter 12), you can publish your movie right on the Web. Choose a
name, a description for your project, and an appropriate size. You can
decide whether to let everyone watch or keep the thing to yourself.
Select the Allow Movie to be Downloaded box if you will indeed allow
downloading.

1 Export Movie: Once again you get to choose a size before exporting the
movie to another location in the Finder.

v Export Using QuickTime: With this option, you can play the movie
back on other computers that have QuickTime. You have a lot of
options for choosing various compression and other settings. These
can get extremely technical, depending on your requirements and the
requirements of the people receiving your video.

v+ Export Final Cut XML: Use this option to send the finished project to
Apple’s professional-oriented video-editing program.

When iMovie and iDVD Get Together

iDVD is a program for authoring, or designing, a DVD. iDVD is tight with
iMovie (and, for that matter, with iTunes and iPhoto). You can exploit
Hollywood-style themes and click a Media button to add pictures and music.
As noted, you have to Share the movie in iMovie before you can do anything
with it in iDVD.

When you'’re ready to burn DVDs, call upon the SuperDrive in your Mac, or a
compatible third-party DVD burner. (Apple works with many types.) All
recent vintage Macs include CD burners, but not all have DVD burners. You
can also author to disk and burn later from another machine.

Let’s touch on a just few of the iDVD basics.
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Choosing a theme

iDVD is based on the concept of themes, menu designs for your DVD, with
differing background images, button styles, fonts, music, and animations.

Click the Themes button and scroll through the list on the right to choose a
theme that meets your requirements, such as the Vintage Vinyl theme dis-
played in Figure 16-9. Many iDVD themes have menus with motion and sound;
for example, the record in the record player shown here spins. You can turn
motion and sound on or off by clicking the motion button (it’s the one with
the two arrows that don’t quite complete a full circle) on the iDVD toolbar.

Many themes default to the widescreen 16:9 aspect ratio available on HDTVs
(and some analog TVs). These themes work also in the standard (4:3) format.
You can also choose themes from prior versions of iDVD (pre-7.0 themes).

You can drop content into designated drop zones. To add a movie to a drop
zone, drag it from the Media pane or elsewhere on the Mac. If you add a
movie with chapter markers, iDVD automatically creates a scene selection
submenu with a left-pointing arrow that serves as a Back button.

An iDVD slideshow

Want to create a DVD slideshow presentation? Follow these steps:

1. In the main iDVD window, click the + button and select Add
Slideshow.
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Figure 16-10:
Dragging
audio to

add a
soundtrack.
|
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w

4.

Double-click the My Slideshow button that now appears in the main
iDVD window.

That window is replaced with a drop zone requesting that you Drag
images here.

From the Media pane, drag an iPhoto album or individual pictures.

From the pop-up menus at the bottom of the screen, choose the dura-
tion your slides will appear and a transition to move smoothly
between slides.

Click Settings.
Select the options you want to add to the slideshow.

If you want slides to repeat, select Loop Slideshow. If you want to
display navigation arrows, select that option. You can also choose to
add image files to a DVD-ROM, show titles and comments, and stick
with the default setting to “duck” audio while playing movies. That
basically means any soundtrack you added fades out when the movie
audio is playing so that you can hear the dialog being spoken.

To add a soundtrack, choose Audio in the media pane and drag the
song you want onto the audio well, shown in Figure 16-10.

The Slide Duration pop-up changes to Fit to Audio. That way, the slides
and music start and end together. If you prefer, return to a duration of
your choosing (1, 3, 5, or 10 seconds).
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Burn

Altering buttons

DVD buttons are also meant to fit a particular theme. But if your ideas clash
with Apple’s, you can change the look of buttons by clicking the, um, Buttons
button. Buttons come in different shapes and sizes and customizable colors.
Buttons can be text-only or display video. A movie button is created when
you drag a movie from the Media pane onto the DVD menu screen.

Map view editing

Click the Map button at the bottom of the screen to switch to iDVD’s Map
view, sort of a bird’s-eye view of your project. You can quickly see

how menus and buttons are laid out and connected to one another, and
double-click the chart to jump to a particular scene.

OneStep DVD

OneStep DVD automatically rewinds the tape, imports your video, and burns
it to a DVD. Back when you first opened iDVD, you had the opportunity to
click OneStep DVD. To use it, connect your digital camcorder using FireWire,
set the camcorder to VCR mode, click OK, and insert a blank disc.

Making a Magic iDVD

Computers are meant to do a lot of stuff for you. So in creating a Magic iDVD,
you choose a theme and drop the movies and photos you want included onto
strips in the main iDVD window. iDVD takes charge from there, adding a main
menu with buttons for your flick, slideshows, and so on. Drop zones are auto-
filled with your stuff. You can edit the Magic iDVD before going on to burn
the project to a disc.

Baby Burn

You have reached a truly exciting moment. You are almost ready to burn
your DVD. To make sure everything is perfect, click Preview to see what your
DVD will look like. A little on-screen remote control functions like a regular
DVD remote so you can simulate the post-burning experience.
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[ also recommend checking out the wealth of information in the Project Info
window by choosing Project=>Project Info. You can make sure you’ve gone
with the right aspect ratio (standard or widescreen). You can see your encod-
ing choice (Best Performance, High Quality, Professional Quality). And you
can see the duration of your project, the capacity being used, and more.

Satisfied? Click the Burn button and insert a blank DVD. The burning process
takes awhile depending on the speed of your burner and the Mac itself. A prog-
ress bar lets you know how the operation is going before the disc finally pops
out. Don’t bother staring at the screen — you probably have better things to
do with your time. Like maybe writing your Oscar acceptance speech.
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The Show Must Go On

In This Chapter

Forming your own GarageBand

Putting together a GarageBand the easy way
Creating podcasts
Broadcasting your podcasts

Sharing your work

Do you fancy yourself the rock icon? Your face plastered on the cover
of Rolling Stone and Entertainment Weekly? Groupies stalking you
wherever you go? Your band’s very own tour bus? I know, it’s all about the
music. Whatever’s driving you, GarageBand ’08 is iLife’s digital recording
studio for making records, creating podcasts, and more.

If you're inclined to skip this chapter because you can’t distinguish an
F-sharp from a B-flat, take note: You need not read music, play an instrument,
or possess a lick of musical talent to compose a ditty through GarageBand.

Sure, having a good ear helps. And if you can belt out a tune, tickle the ivory,
or jam with the best of them, all the better. Connect a microphone, piano
keyboard, or electric guitar to the Mac, and exploit GarageBand to the max.
Although we’re only going to scratch the surface of all that GarageBand can
help you accomplish, this chapter should provide more than enough impetus
to send you on your way to becoming almost famous.

Forming a GarageBand

When you first launch GarageBand, you can choose to Create a New Music
Project, Open An Existing Project, Create New Podcast Episode, or start a
new feature known as Magic GarageBand. For now, we’ll stick with music.
[ address podcasts and Magic GarageBand later:
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. Launch GarageBand

MNew Project
Save As: My Song IZW
I Where: | [] GarageBand 7]
Figure 17-1:
And a one Tempo:
and a two Signature: ‘4.#'4751 Wbpm
and a three. Key: | C + | [ major |
Creating a
new project. T m—
|

The program is located in the Applications folder. Or click the dock icon
shaped like a guitar.

2. Click Create New Music Project.

. In the dialog box shown in Figure 17-1, enter a name for your song

and choose a location for the file (GarageBand is the defaulf).

. Set a tempo, or constant speed, by dragging the slider anywhere

between 40 and 240 beats per minute, or bpm.

. Choose a Time signature and a scale, or key, from the pop-up menus.

Don'’t fret if you don’t know what any of these musical designations
mean. Just stick with the defaults. You’ll learn as you go and can change
them later.

. Click Create.

The window that opens will look something like Figure 17-2.

Keeping on track (s)

Mastering GarageBand is all about getting comfortable with tracks (discussed

in this section) and loops (see the next section).

Most musical compositions consist of several tracks, or layers of individual
parts recorded by different instruments. You can connect instruments

to your Mac through one of the methods mentioned in the “Connecting real
instruments” sidebar or take advantage of more than 100 digitally sampled

software instruments, heard as you play a small on-screen keyboard (shown
in Figure 17-2) by clicking its keys with the mouse. You can choose a

wide variety of software instruments, in all the major instrument families

(percussion, brass, and so on).
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View/hide track
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When you open a new project, GarageBand introduces you to the first of
these software instruments, a grand piano. It appears by default in the tracks
list. It’s the instrument you will hear when you play that miniature keyboard.

<P From the GarageBand Window menu, you can also summon the Musical
Typing keyboard. The keys on your computer keyboard are matched to
certain notes. Keys in the middle row play the white keys of a piano. Keys
of the top row play the black keys.

To add a new track:

1. Click the Create a new track (+) button at the bottom-left corner of the
program, or choose Track->New Track.

2. Select Software Instrument or Real Instrument (see the “Connecting
real instruments” sidebar).

3. Click Create.

A new track shows up in the Tracks list, accompanied in the header by
its icon, name (Grand Piano until you change it), and several tiny con-
trols. Among other functions, these controls let you mute the track, lock
it to prevent editing changes, make it a solo, and permit or disable a
recording.
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In the Track Info pane shown in Figure 17-3, Software Instrument is high-
lighted. You can change your instrument selection from Grand Piano to any
other available instrument. To do so, choose an instrument category from
the left column of the Track Info pane (Pianos and Keyboards in this case,
as shown in Figure 17-4) and a software instrument in the right column

(Smokey Clav).

|
Figure 17-3:
Adding a
software
instrument
track.

|
Figure 17-4:
Adding a
real
instrument
track.
|
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Figure 17-5:
Installing
extra
instruments
and loops.
|

You can open the Track Info pane anytime by clicking the little i icon at
the bottom-right corner of the screen. Alternatively, choose Track=>Show
Track Info.

If the instrument (or loop) you clicked appears dimmed or is not available,
a window such as the one shown in Figure 17-5 pops up. You’'ll have the
opportunity to download and install the missing instruments and loops,
provided you have sufficient space on your hard drive.

If you selected a real instrument in Step 2 (refer to Figure 17-4), choose an
Input (stereo or mono, channel 1 or channel 2), depending on how the instru-
ment is connected to the Mac. Select Monitor from the pop-up menu to be
able to hear the instrument as you play it. If the real instrument you’re choos-
ing is your own voice, choose Vocals and the instrument that most closely
matches your style, such as Epic Diva, Helium Breath, or Megaphone.

The latest version of GarageBand displays the names of the chords you play
through a software instrument. In the Control menu, choose Show Chord in
LCD or click on the icon to the left of the LCD until a tuning fork is shown.

If not already shown, you can access the Visual EQ (equalizer) and other tools
in the Track Info pane by clicking the right-pointing Details arrow at the
bottom of the pane. If the equalizer and other effects (Reverb, Echo, and so
on) are already visible and you don’t plan to change them, click the down-
pointing Details arrow so they all disappear.

The Software Instrument or Apple Loop selected is not currently
I installed on your computer. Would you like to install the complete
i set of GarageBand instruments and loops?

Choose from the following:

(*) Download Now
Choose “Download Now" to download and install the additional content
via the internet using Software Update.

() Download Later
Choose "Download Later” for the additional content to appear in the
Software Update window the next time you open Software Update.

To download the complete set, you must have access to the Internet, and have at
least 1.2 gigabytes of storage (or "free disk space") on your computer. The set will
download and install automatically. After the download is complete, you must
restart GarageBand to use your new Software Instruments and Apple Loops.

Click "OK' to begin.

Cancel OK
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Getting loopy

Don’t let the heading scare you, I'm not advocating alcohol. I'm merely
suggesting you might become artistically intoxicated experimenting with
GarageBand loops, the professionally recorded (and royalty-free) musical
snippets at the very foundation of your composition.

Loops supply drum beats, rhythm parts, melody lines, bass sections, and so
on. Apple includes more than 1,000 loop files with GarageBand. You can add
thousands more by purchasing optional $99 Jam Packs (covering Remix
Tools, Rhythm Section, Symphony Orchestra, World Music, and the newest
addition, Voices).

Click the button that looks like the famous CBS eye logo to open the loop
browser across the bottom portion of the screen. You can view the loop
browser by columns, buttons (as shown in Figure 17-6) or podcast sounds.

Search for loops inside the browser by instrument (Bass, Guitars, Strings,
and so on) genre (Rock/Blues, Urban, Country), mood (Relaxed, Intense,
Dark), or combinations of these. Incompatible loop buttons are dimmed.

The list of loop possibilities shows up on the right side of the browser. Click
one of them to check it out, conveniently in the project’s key and tempo.
Most usefully, you can audition loops while the rest of your project is playing
to hear how all the tracks blend. If the loop passes muster, drag it onto the
timeline. Individual tracks and loops make up the rows of the timeline. To
add a new loop, click Reset in the loop browser and make another selection.

Figure 17-6:
In the loops.
|
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The musical patterns in loops repeat (why do you suppose they’re called
loops anyway?). You can also tug on the right edge of a loop to lay down a
track for the entire song. Loops don’t have to start at the beginning of a
track; and if you want to change the mood midstream, you can add a second
loop onto the same track. If you want more than one loop to play in a song
(which is typical), create multiple tracks.

The beat ruler above the timeline serves as a guide; it displays beats and
measures, the latter is how the units of musical time are, um, measured.

If you go by the name, I dunno, Bono or the Boss, you can create loops from
your own performances. Select a real or software instrument in the timeline.
Choose Edit=>Add to Loop Library. Then type a name for the loop, choose a
scale and genre (from the pop-up menus), decide whether this is a one-shot
deal, and choose an apt Mood Descriptor. Click Create when finished.

Building an arrangement

Adding loops or recording your own musical pearls (with real or software
instruments) creates a region in a track. Regions are color-coded as follows:

v Purple: Real instrument regions you record
+* Blue: Real instrument regions created by loops
v Orange: Real instrument regions from imported audio files

+* Green: Software instrument loops from recordings or loops

Regions can be cut, copied, and pasted, or resized to play as long as you
need them to. You can also move regions to another track or another area
of the timeline.

The latest GarageBand adds an arrange track to help you organize the struc-
ture of your composition. You can define sections (intro, verse, chorus,
bridge, and more) and resize, copy, and drag them around in any order that
makes sense. When you move a section, all associated tracks for that region
move too. Choose Trackm>Show Arrange Track to get started.

Multitake recording

If you're a perfectionist, you can keep recording part of a composition until
you feel your performance is just right. Choose the section of the song you
want to work on by clicking the cycle mode button (labeled in Figure 17-2).

A yellow cycle region appears below the beat ruler. Drag and resize it so that
its left side aligns with the area you want to start recording and the right side
aligns with where you want the region to end.
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Connecting real instruments

If you'd rather not use the on-screen music key-
board to control software instruments, you can
connect a real MIDI keyboard through a USB
cable (on most newer gear) or a MIDI adapter
(on older equipment). MIDI is geek shorthand
for Musical Instrument Digital Interface, a
standard that has been around for years. You
can connect other MIDI instruments, including
guitars, woodwinds, and drums, and record
onto a real instrument track in GarageBand.
Click the red record button when you're ready
to rock. Move the playhead to just before where
you want to start jamming.

If the high-quality instrument you have in
mind is your own singing voice, connect a
microphone (in lieu of the Mac's built-in micro-
phone) to the audio input port on the computer.
Open System Preferences, click Sound, click
Input, and then select Line In. Drag the Input
volume slider to an appropriate level. Good
microphones are especially useful when
you're recording podcasts, as discussed later
in the chapter.

A\

Press record to start recording the appropriate track. The playhead moves
across the region and then starts over again and again. Click Play when you
want to stop recording.

When you are finished, a circled number appears in the upper-left corner of
the cycle region, indicating the number of the active takes or the last take
you recorded. So if you recorded five takes, the circled number is 5. Click
play to hear that take, or click the circled number (5 in this example) and
choose another take from the Take menu that pops up. After auditioning all
your takes, you can delete the ones you have no use for.

You can take the best performance from one take and combine it with
another. To do so, select the cycle region and move the playhead to the point
where you want to seamlessly transition from one take to another. Choose
Edit, Split and then assign each take as before.

Mix it together, maestro

Easy as Apple makes it to lay down tracks and add loops, you won’t become
Quincy Jones overnight. Fact is, even when you match tempos and such,
some music just doesn’t sound good together. I didn’t have much success
blending a Classic Rock Piano with a New Nashville guitar. Mixing or balanc-
ing all the parts so that one track doesn’t drown out another is another
challenge. You can find various mixer controls and level meters under the
Mixer (labeled in Figure 17-2).
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Figure 17-7:
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Notation
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You may want to display your composition with standard notes, clef signs,
and so forth. Select a software instrument region and open Track Editor

by clicking the button at the lower-left corner of the screen. Click the
notation view button (it has a musical note on it) in the lower-right corner
of the editor’s header area and start composing. Notation view is displayed
in Figure 17-7.

You can print professional looking sheet music of your composition by
choosing File>Print in the GarageBand menu.

_ GarageBand  File Edit Track Control Share  Window  Help D 4 = 4 @R Tuel200PM O

Magic GarageBand

If you can read the notes in Figure 17-7, you’ll quickly recognize I'm not a real
musician or composer. (Hey, [ was a great clarinetist in junior high.) I sup-
pose Apple had folks like me in mind when it added a new Magic GarageBand
feature to GarageBand. The idea is to let you conduct a virtual band.

Choosing Magic GarageBand from the opening GarageBand menu displays
the stage shown in Figure 17-8. Below the closed curtain are nine icons,
representing Blues, Rock, Jazz, Latin, and other styles of music. You can
preview a song snippet or the entire ditty in the genre of your choice by
clicking Play and choosing Snippet or Entire Song.
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Magic GarageBand

Figure 17-8:
Waiting for
a Magic
Garage-
Band -
show. Snippet _ " Entire Song @ o e T :

Click the Audition button to see the instruments used in the song. You can
change one or more by clicking an instrument to select it — every time you
mouse over a different instrument a spotlight appears over your selection, as
Figure 17-9 shows. Choose an alternative instrument from the list below the
stage. When your virtual band is just as you like it, click Create Project. The
regular Garage Band window takes over, with appropriate tracks and regions
for your selections.

.M. Magic GarageBand

| |
| 2 / / AT A - < ®
Figure 17-9: [IEE ‘ ¢ @ o ¢ ¢ € d
. Jangle  Strumming HonkyTonk  Punk  Windmills  Big Stack clam None
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curtain. | Change Genre | Snippet (T Entire Song P ) by Create Project
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Creating Podcasts

Figure 17-10:
Your
podcast
broadcast
studio.
|

Podcasts are like your own Internet radio or TV show, with music (from
iTunes or elsewhere), pictures, sound effects, video, or some combination of
these. Fans can find your podcasts on the Net (or in iTunes) and subscribe
to receive them regularly. Podcasting was introduced with GarageBand 3, so
don’t try the steps in this section with an earlier version of the program.

Here’s how to put a polished podcast together.

1. From the opening GarageBand screen, click New Podcast Episode.
2. Type a name for your podcast.

The main screen looks like Figure 17-10. It’s a little different from the
GarageBand screen for music. At the top of the tracks list is a special
Podcast Track to drag photos or other artwork from your iPhoto Library
(or elsewhere), accessible through the GarageBand media browser.
Next are tracks to optimize for a male or female voice, plus Jingles.

3. If you haven’t already done so, plug in your microphone.

4. Choose an audio track (Male or Female) and click the red record
button. Start gabbing using your finest radio voice.

You can apply editing tweaks later.
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5. To add a radio-style jingle to your podcast:
a. Open the loop browser (by clicking the button that looks like
an eye).
b. Select Jingles.

c. Choose a jingle that seems appropriate for your podcast and
drag it onto the timeline.

More than a hundred jingles are included. If you're delivering news
commentary, for example, one of the Broadcast News jingles (Long,
Medium, or Short) might fit the bill. Just click to hear a sample.

. To add extra audio effects:

a. In the loop browser, choose Sound Effects (everything from an
airplane landing to an alarm clock bell) or Stingers (cartoon
chipmunk to comedy horns).

b. As with any other loop, drag Sound Effects onto the timeline.

. To add artwork to your podcast, drag pictures from the Media browser
onto the podcast track.

A chapter marker is added for each picture in a window near the bottom
center of GarageBand.

Folks who listen to your podcast on iTunes or photo-capable iPods can see
the images. You can add URLs to those pictures. To add a visual title to your
podcast, drag the artwork to the Episode drop zone in the bottom-left corner
of the GarageBand program.

Ducking

At times you want to decrease the volume of your background tracks so you
can hear spoken dialogue. The answer is a, um, quack-pot solution called
ducking. (Sorry. Couldn’t resist.)

Your very own talk show

fest. If it's a video chat, GarageBand adds a
new region to the podcast track each time that

A podcast doesn't have to be just about you.
You can host a talk show. With GarageBand

open, start an audio or video chat through iChat,
and click the record button. You'll be asked
whether you want to record the conference.
Click OK. GarageBand creates an instrument
track for each personin your audio or video gab

person starts to speak and grabs a still image
from the iSight camera. That mug is displayed
as artwork. Recording iChat conferences
requires Mac 0S X version 10.4.4 or later.
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Choose Control=>Ducking. In each track’s header, an arrow control appears.
Select the up arrow to make a track a lead track and the down arrow to
make it a backing track. When ducking is on, the sound on backing tracks is
lowered whenever sound is detected on a lead track. You can adjust the
amount of ducking by choosing Track=>Show Track Info, clicking Details, and
then dragging the Ducking Amount slider.

Importing video

GarageBand lets you take advantage of the epic you created in iMovie or
some other QuickTime-compatible video file on your computer. Use

Media Browser in GarageBand to import files located in the Movies folder.
(Here’s where you might apply some of the audio editing in iMovie HD that
was removed in the new iMovie, as discussed in the previous chapter.)

Such files appear as a movie track at the beginning of your GarageBand
project — you cannot change this starting position, nor can you have more
than one video or movie file in a project. If a movie track is already in the
project, you’ll have the option of replacing it with the new footage.

As before, you can record narration, add audio, and add music (through real
or software instruments). You can also add chapter titles and a URL marker.

You won’t be able to open an iMovie in Garage Band until you prepare it for
sharing in iMovie. From iMovie, choose Sharew>Media Browser.

Sharing Your Work

It’s great that you're so creative. But what good does it do you if no one
notices? Fortunately, you can share your GarageBand jewels with your
soon-to-be adoring public in several ways.

Sharing podcasts

When you’re ready to share your podcast you have a few options, each
appropriately found in the Share menu. Click Send Podcast to iTunes to

do just that. Or click Send Podcast to iWeb to do that. In iWeb, the podcast
automatically becomes a blog entry. From iWeb, you can publish your
podcast to MobileMe.

You can also submit your podcast to the iTunes Store. Your podcast is
available free to your awaiting public:
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Figure 17-11:
Using iWeb
Inspector
with your
podcast.
|

1. Click Inspector in the iWeb toolbar (it’s on the bottom right of the
screen), and then click the RSS button to open the Blog & Podcast
window, shown in Figure 17-11.

2. Add the Series Artist name and Contact Email.
Your e-mail address will not show up in iTunes.

3. In the Parental Advisory pop-up, indicate whether your podcast is
Clean or Explicit.

4. Select the Allow Podcast in iTunes Store option.

5. Choose Filec>Submit Podcast to iTunes.

6. Enter copyright information, a category for your blog (Kids & Family,
Science & Medicine, and so on), the language, and again indicate
whether it is Clean or Explicit.

Here’s an example where Apple wants to be PC, as in politically correct.
7. Click Publish and Submit.

You are responsible for owning or getting permission for any copyrighted
material associated with your podcast. Apple maintains the right to pull
the plug.

You have a few ways to share video podcasts. You can send a movie to
Apple’s iDVD program by choosing Share>iDVD. You can send the podcast
to iWeb for publishing on the Internet. Or you can export it as a QuickTime
movie.

0O 0O 0O  Blog & Podcast

hE 28T 008
{ Blog Podcast

Podcast Series

Series Artist

Contact Email

Parental Advisory
| None

MAilow Podcast in iTunes Store

Podcast Episode
Duration: 0:00 Minutes
Episode Artist

Parental Advisory

| None o

E‘A!Iow Podcast in iTunes Store




Ring my chimes

You know those clever ringtones you hear on
cell phones? You can create your own ringtone
for an iPhone in GarageBand and send it to
iTunes. Choose Share=>Send Ringtone to
iTunes. Kindly note that a ringtone needs to be

a repeating section of a song that is forty sec-
onds or less. You can make this happen manu-
ally by clicking the Cycle button or automatically
by clicking Adjust.
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Sharing music projects

You can send a song — or an iPhone ringtone (as noted in the “Ring my
chimes” sidebar) — you created in GarageBand directly to a playlist
in iTunes.

Choose Share=>Send Song to iTunes and choose the compression (typically
AAC Encoder) and Audio Settings (Good Quality, High Quality, Higher
Quality, or Custom) you want. Then click Share.

You can send a single track (or group of tracks) instead of a complete song
to iTunes. Just mute all the tracks you don’t want to send before sending the
ones you do want.

You don’t have to export your ditty to iTunes. You can send it as an audio file
by choosing Share=>Export Song to Disk.

Still another option for your composition is to burn the song to a recordable
CD. Just place a blank disc in your Mac’s optical drive, choose Share=>Burn
Song to CD, choose the settings you want, and click Burn.

You can burn only one song to a CD this way. To burn multiple songs, create
or add them to an iTunes playlist first, and then burn the playlist to a CD
via iTunes.

Whichever way you go, remember, the show must go on. Groupies are
waiting.
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survounded by flaming wWorkstations with the

word, ‘Motherboard’ scrolling underneath.”




In this part . . .

Sooner or later [ was going to run the technical
mumbo-jumbo by you. Fortunately, it’s not nearly as

painful as you might think.

So read on about the virtues of wired and wireless net-
working. Find out how to turn your Mac into a, gosh,
Windows PC. Figure out what to do when your Mac
behaves irrationally. Within limits, you too can become a
Mac fixit man or woman.




Chapter 18
Networking Madness

In This Chapter

Understanding wired and wireless networks
Sharing basics
Brushing up on Bluetooth

n some ways, a treasured Mac is like a baby. The machine is loved,

pampered, even spoiled. But the reality for most of us is that our chosen
computer is but one among many. It may very well have siblings, um, other
computers in the house. Or your Mac may reside in a company or dormitory,
where it almost certainly has to get along with other computers. If you've
bitten into one Apple, you've perhaps bitten into others. For that matter,
chances are quite good that the Mac must share quarters with a Windows
machine. It’s such a brave new world that your Mac may even sit next to a
computer that runs the operating system known as Linux.

In the ideal computing environment, the various machines can share files,
data, music, printers, an Internet connection, and other resources. That’s
what networking, or the practice of connecting multiple computers, is all
about. Although networking topics are as geeky as any you’ll come across,
Apple, in customary fashion, simplifies it as much as possible.

Networking Done Right

There are many right ways and a few wrong ways to network computers. In
this day and age, you can set up a wired or wireless network or, more than
likely, a combination of the two.

Two or more interconnected machines in the same proximity form what geeks
commonly refer to as a local-area network, or LAN for short. Contrast that with
a wide-area network, or WAN.

I'll start with the traditional tethered approach to putting together a network.
You'll be that much happier when you're liberated from wires later.
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The wired way

If the Macs you intend to network are almost always going to stay put in one
location, the wired approach is arguably the best way to proceed. Wired
networks are zippier, more secure, not as prone to interference, typically less
expensive, and arguably the easiest to set up, unless dealing with a mess of
wires becomes, well, a real mess.

In Chapter 2,  introduce you to Ethernet, the data cable whose end looks likes
an oversized phone plug. Such cables also go by the names CAT-5, 10BaseT, or
100BaseT.

Up for more geek terminology? The connector at the end of an Ethernet cable
is called RJ45, not to be confused with RJ-11, the connectors that are put to
use in telephones. RJ stands for Registered Jack, which is probably only useful
if asked in a game of Trivial Pursuit.

To get started with a wired network, plug one end of the cable in to the
Ethernet port included in all modern Macs (save the MacBook Air, where an
Ethernet dongle is an optional accessory). The other end typically plugs in to
an inexpensive network hub, switch, or router, which in turn is connected to
the box feeding your Internet connection, usually a broadband cable modem
or DSL.

Although there are technical distinctions between hubs, switches, and rout-

ers (and routers usually contain built-in hubs), I'll use the terms interchange-
ably here. In any case, routers contain multiple jacks, or ports, for connecting
each Mac (or other computer) or printer that becomes part of your network.

Cutting the cord

Certain benefits of technology are so obvious they practically explain them-
selves. Wireless is one of those liberating technologies. By eliminating cables,
you can

v Wander around with a laptop and still hold on to a connection.

v Drastically reduce the tangle of cables and cords, so the area behind
your desk won’t be nearly as untidy.

v Easily add on to the network later, without worrying about connecting
cables.

1 Access other wireless networks outside your home or office, through
public or private hotspots (found in numerous coffeehouses, airports,
libraries, parks, and elsewhere). Accessing these hotspots may or may
not be free.
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Landing safely at the AirPort

All the Macs introduced during the last several years are capable of exploit-
ing wireless networking through radio technology that Apple brands AirPort.
Most of the rest of the computing world refers to the core technology as
Wi-Fi, as outlined in the “ABCs of Wi-Fi” sidebar.

If you have a Mac without built-in wireless, you can install an optional $49
AirPort Extreme card. Make sure you have OS X version 10.2.7 or later. Also
note that AirPort Extreme is not compatible with Power Mac G5 Dual and
Power Mac G5 Quad computers introduced in October 2005.

Macs with built-in wireless communicate over the air — even through walls
and at times considerable distances — with a compatible router or base
station.

As of this writing, Apple sells a $179 AirPort Extreme Base Station with
Gigabit Ethernet, and a $99 AirPort Express Base Station, Apple also sells two
versions of what it calls Time Capsule, which weds an 802.11n AirPort
Extreme base station with a wireless Time Machine-capable hard drive for
networked backups. (See Chapter 13 for more on Time Machine.) A Time
Capsule with one terabyte of storage commands $499; a 500GB version, $299.

Apple grounded the first-generation AirPort base station model and cards,
though you can still find them on eBay. The cards may be your only salvation
if you hope to go wireless on an older Mac.

Although Apple would love to sell you an AirPort base station, wireless-
capable Macs can also tap in to routers produced by the likes of Belkin,
D-Link, Linksys, and Netgear, even if you previously set those up to work
with a Windows network. Windows machines can also take advantage of an
AirPort base station.

The latest AirPort Extreme has five ports as follows:

v A single Ethernet Wide Area Network, or WAN, port
v Three Ethernet Local Area Network, or LAN, ports
v A single USB port

The contraption also incorporates technology called MIMO. Although it
sounds like a moniker you’'d slap on a robot, MIMO stands for Multiple In
Multiple Out. All it means is you should get excellent range in your home,
office, or wherever you are setting up your wireless network. The range and
speed of any wireless network is affected by all sorts of factors, including
interference from other devices, concrete, and metal walls.

A combination of up to fifty Macs or Windows PCs can simultaneously share
a single AirPort Extreme base station.
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ABCs of Wi-Fi

The underlying technology behind AirPort is
called Wi-Fi, the friendlier moniker applied to
the geekier 802.11 designations. “Eight-oh-two-
dot-eleven” (as it's pronounced) is followed by
a letter, typically b, g, or n. These letters indi-
cate the speed and range you can expect from
your wireless configuration. Alas, the geek
alphabet makes little sense. Indeed, a few years
ago, products that met a wireless standard
called 802.11a hit the market after those based
on 802.11h. And here you thought you had
learned your ABCs by kindergarten?

AirPort Extreme measures up to the speedy
modern draft 802.11n standard. This newer
standard is backwards compatible, meaning

products based on it will work with older gear,
though not to its fullest potential.

Keep in mind that when it comes to Internet
downloading and uploading speeds, the limiting
factor is your Internet provider or the site or
server that you are trying to connect, not the
maximum networking speeds that your Wi-Fi
gear is capable of. Faster networking speeds
refer to how swiftly files are delivered from one
computer to another device on the network,
which is important if you want to transfer, or
stream, sizable video files. But you won't surf
the Net any faster than the signal coming in
from your ISP.

You can set up a network with AirPort Extreme in several ways. Here is the

most common method:

1. Connect the Ethernet cable hooked up to your cable or DSL modem to
the WAN port on the base station.

See, not all cords are eliminated in a wireless scenario. There’s no
power switch; status lights are your only immediate clue that your

AirPort has taken off.

2. Connect any additional Ethernet devices to the LAN ports.

3. If you want to network a USB printer, connect it to the USB port on the
AirPort. You can also connect a USB hard disc to store or share files or

hub.

4. Plug the AirPort Extreme to a power outlet.

AirPort Extreme doesn’t have an on-off switch. It will come alive when
you plug it in; the only way to shut it down is to pull the plug.

5. To go wireless, run the AirPort Utility setup assistant software, found
in the Utilities folder inside the Applications folder.

This step involves responding to a series of questions on what to call
your network, passwords, and so on. You may have to enter specific
settings from your Internet provider, along the lines of a static IP
address or DHCP client ID. Through the AirPort Utility software, you
can manually apply various advanced security and other settings.
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< «3) 4 You can determine the signal strength of your wireless connection by
examining the radiating lines icon in the menu bar pictured here.

Boarding the AirPort Express

It looks kind of like a power adaptor that might come with an older Apple
laptop, right down to its built-in plug (see Figure 18-1). But the rectangular
near seven-ounce AirPort Express device is a versatile little gadget. This
portable hub has just three ports on its underbelly: Ethernet, USB, and an
analog/optical audio minijack.

Figure 18-1:
The portable
base
station,
AirPort
Express.
|

Courtesy of Apple

If you plan on using AirPort Express as a router, plug the device in to an AC
outlet and connect an Ethernet cord to your cable modem or DSL. You'll use
the same AirPort software as the Extreme base station.

<P There’s no on-off button; status lights clue you in on how things are going. A
steady green status light tells you that you’ve connected with no problem.
Flashing amber means the device is having trouble making a connection and
you may have to resort to other means, including (as a final resort) taking
the end of a straightened paperclip and holding down a reset button for ten
seconds.

Here’s what the newest AirPort Express can accomplish:
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v As mentioned, connect it to your cable modem or DSL and use it as a
wireless 802.11n router, just like its larger sibling.

v Use it as a wireless bridge to extend the range of an existing AirPort
network to, say, your attic or backyard.

This process, known as creating a WDS (Wireless Distribution System),
has a potential downside: It could impair the performance of your
existing network. Open the AirPort Setup Assistant software and follow
the on-screen instructions.

v Connect a printer to the AirPort Express USB port to share that printer
with any computer on the network.

v+ Connect a cable from the broadband box in a hotel room and roam
around the room and surf wirelessly.

AirTunes

One more clever feature is available, and it involves the aforementioned
audio minijack. If you connect AirPort Express to your home stereo receiver
or powered speakers, you can pump the music from your Mac (or Windows)
iTunes library through your stereo system. You can use either a ministereo-
to-RCA cable or a minidigital, fiber-optic TOSLINK cable, if your stereo can
accommodate that kind of connector.

Either way, iTunes detects the remote connection. Through a small pop-up
menu, you can click Computer to listen to music through your Mac (or what-
ever speakers it is connected to) or you can listen through Express and
whichever speakers or stereo it is hooked up to. Apple refers to this wireless
symphony as AirTunes.

Apple will sell you a kit with these optional (Monster brand) cables for $39.
For about $60, Apple will also sell you a Keyspan Express remote control.
Absent such a remote, you'll have to race to the Mac with iTunes to determine
which songs will play through the stereo. The Keyspan remote control’s
“receiver” connects to the USB port on the AirPort Express device.

Better still, if you have an iPhone or iPod Touch, download Apple’s free
Remote application from the App Store. It controls AirTunes (along with
AppleTV and iTunes).

Testing your network

With all your equipment in place it’s time to make sure everything works as it
should. Fortunately, testing your network is as easy as opening Safari and
seeing whether you can browse.
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If you run into problems, click the signal strength icon in the menu bar and
make sure an AirPort network or other router is in range.

If you're still having trouble, open System Preferences under the % menu and
choose Network. Click the Assist Me button, and then click Diagnostics in the
dialog box that appears. You can check the status of AirPort and Network
Settings, your ISP, and so on.

If you live in an apartment building or are right on top of your neighbors,
their routers may show up on your Mac’s list. In some instances, the signal
will be strong enough so that you may piggyback on their setup, not that 'm
advocating doing so. Let this be a lesson that they should have implemented
their security settings (requiring robust passwords) and that you should do
the same when setting up your Wi-Fi network.

Let’s Share

Responsible parents teach kids how to share toys. When the youngsters grow
up and their toy of choice is a Macintosh, with any luck they’ll still be in that
sharing frame of mind.

Anyway, with your networking gear in place, do the following:

1. Choose ®>System Preferences.
2. In the Internet & Network section, click Sharing.

The pane shown in Figure 18-2 opens. You may want to change your
computer name at this point. Calling it Edward Baig’s iMac, as 1 do,
makes it sound like “it’s my computer, and you can’t play with it.”
Naming it Basement iMac would help you distinguish the computer from,
say, Bedroom MacBook Pro.

3. Select the various sharing preferences you feel comfortable with.

If you select File Sharing, users of other machines can access any Public
folders on the Mac. If you change your mind about sharing — you may
feel uneasy about having just anyone on the Net read those publicly
available files — deselect the box.

Other Mac users can access your machine by choosing Go=>Network in the
Finder.

If you're a MobileMe subscriber who plans on taking advantage of the Back
to My Mac feature (see Chapter 12), make sure to select the Screen Sharing
option.

317
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Sharing
<> Show All Q
Computer Name: |Edward Baig's iMac
Computers on your local network can access your computer at. (Edit... )
Edward-BaigsiMac.local e
On | Service @ DVD or CD Sharing: On
[ DVD or CD Sharing This allows users of other computers to use this computer's DVD or CD
¥ Screen Sharing drive remotely.
™ File Sharin
— 9 ¥ Ask me before allowing others to use my DVD drive
¥ Printer Sharing
1 Web Sharing
[1  Remote Login
[l Remote Management
[1 Remote Apple Events.
[]  Xgrid Sharing
Internet Sharing
| @ Bluetooth sharing
Figure 18-2:
’ .
It's polite
]
tO Share' J-ﬂ Click the lock to prevent further changes. /:_’\
|

Brushing Up on Bluetooth

Of all the peculiar terms you come across in the tech world, Bluetooth is
probably my favorite. The name is derived from tenth-century Danish
monarch Harald Blatand, evidentially the wireless networking champ of his
time. Blatand was considered a peacemaker in warring Scandinavia, and
isn’t networking after all about bringing people — or things — together? In
any case, Blatand apparently translates to Bluetooth in English.

Fascinating history, Ed, but I thought I bought Macs For Dummies, not European
History For Dummies. What gives?

Fair point. Here’s the drill: Bluetooth (the technology, not the Viking king) is
a short-range wireless scheme that lets your Mac make nice with a gaggle of
compatible gadgets, from up to thirty feet away.

Among the tricks made possible with Bluetooth:

v Connect the Mac to a Bluetooth cell phone. If you don’t have access to a
Wi-Fi hotspot, you may be able to use the phone as a modem to connect
wirelessly to cyberspace.

v Wirelessly print through a Bluetooth printer.

v Exchange files with another Bluetooth-ready Mac or other computer or
gadget.

v Schmooze via iChat through a Bluetooth headphone.
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v Synchronize data with a Palm-based handheld or other mobile device.

v Control a wireless Bluetooth keyboard or mouse.

Newer Macs come equipped with Bluetooth capabilities. Companies such as
Belkin and D-Link sell Bluetooth USB adapters in the $25-$40 ballpark for
older computers that lack the capability.

Getting discovered

The path to a meaningful Bluetooth experience starts in System Preferences.
Click Bluetooth under the Hardware section, and you're taken to the area
shown in Figure 18-3.

Before the Mac can communicate with a Bluetooth device or vice versa, the
machine’s Bluetooth feature must be powered on. To help other devices find
your Mac, select the Discoverable option.

<P Similarly, you’ll want your other Bluetooth devices to be placed in a
Discoverable mode so that your Mac can communicate with them. But be
wary. If you're out in public, you may want to turn off Discoverable mode for
security or privacy reasons.

Click Advanced for more control over your Bluetooth behavior. You can

v Open the Bluetooth Setup Assistant at startup when your Bluetooth
mouse or keyboard aren’t recognized.

v Allow a Bluetooth keyboard or mouse to wake up a sleeping computer.

Bluetooth
<[> || Showall Qwind

e? “Edward Baig's iMac” is the name Bluetooth devices use to connect to this computer

¥ on ¥ Discoverable
Type Keyboard
I (e Services Apple Wireless Keyboard
. L paimOne Device raired ﬂ Yes
Flgure 18-3: = o Not Connected Connected ® Yes

Control Jdreloan ks
everything 00-04-53-0c-67-22
through
Bluetooth
prefer- P
ences. ¥ Show Bluetooth status in the menu bar (" Advanced... ) (2)
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v Have your Mac prompt you when a Bluetooth audio device attempts to
connect to the computer.

v Share your Internet connection with other Bluetooth devices.

You can also control how the various devices share files with your Mac. Head
back to the main System Preferences screen and click Sharing. Make sure the
Bluetooth Sharing box is selected. You then get to determine other choices,
including whether to Accept and Open or Accept and Save items sent from
other Bluetooth computers and devices. If you save them, you’ll get to
choose where to put those items. And select Ask What to Do if you want to
make the decision about saving or opening the item on a case-by-case basis.

You can also determine the Public or other folders that Bluetooth devices
are permitted to browse on your computer. As one other key measure of
security, select the Require Pairing for Security option (described next),
which means a password is required before files can be transferred.

Pairing off
To pair, or set up, Bluetooth devices to work with your Mac, follow these
steps:

1. Choose Bluetooth in System Preferences.

2. Click the + at the bottom-left corner of the Bluetooth window.

Alternatively, if the Bluetooth status icon appears in Leopard’s menu
bar, click the icon and click Set up Bluetooth Device. Either way, the
Bluetooth Setup Assistant appears.

3. Select the types of device you want to set up, such as a mobile phone
or printer.

Select Any Device if the device you have in mind is not on the list. Make
sure the given gizmo is within thirty feet of the computer.

4. Make sure Bluetooth is turned on in the selected device.

(If Bluetooth is not turned on, you may have to dig through the device’s
menus to find the control that wakes up Bluetooth.) With any luck, the
Mac should find it. As shown in Figure 18-4, my Bluetooth setup found an
iPhone.

5. Click Continue.

The Mac spends a few seconds gathering whatever intelligence it can
about the chosen device to determine how to interact with it.



Chapter 18: Networking Madness 32’

.00 Bluetooth Setup Assistant

Bluetooth Device Set Up

Searching for your device

When your device appears in the list, select it and click Continue. If you
don't see it in the list, make sure itis “discoverable.” See the
documentation that came with your Bluetooth device to determine if you
need a specific passkey option. Otherwise, select it and click Continue.

| Devices Type |
iPhane Smartphone

| |
Figure 18-4: w  Searching for devices - 1 found.
Discovering
an iPhone. ( Passkey Options_.. | Go Back
|
6. Click Continue again.
The device asks you to enter a passkey — it’s the code that will
complete the process. The documentation for the device may specify
what you need to enter for the passcode.
7. Enter the passkey.
The gizmo and the Mac can share a Bluetooth connection.
QNING/ . o . .
Ny While you can pair just about any Bluetooth device with your computer, you

should have a compelling reason to do so. As of this writing, I could not, for
example, send a file via Bluetooth to the iPhone that I paired.

Still, given all the various ways to network your Mac, you should be pleased
that your prized computer is playing so nicely with others.
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Chapter 19
Surviving in a Windows World

In This Chapter

Finding out what Macs and Windows have in common
Migrating to a Mac from Windows

Enlisting in Boot Camp

Navigating a Parallels universe

f it weren’t for the fact that their darling computers are so darn special,

you might expect loyal Macintosh users to have an inferiority complex.
But there’s nothing inferior about the Mac operating system, save its
teeny-tiny market share.

Apple has had only modest success through the years getting Windows users
to switch to the Mac camp. However, the runaway success of the iPod and
the iPhone as well as the move to Intel processors have been helping Apple
lure more Windows defectors. So have Apple’s clever and funny TV ads. The
spots pit a rather hip Mac guy against a nerdy PC counterpart.

The bottom line is that this is, for better or worse, still a Windows-dominated
world. More times than not, the Apple user has to adapt to the Windows
environment rather than the other way around. From time to time, the Mac
user encounters programs and Web sites that get along only with the
Windows platform. Still, the remarkable Apple-Intel alliance demonstrates
that in this topsy-turvy world anything is possible.

What'’s more, as we'll see in this chapter, you can actually transform the

newest Macs into fully functioning Windows PCs. That bears repeating: You
can actually transform the newest Macs into fully functioning Windows PCs.

What Mac and Window's
Have in Common

For all their differences, Mac and Windows are more alike than you may
initially grasp. And common ground is a good thing:
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v Macs and Windows PCs can share the same printers, scanners, digital
cameras, mice, keyboards, and other peripherals.

* Both systems are fluent in the common file types, including PDFs, JPEGs,
and text.

v Microsoft produces a version of Office for both platforms. So you can
work in programs such as Word, Excel, and PowerPoint with little
difficulty. The Mac and Windows versions of Office have used the same
files since Office 97 for Windows came onto the scene.

v The Mac can read most Windows PC—formatted CDs and DVDs.

v Both sides can easily communicate by e-mail or using the AIM (AOL)
instant messaging service.

» You can access a MobileMe account (Chapter 12) from a Windows PC.

v Versions of Windows Media Player, QuickTime Player, and RealPlayer
work on a Mac.

v As noted in Chapter 18, the two systems can be on the same wired or
wireless network and share files.

+* And as you already know, Intel is now inside both computers.

Making the Switch

Okay, so you've read enough of this book to satisfy your curiosity about the
Mac and you're ready to defect.

But frankly, you've invested time and energy over the years in getting your
Windows files and preferences just as you like them. Within certain limits,
this section describes ways to replicate your Windows environment on

a new Mac.

Move2Mac Software

The $50 Move2Mac program from Detto Technologies does most of the heavy
lifting of moving to a Mac from Windows. You create a profile of settings and
files that you want to move over from the PC, and let the software take over

from there.
QMING/ Move2Mac combines software you load on both your Mac and PC with a
R special cable to connect the two. For pre-Windows XP systems, get the version

of Move2Mac with a Mac-USB-to-PC-parallel cable. For an XP machine, get a
USB-to-USB cable.
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While the software is smart enough to put files in the right placeMove2Mac
can’t do everything. Applications are not ported over from the PC, nor does
Detto’s program convert PC files to a Mac format. That’s not a big deal for
many major programs, but it can be for some. Check out www.detto.com/
mac-file-transfer.html for more information.

Help from Apple

When you buy a new Mac at the Apple Store, you qualify to have a certified
Mac technician, not so modestly known as a Genius (see Chapter 19), transfer
all your data for free. If you purchased your Mac online or at another retailer,
a Genius will still transfer your data, for a fee starting at $50.

The PC must be running Windows 95 or later, and you need to bring your
Windows installation disks, any appropriate cables, and the PC keyboard and
mouse. Under this free scenario, you have to configure settings on your own.

Burning a disc

Because your Mac can read CDs or DVDs formatted for Windows, you can
burn your important files onto a disk and copy them onto your Apple. You
may not have to burn all your files onto a disc, but a good place to start

is in your My Documents (XP) or Documents (Vista) folders on the Windows
machine. These folders very well may include photos and videos.

External hard drives

You can exchange files on external USB or FireWire-based hard drives and
USB thumb drives.

You can even use an iPod as an external drive by setting it up for disk use.
Temporarily dump songs off the iPod to create more room (then add the
music back later). Visit docs.info.apple.com/article.html?artnum=
300173 for a detailed explanation.

Using an existing network

Another way to get files from Windows to a Mac is by using a network. Make
sure file sharing is turned on in Windows. Head to the Network and Sharing
Center on a Windows Vista machine to start.
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Add your Mac to your wired or wireless network (if not already part of it) and
exchange files as outlined in Chapter 18.

The KUM switch

If you just bought a Mac but are holding on to your Windows computer for
awhile, consider a KVM (keyboard-video-mouse) switch. This device uses
USB to let the two machines share the monitor and various peripherals. A
Belkin KVM switch with all the necessary cables is roughly $70.

Enlisting in Boot Camp

WBER
“&
&
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In the preceding section I touched on various strategies for allowing separate
Mac and Windows machines to coexist. But if you own one of the newer
Intel-based Macs, you can run OS X and Windows XP on one machine.

It may seem like divine intervention. In fact, it’s been possible to run
Windows on a Mac for some time — with agonizing limitations. Older Macs
loaded with Microsoft’s Virtual PC emulation software could do Windows,
too, but the program was painfully slow. Even if you find an old copy of the
software, it won’t work with any current Macs.

Boot Camp, Apple’s near-finished beta software, shook up the computing
public upon its apocalyptic arrival in April 2006. Boot Camp graduated from
beta status with the arrival of Leopard, which includes Boot Camp Assistant
software stored in the Utilities folder under Applications.

Boot Camp itself is free, but you have to supply your own single-disc, full-
install version of the Windows XP CD with Service Pack 2 or later or Windows
Vista. An XP or Vista upgrade disc won'’t cut it.

Other requirements follow:

v An Intel Mac with OS X version 10.5 or later — if need be, run Software
Update

1 At least 10GB of free space on the startup disc

v A Mac OS X Leopard installation disc

If you don’t run into snags, the entire installation (including Windows) should
take about an hour.

But because snags are possible, back up all your important information on the
Mac’s startup disk.



Chapter 19: Surviving in a Windows World 32 7

Figure 19-1:
Making
space for
Windows.
|

Basic training

Following are the steps to get through Boot Camp. The assumption here is
that you haven't already installed Windows through the Boot Camp beta:

1. Run Boot Camp Assistant (in the Utilities folder under Applications) to
make sure you have the latest firmware on your computer.

You'll find any updates at www.apple.com/support/downloads/.
Follow any on-screen instructions if you are updating the firmware. If
using a portable computer, make sure to connect the power adapter.

2. Create a partition for Windows XP or Vista.

You are essentially carving out an area of your hard drive for the
Windows operating system, as shown in Figure 19-1. This partition must
be at least 5GB and can swell as large as the total free disc space on
hand minus 5GB. If you don’t plan on doing much in Windows, keep the
XP or Vista partition small; if you plan on running graphics-heavy games
and a lot of Windows programs, you might devote a more generous
chunk to Windows. Drag the divider to set the partitions for both OS X
and Windows. Or click Divide Equally to make equal partitions. Still
another option: Click 32GB to devote that much to Windows.

If you have more than one internal hard drive, you can select which disc
to partition. If any of this makes you nervous, know that you can remove
the Windows partition later and go back to a single-partition Mac.

3. Insert the Windows CD. Click Start Installation.

If you exited Boot Camp Assistant before installing Windows, open it
again, choose Start the Windows Installer, and click Continue.

Boot Camp Assistant

Create a Partition for Windows

Each operating system requires its own partition on the disk.
Drag the divider to set the size of the partitions, or click one
of the buttons.

/" ! "Macintosh HD" will be partitioned as:

\ *
% >
Mac 05 X | Windows

69 GB 5GB
49 GB free

(" Divide Equally ) (  Use32GB )

Go Back | ( Partition
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4. When asked to choose the Windows partition, select C: if you are
running Windows XP or select Disk 0 Partition 3 BOOTCAMP if you
are running Vista.

Failure to do so could wipe out your entire Mac OS X startup disk.
5. Format the partition:

¢ For Windows XP, format the partition in either the NTFS file
system or FAT.

FAT provides better compatibility between the two operating
systems but is available only if the partition you created for
Windows is 32GB or smaller; NTFS is more reliable and secure,
but you won’t be able to save files to Windows from Mac OS X.

¢ For Vista, format the partition using NTFS. Click Drive Options
(Advanced), click Format, and then click OK. Click Next.

6. After Windows is installed, eject the Windows disc by going to My
Computer, selecting the optical drive (D:), and clicking Eject This Disk
in the Systems Task list.

7. Insert the Leopard installation disc, and follow the on-screen
instructions.

At this juncture you're loading Boot Camp drivers so that Windows
recognizes AirPort, Bluetooth, the iSight camera, the Eject key on the
Mac keyboard, networking, audio, graphics, and so on.

A Boot Camp control panel for Windows and an Apple Boot Camp
system tray item will be added.

8. When you see the message that the software “has not passed Windows
Logo testing,” click Continue Anyway.

Don’t cancel any driver installers. The computer will restart.
9. Follow any Found New Hardware instructions.

As with any new Windows computer, Microsoft requires that you activate
your XP or Vista software with thirty days.

It’s great that you can use Windows on the Mac. But by now you may be
longing to return to the OS X environment. The next section tells you how.

Switching operating systems

You can go back and forth between Leopard and Windows, but you can’t
run both simultaneously under Boot Camp. Instead, you have to boot one
operating system or the other, thus the name Boot Camp.
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Restart your machine and press down the Option key until icons for each
operating system appear on the screen. Highlight Windows or Macintosh HD
and click the arrow to launch the operating system of choice for this session.

If you want OS X or Windows to boot every time, choose ®=>System
Preferences and click Startup Disk. Choose the OS you want to launch by
default.

You can perform the same function in Windows by clicking the Boot Camp
system tray icon and selecting the Boot Camp Control Panel. Click either
the Macintosh HD or Windows icon, depending on your startup preference.

A Parallels (and Fusion) Universe

\\3

As we've just seen, Boot Camp’s biggest drawback is its requirement that you
reboot your computer every time you want to leave one operating system for
a parallel universe. Can anyone spell hassle?

Two $80 remedies are readily available, Parallels Desktop from a Virginia
startup, Parallels, Inc., and VMWare Fusion from VMware of Palo Alto,
California. Their respective software takes the form of a virfual machine. The
programs simulate a Windows machine inside its own screen within OS X. Or,
if you feel like it, go full-screen with Windows. The faux machine behaves just
like the real deal. You can add software, surf the Web, listen to music, and
play Windows games on a Mac.

You can even apply this virtualization stuff with versions of Windows dating
back to Windows 3.1 as well as Linux, Solaris, OS/2, MS-DOS, and other
operating systems.

Parallels and Fusion differ from Boot Camp because you can run any OS while
you run Leopard, without having to restart. What’s more, you can share files
and folders between OS X and Windows and cut-and-paste between the two.
The Coherence feature inside Parallels lets you run Windows programs like
they were Mac apps.

Neither program, as of this writing, supports the prettier Aero interface in
Vista. And, in my experience using Parallels, installation can be a bit tricky.

Check out Parallels at www.parallels.com and VMWare Fusion at www .
vmware.com/products./fusion.

Virtual or not, you are running Windows on or inside your Mac. So take all the
usual precautions by loading antivirus and other security software.

Comforting, isn’t it, to know that Macs do well in a Windows world?
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Chapter 20
Handling Trouble in Paradise

In This Chapter
Fixing a cranky or frozen computer
Getting inside Disk Utility
Finishing off Startup problems

Reinstalling the operating system
Repairing common problems
Maintaining the computer

Summoning outside assistance

‘m reluctant to morph into Mr. Doom-and-gloom all of a sudden, but after
reading about all the wonderful things Macs can do, it is my unpleasant
duty to point out that bad @#$& happens. Even on a Mac.

Fortunately, most issues are minor. A stubborn mouse. Tired hardware.
Disobedient software. Under the most dire circumstances, your computer or
a key component within is on its last legs. After all, a Mac, like any computer,
is a machine. Still, rarely is a problem beyond fixing. So stay calm, scan
through this chapter, and with luck you’ll come across a troubleshooting

tip to solve your issue. If not, I provide recommendations on where to

seek help.

A Cranky Computer

Your Mac was once a world-class sprinter but now can barely jog. Here are
four possible explanations, and a fix to go with each one.

+* Your Mac needs more memory. The programs you're running may
demand more RAM than you have on hand. I always recommend getting
as much memory as your computer (and wallet) permit. Adding RAM to
the recent class of Mac machines isn’t difficult (check your computer’s
documentation for specifics), though it does involve cracking open the
case and making sure you're buying the right type of memory.
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+* Your Mac is running out of hard drive space. This is an easy one:
Remove programs or files you no longer use. There must be something
you can live without. But if every last bit is indispensable, purchase an
additional drive.

+* Your Mac’s processor, or CPU, is overtaxed. If you suspect this might
be the case, open the Activity Monitor, which is shown in Figure 20-1, by
choosing Applications=Utilities. Activity Monitor reveals a lot about the
programs and processes currently running on your machine. Click the
CPU header to display the applications exacting the heaviest workload
on your CPU (central processing unit). The most demanding are on top.
Quit those you don’t need at the moment.

»* The Mac may be trying to save energy. On a laptop, the Mac may be
slowing the processor purposely. Choose ®>System Preferences and
click Energy Saver. Use the Optimization pop-up menu near the top to
switch from Better Energy Savings to Better Performance.

Figure 20-1:
Monitoring
your
activities.
|

A Frozen Computer or Program

Mentioning beach balls to anyone but a Mac maven usually conjures up
pleasant images of the surf, sand, and a glorious summer afternoon. Now Mac
people love a day at the beach as much as anybody. But the sight of a color-
ful spinning beach ball is less welcome on your Apple, at least when that ball
never seems to leave the screen. A beach ball that spins — and spins, and
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Figure 20-2:
Bailing
through the
Force Quit
command.
|

spins some more — is a sign that a cranky Mac has turned into a frozen Mac
or that at least one of the programs on the machine is throwing a high-tech
temper tantrum. (In some cases, you may see a spinning gear cursor instead.)
Those of you familiar with Windows can think of this as the Mac equivalent of
the hourglass that lingers on the screen.

It isn’t often that a frozen program will crash the entire system, but it does
happen. Your first instinct is to stick a pin inside this virtual spinning beach
ball of death, if only you knew how. If you’re a model of patience, you can
attempt to wait the problem out and hope the spinning eventually stops. If it
doesn’t, consider the options described in this section.

Force Quit

Force Quit is the Mac’s common way of telling an iced application, “I'm as
mad as hell and I'm not going to take it anymore.” (If you're too young,
that’s a reference to the 1976 movie Network, as in television network.)

Choose ®>Force Quit or press 38+Option+Esc. A window like the one in
Figure 20-2 appears. Click the name of the deviant application (“not
responding” probably appears next to its name). Under Force Quit you
typically won’t have to reboot your computer.

Because you will lose any unsaved changes, Apple throws up a little
admonition before allowing you to Force Quit. Alas, you may have no choice.

Ctrl-clicking a dock icon brings up a pop-up menu whose bottom item is Quit.
If you hold down the Option key, Quit becomes Force Quit.

Force Quit Applications

If an application doesn't respond for a while,
select its name and click Force Quit.
EE Activity Monitor I
« Bluetooth File Exchange 1
& CarageBand
F Grab
& iMovie
& iPhoto
1 iTunes
IR Mail
You can open this window by pressing (m\

Command +Option+Escape.

A

333
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Figure 20-3:
Helping
Apple
troubleshoot.
|

When a program quits on you

Sometimes, for reasons known to no one, a program keels over. Just like that.
You could reopen the app and hope this was a one-time aberration caused
by mischievous space aliens en route to the planet Vista. Or you might have
a chronic ailment on your hands.

When programs suddenly drop, you may see dialog boxes with the word quit
unexpectedly, like the ones shown in Figure 20-3. Sometimes the box lets you
click to Reopen the fussy program; sometimes the option is to Try Again. OS
X restores the application’s default settings (thus setting aside newer prefer-
ences settings), in case something you (imagine that?) caused the snafu.

If you really need one, I've got a couple apps that like to drop out on a fairly
frequent basis and can do a screen cap of the dialog for you. Word2008 is one
of them, which is why I'm using an older version for editing. Also, iMovieHD
is “still current” for people needing the functionality that Assuming every-
thing went swell from there, you’ll be given the option of keeping the new
settings upon quitting the program. Your old preferences are saved in a file
with a .saved extension, in case you ever want to go back. If that is the case,
move the newer and current preferences file from its present location and
remove the .saved extension from the older file.

If you feel like doing your itty-bitty part to help Apple make things right
in the future, you can share a problem report like the one in Figure 20-3 with
the company. Apple won'’t directly get in touch with you about the issue.

Problem Report for GarageBand

! Comments = Problem Details  System Configuration |

Date/Tine: Z0BE-B9 95 22:27:19 8468 =
05 Version: 18.5.4 (Build 9E17) q
Architecture: 1386

Report Version: 4

Command 2 GarageBand

Path: Shpplications/Garageband . apps/Contents/MaclS,GorageBand
Wersion: 4.1.2 (246.7)

Build Version: 16

Project Mame: GorageBand_App

Source Version: 2486788

Parent.: launchd [146]
PID: za4
Event.: hang
Time: §.59s
Steps: 36
Your personal information is not sent with this report. You will not be
(7)) contacted in response to this report. For Aople product suppart, visit (" Send to Apple

"~/ http:/ fwww.apole.com/support] or your nearest Apple store \

b
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If the problem continues, it may be time to visit the library. No, not that
kind of library. A Preferences folder lives inside your Library folder, which
in turn resides in your Home folder. Whew! Got it? These preferences files
have the .plist suffix and typically begin with com. followed by the names of
the developer and program, as in com.microsoft. Word.plist. Try dragging a
.plist file with the name of the troubled application out to the desktop. If the
program runs smoothly, trash the corrupted preferences file.

Just to keep you on your toes, a separate Preferences folder resides inside a
separate Library folder inside your Macintosh HD folder (which you can click
on the left side of the Finder). You may have to repeat this drill there.

Forcing a restart

Force Quit will usually rescue you from a minor problem, but it’s not effective
all the time. If that’s the situation you're in now, you’ll likely have to reboot.
The assumption here is that your frozen computer won’t permit you to start
over in a conventional way by choosing #=Restart.

Instead, try holding down the power button for several seconds or press
Ctrl+88 and then the power button. If all else fails, pull the plug (or remove
the battery from a laptop), though only as a last resort.

Safe boot

Starting Leopard in Safe mode activates a series of measures designed to
return your computer to good health. It runs a check of your hard drive
(see the next section), loads only essential kernel extensions (system files)
while ignoring others, trashes what are called font cache files, and disables
startup and login items.

To start in Safe mode, press the power button to turn on your computer,

and press and hold the Shift key the instant you hear the familiar welcome
chime. Release Shift when the Apple logo appears. You’ll know you've done it
correctly because the words Safe Boot appear in the login window. (Before
Tiger, the words Safe Boot appeared on the OS X startup screen; this feature
was not an option before OS X version 10.2.)

Because of its under-the-hood machinations, it will take considerably longer
to boot in Safe mode. This is perfectly normal. So is the fact that you can’t
use AirPort, a USB modem, or your DVD player, you can’t capture footage in
iMovie, and you can’t use certain other applications or features.
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If the Safe boot resolved your issue, restart the Mac normally next time,
without pressing Shift. If not, it might be time to check your warranty or call
in an expert, as noted later in this chapter.

Disk Utility

Figure 20-4:
Disk Utility
can fix
permissions
and repair
your hard
drive.
|

Just about every championship baseball team has a valuable utility player

to fill nearly every position. The versatile Disk Utility tool on your Mac serves
this purpose for all things hard drive-related. At a glance, it gives you a
summary of your drives, including disk capacity, available space, and number
of files and folders.

I'll concentrate on two of the main tasks Disk Utility performs: repairing
damaged disks and fixing bungled permissions, as shown in Figure 20-4.

Read the “Don’t try (most of) this at home” sidebar for a peek at Disk Utility’s
other stunts.

0

800 Macintesh HD =

LI S S SN E S E B %

Verify Info Bum Unmeunt Eject Enable journaling Newlmage Convert Resize Image

= First Aid | Er RAID  Restore |
{7 233.8 GB Maxtor 61250 —_— e —
B Macintosh HD If you're having trouble with the selected disk:

) disk0s3 » Click Repair Disk. If the repair fails, back up and erase the disk.
+ If Repair Disk is unavailable, click Verify Disk. If the disk needs repairs, start up from

K1 465.8 GB G-TECH G-DRIVE your Mac OS X installation dis, and then choose Utilities > Disk Utility.

51 Backup
e If you have a permissions problem with a file installed by the Mac 05 X installer, click
9 MATSHITA DVD-R U)-846 Repair Permissions.
99 Session 1
) iTunes 7.7 ™ Show details (Clear History )

B
Reading permissions database.
Reading the permissions database can take several minutes.
Permissions differ on “private var/log/secure.log", should be ~rw-— - Lt H
Permissions differ on "Applications /Utilities /AirPort Utility.app/Contents /Reso...
Permissions differ on "Applications /Utilities /AirPort Utility.app/Contents /Reso...
Permissions differ an "Applications /Utilities/AirPort Utility.app/Contents/Reso...
Permissions differ an "Applications  Utilities/AirPort Utility.app/Contents/Reso..
Permissions differ on "Applications /Utilities/AirPort Utility.app/Contents/Reso...
Permissions differ on "Applications/Utilities/AirPort Utility.app/Contents/Rese... ||
Permissions differ on “Library/Application Support/Apple/ParentalControls/AL... |

3 Parallels-Desktop-3188.

(" Verify Disk Permissions (" Verify Disk

( Repair Disk Permissions

=i Mount Point: / Capacity : 228 GB (244,813,135,872 Bytes)
== Format : Mac OS Extended (Journaled) Available : 13.2 GB (14,188,129,728 Bytes)

Owners Enabled : Yes Used : 214.8 GB (230,624,006,144 Bytes)
) Number of Folders : 193,443 Number of Files : 943,785

Permissions granted

As the computer’s administrator, you have the right to open, view, and
modify programs, folders, and files on your drive at will. Other user accounts
on your system (as described in Chapter 5) are given varying privileges

to read and change stuff. To regulate who gets to do what, the Mac has
established a complex set of permissions.
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Don't try (most of) this at home

Some of Disk Utility’s other capabilities are
downright scary for the novice user but worth
mentioning justthe same. For instance, you can
use Disk Utility to erase your disks so that files
can’tbe recovered. Unless you're a world-class
spy, you do not want to do this.

The program can partition, or break up, your
drive into separate volumes that OS X treats as
discrete discs. What's more, a new Leopard
stunt lets you enlarge, shrink, or add partitions
without wiping out the data on the entire hard
drive. To expand a volume, click the name of the
hard drive in the left-hand list (see the figure),
and then click the Partition tab. From the Volume
Scheme list, choose the volume just beneath
the one you want to enlarge, and click the —
button to delete it. You can now take advantage

of the newly freed space by dragging the divider
atthe bottom of the partition you are expanding.
Alternatively, assign a new size in the box pro-
vided. If there’s leftover space, click the +
button to add a new volume and name it. When
you are finished with all this, click Apply.

Disk Utility can also create disk images, which
are electronic files that store other files and
folders. Disk images can be used for multiple
purposes, such as backing up, hauling files from
one Mac to another, and e-mailing files.

And here’s a techie mouthful if ever there was
one: Disk Utility can also create a RAID scheme,
geek talk for Redundant Array of Independent
Disks. It's a method of using several separate
hard drives as a single volume.

800

4 08 o

Verify Info  Burn

4

G-TECH G-DRIVE

B'E O

Mount  Eject Enable Journaling Newlmage Convert Resize Image

Ell 0

' 5233.8 GB Maxtor 61250

{“FirstAid _ Erase | Partition RAID  Restore |

2 Macintesh HD
) disk0s3
[ Backup
2/MATSHITA DVD-R UJ-846

Volume Scheme:

|_2 Partitions

) iTunes 7.7

3| Parallels-Desktop-3188..
Backup

Backup_2

Disk Description : G-TECH G-DRIVE
Connection Bus : FireWire
Connection Type : External

Connection ID : 7895601599226450

®

S.M.ART. Status
Partition Map Scheme : GUID Partition Table

Volume Information

=

Name:

Format: | Mac OS Extended (Journaled)

Size:

To erase and partition the selected disk, choose a
volume scheme, set options for each volume, and
click Apply. To resize the volumes on the selected
disk, drag the dividers between them and click
Apply.

(Rever ) (C Apply )

Total Capacity :
Write Status :

465.8 GB (500,107,862,016 Bytes)
Read /Write
Not Supported
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Sometimes, because of new software you installed or a power glitch, these
permissions get messed up, resulting in programs that freeze or fail to open.
Disk Utility may be your salvation. Frankly, you may want to run the following
steps anyway, as preventive maintenance, particularly if you installed a
major operating system update or a new application:

1. Open Disk Utility in the Utilities folder under Applications, and click
the First Aid tab.

2. In the panel on the left, click to highlight the name of your disk,
volume or what’s called an image.

3. Click Verify Disk Permissions to test permissions without changing
anything (even if a permissions screw-up is ultimately revealed) or
click Repair Disk Permission to test and set things straight.

As Disk Utility goes about its business, a log of puzzling messages may
show up in the results window. Don’t try and make heads or tails out of
them because they don’t necessarily indicate that your permissions
SOMBER were amiss.
&

You can repair permissions only on the disk used to start OS X.

Repair job

If you suspect your hard drive is actually damaged (even a reboot doesn’t
seem to do much good), run Verify Disk to uncover any errors. If there are
any, you must be an administrator to authorize a repair. You can’t repair (or
even test) write-protected disks and nonrecordable CDs and DVDs.

<MBER But the most important restriction is this: Although you can use Disk Utility to
test the drive you're using (and, as we've seen, fix permissions), you can’t
repair it until you boot from another disk. This is most likely your Mac OS X
installation CD or DVD, which I hope you can easily lay your hands on. With
that in mind, it’s a good idea to make a copy of your install disc right now and
stash it in a safe place.

After booting with this other disc, open Disk Utility, select your startup disc,
and click Repair Disk. Incidentally, booting from the other disc is somewhat
tricky. To do so, hold down the C key and wait until OS X boots. Make a
language selection and select Disk Utility from the menu.

Get SM.AR.T.

After booting from the install disc, you may want to get really SM.A.R.T. —
as in Self-Monitoring Analysis and Reporting Technology. When you select a
hard drive in Disk Utility, the SSM.A.R.T. status appears at the bottom of the
window. If the status shows Verified, your disc is in okay shape.
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If About to Fail appears in red, you have a ticking time bomb on your hands.
Immediately back up your disc and critical files and replace the disc pronto.

Be aware that you can’t check the S.M.A.R.T. status of all external drives.

Startup Problems

A\\S

[ just discussed a few ways to get you out of a pickle. But what if you can’t
even start the Mac? This is a very unusual circumstance. You probably have
no power because the plug came loose (blame it on the dog), the switch on
the power strip is off, your battery ran out of juice, or there’s a blackout in
your neighborhood. Did you even notice that the lights went out?

On some laptops, you can tell if a battery needs recharging by pressing a
small button on the battery. Lights on the battery let you know how much
strength the battery has.

Here’s another thing to try: Press power and hold down the 8, Option, P, and
R keys and wait until you hear the startup chime a second time.

If you've added memory, installed an AirPort Card, or installed another
component and the machine fails to start, make sure the installation

is correct and try again. If your computer still can’t be revived, try removing
the memory or card you just installed and then give it another shot.

After that, if you still can’t restart, you may have to seek warranty service, as
discussed later in this chapter.

Reinstalling 0S X

If a problem has truly brought your computer to its knees, it may be time to
reinstall your favorite operating system. It’s bad enough that you have to
suffer through the hassle. You're understandably panicked about retaining
files and user settings.

Remain calm. Then do the following:

1. Insert the OS X installation disc in your CD or DVD drive.

2. Double-click the Install Mac OS X icon and go through the usual
installation drill.
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3. When asked, choose your current OS X disk as your destination disk
(which in all likelihood is your only option anyway).

4. Click Options.
You've arrived at an important point in the process.

5. If you want to salvage existing files and settings, select Archive and
Install and then Preserve Users and Networks Settings. If you prefer
starting anew, select Erase and Install, keeping in mind that you can’t
undo it.

6. Click Continue.

7. To install certain parts of OS X, click Customize. To perform Apple’s
recommended basic installation, click Install.

8. Because the OS X disk you have may not have all the latest tweaks,
pay a visit to Software Update (found in the % menu) to bring Leopard
(or whichever version of OS X you’re using) up to date.

A retail version of OS X may differ some from the version that was loaded on
your computer.

Do not reinstall an earlier version of OS X over a later one. If for some reason
you feel compelled to do so, erase your hard drive or select the erase option
in the OS X installer. You'll have to reinstall any software updates.

Reinstalling 0S 9

Reinstalling OS 9 or, for that matter, running Classic apps, is no longer an
option under Intel Macs (see the “Turn-of-the-century Macs” sidebar) or any
Mac running Leopard. But if you have an older machine, you can install a Mac
0S 9 System folder with an OS 9 install CD or OS X installation discs. If the
former, hold down the C key as your Mac restarts. This will let you start from
the disc in your optical drive. If using an OS X disc, insert the Additional
Software & Hardware Test disc. Then double-click Install Additional Software
and you’ll be guided on-screen from there.

Common Fixes to Other Problems

Sometimes all your Mac needs is a little first aid rather than major surgery. In
this section, I consider some minor snags.
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Turn-of-the-century Macs

Back in 1999, people fretted about Y2K. Bill
Clinton was acquitted in his impeachment trial.
Lance Armstrong captured the first of his Tour
de France titles. During the fall of that year,
Apple introduced 0S 9, the beginning of the end
for what came to be known as the Classic Mac
operating system. 0S 9 finally yielded to some-
thing new and better in 2001, the more robust
0S X, our Mac playground throughout this book.
(Before the fact checkers come after me, 0S X
was available as a public beta in 2000.)

The very next year, Steve Jobs presided over a
mock funeral for 0S 9 at a conference. Apple’s
boss mournfully lifted an 0S 9 box out of a
casket and quipped, “He’s now in that great bit
bucket in the sky.” 0S 9 was still breathing,
though. Macs sold early in the twenty-first

century could start in the new operating system
through an 0S 9 simulator called Classic mode.
Macs sold after January 2003 would start only
in 0S X, though folks could continue to use older
software through 0S X's Classic environment.

This too would not last. In 2006, with the intro-
duction of the Intel Macs, Apple announced
that Classic would no longer be supported. And
nowadays Classic is no longer available even
on G4s and G5s running Leopard (at least with-
out software called SheepShaver). There’s not
much to running Classic apps (if your computer
is capable). Double-click an 0S 9 program,
and the Classic environment kicks into gear. If
visible, you can also click the number 9 icon in
the 0S X menu bar and choose Start Classic.

A jumpy mouse

Real mice live for dust and grime. And so for a long time did computer
rodents. But the optical-style mice included with the most recent Macs don’t

get stuck like their ancestors because this kind of critter doesn’t use the little

dust-collecting rolling ball on its underbelly.

Be aware that optical mice don’t like glass or reflective surfaces, so if you
find your mouse on one, place a mouse pad or piece of paper underneath.

If your mouse doesn’t respond at all, unplug it from the USB port and then
plug it in again, just to make sure the connection is snug. If you have a
wireless mouse, make sure it is turned on and the batteries are fresh.

Meanwhile, if you want to change the speed of your on-screen mouse pointer
or want to change clicking speeds, visit Keyboard & Mouse under System
Preferences, as described in Chapter 4.

A stuck CD

It’s cool the way most Macs practically suck up a CD. Here’s what’s not cool:
when the drive, particularly the slot-loading kind, won’t spit out the disc.
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Take a stab at one of these fixes:

+* Quit the program using the disc and then press Eject on the keyboard.

+* Open a Finder window, and click the little eject icon in the sidebar. Or
try dragging the disc icon from the Mac desktop to the trash.

1 Log out of your user account (under the ® menu) and then press Eject
on the keyboard.

1 Restart the computer while holding down the mouse button.

My Mac can no longer tell time

If your computer can no longer keep track of the time and date, its internal
backup battery may have bit the dust. On some models, you can’t replace
this battery yourself; you’ll have to contact the Apple store or an authorized
service provider.

The wrong program answers
the call of duty

The Mac makes certain assumptions about which application ought to

open a particular file when summoned. For example, Preview is Leopard’s
document viewer of choice and routinely handles JPEG graphics and PDF
documents, and .doc files are the province of Microsoft Word (that is, unless
Pages in Apple’s iWork ’'08) takes over. But say you want the Adobe programs
Photoshop and Reader to be responsible for JPEGs and PDFs, and Mac’s

own word processor, TextEdit, to take care of DOC duties?

Here’s what to do:

1. Highlight the icon of the file you want opened by a different
application and press 38+1.

2. In the Get Info panel that appears, click the right-facing triangle next
to Open With and choose the application to handle the document
from here on out, as shown in Figure 20-5.

In this example, I've taken a .doc file that would otherwise open in
Word and put TextEdit in charge. Incidentally, if you want to open the
file from a different parent than Apple suggests, choose Other from
the pop-up menu.
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Figure 20-5:
Letting a
different

application

open
your file.
|

Alternatively, access the Open With command by highlighting the file
icon in question and choosing File>Open With. You can also bring up
the Get Info pane from the same menu. Still another way to get to Open
With: Press Control while clicking the icon (or right-click if your mouse
has two buttons).

3. If you want the application to open each and every file of this type
that you beckon in the future, click Change All.

® M O [ | Perhaps it (7).doc Info

[ -‘ Perhaps it (7).doc 40 KB
|| Modified: Today at 12:16 AM

¥ Spotlight Comments:

¥ General:
Kind: Microsoft Word 97 - 2004
document
Size: 40 KB on disk (34,618 bytes)
Where: [Users/edwardbaig/Documents
Created: Tuesday, April 22, 2008 3:05 PM
Modified: Today at 12:16 AM
Label: x| B @ L EEHEE
] Stationery Pad
] Locked

¥ More Info:

¥ Name & Extension:

Perhaps it (7).doc

[] Hide extension

¥ Open with:
[ Textedit +]
Use this application to open all documents
like this.
Change All...
¥ Preview:
DOC
P Sharing & Permissions Vs

Kernel clink

Out of the blue, you are asked to restart your computer. In numerous
languages, no less. Your machine has been hit with a kernel panic. The proba-
ble cause is corrupted or incompatible software. (One of these panics can
also be induced by damaged hardware, although that is highly unlikely.)

343
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The good news is that a system restart usually takes care of the problem with
no further harm. If it doesn’t, try removing any memory or hardware you've
recently added. Of if you think some new software you installed may have
been the culprit, head to the software publisher’s Web site and see whether
it’s issued a downloadable fix or upgrade.

SOS for DS

If you're surfing the Web and get a message about a DNS entry not being
found, you typed the wrong Web address or URL, the site in question no
longer exists (or never did), or the site is having temporary problems. DNS is
computer jargon for Domain Name System or Server. Similar messages may be
presented as a 404 not found on this server error.

Curing the trash can blues

In the physical world, you may try and throw something out of your trash can
but can’t because the rubbish gets stuck to the bottom of the can. The virtual
trash can on your Mac sometimes suffers a similar fate: A file refuses to
budge when you click Empty Trash in the Finder menu.

Try junking the files by holding down the Option key when you choose Empty
Trash.

A file might refuse to go quietly for several reasons. For starters, you can’t
delete an item that is open somewhere else on your computer, so make

sure the item is indeed closed. Moreover, you may be trying to ditch a file

to which you do not have sufficient permission. The other most likely
explanation is that a locked file is in the trash. You can unlock it by choosing
File>Get Info and making sure the Locked box is not selected.

After a program unexpectedly crashes, one or more Recovered Files folders
may appear in your trash after a restart. Temporary files are often used and
disposed of by your applications, but during a crash the files may not get
disposed. If any of these files are valuable, drag them out of trash. More often
than not, however, it is safe to discard them with the rest of the garbage.

Useful Routine Maintenance

Your computer can use some TLC every so often. This section has a few tips
for helping it out.
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Purge unnecessary files and programs

If you've had your Mac for awhile, you’ve probably piled on programs and
files that no longer serve a purpose. Maybe drivers are associated with a
printer you replaced a couple of years ago. Maybe you have software you
fell out of love with. Even if these files aren’t slowing down the system,
they’re hogging disk space. These programs may even be agitating in the
background. The Activity Monitor I mentioned earlier in this chapter may
clue you in.

Bottom line: It’s time to send these files and programs off to retirement for
good (with generous severance packages, of course). You already know
how to trash files. But it’s not always obvious which files to dispose of. Some
programs leave shrapnel all over your hard drive.

Type the name of the application you are getting rid of inside a Finder search
box and do your best to determine whether files shown in the results are
associated with the application you want to blow off.

Don’t delete files that you know little or nothing about. The consequences
aren’t pretty if you accidentally trash a crucial system file; you’ll need
administrative access to rid some key files. If you do throw unfamiliar files in
the trash, wait a day or so until you're satisfied that you don’t need them.

Backing up your treasures

[ know I've beaten you on the head with this throughout the book. Consider
this the final nag. Back up. Back up. Back up. Whether you use Time Machine,
Disk Utility, third-party software, or another method, JUST DO IT. SOONER
RATHER THAN LATER. There, I've finished shouting.

Updating software

As a matter of course, visit Software Update under System Preferences or in
the ® menu, or arrange to have your Mac check regularly for updates. I
update weekly, but you can have your computer do it as often as every day
or as infrequently as monthly (which I don’t recommend). If you’re passing
through System Preferences for any other reason, you can always go to
Software Update and click Check Now. You can also select a box to let your
machine download important updates automatically. It’s not a bad idea.
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Head over to the support areas of the Web sites of the publishers of other
software on your computer to see whether they’ve updated their programs.
The download is typically free.

Summoning Outside Help

Pretty much everything I've described in this chapter up to now is something
you ought to be able to handle on your own. But eventually you’ll run into
situations beyond your expertise, especially if you face a serious hardware
issue. Or perhaps you merely lack the time, patience, inclination, or confi-
dence. [ understand your reluctance. Fortunately, you can find help in plenty
of places, though the help is not always free.

Third-party software

For all the fine troubleshooting tools included on a Mac, you may at times
want to look to outside software. Here are some programs that may bail you
out of a jam or help with routine maintenance. Prices and version numbers
are subject to change:

v Alsoft DiskWarrior 4, at www.alsoft.com. A $100 repair utility that
warns you of impending drive failure. Check to make sure DiskWarrior is
compatible with your model.

v Cocktail, at www.macosxcocktail.com. A $15 shareware utility.

v OnyX 1.9.6 for Mac OS X 10.5 (Leopard), at www. titanium. free. fr/
pgse/english/download.html. A free downloadable program from
Titanium Software that can run a variety of maintenance tasks.

v Prosoft Data Rescue II, at www . prosofteng. com. A $99 program
designed to help you recover files from a corrupt hard drive.

v SpringCleaning 9.1.1, at my . smithmicro.com/mac/springcleaning/
index.htmlwww.allume.com. A $50 utility that aims to boost perfor-
mance by helping to eliminate stray files.

v TechToolPro, at www.micromat . com. A $98 problem solver from
Micromat.
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AppleCare

Your Mac comes with ninety days of free telephone support and a year of
free support at an authorized Apple retailer. The extended warranty program
called AppleCare lengthens the time you can get phone support to three
years (from the day of purchase).

AppleCare covers the computer itself plus AirPort Express and Extreme base
stations, Time Capsule, MacBook Air SuperDrive, and Apple RAM (used with
the Mac, of course). With certain models, including Mac Mini, you can also
cover one Apple display if purchased at the same time.

Fees depend on the gear you're covering: AppleCare for an Apple display is
$99; Mac Mini, $149; iMac, $169; MacBook, MacBook Air, $249; Mac Pro, $249;
MacBook Pro, $349. Extended warranties are like any form of insurance —

a crap shoot, but a crap shoot worth taking for some folks.

Consulting Einstein

One of the features of the Apple retail store is the Genius Bar. Apple’s in-store
experts can answer questions about your Mac and, if need be, install memory
and handle repairs (for a fee). My own experience leads me to believe that
these (mostly) young men and women are quite knowledgeable about the
subjects you're likely to hit them with. Judging by blog posts, however, not
all of them are ready for Mensa. Now the bad news. You can’t exactly mosey
up to the Genius Bar. Which leads me to . . .

Making a reservation

Meeting up with an Apple-branded Genius requires an appointment. Go to
www.apple.com/retail and click the Apple store near you (if there is one)
Look for Make Reservation. You’ll have to sign in as a Guest or ProCare
member (see the next section). You can stake a claim on the next opening.

If you're already in an Apple store and it’s not crowded, make a reservation on
the spot using one of the Macs in the store.

Consulting a pro

As a ProCare member, you can book an appointment with a Genius at the
store of your choice up to a fortnight in advance. At $99 a year, ProCare isn’t
cheap, but you get the following princely privileges: priority repairs, an
annual computer tune-up (systems diagnostics, a cleaning for your display
and keyboard, and more), and help setting up a new machine.
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One to One Training

Another $99-a-year service called One to One Training provides face-to-face
tutorials on a variety of topics, from moviemaking to digital photography.
Training sessions are at your local Apple store; you can make a reservation
online.

If there’s bad news to any of this it’s that Apple used to include personal
training as part of ProCare. No more.

Help, 1 need somebody
It sounds like a cliché, but free (or low-cost) help is all around you:

v The geeky next-door neighbor, your cubicle-mate, or the friends you
didn’t know you had on the Web.

v At a social networking site such as Meetup.com, you can search for and
perhaps find a Macintosh user group meeting in your neck of the woods.

v Get referrals from Apple at www.apple.com/usergroups. You'll find
an events calendar; enter your Zip code to find a group close by.

v For free online answers, poke around the newsgroups and computer
bulletin boards, as described in Chapter 11.

v Check out the troubleshooting articles at www.apple.com/support.

v~ Before leaving a chapter on troubleshooting and the geek section of this
book, I'd be remiss if [ didn’t mention one other avenue for help. It’s the
Help menu found with most every program you use. To be sure, not
every one of your questions will be answered satisfactorily, and you
have to be careful in how you phrase your question. But before heading
on a wild goose chase in search of an enlightening response, give the
Help menus a try. They’ve been right there all along.
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In this part . . .

'm always volunteering my top ten movie lists for a

given year or genre, but then this isn’t Movie
Appreciation For Dummies. | guess it’s not appropriate for
me to serve up a list of my top ten favorite songs of all
time either.

In this part, | meet my “lists of ten” For Dummies quota
with ten nifty dashboard widgets, ten top Apple- and
Mac-related Web sites, and ten neat stunts your machine
can adeptly handle, with a helpful assist from you.

(Pssst keep it quiet, but there’s The Godfather, Citizen
Kane . ..)




Chapter 21

Ten Clever Dashhoard Widgets

In This Chapter
Cocktail
Countdown Plus
Gas
Hurricane Tracker

iStat pro

Movies

pearLyrics/Sing that iTune
Send SMS

Wikipedia

Word of the Day

Tlink of the Dashboard widgets of Chapter 6 fame as a reflection of our
busy lives. We're all distracted, pressed for time, going every which way.
We generally know what we want, and we want it now. In this fast-food soci-
ety, snack software seems inevitable.

In this chapter, I present in alphabetical order a list of ten yummy widgets.
With more than 4,800 widgets available as of this writing on Apple’s site, you
can easily come up with a menu of ten more widgets, and ten more after that.
And so on. To find them at Apple, head to www.apple.com/downloads/
dashboard. You can also search cyberspace for other dashboard widgets.
Most widgets are free, though donations are often requested.

Cocktail

Can you mix an, um, Apple Martini? Kamikaze? Or Piper at the Gates of Dawn?
The free Cocktail widget from Seven lets you impress buddies with your mix-
ologist skills. Just type the drink you have in mind. Cocktail’s database
includes nearly seven thousand drink recipes. Click “Feelin Thirsty?” for a
random selection. With its martini-glass icon, shown in Figure 21-1, Cocktail
has one of the better-looking widgets too.
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Figure 21-1:
I'll have a
Cocktail
with that
widget.
|

Countdown Plus

Gas

Hmm. Steven Chaitoff’s simple Countdown Plus widget tells you how much
time is remaining until a specified date, such as the newborn’s due date, your
next vacation, your anniversary, or the day you’ll be paroled.

[ loath paying a small ransom at the pump. Gas from Jason Barry might help
you save a few pennies per gallon. The widget delivers information from
GasPriceWatch.com and has links to AAA gas data. You can sort results by
Regular, Plus, Premium, or Diesel and set preferences to find stations within
one to fifteen miles of a designated Zip code. What’s more, click the address
of the gas station of choice, and the widget fires up Google Maps on your
browser. The Gas widget is free, but its producers hope you’ll pass along
some of your savings to them (via PayPal). You can display the widget with a
pole or without.

Hurricane Tracker

If you live or expect to vacation in an area affected by hurricanes, Hurricane
Tracker and Hurricane Tracker Companion from Travel Widgets are useful
resources (see Figure 21-2 for a peek at both). The front of Hurricane Tracker
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includes text links to the National Hurricane Center advisories; satellite
imagery is on the back. The Companion widget lets you choose how you want
satellite images to appear (Visible, Infrared, Water Vapor).

Hurricane Track
el last checked - 23rd Aug
Tropical Storm FAY Public Advisory Number 32
Tropical Storm FAY Forecast/Advisory Number
37

Tropical Storm FAY Forecast Discussion Number
31

Tropical Storm FAY Wind Speed Probabilities

e

Tropical Storm FAY Graphics
- Hurricane Local Statement forTropical Storm
Flgure 21-2: FAY issued from New Orleans / Baton Rouge, LA —
. Hurricane Local Statement forTropical Storm 4
Trackmg FAY issued from Mobile, AL / Pensacola, FL M

storms.
—

iStat pro

Former New York City Mayor Ed Koch used to always ask, “How am [ doing?”
This customizable system monitor widget from iSlayer.com lets you quickly
get a sense of how your Mac is doing. As Figure 21-3 shows, you can check
out CPU, memory and disk usage, gauge temperature sensors, and more.

Figure 21-3: P
A quick way | st Chbw Wi B e Him
to monitor : :
your Mac.
|

Untitled

0.76, 0.31, 0.75

Movies

Want to know the flicks playing in the hood? Want to read a synopsis and
view trailers to help you decide which to see? That’s just what Movies, a
simple film fan widget from Apple, lets you do. Apple supplied the widget
with Leopard. It even lets you purchase tickets (via Fandango). Now let’s see,
Vicky Christina Barcelona (see Figure 21-4) or The Dark Knight . . .
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Figure 21-4:
A going to
the movies
widget.
|

Movies Tomorrow *

AMC Loews Palisades Cent...
AMC Loews Wayne 14

Swing Vote

Tell No One

Thrillain Manila Clearview Clairidge Cinemas

Clearview Tenafly Cinema 4

Clearview Warner Quad i

Edgewater Multiplex Cinemas

Tropic Thunder

"

Vicky Cristina Barcelona

Javier Bardem, Patricia Clarkson, Penélope
Cruz
nre: Romance

Vicky and Cristina, these two young

Americans spend a summer in Spain and meet
a flamboyant artist and his beautiful but

insane ex-wife. Vicky is straight-laced and
about to be married. Cristina is a sexually
adventurous free spirit. When they all become |
amorously entangled, both comedic and

Trailer €

pearLyrics/Sing that iTune

Sad refrain. One of my favorite widgets, pearLyrics, is no longer available,
apparently over legal disputes with some in the music industry. | mention it
anyway because it still works on my machine and the idea behind it is so
appealing to any music fan who has ever wanted to sing along but can’t
remember the words. Besides, you can still download a similar widget called
Sing that iTune.

The two widgets display the lyrics of songs you're listening to in iTunes,

at least a decent part of the time. And Sing that iTune, unlike pearLyrics,
displays album cover art. It also lets you download artwork, save lyrics in
iTunes, and search for Japanese or Chinese lyrics. Who knows, maybe
pearLyrics will return someday. In the meanwhile, check out Sing that iTune.

Send SMS

SMS stands for Short Message Service, a popular global standard for dis-
patching text messages to cell phones. This widget from SMS Mac lets you
send text messages to a mobile phone from your keyboard. You type your
missive in the area provided on the front of the widget, and then click to flip
it over to enter a recipient and a phone number.

Your first purchase totals $15 (you can pay through PayPal) and covers the
$10 annual fee and first 50 SMS messages ($5). Not cheap.
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Wikipedia
With the free collaborative Wikipedia encyclopedia, which I describe in
Chapter 11, you can search on most any topic imaginable. Or try clicking the
little ? button next to the search field to display an article randomly, on sub-
jects ranging from the Danish parliamentary election of 1975 to nineteenth-
century cowboy outlaw William “Curly Bill” Brocius (or Brocious — Wikipedia
isn’t sure). Indeed, anyone can contribute to a Wikipedia entry, so the infor-

mation you uncover may be open to interpretation and possibly inaccurate.
Click the Wikipedia button in the widget to jump to the full Wikipedia site.

Word of the Day

I'm feeling rather sedulous. After all, 'm diligent in my application or pursuit
and steadily industrious. Besides, sedulous is my Word of the Day, delivered
by a widget of the same name. Definitions (like the one provided in the
sentence before this one) are supplied by Dictionary.com.

Those of you seeking to bolster your vocabulary are kindly encouraged to
make a donation.
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Chapter 22
Ten Indispensable Mac Web Sites

In This Chapter
Applelnsider
MacFixIt
MacOSX Hints
MacRumors

MacSurfer

MacWorld

Other World Computing
The Unofficial Apple Weblog
VersionTracker

Apple

n my line of work, I often get the “how come you didn’t” e-mail or phone

call, as in “how come you didn’t write about my company or product?”
So I won’t be shocked to hear folks asking about this chapter, “how come
you didn’t choose my favorite Macintosh Web site?” Limiting any list to
ten is exceedingly difficult. Especially when it comes to Web sites about
your trusted computer. Heck, one of my editors wanted me to shoehorn in a
mention of www.mactech.com because it’s an incredible compendium of
Mac-related technology discussions and articles. Jeez, I guess I just did, and
it doesn’t even count against my ten.

Applelnsider

www.appleinsider.com

As with many other comprehensive sites devoted to the Cupertino crowd
(including some in this list), you'll find lots of news and reviews concerning
all things Apple. But Applelnsider also wants to solicit your help. You're
invited to submit rumors and information to the site — and may even do so
anonymously.
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MacFixlt

www.macfixit.com

When something has gone wrong and you're still seeking answers despite
my best efforts in Chapter 20, check out MacFixIt. This troubleshooting site
tackles a gaggle of issues, though you’ll have to pay $24.95 a year for the

Pro version with tutorials, full access to more than a decade of content,

and e-mail alerts related to the products you care about. Among the many
topics I came across were making banking sites work with Safari, funky error
messages in iChat, and iTunes authentication problems.

MacOSX Hints

www .macosxhints.com

At the MacOSX Hints site, you can learn to create a partitioned RAID setup,
convert PowerPoint graphic metafiles, secure e-mail with digital certificates,
and avoid strange GUI behavior with certain aliases. As you can see, some of
the searchable hints can get technical.

MacRumors

Www.Mmacrumors .com

Apple is one of the most secretive outfits on the planet. Seldom does the
company spill the beans on new products in advance. That doesn’t prevent
numerous Apple watchers from speculating on what might be coming out
of Cupertino. Besides, who doesn’t love a juicy rumor now and then? Is
Apple merging with Nintendo? (Don’t count on it.) Is Apple going to add a
subscription music plan to iTunes? (Don’t count on that either.) Head to
MacRumors for the latest dirt.

MacSurfer

www.macsurfer.com

MacSurfer is a wonderful resource for the Apple news junkie. MacSurfer’s
Headline News sports links to articles on all things Apple, including tradi-
tional media, Web sites, Apple itself, and bloggers. Links are segregated by
Apple/Macintosh, OS X, General Interest/Potpourri, Hardware/Software,



Reviews/How-To/Tutorials/Tips, Analysis/Commentary/Editorial/Opinion,
Press Releases/Products/Public Relations, Computer Industry, Finances,
and more.

Macworld

www .macworld.com

It’s all here at Macworld: news, troubleshooting through blogs such as Mac
911, product reviews, discussion forums, and current and past articles from
Macworld magazine.

Other World Computing

www.macsales.com

Need more RAM for your computer? Or an extra hard drive perhaps? Maybe
even an add-on that would let you watch TV on your Mac? Other World
Computing (OWC) has been specializing in sales of Mac accessories since the
first Bush administration. The online retailer has earned a stellar reputation
for prompt delivery and reliability.

The Unofficial Apple Weblog

www . tuaw.com

The Unofficial Apple Weblog (tuaw) is an enthusiast’s blog that lets people
comment on Apple articles and reviews written by the likes of yours truly in
USA TODAY. (Sure it’s a shameless plug for me and my paper, but we are
nearing the end of the book. And there are plenty of links to articles by other
journalists.)

VersionTracker

www .versiontracker.com/macosx

VersionTracker is a repository for downloadable shareware, freeware,
and updates to Mac software. Click a name to discover more about what a
program does and to eyeball ratings and feedback.
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And Last but Not Least, Apple.com

www . apple.com

Apple may seem like an obvious place to go. Heck, you probably already
landed there just by opening Safari the first time. And you may not love the
full blitz of Mac, iPod, and iPhone advertising and promotions, even if you
already drank Apple’s Kool-Aid. But presumably most of you already have
sweet feelings for the company’s products.

As I hinted at in Chapter 20, www. apple.com is full of helpful resources,
especially for, but not limited to, newbies. You can download software
updates and manuals, post questions in discussion forums, read press
releases, and consult the knowledge base. Mostly, I think, you’ll walk away
with a renewed sense of goodwill for the company responsible for the
computer most of you fancy so much.
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Ten Things to Leave You With

In This Chapter

Remote madness

If math moves you

Speaking another language

Zip it in the bud

FYI on FTP

Screen capture

Watching TV on a Mac

Read magazines

Would you like to play a game of chess?
Speech recognition

So here we are hundreds of pages into this book, and there’s still more
to tell. Truth is, I could probably go on for hundreds more pages and
still not do justice to everything your Mac can accomplish (with more than
a little help from you, of course). So even though the programs, functions,
or capabilities covered in this chapter didn’t quite make it into the book
elsewhere, don’t consider them unloved or an afterthought.

At the risk of tossing another well-worn cliché your way, last is most defi-
nitely not least.

Remote Madness

Roughly the size of a Bic disposable lighter or an iPod Shuffle, the simple
iPod-white Apple remote, which the company has started including with
some Mac models, has minimal buttons: play/pause, volume up/down, fast-
forward, rewind, and Menu. Its main purpose is to control the friendly icons
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and menus that make up the Front Row interface (mentioned in Chapter 4),
which lets you listen to music and view photos, DVDs, and videos from
across the room. But the multitalented Apple remote can also help you listen
to an iPod, provided it has what’s called a Universal Dock connector.

But suppose you have more than one Mac that’s compatible with the remote
control or perhaps Apple TV (which comes with it). You’ll want to pair the
remote with a specific computer or other gear so that pressing the button
doesn’t make all the machines in one room bump heads. Here’s how: Move
the remote within three or four inches of the Mac and press and hold the fast
forward and Menu buttons at the same time for five seconds. A little chain-link
symbol appears on-screen to tell you the pairing has been completed.

If Math Moves You

Figure 23-1:
Graphing a
Conchoid
through
Grapher.
|

I don’t pretend to know a Conchoid (Figure 23-1) from a Lorentz’s Attractor;
the mathematics are frankly lost on me. But the Grapher bundled with OS X
and accessed through the Utilities folder (under Applications) lets you graph
two- and three-dimensional mathematical equations. Moreover, the pro-
gram’s animations are pretty darn cool. And if you're curious about what the
aforementioned Conchoid, Lorentz’s Attractor, and other 2D and 3D formulas
and equations look like, click the names in the Grapher Examples menu.

P00 B OBT + m iarisi Gwadlug O

|
¥ i b | gal), b, vl 27 dm) 2 kpsd 2wl 8
L2l | it

+il o |

F"!ﬂ - NesGE



Chapter 23: Ten Things to Leave You With 363

Speaking Another Language

|
Figure 23-2:
The Mac is
multilingual.
|

Back when you first set up your Mac, you selected the language you wanted
to use. But circumstances change. You suddenly have the opportunity to run
your company’s Rome office, and now you must immerse yourself in Italian.

To change your computer’s preferred language, choose System Preferences
from the ® menu and select International. Click the Language tab, as shown
in Figure 23-2. Drag the language you want to use for application menus,
dialog boxes, and so forth to the top of the language list.

Next, click the Formats tab under International to choose the region you live
in, customize dates, time, and native currency, or decide whether to go
metric or use the U.S. system of measurement. If you also click the Input
Menu tab, you can choose a different keyboard layout, such as the Japanese
Kana Palette or the Korean Hangul.

nternational
ar» Show All Q

! Language Formats Input Menu |

Languages:

Drag languages into the order you
prefer for use in application menus,
dialogs, and sorting.

Italiano
English

Deutsch | rg—
g Edit List...
Espafiol —
Frangais /. Changes take effect in the Finder the next
time you log in. Changes take effect in
Nederlands applications the next time yeu open them.
=
BEE 1 Your preferred language differs from that
Dansk of your currently selected date, time, and
" number formats. You can change your
Suomi formats in the Formats tab.
B2
Norsk Bokmal
Portugués Order for sorted lists:
Svenska | italiano
R
Word Break:
SERRRIC

[‘Standard 2]

Zip It in the Bud

Files you download from the Internet are often compressed or zipped — and
for good reason. Zipped files take up less space and arrive much faster than
files that haven’t been squeezed down.
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Compressed files are easily identified by their extensions, such as .zip

(a common standard used in OS X and Windows) and .sit. Such files must be
unzipped before you can read them. Apple used to include a program for this
purpose called Stufflt Expander. OS X lets you decompress .zip files — but
not .sit files — sans Stufflt.

Stufflt from SmithMicro Software still comes in handy for opening those other
types of compressed files, notably the .sit or .sitx compressed types. Go to
www.stuffit-expander.comwww.stuffit.com/mac/index.html to
download a free version of the software or to splurge for the Deluxe version
(around $80, though I've seen it discounted for much less). In addition to
shrinking files to a fraction of their size, Stufflt Deluxe lets you encrypt and
back up files.

Meanwhile, you can archive or create your own .zip files through OS X, which
is obviously useful if you're e-mailing a number of meaty files to a friend.
Right-click (or Ctrl-click) files you want to compress inside Finder and choose
Compress Filename. The newly compressed files carry the .zip extension. The
archive is created in the same location as the original file and is named origi-
nalfilename.zip. You can also choose Filer>Compress. If you compress a lot of
files at once, the archive takes the name Archive.zip.

By default, compressed files are opened with the Archive Utility. It appears in
the Dock (in Leopard) while the files are being unsqueezed, unless you
choose to open them with Stuffit Expander or some other program.

FUl on FTP

WING/

FTP (File Transfer Protocol) sites are usually set up by companies or individu-
als to make it easy to exchange sizable files over the Internet, typically but
not exclusively video or picture files. The Mac has a built-in FTP server for
giving other folks access to your machine.

To grant such access, choose ®System Preferences, and click Sharing.
Select the File Sharing box and click Options. Click Share Files and Folders
Using FTP. People on other computers can now share and copy files to

and from your machine. You might also have to open ports in your router’s
software to allow access.

Don’t take this step lightly. Consider the security ramifications before allowing
just anyone access to your machine. Right under the box you just selected is
the warning, “FTP logins and data transfers are not encrypted.”

Now suppose you want to access someone else’s FTP site. From the Finder
Menu, choose Go>Connect to Server. Enter the server address in the box
provided and click Connect. Depending on the server you're attempting to
connect to, you'll likely have to enter a name and a password.
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You may be able to drag and drop files from your machine onto that FTP
server. But often you need help from outside software. I rely on a $25 share-
ware program called Fetch (available at www . fetchsoftworks.com) to
dump files onto an FTP server. Other fine FTP choices include Transmit3
(www .panic.com) and RBrowser (www . rbrowser . com).

Screen Capture

Unless you're planning on writing a book similar to this one, you're probably
wondering why the heck you’d ever want to take a picture of your computer
screen. Let me suggest a few possibilities: maybe you want to take a picture
of the screen for a presentation at work. Or perhaps you want to show
precisely what a funky error looks like to the person who just might help you
correct the problem. Regardless of motivation, if you want to grab a picture
of the Mac screen (or any of its windows), it may be time to open the Grab
utility. Go to Applications=>Utilities and click Grab. Through Grab’s Capture
menu, you can take a picture of a full screen, window, or menu, as follows:

v Select Window (or press Shift+3+W), click Choose Window, and then
click the window to grab its picture.

v Select Screen (or press 8+Z). Then to capture the full screen, click
anywhere outside the window that appears.

v Choose Capture~>Timed Screen (or press Shift+8+Z), and then click
Start Timer in the window that appears. Grab captures the full screen
ten seconds later. This gives you a chance to prepare the screen to your
liking (perhaps by activating a menu) before the image is captured.

v Select Selection (or Shift+cmd+A). Then use the mouse to drag over the

@ portion of the screen you want to grab.

o‘
Still other universal system shortcuts follow. These do not require that you
open the Grab utility:

v Press 38+Shift+3 to take a picture of the whole screen.

v Press 38+Shift+4 and drag the mouse to select the part of the screen you
want to grab.

v Press 38+Shift+4, press the spacebar, move the pointer to highlight the
area you want in the picture, and then click. This is useful for taking a
picture of, say, the menu bar. If you press the spacebar again, you can
select the area by dragging the mouse instead. Press Escape to cancel.

<P Screen shots captured in this matter are saved as files on the desktop. If you'd
rather paste the captured image into a document, press the Control key when
you press the other keyboard combinations, which places the picture in the
clipboard. From there, you can paste the image into your chosen document.
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Watching TV on a Mac

For all its multimedia glitz, none of the Mac models, at least as of this writing,
comes with a built-in television tuner. It’s one of the few areas in which
machines based on Microsoft’s Media Center software claim bragging rights.
Not only do such Media Center machines let you watch TV directly from your
computer screen, but they function much like TiVo digital video recorders or
DVRs. Among other stunts, that means you can pause and rewind live TV and
record shows to watch on your schedule, not the one some network pro-
gramming exec has in mind.

Just because Apple hasn’t put a TV tuner in the Mac, the same cannot be said
of third-party companies. I recommend checking out the various EyeTV
options from Elgato Systems. Elgato’s step-up $200 EyeTV 250 Plus Digital TV
Recorder is futureproofed for the big switchoff in February 2009, when most
analog TV broadcasts will cease to exist in favor of digital broadcasts. And
EyeTV software gives you a lot of editing flexibility. Also check out Miglia’s
rival TVMini products at www.miglia.com.

Read Magazines

The next version of OS X, dubbed Snow Leopard, is on the way (and may
have hit the market by the time you read this). It’s practically a given stuff
will change. By its nature, technology is a scorching hot, competitive,
time-sensitive business, and Apple moves more quickly than most. So while I
trust the information in this book will prove useful for the foreseeable if not
long-term future, I have to admit some of the info will go stale. An excellent
way to stay current is to regularly peek at the prominent Mac-oriented
magazines, MacLife (formerly MacAddict) and Macworld. Yea, | know the way
to stay current is to go online (as the preceding chapter proved). But heck,
I'm still a print journalist and want the medium to continue to thrive.

Would You Like to Play
a Game of Chess?

Ah, the question posed by the (ultimately) defiant Hal 9000 computer in the
classic film 2001: A Space Odyssey. Turns out, your Mac can play a mean
game of chess too, without, as HAL did, turning on its human masters. The
Mac’s Chess program, found in the Applications folder, lets you compete
against the computer or a human partner.



Chapter 23: Ten Things to Leave You With 36 7

What’s more, by accessing Preferences in the Chess menu, you can change
the board style and pieces from the wooden board shown in Figure 23-3 to
grass, marble, or metal. You can also drag a slider inside Chess Preferences
to make the computer play faster or stronger.

Just like HAL, your Mac can speak as it makes its moves — in about two
dozen voices, no less, from Deranged (probably appropriate for HAL) to
Hysterical. Then again, you can speak back, so long as Allow Player to Speak
Moves is selected in Preferences. Try it out for size: “Pawn e2 to e4 to move
the white king’s pawn,” for example. Which leads me to the next section.

Edward Baig - Computer (2. .. e7-e5)

Figure 23-3:
Your move.
|

Speech Recognition

Are you the bossy type who likes to bark out orders? If so, you’ll love that the
Mac can respond to your spoken commands, everything from “Quit this
application” to “Switch to Finder.” And for people physically unable to type
or handle a mouse, speech recognition may be their only avenue to getting
things done on a computer.

Open System Preferences, again under the ® menu, and choose Speech.
Make sure the Speech Recognition pane is selected, as shown in Figure 23-4.
Now, click to turn on the Speakable Items button. A round microphone
feedback window appears on your desktop, with the key or keyword you
need to press to alert the Mac that you are about to speak. Press the Escape
key to start barking out commands.
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|
Figure 23-4:
The Mac

is all about
free speech.
|

\\j

| -

Speech
| [ showAll | Q

Speech Recognition Text to Speech

Speakable Items: =) On ) Off

! Settings  Commands

Microphone: Internal microphone 5 ] ¢ Calibrate... )

Listening Key: Esc { Change Key... |

Listening Method: '« Listen only while key is pressed
_ Listen continuously with keyword

Keyword is:
Keyword: Computer

Upon Recognition: z Speak command acknowledgement

Play this sound: Whit

To check out a list of the commands your computer can understand, click the
little triangle at the bottom of the feedback window and then click Open
Speech Commands window.

Click Calibrate to improve the performance of your internal (or connected)
microphone. The calibration process involves adjusting a slider and speaking
aloud the phrases listed on the screen (such as Open a document and Show
me what to say) until the computer makes these phrases blink in recognition.

If you want to have fun with speech, ask the Mac out loud to tell you a joke. It
will respond with a lame “Knock knock” joke like this one:

“Knock knock.”
“Who’s there?”
“Thistle.”
“Thistle who?”

“Thistle be my last knock knock joke.”

Thistle, um, be my last joke too.
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Back to My Mac feature, 205, 208-209
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cable modem, 147
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video out, 27
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Copy command, 22
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Countdown Plus widget, 352
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closing, 105
icon, 41
opening, 105
widgets, 104-107, 156-158, 351-355
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delete key, 21
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desktop. See also dock; windows
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overview, 16-17
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Detto Technologies, 324
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disruptive technology, 249
importing images from, 252-253
Digital Rights Management (DRM), 244
digital shoebox, 253, 270
Digital Subscriber Line (DSL), 147
digital video discs. See DVDs
Digital8 camcorders, 274
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disk images, 337
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Disk Utility drafts, saving in Mail, 170
creating disk images, 337 dragging and dropping, 19, 117
creating RAID scheme, 337 drivers, 135
fixing permissions, 336-338 DRM (Digital Rights Management), 244
overview, 336 DSL (Digital Subscriber Line), 147

DiskWarrior program, 346 ducking, 304-305

displays, 90 duplex printing, 134

disruptive technology, 249 duplicate photos, 253

DNS (Domain Name System), 344 DVDs (digital video discs)

dock authoring, 288
adding items to, 42 burning photos to, 270
hiding, 43 burning videos to, 291-292
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minimizing, 43 DVI output, 27
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quitting programs, 46 ® E o

Stacks, 43-46
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creating alias, 129-130
creating in TextEdit, 113-115
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dragging and dropping, 117
duplicating, 120
formatting, 123-125
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printing, 134-139
retrieving from trash bin, 129
revising, 127-128
saving, 126-127
scanning, 140
selecting pages of text, 117
selecting text in, 115-117
sending fax, 141-142
Undo Typing command, 117
Dogpile search engine, 161
Domain Name System (DNS), 344

dot matrix printers, 132 ;
double-clicking, 19 MobileMe, 205, 208
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data detectors, 182
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forwarding, 181
incoming, 174-175
ISP, 149
junk, 176-177
lower case letters, 173
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spell checking, 172
stationery, 169-170
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viewing photo slideshows, 181
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accounts with, 267
encryption, 217-218
End key, 21
Energy Saver, 64-65, 332
Enhance tool, 264-265
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Ethernet, 26
EV-DO (Evolution Data Optimized), 148
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iMovie, 278
iPhoto, 255-256
Events view, iPhoto, 250, 255
Evolution Data Optimized (EV-DO), 148
Expedia Web site, 202
Export Final Cut XML option, iMovie Share
menu, 287
Export Movie option, iMovie Share menu, 287
Export Song to Disk command, GarageBand,
307
Export Using QuickTime option, iMovie Share
menu, 287
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FAT file system, 328
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Fetch FTP software, 365
fiber-optic broadband, 147
file attachments, 170-171, 180
file extension, 126, 170
File Transfer Protocol (FTP), 364-365
files
attaching to e-mail, 170-171
backing up, 345
column view, 36-37
Cover Flow, 37-38
deleting, 345
icon view, 33-34
list view, 34-35
Quick Look, 38-39
restoring, 221
searching for, 95-104
Stacks, 43-46
zipped, 363-364
FileVault, 217-218
Finder, 30, 41, 100-102
FIOS network, 147
Firefox browser, 158
Firewire connector, 15, 26
flagging messages, Mail, 181
folders, 31-32
Font Book, 121-122
font cache files, 336
fonts. See also text
disabling, 122
Font Book, 121-122
overview, 119-120
previewing, 120
printing, 122-123
Force Quit, 333
forums, 197
forwarding e-mails, 181
frame ranges, 280
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free programs Google search engine, 159-161
Address Book, 47-49 Google Talk, 196
calculator, 51 GPS (Global Positioning System), 59
dictionary, 51 Grab utility, 365
iSync, 50 Grapher, 362
overview, 46-47 graphical user interface (GUI), 10
Preview, 52 Grid view, 231
QuickTime Player, 51 group account, 71
quitting, 46 guest account, 71
Stickies, 50 GUI (graphical user interface), 10
TextEdit, 51

Front Row software, 57

frozen programs i H o

Force Quit, 333

forcing restart, 335 .

overview, 332-333 hard d.rlve

- backing up, 208

program quits, 334-335 defined. 23

Safe boot, 335-336 ’
FTP (File Transfer Protocol), 364-365
full-screen edit mode, iPhoto, 261-262
function keys, 20

H.264 video standard, 194

disk images, 337
Disk Utility, 336-338
erasing, 337
partitioning, 337
repairing, 337
o G o restoring, 221
S.M.AR.T. status, 337-338
Gallery, MobileMe, 205, 210-211, 268-269, 287 troubleshooting, 332, 336-339

GarageBand HDV, 274
adding tracks, 294-297 headphones, 27
building arrangement, 299 Hewlett-Packard, 8
connecting MIDI instruments, 300 hint, password, 16
creating new project, 293-294 History menu, 156
creating podcasts, 303-304 home folder, 32
ducking, 304-305 Home key, 21
icon, 11, 41 home page, 151-152
importing video, 305 Hotmail, 164
loops, 298-299 hotspots, 312
Magic GarageBand feature, 301-302 hubs, 312
mixer controls, 300-301 Hurricane Tracker, 352-353
multitake recording, 299-300
overview, 293 ° 1 PY
sharing, 305-307

Gas widget, 352
Genius Bar, 347-348
Genius playlists, iTunes, 235 .
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IBM, 54
iBook, 58
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.mac account, 189
.me account, 189
networks, 189
overview, 188-189
parental control, 78
preferences, 192-193
requirements, 189
screen name and password, 189
screen sharing, 196
sharing files, 194-196
sharing tunes, 181
tabbed chats, 193
uses, 188-189
video chats, 194
iChat Theater, 194-196
icon view, 33-34
icons
aliases, 130
in dock, 40-43
overview, 31
used in book, 4
identity, creating, 16
iDisk, 205, 207
iDVD
altering buttons, 291
choosing themes, 289
creating slideshows, 289-290
icon, 41
Magic iDVD, 291
Map view, 291
OneStep DVD, 291
overview, 11, 288
iLife suite, 11
IM. See instant messaging
iMac
On button, 14
Front Row software, 57
hard drive, 24
iSight video camera, 57
overview, 56-57
RAM, 24
IMAP (Internet Mail Access Protocol), 166
iMixes, 241
iMovie. See also post-production, iMovie
burning DVD, 291-292
file formats, 274
icon, 41
iDVD, 288-291
importing video into, 273-276
overview, 271-272

recording directly to, 277-278
Share menu options, 287-288
shooting film, 272-273
source video, 280
iMovie HD, 271, 276
impact printer, 132
ink, running out of, 139
inkjet printers, 132
input methods, 95
insertion point, 113
Installed Updates, 91
installing Windows, 327-328
Instant Alpha feature, Preview, 52
instant messaging (IM). See also iChat AV
America Online, 186-187
buddy list, 188, 189-191
chatting, 191-193
disadvantage of, 188
iChat Theater, 194-196
lack of interoperability, 188
overview, 186-187
presence, 188
screen sharing, 196
video chats, 194
Intel processors, 54
interface, 18
Internet. See also iChat AV; Safari browser
alternative browsers, 158-159
blogs, 198-199
broadband, 146-148
chat rooms, 186
dating sites, 200
dial-up, 146
DNS errors, 344
e-commerce, 200-201
modem speed, 147
newsgroups, 197-198
online research, 201
online travel sites, 202
overview, 11-12, 145-146
search engines, 159-161
security, 213-217
social networking, 199
World Wide Web, 145
Internet Explorer, 158-159
Internet Mail Access Protocol (IMAP), 166
Internet radio, 237-238
Internet Relay Chat (IRC), 186
Internet Service Provider (ISP), 148-149
iPhone (3:2) aspect ratio, 282
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iPhone lite, 227-228

iPhone ringtone, 307

iPhoto
assigning keywords to photos, 257-258
assigning ratings, 258-259
burning photos to CDs and DVDs, 270
cards and calendars, 268
cropping images, 263-264
e-mailing pictures, 267

enhancing and adjusting photos, 264-265

Events view, 250, 255
finding pictures by date, 256-257
full-screen edit mode, 261-262
icon, 41
importing images, 252-253
iWeb, 269-270
library, 82
MobileMe Gallery, 268-269
opening, 251-252
overview, 11, 250
photo books, 267
Photo view, 251, 254
placing photos into albums, 259-260
reducing red-eye, 265
retouching photos, 264
rotating images, 262
skimming events, 255
slideshows, 265-266
smart albums, 260
special effects, 265
splitting and merging events, 255-256
straightening photos, 264
themed prints, 268
thumbnails, 254
touching up photos, 261-265
viewing pictures, 260-261
iPod
Classic, 226
connecting to Mac, 24
as external drive, 325
games, 248
iTunes, 226-228
loading tunes onto, 236
Nano, 226-227
recharging, 26
Shuffle, 227
Touch, 227-228
IRC (Internet Relay Chat), 186
iSight video camera, 56-57, 277-278
iSlayer.com iStat pro, 353

ISP (Internet Service Provider), 148-149
iStat pro, 353
iTunes

AirTunes, 316
allowances, 245
App Store, 248
audio file formats, 236
audiobooks, 246
Back button, 229
burning audio CDs with, 236-237
buying and renting movies, 247
buying music, 243-245
Cover Flow, 230
digital rights management, 244
Equalizer button, 231
Forward button, 229
functions, 229
games, 248
Genius playlists, 235
gifts, 245
Grid view, 231
icon, 41
iMixes, 241
importing audio files, 233
iPods, 226-228, 236
lectures, 248
online music recommendations, 239-241
opening, 229
playback control, 230
playlists, 233-234
podcasts, 246
remote control, 316
rendering movie, 287
ripping audio CDs, 232-233
searching for music, 241-243
sending GarageBand songs to, 307
sharing tunes, 191, 245
Shuffle button, 231
smart playlists, 234
tuning in to Internet radio, 237-238
video and TV shows, 247
visual effects, 232
volume slider, 230

iWeb
exporting photos to, 269-270
icon, 41
overview, 11, 210-211
podcasts, 306

iWeb Inspector, 306
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Jabber IDs, iChat, 189
Jobs, Steve, 14, 54
JPEG files, 253

junk mail, 176-177
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Ken Burns effect, iMovie, 286-287
Kensington Security lock cable, 27
kernel, 343-344
keyboard
function keys, 20
overview, 20
QWERTY style, 20
shortcuts, 22-23
useful keys, 21
keyboard-video-mouse (KVM) switch, 326
keychain, 218
keyloggers, 214
Keynote program, 37
Keyspan Express remote control, 316
kilobyte, 24
KVM (keyboard-video-mouse) switch, 326
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LAN (local-area network), 311
language, selecting, 14-15
Language tab, System Preferences, 363
laptop

advantages of, 55

batteries, 63-65

On button, 14

buying tips, 58

defined, 8

versus desktop, 55

energy saver, 64-65

F keys, 20

MacBook, 61

MacBook Air, 61

MacBook Pro, 59-60

modified, 59

sleep mode, 18

trackpad, 19, 62-63

traveling weight, 58
laser printers, 133
Last Import folder, iPhoto, 220

layout, print, 137
LCD display, 59, 90, 134
left-clicking, 19
Leopard OS X
default desktop, 30
dictionary, 51
iChat Theater, 194-196
new features, 94-95
overview, 93
Preview, 52
sidebar, 36
Spaces, 86-89

Spotlight desktop search, 95-104

welcome movie, 15
letterbox, 282
links, 151-152
list view, 34-35
local-area network (LAN), 311
locks, laptop, 27
logging in, 219
logging off, 81
logging out, 219
Login screen, 80
logs, parental control, 78
loop browser, 298
loops, 298-299
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.Mac. See MobileMe

Mac computers
buying, 8-9
connectors, 24-27
data and time settings, 16
graphical user interface, 10
hard drive, 23
keyboard, 20-23
memory, 24
mouse, 18-19
networking, 12
overview, 1-4, 7-8
peripherals, 9
registering, 16

replicating Windows on, 324-326

shutting down, 17

sleep mode, 18

tools, 10-11

troubleshooting, 12

turning on, 13-14
Mac mini, 57
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Mac OS 9, 340-341
Mac OS X
overview, 8
reinstalling, 339-340
versions, 31, 93
Mac Pro, 58
Mac technicians, 325
MacBook
defined, 8
features, 61
modified, 59
price, 61
MacBook Air
defined, 8
features, 61
price, 61
trackpad, 62-63
wireless migration with, 15
MacBook Pro
defined, 8
features, 59-60
hard drive, 24
price, 59
mac.com ID, 189
MacFixIt Web site, 358
MaclLife magazine, 366
MacOSX Hints Web site, 358
MacRumors Web site, 358
MacSales.com Web site, 359
MacSurfer Web site, 358-359
Macworld magazine, 366
Macworld Web site, 359
Magic GarageBand, 301-302
Magic iDVD, 291
Magnification slider, Dock, 42
MagSafe connector, 60
Mail. See also e-mail
account setup, 164-166
addressing messages, 166—-168
attachments, 170-171
composing message, 168-169
e-mailing pictures with, 267
getting most out of e-mail, 181-182
icon, 41
managing incoming mail, 174-178
MobileMe, 205
Notes, 183-184
opening attachments, 180
overview, 163-164
saving drafts, 170

searching, 180
setting rules, 178
signatures, 172
Smart Mailboxes, 179
spell checking, 172
stationery, 169-170
to-dos, 184
maintenance. See also troubleshooting
backing up files, 345
deleting unnecessary files and programs,
345
updating software, 345-346
malware, 213
Managed with Parental Controls account, 70
Map view, iDVD, 291
master password, 217
Match.com dating site, 200
Matte effect, iPhoto, 265
.mbox package, 181
McAfee Avert Labs, 213-214
.me account, 189
measures, beat ruler, 299
Media Browser, 287
Media Center, 366
memory, 24, 331
memory cards, 250
memory slot, 134
menu, 31
menu bar, 31
metadata, 97, 256
mice, 18-19, 341
Micro MV camcorder, 274
Microsoft Windows. See Windows operating
system
Microsoft Word format, 126
MIDI (Musical Instrument Digital Interface),
300
Miglia products, 366
migration
overview, 15
Time Machine, 222
Migration Assistant, 222
MIMO (Multiple In Multiple Out), 313
MiniDV camcorders, 273-274
Mini-DVI output, 27
Mixer, GarageBand, 300-301
MobileMe
Apple Backup, 208
back to My Mac, 208-209
blogs, 198



e-mail, 165, 208
features, 205
Gallery, 205, 210-211, 268-269, 287
iChat, 189
iDisk backups, 207
membership, 204
overview, 203-204
setting up, 205-206
signing up, 204
synchronizing e-mail, 181
ModBook, 59
modems
cable, 147
cellular broadband, 148
dial-up, 146
DSL, 147
FIOS, 147
satellite, 148
Mood Descriptor, GarageBand, 299
Motorola, 54
mouse, 18-19, 341
Move2Mac software, 324-325
movies
adding photos to, 286-287
adding to project, 282
aspect ratio, 282
audio adjustments, 281-282
burning to DVDs, 291-292
buying and renting, 247
cropping, 281
events, 278
exporting, 287-288
frame ranges, 280
marking, 279-281
music, 282-283
normalizing volume, 280
sharing, 287-288
skimming, 278-279
sound effects, 282-283
source, 280
titles, 286
transitions between clips, 285-286
trimming clips from, 284-285
Movies widget, 353
MP3 files, 236-237
MPEG-2, 274
MPEG-4, 274
MPEG-4 AAC, 236
MSN Hotmail, 164
MSN search engine, 161

multifunction devices, 9, 133
Multiple In Multiple Out (MIMO), 313
multitake recording, 299-300
multitasking, 24
music. See also GarageBand
adding to video, 282-283
digital rights management, 244
formats, 236
importing into iTunes, 233
searching for, 101-102
Musical Instrument Digital Interface (MIDI),
300
MySimon shopping site, 201
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netizens, 185
networking. See also Bluetooth; wireless
network

LAN, 311

overview, 12, 311

sharing, 317-318

WAN, 311

wired, 312
New Accounts window, 72
New Oxford American Dictionary, 51
newsgroups, 197-198
Notation view, GarageBand, 301
notebook computers. See laptop
Notes feature, Mail application, 183-184
NTEFS file system, 328
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On button, 14

One to One Training service, 348

OneStep DVD, iDVD, 291

online bulletin boards, 197

online gaming, 186

online music recommendations, 239-241

online research, 201

online scams, 175

online shopping, 200-201

online travel sites, 202

OnyX 1.9.6 for Mac OS X 10.5 program, 346

operating system. See Leopard OS X; OS X
operating system; Windows operating
system

Option key, 21
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Orbitz.com travel site, 202
organizers

Address Book, 47-48

iCal, 49

iSync, 50

Smart Groups, 48-49

Stickies, 50
OS 9 operating system, 340-341

OS X operating system. See also Leopard OS
X

overview, 8, 94
reinstalling, 339-340
versions, 31, 93

Other World Computing Web site, 359
Oxford American Writer’s Thesaurus, 51

oo

Page Down key, 21
Page Up key, 21
pages. See Web pages
paper

handling, 137

longevity of, 140

quality, 138

running out of, 139

type, 138
paper tray, 134
paragraphs, aligning, 124
parallel port, 134
Parallels Desktop software, 329
parental controls

content, 78

e-mail, 181

iChat, 78

ISP, 149

logs, 78

mail, 78

overview, 70

system, 77

time limits, 78

user accounts, 70
partitions, 337
password

creating, 16

keychain, 218

log on, 80-81

master, 217
Paste command, 22, 118

patch, 91
Paypal, 216
PDF files, viewing, 52
pearLyrics widget, 354
peripherals, 9
permissions, 336-338
phishing, 175, 215-216
phone jack, 26
Photo Booth
applying special effects, 75-76
overview, 73
sharing photos, 76-77
stock backdrops, 76
taking pictures, 74-75
thumbnail, 76-77
photo browser, iPhoto, 261-262
photos
adding to movies, 286-287
books, 267
burning to CDs and DVDs, 270
cards and calendars, 268
cropping, 263-264
duplicate, 253
e-mailing, 267
enhancing and adjusting, 264-265
file formats, 253
finding by date, 255-256
full-screen edit mode, 261-262
importing into iPhoto, 252-253
iWeb, 269-270
keywords, 257-258
metadata, 256
MobileMe Gallery, 210-211
ratings, 258-259
reducing red-eye, 265
retouching, 264
rotating, 262
Rule of Thirds, 263
sharing, 210-211, 270
slideshows, 181, 265-267
special effects, 265
straightening, 264
themed prints, 268
viewing, 250-251, 260-261
Photos view, iPhoto, 251
pillar box, 282
pixels, 90
playlists, iTunes, 233-235
.plist file, 335
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podcasts
backing track, 305
creating, 11, 303-305
downloading, 246
ducking, 304-305
iWeb Inspector, 306
lead track, 305
publishing, 305-306
talkshow, 304
video, 305
pointing devices, 10, 18
points, font, 120
POP (Post Office Protocol), 166
pop-up blocker, 154
portals, 151, 161
ports
defined, 24
Ethernet, 26
ExpressCard slot, 27
external monitor jack, 26
Firewire, 26
headphones, 27
locating, 25
lock, 27
parallel, 134
phone jack, 26
router, 312
USB, 25-26
video out, 27
video output jack, 26
Post Office Protocol (POP), 166
post-production, iMovie
adding photos to, 286-287
creating project, 282
cropping video, 281
improving sound, 281-282
music and sound effects, 282-283
overview, 278
playback, 279
Skimming feature, 278-279
sorting events, 278
titles, 286
transitions between clips, 285-286
trimming, 284-285
voiceovers, 283-284
working with video, 279-280
PowerBook, 58
PowerPC processors, 54
Preview, 41, 52
PriceGrabber shopping site, 201

printers
all-in-one, 133
choosing, 132-133
connecting and activating, 134
inkjet, 132
laser, 133
memory slot, 134
networking capabilities, 134
options, 137-138
overview, 9
paper trays, 134
previewing print, 138-139
setting up, 135-137
troubleshooting, 139
privacy policy, 15
private browsing, 156
private subfolders, 32
processor, 31, 53-54
Programmer calculator, 51
programs. See also bundled programs;
specific programs by name
troubleshooting, 342-343
updating, 345-346
Prosoft Data Rescue Il program, 346
Python language, 95

.Q.

Quick Look feature, 38-39
QuickTime Player, 41, 51, 287
QWERTY keyboard, 20
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RadioLover application, 238

RAID (Redundant Array of Independent
Disks), 337

random access memory (RAM), 24, 331

RAW files, 253

RBrowser FTP server, 365

Really Simple Syndication (RSS), 181, 198-199

rechargeable batteries, 64

Recovered Files folder, 344

Red-Eye tool, iPhoto, 265

Redundant Array of Independent Disks
(RAID), 337

refresh rate, 90

region, selecting, 15

regions, track, 299
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registration, 16 scanner, 9, 140

reinstalling OS X, 339-340 scheduler, 137

remote, Apple, 361-362 Scientific calculator, 51

resolution, 90 screen capture, 365

restarting computer, 335, 343-344 screen saver, 83-84

restoring computer, 221 screen sharing, 196

restricted subfolders, 32 scripting, 107

Retouch tool, iPhoto, 264 search engines

reverse phone lookup, 161 Dogpile, 161

Rich Text Format (RTF), 126 Google, 159-161

right-clicking, 19 MSN, 161

ringtone, iPhone, 307 Yahoo!, 161

ripping audio CDs, 232-233 Second Life chat setting, 186

RJ-11 connector, 312 security

RJ-45 connector, 312 encryption, 217-218

Rosetta technology, 54 FileVault, 217-218

routers, 312 firewalls, 216-217

RSS (Really Simple Syndication), 181, 198-199 Internet, 213-217

RTF (Rich Text Format), 126 keychain, 218

Ruby language, 95 logging in and out, 219

Rule of Thirds, 263 overview, 213
password management, 218
threats, 213-216

L S L Time Machine, 219-222

Self-Monitoring Analysis and Reporting
Technology (S.M.A.R.T.), 337-338

Send SMS widget, 354

Send Song to iTunes command, GarageBand,
307

Sepia effect, iPhoto, 265

serial number, 31

Share Screen option, Finder, 209

shareware, 106

icon. 41 sharing, network, 317-318
. Sharing Only account, 71

overview, 150-151 Sh

op-up blocker. 154 eepsaver softyvare, 341

pop-up b 7 156 Shopzilla Web site, 201

private browsing, Short Message Service (SMS), 354

reporting bug to Apple, 158 short name. 16

RSS subscriptions, 1399 shortcuts, keyboard, 22-23

SnapBack, 155 .
P Shuffle button, iTunes, 231
tabbed browsing, 155-156 shutting down, 17

toolbar, 151 sidebar. 36
using Web picture as desktop picture, 158 ionat ’ Mail. 172
Web clipping, 156-157 signatures, hatl,
Safe mode boc;ting in. 335-336 Simple Mail Transfer Protocol (SMTP), 166
satellite bl;oadband, 1’48 Sip g that iTune widget, 354
.saved extension, 334-335 ‘Slj[ ﬁle§, 364 . .
saving files, 126-127 skimming feature, iMovie, 278-279
scale. 297 ’ sleep mode, 18

Safari browser
address field, 151
bookmarks, 152-154
clicking links, 151-152
filling out forms, 155
finding terms or phrases in Web page,
154-155
History, 156
home page, 151-152
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slideshows, 181, 265-267, 289-290
S.M.A.R.T. (Self-Monitoring Analysis and
Reporting Technology), 337-338
Smart Folders, 103-104
Smart Groups, 48-49
smart links, 125
Smart Mailboxes, 179
smart photo album, 260
smart playlists, iTunes, 234
smart quotes, 124
SmithMicro Software, 364
SMS (Short Message Service), 354
SMTP (Simple Mail Transfer Protocol), 166
SnapBack, 155
snoopware, 214
social networking, 199
software, updating, 345-346
software drivers, 135
software instruments, 294-297
Software Update, 31, 91
songs
adding to video, 282-283
digital rights management, 244
formats, 236
importing into iTunes, 233
sound effects, 282-283
Sound Preferences, 90
source video, 280
Spaces
icon, 41
keyboard shortcut, 20
moving windows between, 89
organizing, 87
tips, 88-89
spam
avoiding, 177-178
categories, 175
filtering, 178
Speakable Items button, Speech Recognition,
367
speakers, volume control, 21
speech recognition, 367-368
spell checking
documents, 114
e-mail, 172
Spotlight
Boolean query, 100
calculator, 100
customizing search in, 98-100
dates, 100

definition, 100
Finder window, 100-102
intelligent searching, 98-100
launching application with, 97
metadata search, 97
overview, 95
preferences, 103
quotes and phrases, 100
search results, 97-98
searching with, 95-96, 180
Smart Folders, 103-104
Web history, 100
SpringCleaning 9.1.1 utility, 346
spyware, 214
Stacks
adding, 46
contextual menu, 44
icon, 41
opening, 44-46
overview, 43-44
Standard (4:3) aspect ratio, 282
Standard user account, 70
startup problems, troubleshooting, 339
stationery, Mail, 169-170
Stealth mode, 217
stores, Apple, 8-9
Straighten tool, iPhoto, 264
streaming audio, 238
Stuffit Expander, 363-364
subfolders, 32
subscriptions, RSS, 199
surfing. See Internet
surge protector, 18
switches, 312
switching to Macs
burning data to CDs or DVDs, 325
certified Mac technician, 325
external hard drives, 325
KVM switch, 326
Move2Mac software, 324-325
using existing network, 325-326
synchronizing, 50
System Preferences
Accounts, 71
clock, 90
Desktop & Screen Saver, 82-83
displays, 90
Exposé & Spaces, 86-87
Firewall, 216
icon, 41
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System Preferences (continued)
MobileMe, 205-206
overview, 89
Print & Fax, 138, 142
Software Update, 91
sound, 90
Spotlight, 103
Universal Access, 91-92

System Profiler, 31
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tabbed browsing, 155-156
tables, creating, 124

talkshow, 304

tape-based camcorders, 274-275
TCP buffer size, 95

technical support. See also troubleshooting

AppleCare, 347
Genius Bar, 347
One to One Training, 348
tips, 348
technicians, Mac, 325
TechToolPro program, 346
templates, iWeb, 269
tempo, 297
temporary files, 344
temporary storage, 24
terabyte, 24
Terminal program, 94
text
changing fonts, 119-120
cutting and pasting, 118
dragging and dropping, 117-118
locating, 124
selecting, 115-116
spell checking, 114
TextEdit
creating document, 113-115
fonts, 119-123
formatting, 123-125
overview, 51, 112
printing, 134-139
saving document, 126-127
selecting text in document, 115-117
The Unofficial Apple Weblog (tuaw)
Web site, 359
themed prints, 268
third-party software, 346

thumbnails, 76-77, 254
TIFF files, 253
Time Capsule appliance, 220, 313
time limits, parental controls, 78
Time Machine
additional hard drive for, 23
backing up, 220
icon, 41
migrating data with, 222
overview, 219
restoring computer with, 221
restoring lost files, 221
setting up, 219-220
wireless companion, 220
time zone, 16
titles, movie, 286
to-dos, Mail application, 184
toner, 133, 139
Top Songs list, iTunes, 242
Track Editor, GarageBand, 301
Track Info pane, GarageBand, 296-297
trackpad, 19, 62-63
Tracks list, GarageBand, 295
trademark infringement, 14
transitions, iMovie, 285-286
Transmit3 FTP server, 365
trash, 41
trash bin, 128-129
Travel Widgets, 352
traveling weight, laptop, 58
Travelocity travel site, 202
trimmer, iMovie, 284-285
TripAdvisor Web site, 202
troubleshooting. See also Time Machine
clock and date, 342
disk problems, 336-339
DNS error, 344
Empty Trash, 344
frozen programs, 332-336
incoming mail, 174-175
kernel, 343-344
lost files, 221
mouse, 341
overview, 12
printers, 139
reinstalling OS X, 339-340
restoring computer, 221
slowness, 331-332
startup problems, 339
stuck CD, 341-342
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third-party software, 346
when wrong program opens, 342-343
tuaw (The Unofficial Apple Weblog)
Web site, 359
turning off, 17
turning on, 13-14
TV tuner, 366
TVMini products, 366
two-sided printing, 134
type size, font, 120
TypePad service, 198

olf o

Uniform Resource Locator (URL), 151
Universal Access, 91-92
Universal software applications, 54
UNIX operating system, 94
upload speed, 147
URL (Uniform Resource Locator), 151
USB hub, 25
USB ports, 25-26
USB-TO-USB cable, 324
Use Image as Desktop Picture command, 158
Usenet, 197
user accounts
administrator, 70
creating, 16, 71-73
deleting, 81-82
fast user switching, 81
login options, 80-81
parental control, 70, 77-79
password, 80-81
picture, 76
ranking, 70
sharing only, 71
standard, 70
User font grouping, Font Book, 121

oo

Verify Disk operation, 337
VersionTracker Web site, 359
video
adding photos to, 286-287
adding to project, 282
aspect ratio, 282
audio adjustments, 281-282

burning to DVD, 291-292
cropping, 281
events, 278
exporting, 287-288
frame ranges, 280
importing into iMovie, 273-276
marking, 279-281
music, 282-283
normalizing volume, 280
playback, 279
podcasts, 305
sharing, 287-288
skimming, 278-279
sound effects, 282-283
source, 280
titles, 286
transitions between clips, 285-286
trimming, 284-285
video chats, 194
video out, 27
video output jack, 26
View Options window, 34
views
column, 36-37
Cover Flow, 37-38
icon, 33-34
list, 34-35
Vignette effect, iPhoto, 265
Vintage Vinyl theme, iDVD, 289
virtual machine, 329
virtual memory, 219
viruses, 12, 214
VMWare Fusion, 329
Voice Enhancement box, iMovie, 284-285
voiceover, recording, 284-285
volume control, 21

o[/ o

Wacom pen, 59
WAN (wide-area network), 311
WAV files, 236
WDS (Wireless Distribution System), 316
weather forecast, 161
Web browser. See also Safari browser
Firefox, 158
Google Chrome, 158
iCab, 158
Internet Explorer, 158-159
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Web e-mail, 164
Web pages. See also Internet
clipping, 156-158
finding terms or phrases in, 154-155
forms, 155
links, 151-152
pop-ups, 154
private browsing, 156
returning to starting point, 155
tabbed browsing, 155-156
Web publishing, 205
Web sites
Apple.com, 360
Applelnsider, 357
camcorders, 273
MacFixIt, 358
MacOSX Hints, 358
MacRumors, 358
MacSurfer, 358-359
Macworld, 359
third-party software, 346
The Unofficial Apple Weblog, 359
VersionTracker, 359
webcams, 186
welcome screen, 16
wide-area network (WAN), 311
Widescreen (16:9) aspect ratio, 282
widgets
bar, 106
Cocktail, 351-352
Countdown Plus, 352
creating, 156-158
downloads, 105-107
Gas, 352
Hurricane Tracker, 352-353
icons, 105
iStat pro, 353
Movies, 353-354
overview, 104-105
pearLyrics, 354
rearranging, 107
Send SMS, 354
Sing that iTune, 354
tips, 106-107
Wikipedia, 354
Word of the Day, 355
Wi-Fi, 314
Wikipedia, 201, 354

wikis, 201
windows
closing, 43
hiding, 85
minimizing, 43
moving between spaces, 89
opening, 85
overview, 31-32
Quick Look, 38-39
views, 32-38
Windows operating system
Boot Camp, 326-329
versus Mac OS X, 8
overview, 323-324
switching to Macs from PCs using, 324-326
wired network, 312
wireless broadband, 148
Wireless Distribution System (WDS), 316
wireless mouse, 18
wireless network. See also AirPort; Bluetooth
AirTunes, 316
overview, 312
testing, 316-317
Wi-Fi, 314
Word of the Day widget, 355
word processing, 112. See also TextEdit
WordPress service, 198
workflow, 108-109
World Wide Web, 145
writing direction, 124
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XML feeds, 181, 199
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Yahoo! Mail, 164

Yahoo! Personals, 200
Yahoo! search engine, 161
YouTube, 287
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zipped files, 363-364
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